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Bio-Rad Tehniskais atbalsts
Bio-Rad tehniskā atbalsta dienesta ASV darba laiks ir no pirmdienas līdz piektdienai, no plkst. 05.00
līdz 17.00 PT.

Tālrunis: 1-800-424-6723, 2. opcija

E-pasts: Support@bio-rad.com (tikai ASV/Kanāda)

Lai saņemtu tehnisko palīdzību ārpus ASV un Kanādas, sazinieties ar savu vietējo tehniskā atbalsta
biroju vai noklikšķiniet uz saites Contact Us (Sazinieties ar mums) vietnē www.bio-rad.com.

Paziņojums
Nevienu šīs publikācijas daļu nedrīkst reproducēt vai pārsūtīt nekādā formā un ne ar kādiem
elektroniskiem vai mehāniskiem līdzekļiem, tostarp fotokopēšanu, ierakstīšanu vai kādu citu
informācijas glabāšanas vai izgūšanas sistēmu, bez Bio-Rad rakstiskas atļaujas.

Bio-Rad patur tiesības jebkurā laikā modificēt savus izstrādājumus un pakalpojumus. Šī rokasgrāmata
var tikt pārveidota bez iepriekšēja brīdinājuma. Lai gan šī informācija ir sagatavota, lai nodrošinātu
precizitāti, Bio-Rad neuzņemas nekādu atbildību par kļūdām vai izlaidumiem, vai par kādu kaitējumu,
kas izriet no šīs informācijas piemērošanas vai lietojuma.

BIO-RAD ir Bio-Rad Laboratories, Inc. preču zīme

BIO-RAD, HARD-SHELL un MICROSEAL ir Bio-Rad Laboratories, Inc. preču zīmes noteiktās
jurisdikcijās.

SYBR ir Thermo Fisher Scientific Inc. preču zīme. Bio-Rad Laboratories, Inc. ir licence pārdot
reaģentus, kas satur SYBR Green, lietojumam reāllaika PCR tikai zinātniskās pētniecības nolūkos.

EvaGreen ir Biotium Inc. preču zīme. Bio-Rad Laboratories, Inc. ir Biotium Inc. izsniegta licence pārdot
reaģentus, kas satur EvaGreen krāsvielu lietojumam reāllaika PCR tikai zinātniskās pētniecības
nolūkos.

Visas pārējās šajā dokumentā lietotās preču zīmes pieder attiecīgajiem to īpašniekiem.

Autortiesības © 2022 pieder Bio-Rad Laboratories, Inc. Visas tiesības paturētas.

http://www.bio-rad.com/


Paredzētā lietošana

Paredzētā lietošana
CFX96 Dx sistēma un CFX96 DeepWell Dx sistēma ar CFX Manager Dx programmatūru ir
paredzētas PCR veikšanai ar fluorescences analīzi, lai noteiktu kvantitatīvās nukleīnskābes
sekvences. Paredzēts, ka sistēmas un programmatūru in vitro diagnostikā lietos apmācīti laboratoriju
tehniķi. Sistēmas ir paredzētas lietošanai ar trešo pušu diagnostikas nukleīnskābes testiem, kas ražoti
un marķēti diagnostikas nolūkiem.

Lexicon simboli
Svarīgi! Būtiskas izmaiņas ir izceltas!

Ražotājs Partijas numurs

Izlietot līdz Lietošanai in vitro diagnostikā

Temperatūras ierobežojumi Kataloga numurs

Meklējiet lietošanas instrukcijās Testu skaits

Lietošanai ar Sērijas numurs

Tikai ar recepti Satur lateksu
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CEmarķējums – Regula (ES) 2017/746
par in vitro diagnostikas medicīnas

ierīcēm

Tulkojumi
Produkta dokumenti var tikt nodrošināti papildu valodās elektroniskā formā.
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Drošuma un normatīvā atbilstība
Lai CFX96 Dx sistēma vai CFX96 DeepWell Dx sistēma ar CFX Manager Dx programmatūru, turpmāk
šajā dokumentā saukta CFX Dx system, darbotos droši, Bio-Rad ļoti iesaka, lai jūs ievērojat šajā sadaļā
un visā rokasgrāmatā uzskaitītās drošuma specifikācijas.

Svarīgi! CFX96 Dx un CFX96 DeepWell Dx sistēmas ir apstiprinātas lietojumam kā in vitro
diagnosticēšanas (IVD) medicīniskās ierīces.

Drošuma brīdinājumu etiķetes
Uz instrumenta un šajā rokasgrāmatā izvietotās brīdinājumu etiķetes brīdina jūs par fiziskas traumas
vai kaitējuma avotiem. 1. tabula definēta katra drošuma brīdinājuma etiķete.

Ikona Nozīme

Brīdinājums par fiziskas traumas vai iekārtas sabojāšanas risku
CFX Dx sistēmas ekspluatēšana pirms šīs rokasgrāmatas lasīšanas var radīt
fiziskas traumas risku. Droša lietojuma nolūkā nedarbiniet šo instrumentu nekādā
citā veidā, kas nav norādīts šajā rokasgrāmatā. Ar šo instrumentu drīkst strādāt tikai
kvalificēts laboratorijas personāls, kas apmācīts drošā darbā ar elektroiekārtām.
Vienmēr ar visiem sistēmas komponentiem darbojieties rūpīgi un ar tīrām, sausām
rokām.

Brīdinājums par rīkošanos ar bioloģiski bīstamiem materiāliem
Rīkojoties ar bioloģiski bīstamiem paraugiem, ņemiet vērā ieteiktos piesardzības
pasākumus un vadlīnijas un ievērojiet visas vietējās vadlīnijas konkrēti jūsu
laboratorijai un atrašanās vietai.

Brīdinājums par apdegumu risku
DNS amplifikators ģenerē pietiekami lielu karstumu, lai radītu smagus apdegumus.
Darba laikā vienmēr valkājiet aizsargbrilles vai kādu citu acu aizsardzības līdzekli.
Vienmēr uzgaidiet, līdz paraugu bloks atgūst gaidstāves temperatūru, un tikai tad
veriet vaļā vāku un izņemiet paraugus. Vienmēr saglabājiet maksimālu atstatumu,
lai nepieļautu netīšus ādas apdegumus.

1. tabula. Drošuma brīdinājumu etiķešu nozīme
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Drošuma un normatīvā atbilstība

Ikona Nozīme

Brīdinājums par sprādzienbīstamību
Parastas ekspluatācijas laikā paraugu bloki var sakarst pietiekami, lai šķidrumi sāktu
vārīties un eksplodētu.

1. tabula. Drošuma brīdinājumu etiķešu nozīme, turpinājums

Droša lietojuma specifikācijas un atbilstība
2. tabula uzskaitītas droša lietojuma specifikācijas attiecībā uz Bio-Rad CFX Dx reāllaika PCR
noteikšanas sistēmām. Lai nodrošinātu atbilstību A klases FCC ierobežojumiem, ar šiem
instrumentiem jālieto piegādātie ekranētie kabeļi.

Lietojuma aspekts Droša lietojuma nosacījumi

Nominālā ievades jauda 100–240 VAC, 50–60 Hz, 850Wmaks.

Pārsprieguma kategorija II

Drošinātāji 10 A, 250 V, 5 x 20 mm, ātra izdegšana (daudz. 2)

Darba vide Lietot tikai iekštelpās

Darba temperatūra 15–31 °C

Glabāšanas temperatūra no -20 °C līdz 60 °C

Relatīvais mitrums Līdz 80 % (bez kondensēšanās)

Augstums virs jūras līmeņa Līdz 2000 metriem virs jūras līmeņa

Piesārņojuma pakāpe 2

2. tabula. Droša lietojuma nosacījumi
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Apdraudējumi

Normatīvā atbilstība
CFX Dx reāllaika PCR noteikšanas sistēma ir testēta un atzīta par atbilstošu visām spēkā esošajām
šādu drošuma un elektromagnētisko standartu prasībām:

n IEC 61010-1:2010 (3. izd.), EN61010-1:2010 (3. izd.). Elektriskās iekārtas mērīšanai, kontrolei un
laboratorijas lietojumam— 1. daļa. Vispārējās prasības

n IEC 61010-2-010:2014, EN 61010-2-010:2014. Drošuma prasības attiecībā uz elektriskajām
iekārtām mērīšanai, kontrolei un laboratorijas lietojumam. 2-010. daļa: Īpašas prasības attiecībā
uz laboratorijas iekārtām materiālu karsēšanai

n IEC 61010-2-081:2015, EN 61010-2-081:2015. Drošuma prasības attiecībā uz elektriskajām
iekārtām mērīšanai, kontrolei un laboratorijas lietojumam. 2-081. daļa: Īpašas prasības attiecībā
uz automātiskajām un pusautomātiskajās laboratorijas iekārtām analīzei un citiem nolūkiem
(ietver 1. grozījumu)

n IEC 61010-2-101:2015 (2. izd.). Drošuma prasības attiecībā uz elektriskajām iekārtām mērīšanai,
kontrolei un laboratorijas lietojumam. Īpašas prasības attiecībā uz in vitro diagnosticēšanas (IVD)
medicīniskajām iekārtām

n IEC 61326-1:2012 (A klase), EN 61326-1:2013 (A klase). Elektriskās iekārtas mērīšanai, kontrolei
un laboratorijas lietojumam. EMS prasības, 1. daļa. Vispārējās prasības

n IEC 61326-2-6:2012, EN 61326-2-6:2013 (A klase). Elektriskās iekārtas mērīšanai, kontrolei un
laboratorijas lietojumam. EMS prasības. Īpašas prasības attiecībā uz in vitro diagnosticēšanas
(IVD) medicīniskajām iekārtām

Svarīgi! Šī iekārta ģenerē, lieto un var izstarot radiofrekvenču enerģiju, un, ja tā nav uzstādīta un
netiek lietota saskaņā ar nodrošināto instruējošo dokumentāciju, var izraisīt kaitīgus radiosakaru
traucējumus. Sistēmu darbināšana dzīvojamā rajonā, iespējams, radīs kaitīgus traucējumus, un
tādā gadījumā no lietotājiem tiks prasīts novērst šādus traucējumus uz sava rēķina.

Apdraudējumi
CFX Dx reāllaika PCR noteikšanas sistēma ir paredzēta, lai droši darbotos, kad to lieto veidā, ko
noteicis ražotājs. Ja CFX Dx reāllaika PCR noteikšanas sistēmu vai kādu no tā komponentiem
izmanto veidā, kuru nav norādījis ražotājs, raksturīgā aizsardzība, ko nodrošina instruments, var tikt
traucēta. Bio-Rad Laboratories, Inc. nav atbildīga par jebkādu traumu vai kaitējumu, ko izraisījusi šī
aprīkojuma izmantošana jebkādā nenorādītā veidā vai instrumenta pārveidojumi, kurus nav veicis Bio-
Rad vai pilnvarotais pārstāvis. CFX Dx reāllaika PCR noteikšanas sistēmas apkope jāveic tikai
apmācītam Bio-Rad personālam.
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Drošuma un normatīvā atbilstība

Bioloģiskie apdraudējumi
CFX Dx reāllaika PCR noteikšanas sistēma ir laboratorijas produkts. Tomēr, ja strādājat ar bioloģiski
bīstamiem paraugiem, rīkojieties saskaņā ar vietējiem noteikumiem un vadlīnijām konkrēti jūsu
laboratorijai, kā arī pildiet turpmākos norādījumus.

Piezīme. Parastajās šī instrumenta darbībās nekādu bioloģiski bīstamu vielu izplūde nenotiek.

Vispārējie piesardzības pasākumi

n Vienmēr valkājiet laboratorijas virssvārci, laboratorijas cimdus un aizsargbrilles ar sānu vairogiem
vai cieši piegulošās aizsargbrilles.

n Nepieļaujiet roku saskari ar muti, degunu un acīm.

n Pirms darba ar potenciāli infekcioziem materiāliem nodrošiniet, lai jebkādas brūces vai nobrāzumi
būtu pilnībā pasargāti.

n Pirms aiziešanas no laboratorijas un pēc darba ar potenciāli infekciozu materiālu rūpīgi
nomazgājiet rokas ar ziepēm un ūdeni.

n Pirms strādāšanas pie darba galda noņemiet rokas pulksteni un rotaslietas.

n Glabājiet visus infekciozos vai potenciāli infekciozos materiālus neplīstošos hermētiskos
konteineros.

n Pirms laboratorijas atstāšanas novelciet aizsargapģērbu.

n Nedrīkst ar uzvilktu cimdu rokā rakstīt, atbildēt uz tālruņa zvanu, ieslēgt gaismas slēdzi vai
pieskarties kaut kam tādam, kam citi cilvēki var pieskarties bez cimdiem.

n Cimdus mainiet bieži. Ja cimdi ir acīmredzami piesārņoti, tie nekavējoties jānovelk.

n Materiālus, kurus nevar pienācīgi attīrīt, nedrīkst pakļaut potenciāli infekciozu materiālu
iedarbībai.

n Pabeidzot darbu ar bioloģiski bīstamiemmateriāliem, notīriet darba zonu ar atbilstošu
dezinfekcijas līdzekli (piem., ar 1:10 atšķaidītu sadzīves balināšanas līdzekli).

Konkrēti IVD piesardzības pasākumi

n Visi pacientu paraugi ir potenciāli bioloģiski bīstami materiāli, tāpēc ar tiem atbilstoši jāstrādā,
piemērojot universālos drošības pasākumus.

n Parastas šī instrumenta darbības laikā nekādu bioloģiski bīstamu vielu izplūde nenotiek.
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Apdraudējumi

Virsmas atsārņošana

BRĪDINĀJUMS! Lai nepieļautu elektriskā trieciena risku, pirms atsārņošanas
procedūru veikšanas vienmēr izslēdziet instrumentu un atvienojiet no elektrotīkla.

Nosauktos laukumus var tīrīt ar jebkādu slimnīcas kategorijas baktericīdu, virucīdu vai fungicīdu
dezinfekcijas līdzekli:

n Ārējais vāks un šasija

n Iekšējā reakcijas bloka virsma un reakcijas bloka iedobes

n Vadības panelis un displejs

Lai sagatavotu un lietotu dezinfekcijas līdzekli, skatiet produkta ražotāja sniegtās instrukcijas. Vienmēr
pēc dezinfekcijas līdzekļa lietošanas vairākas reizes skalojiet reakcijas bloku un reakcijas bloka
iedobes ar ūdeni. Pēc skalošanas ar ūdeni rūpīgi nosusiniet reakcijas bloku un reakcijas bloka
iedobes.

Svarīgi! Nelietojiet abrazīvus vai kodīgus mazgāšanas līdzekļus vai spēcīgus sārmainus
šķīdumus. Šie līdzekļi var saskrāpēt virsmas un sabojāt reakcijas bloku, attiecīgi sagraujot
precīzu termisko kontroli.

Bioloģiski bīstamu materiālu utilizācija

Tālāk norādītos potenciāli piesārņotus materiālus utilizējiet saskaņā ar vietējiem, reģionālajiem un
valsts laboratorijas prakses noteikumiem:

n Klīniskie paraugi.

n Reaģenti

n Izlietoti reakciju trauki vai citi palīgmateriāli, kas var tikt piesārņoti.

Ķīmiskais apdraudējums
CFX Dx reāllaika PCR noteikšanas sistēma nesatur potenciāli bīstamus ķīmiskos materiālus.

Sprādzienbīstamības vai uzliesmojamības apdraudējumi
CFX Dx reāllaika PCR noteikšanas sistēma nerada nekādu neparastu apdraudējumu, kas saistīts ar
uzliesmojamību vai sprādzienbīstamību, ja to lieto pareizi, atbilstoši Bio-Rad Laboratories
norādījumiem.

Lietošanas rokasgrāmata | 17



Drošuma un normatīvā atbilstība

Elektrīiskās strāvas riska faktori
CFX Dx reāllaika PCR noteikšanas sistēma nerada neparastu elektrisko apdraudējumi operatoriem, ja
tā ir uzstādīta un darbināta pareizi, neveicot fiziskus pārveidojumu, kā arī pieslēgta barošanas avotam
ar atbilstošiem parametriem.

Transportēšana
Pirms CFX Dx reāllaika PCR noteikšanas sistēmas, tā optiskās reakcijas moduļa vai DNS
amplifikatora pamatnes pārvietošanas vai transportēšanas jāveic atsārņošanas procedūra. CFX Dx
reāllaika PCR noteikšanas sistēmu un optiskās reakcijas moduli vienmēr pārvietojiet vai transportējiet
atsevišķos konteineros kopā ar komplektācijā ietilpstošajiem iepakojuma materiāliem, kas aizsargās
instrumentu pret bojājumiem. Ja pienācīgi konteineri nav atrodami, sazinieties ar vietējo Bio-Rad
biroju.

Akumulators
CFX Dx system DNS amplifikatorā tiek lietota 3 V litija metāla monētveida baterija un 4,8 V
niķeļa-metāla hibrīdais atkārtoti uzlādējamais akumulators, lai saglabātu laika iestatījumus un darba
datus maiņstrāvas energoapgādes pārtraukuma gadījumā. Ja laika un/vai darba dati nepaliek iestatīti
pēc tam, kad ierīce tiek izslēgta, tā var būt norāde uz to, ka akumulators/baterija izlādējas. ja tā notiek,
sazinieties ar Bio-Rad tehniskā atbalsta dienestu, lai saņemtu palīdzību.

Nemēģiniet mainīt bateriju/akumulatoru. Sazinieties ar Bio-Rad tehniskā atbalsta dienestu.

Utilizācija
CFX Dx reāllaika PCR noteikšanas sistēma satur elektromateriālus; tie jāutilizē kā nešķiroti atkritumi
un jāsavāc atsevišķi saskaņā ar Eiropas Savienības Direktīvu 2012/19/ES par elektrisko un
elektronisko iekārtu atkritumiem—EEIA direktīvu. Pirms utilizācijas sazinieties ar vietējo Bio-
Rad pārstāvi, lai saņemtu valstij specifiskus norādījumus.

Garantija
Uz CFX Dx reāllaika PCR noteikšanas sistēmu un ar to saistītajiem piederumiem attiecas standarta
Bio-Rad garantija. Lai iegūtu papildu informāciju par garantiju, sazinieties ar vietējo Bio-Rad biroju.

18 | CFX96 Dx un CFX96 DeepWell Dx sistēmas



1. nodaļa. Ievads
Bio-Rad CFX Dx reāllaika PCR amplifikācijas sistēmas in vitro diagnostikai (IVD) piedāvā jaunākos
tehnoloģijas sasniegumus, ļaujot veikt PCR kvantitatīvo noteikšanu ar standarta līkni, gēnu
ekspresijas analīzi, alēlisko diskrimināciju un galapunkta analīzi.

CFX Dx sistēmas veido divi aparatūras moduļi un programmatūra:

n CFX96 Dx vai CFX96 DeepWell Dx optiskās reakcijas modulis (ORM)

n C1000 Dx DNS amplifikatora

n CFXManager Dx programmatūra

Izmantojot kopā ar CFX Manager Dx programmatūru, jūs varat veikt tālāk norādīto.

n Ģenerēt tūlītējus rezultātus ar rīku Startup Wizard (Startēšanas vednis)

n Ievadīt vai rediģēt informāciju par iedobēm pirms izpildes, izpildes laikā un pēc izpildes

n Interpretēt sarežģītus datus un izskaidrot gēnu ekspresijas pētījumu, izmantojot rīkus, piemēram,
PrimePCR kontroles materiālu analīzi, un atsauces gēnu atlasītāju.

n Sagatavot visaptverošas atskaites par reāllaika PCR datiem.

CFX Dx PCR noteikšanas sistēmas
3. tabula uzskaitīti Bio-Rad IVD PCR produkti, ko piegādā ar CFX Dx system.

Piezīme. CFX Dx system piegādā ar CFX Manager Dx programmatūru, C1000 Dx DNS
amplifikatora un vai nu CFX96 Dx, vai CFX96 DeepWell Dx optiskās reakcijas moduli.

Kataloga Nr. Apraksts

1845097-IVD CFX96 Dx ORM *

1844095-IVD CFX96 DeepWell Dx ORM

1841000-IVD C1000 Dx DNS amplifikatora

12007917 CFX Manager Dx programmatūra v3.1

3. tabula. CFX IVD PCR noteikšanas sistēmas

* Optiskās reakcijas modulis
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1. nodaļa. Ievads

Papildu informācija
Šajā dokumentā izskaidrots, kā droši iestatīt un darbināt CFX96 Dx un CFX96 DeepWell Dx reāllaika
PCR noteikšanas sistēmas ar CE-IVD marķējumu. Šajā dokumentā šīs sistēmas tiek sauktas par CFX
Dx system. Turklāt šajā dokumentā paskaidrots, kā lietot CFX Manager Dx software ar CFX Dx
system.

Padoms. Noklikšķiniet uz Bio-Rad logotipa jebkura CFX Manager Dx software loga augšējā
labajā stūrī, lai palaistu Bio-Rad tīmekļa vietni. Šajā vietnē ir saites uz tehniskām piezīmēm,
rokasgrāmatām, informāciju par produktiem un tehnisko atbalstu. Šajā vietnē nodrošināti arī
daudzi tehniski resursi par trauciņu metožu un pielietojumu dažādību saistībā ar PCR, reāllaika
PCR un gēnu ekspresiju.
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2. nodaļa. C1000 Dx DNS amplifikatora
iestatīšana

Šajā nodaļā izskaidrots, kā iestatīt CFX Dx system C1000 Dx DNS amplifikatoru jūsu darba vietā.

Padoms. Pirms DNS amplifikatora iestatīšanas iepazīstieties ar DNS amplifikatoru un tā optisko
reakcijas moduli, portiem un piederumiem.

Prasības attiecībā uz uzstādīšanas vietu
Šajā sadaļā redzamajās tabulās ir uzskaitītas prasības attiecībā uz telpām, apkārtējās vides
aizsardzību un barošanu, kurām jāatbilst, lai veiksmīgi uzstādītu un izmantotu DNS amplifikatoru CFX
Dx system.

Piezīme. Uzstādiet DNS amplifikatoru CFX Dx system uz līdzenas, sausas virsmas ar pietiekamu
vēsa gaisa plūsmu, lai tas darbotos pareizi.

Prasības attiecībā uz vietu uz galda

Vienums Tehniskie dati

Ieejas jauda Līdz 850W, maksimums

Frekvence 50–60 Hz, vienfāzes

USB porti 5 A, 1 B

Izmēri P: 13 collas; 33 cm

D: 18 collas; 46 cm

A: 14 collas; 36 cm

Svars 47 mārciņas; 21 kg

4. tabula. Prasības attiecībā uzCFX Dx system DNS amplifikatoru paredzēto vietu uz galda
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2. nodaļa. C1000 Dx DNS amplifikatora iestatīšana

Darba vides prasības

Parametrs Diapazons Mitruma diapazons

Ekspluatācijas apstākļi 15–31 °C

59–87,8 °F

0–80 % (relatīvais mitrums),
nekondensējošs

Uzglabāšanas apstākļi 15–31 °C

59–87,8 °F

0–80 % (relatīvais mitrums),
nekondensējošs

5. tabula. CFX Dx system DNS amplifikatora darba vides prasības

Strāvas prasības
CFX Dx system DNS amplifikatora barošanai jābūt stabilai un jāatbilst tehniskajiem datiem, lai
nodrošinātu pareizu darbību. Barošanas vada, kas pievienots barošanas ievadam, nominālajam
strāvas stiprumam jābūt 7 A vai vairāk.

Vienums Tehniskie dati

Elektrotīkla spriegums 100–240 V, maiņstrāva; 50–60 Hz, vienfāzes

Maksimālā jauda <850 vati

Barošanas kontaktligzdu skaits Ne mazāk par 2 barošanas kontaktligzdām:

n 1 kontaktligzda DNS amplifikatoram;

n 1 kontaktligzda datoram, kurā darbojas CFX Manager Dx
programmatūra.

6. tabula. Prasības attiecībā uz CFX Dx system barošanu
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Sistēmas pārskats

Sistēmas pārskats
Šajā sadaļā redzamajās ilustrācijās tiek parādīti DNS amplifikatora C1000 Dx galvenie komponenti.

Priekšskats

1. Optiskās reakcijas modulis— ietver optisko sistēmu, lai vāktu fluorescences datus, un
DNS amplifikatora bloku. CFX Dx reāllaika PCR noteikšanas sistēmas atbalsta CFX96 vai
CFX96 DeepWell Dx moduli.

2. Statusa LED—norāda, kad tiek izmantots bloks.

3. Vāka poga—atver un aizver optiskās reakcijas moduļa vāku un hermetizē reakcijas
kameru.

4. DNS amplifikatora C1000 Dx pamatne—nodrošina sistēmas barošanu sakarus un
ietver optiskās reakcijas modeļus CFX96 Dx un CFX96 DeepWell.

5. Priekšējā paneļa displejs un pogas— ļauj kontrolēt sistēmu savrupā režīmā.

Svarīgi! Lai nodrošinātu in vitro diagnostikas gēnu pētījuma datu integritāti, CFX
Manager Dx programmatūra neatbalsta datus, kurus DNS amplifikators ir ģenerējis
savrupā režīmā.

6. Apsildīts iekšējais vāks—uztur vāka temperatūru, lai nepieļautu kondensāciju un
iztvaikošanu.

7. Parauga/reakcijas bloks—notur reakciju trauku, tostarp mēģenes un mikrotrauciņi.

APZĪMĒJUMI
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2. nodaļa. C1000 Dx DNS amplifikatora iestatīšana

skats no aizmugures

1. Ethernet ports— izveido DNS amplifikatora C1000 Dx un tīkla savienojumu.

2. USB B tipa ports— izveido DNS amplifikatora C1000 Dx un datora, kurā darbojas CFX
Manager Dx programmatūra, savienojumu.

3. USB A tipa porti—pārsūta datus uz USB zibatmiņas disku un no USB zibatmiņas diska.

Svarīgi! Lai nodrošinātu in vitro diagnostikas gēnu pētījuma datu integritāti, CFX
Manager Dx programmatūra neatbalsta datus, kurus DNS amplifikators ir ģenerējis
savrupā režīmā.

4. Seriālais pārbaudes ports— tikai pakalpojuma pārbaudei.

5. Dzesēšanas atveres—dzesē DNS amplifikatoru.

Svarīgi! Nenobloķējiet dzesēšanas atveres. Optimālai darbībai nodrošiniet, lai gaiss
varētu cirkulēt aiz DNS amplifikatora pamatnes.

6. Barošanas ieeja—maiņstrāva; izmantojiet komplektācijā iekļauto barošanas vadu.

7. Barošanas slēdzis—balansiera slēdzis DNS amplifikatora ieslēgšanai un izslēgšanai.

8. Drošinātāji—drošinātāju tehniskos datus skat. Droša lietojuma specifikācijas un atbilstība
14. lpp.

APZĪMĒJUMI
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Optiskās reakcijas moduļi

Optiskās reakcijas moduļi
DNS amplifikators C1000 Dx ir saderīgs ar tālāk norādītajiem Bio-Rad optiskās reakcijas moduļiem, lai
veiktu reāllaika PCR:

n CFX96 Dx optiskās reakcijas modulis.

n CFX96 DeepWell Dx optiskās reakcijas modulis.

Izvēlētais CFX Dx optiskās reakcijas modulis un DNS amplifikators tiek piegādāti atsevišķās kārbās.
CFX Manager Dx programmatūra tiek piegādāta kopā ar optiskās reakcijas moduli.

Svarīgi! Optiskās reakcijas modulis ir kalibrēts ar to DNS amplifikatora pamatni, ar kuru tas tiek
piegādāts. Tādēļ nelietojiet optiskās reakcijas moduli ne ar vienu citu DNS amplifikatora pamatni
vai DNS amplifikatora pamatni ne ar vienu citu optiskās reakcijas moduli.

Abi optiskās reakcijas moduļi ietver pilnībā pielāgojamu apsildīto vāku, kas spēj uzticami darboties ar
plašu reakciju trauku klāstu. Katrs optiskās reakcijas modulis satur dzesēšanas ventilatorus straujas
karsēšanas un dzesēšanas vajadzībām.

Katru CFX Dx optiskās reakcijas moduli veido tālāk norādītie komponenti:

n Apsildīts iekšējais vāks—uztur vāka temperatūru, lai nepieļautu kondensāciju un iztvaikošanu.

n Paraugu/reakcijas bloks— tur reakcijas traukus, tostarp mēģenes un mikrotrauciņus.

n Vāka poga—atver un aizver vāku un hermetizē reakciju.

n Statusa LED—kad šis indikators deg, tas norāda uz to, ka bloks tiek lietots.

Ieteicamie paraugu tilpumi
Lietojot C1000 Dx DNS amplifikatoru, maksimālo parauga tilpumu nosaka lietotā reakcijas moduļa
veids. 7. tabula uzskaitīti ieteicamie apjomi, kādus lietot ar katru reakcijas moduli.

Iedobju skaits Bloku skaits
Ieteicamais parauga tilpums, µl

(augšējā robežvērtība)

96 iedobes 1 10–50

96 dziļās iedobes 1 10–125

7. tabula. Lieluma un tilpuma ierobežojums reakcijas moduļiem
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2. nodaļa. C1000 Dx DNS amplifikatora iestatīšana

DNS amplifikatora C1000 Dx instalēšana
DNS amplifikatora C1000 Dx pamatne ir piegādāta no optiskā reakcijas moduļa atsevišķā kārbā.
Iesaiņojuma saturs:

n DNS amplifikatora C1000 Dx pamatne;

n Strāvas vads

n 1 USB kabelis.

DNS amplifikatora C1000 Dx instalēšana.

1. Izsaiņojiet un uzstādiet DNS amplifikatora C1000 Dx pamatni.

2. Reakcijas moduli piestipriniet pie pamatnes.

3. Izņemiet transportēšanas skrūvi.

Sadaļā šie uzdevumi ir izskaidroti sīkāk.

DNS amplifikatora C1000 Dx izsaiņošana un uzstādīšana
Svarīgi! Pirms DNS amplifikatora ekspluatācijas izlasiet informāciju, kas sniegta Drošuma un
normatīvā atbilstība 13. lpp. un Drošuma brīdinājumu etiķetes 13. lpp.

Padoms. Nodrošiniet, ka uzstādīšanas laikā datoram, kurā darbosies CFX Manager Dx
programmatūra, blakus DNS amplifikatoram ir pietiekami daudz vietas.

DNS amplifikatora pamatnes izsaiņošana un uzstādīšana

1. Atrodiet iepakojumu, kas satur DNS amplifikatora pamatni.

2. Izņemiet pamatni no iepakojuma materiāliem.

Padoms. Uzglabājiet iepakojuma materiālus turpmākam lietojumam. Ja trūkst kādas daļas
vai tā ir bojāta, sazinieties ar vietējo Bio-Rad biroju.

3. Novietojiet DNS amplifikatora pamatni uz līdzenas, sausas virsmas ar pietiekamu vēsa gaisa
plūsmu, lai tas darbotos pareizi.

4. Iepakojuma materiālos atrodiet barošanas vadu un vienu tā galu pievienojiet barošanas ievadam
DNS amplifikatora aizmugurē.

Svarīgi! Vēl nepieslēdziet instrumentam barošanu.

5. IVD reakcijas moduli piestipriniet pie pamatnes. Turpiniet ar Optiskās reakcijas moduļa
piesaistīšana 27. lpp.
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DNS amplifikatora C1000 Dx instalēšana

Optiskās reakcijas moduļa piesaistīšana
Bio-Rad piegādā CFX96 Dx vai CFX96 DeepWell optiskās reakcijas moduli ar tā DNS amplifikatora
C1000 Dx bāzi (taču atsevišķā kastē). Rūpīgi izsaiņojiet optiskās reakcijas moduli un pārbaudiet, vai
piegādes konteinerā ir barošanas un USB kabeļi.

Svarīgi! Katrs optiskās reakcijas modulis ir kalibrēts ar to DNS amplifikatora bāzi, ar kuru tas tiek
piegādāts. Tādēļ nelietojiet optiskās reakcijas moduli ne ar vienu citu DNS amplifikatora bāzi.

Nodrošiniet, lai DNS amplifikatora C1000 Dx bāze balstītos uz līdzenas, sausas virsmas ar pietiekami
vēsu gaisa plūsmu, lai darbotos pareizi.

Reakcijas moduļa pievienošana DNS amplifikatora bāzei

1. Novietojiet DNS amplifikatoru C1000 Dx piemērotā vietā ar fiksējošo aizturi uz leju.

2. Paceliet optiskās reakcijas moduli, satverot to rokturu iedobēs virs sānu gaisa ventilācijas
atverēm, pozicionējiet moduli C1000 Dx reakcijas moduļa nišā, atstājot aptuveni 2 cm brīvu vietu
priekšpusē. Kad optiskais modulis ir ievietots nišā, tam jānosedz Bio-Rad logotips nišas
priekšpusē.

3. Velciet fiksējošo aizturi uz augšu, līdz tas ir vienā līmenī ar moduļa nišas sāniem. Šī darbība
pavirza moduli uz priekšu, nofiksējot vietā.
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2. nodaļa. C1000 Dx DNS amplifikatora iestatīšana

4. Pārliecinieties, vai modulis ir pilnībā un līdzeni uzlikts uz DNS amplifikatora C1000 Dx bāzes.
Starp moduli un bāzi nedrīkst būt tukšas telpas.

5. Iespraudiet barošanas kabeli DNS amplifikatora C1000 Dx bāzes aizmugurē un atbilstošā
elektrotīkla kontaktligzdā, pēc tam nospiediet jaudas slēdzi DNS amplifikatora C1000 Dx
aizmugures panelī, lai sistēmu iedarbinātu.

Transportēšanas skrūves izņemšana
Svarīgi! Bio-Rad optiskās reakcijas moduļi tiek piegādāti ar sarkano transportēšanas skrūvi, kas
ievietota iekšējā vākā, lai stabilizētu optisko reakcijas moduli transportēšanas laikā. Pirms
optiskās reakcijas moduļa ekspluatācijas transportēšanas skrūve jāizņem.

Transportēšanas skrūves izņemšana

1. DNS amplifikators C1000 Dx atpazīst transportēšanas skrūves atrašanos optiskās reakcijas
modulī un parāda ziņojumu, kurā sniegts norādījums izņemt skrūvi.
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DNS amplifikatora C1000 Dx instalēšana

2. Lai izņemtu transportēšanas skrūvi, ievērojiet norādījumus. Tālāk redzamajā diagrammā ir
parādīta transportēšanas skrūves atrašanās vieta.

Piezīme. Ja jebkāda iemesla dēļ reakcijas modulis ir jāatgriež, transportēšanas skrūve
jāievieto atpakaļ. Uzglabājiet skrūvi drošā un pieejamā vietā.

Paraugu trauciņu ielādēšana
Lai nodrošinātu paraugu vienmērīgu sasildīšanu un atdzesēšanu, trauciņiem jābūt pilnīgā saskarē ar
reakcijas bloku. Lai nodrošinātu atbilstošu saskari, veiciet tālāk norādītās darbības.

n Pirms paraugu ielādēšanas pārliecinieties, vai bloks ir tīrs.

n Stingri iespiediet atsevišķās mēģenes, mēģeņu joslas vai mikrotrauciņus bloka iedobēs.

n Lietojot vienu vai vairākas mēģenes, izmantojiet mēģeņu ietvaru (kataloga Nr. 1849000 vai Nr.
1849001), vai arī ielādējiet vismaz vienu tukšu mēģeni katrā bloka stūrī, lai nodrošinātu to, ka
vāks vienādi piespiež visas atsevišķās mēģenes.
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2. nodaļa. C1000 Dx DNS amplifikatora iestatīšana

Trauciņu ielāde optiskās reakcijas modulī

Svarīgi! Ekspluatējot CFX Dx system, vienmēr vienmērīgi līdzsvaro mēģeņu stripus vai pievieno
mēģeņu vāciņus stūros esošajām iedobēm, lai nodrošinātu, ka apsildītais vāciņš visam blokam
veido vienmērīgu spiedienu.

Trauciņu ielāde optiskās reakcijas modulī

1. Lai atvērtu motorizētu vāku, veiciet vienu no tālāk norādītajām darbībām.

n CFXManager Dx programmatūras rūtī Detected Instruments (Atklātie instrumenti)
noklikšķiniet uz Open Lid (Atvērt vāku).

n Programmatūras cilnē Start Run (Sākt izpildi) noklikšķiniet uz Open Lid (Atvērt vāku).

n Nospiediet vāka pogu instrumenta priekšpusē.

2. Blokā ievietojiet mikrotrauciņu, atsevišķas mēģenes vai mēģeņu stripus ar hermētiskiem
vāciņiem.

Svarīgi! Pārbaudiet, vai mēģenes ir pilnībā noslēgtas, lai nepieļautu noplūdi.

Padoms. Optimālu rezultātu sasniegšanai CFX Dx system.

3. Precīzai datu analīzei pārbaudiet, vai reakciju orientācija blokā ir tieši tāda pati kā iedobju satura
orientācija CFX Manager Dx programmatūras cilnē Plate (Trauciņš).

Padoms. Jūs varat rediģēt iedobju saturu, izmantojot CFX Manager Dx programmatūru
pirms izpildes, izpildes laikā vai pēc izpildes.

4. Lai aizvērtu motorizētu vāku, veiciet vienu no tālāk norādītajām darbībām:

n Nospiediet vāka pogu uz instrumenta.

n Programmatūras rūtī Detected Instruments (Atklātie instrumenti) noklikšķiniet uz Close Lid
(Aizvērt vāku).

n Programmatūras cilnē Start Run (Sākt izpildi) noklikšķiniet uz Close Lid (Aizvērt vāku).

Svarīgi! Nodrošiniet, lai nekas nenobloķētu vāku, kad tas aizveras. Lai gan vāks ir aprīkots
ar drošības mehānismu, kas neļauj tam aizvērties, sajūtot šķērsli, pirms aizvēršanas
nenovietojiet neko vāka ceļā.
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DNS amplifikatora C1000 Dx instalēšana

PCR plastmasas un reaģentu patēriņa produkti

Lai atrastu un pasūtītu ieteiktos plastmasas patēriņa produktus darbam ar CFX Dx sistēmu, dodieties
uz Bio-Rad tīmekļa vietni. Šai vietnei var piekļūt no izvēlnes vienuma
Help > PCR Plastic Consumables Web Site (Palīdzība > PCR plastmasas patēriņa produktu tīmekļa
vietne) CFX Manager Dx programmatūrā. Papildus ieskatieties plastmasu atlasītāja un reaģentu
atlasītāja resursos, kas palīdzēs jums viegli atrast un pasūtīt plastmasas patēriņa produktus un
reaģentus konkrēti savas aparatūras un PCR vajadzībām.

Pievienoto instrumentu atklāšana
Instalēšanas laikā CFX Manager Dx software instalētājs automātiski instalē instrumentu draiverus
datorā, kurā darbojas CFX Manager Dx software. CFX Manager Dx atklāj pievienotos instrumentus,
kad jūs palaižat programmatūru.

Svarīgi! Pirms programmatūras instalēšanas C1000 Dx DNS amplifikators jāatvieno no CFX
Manager Dx datora. Programmatūras instalēšanas laikā DNS amplifikators nav jāizslēdz.

Pievienoto instrumentu atklāšana

1. Ja tas vēl nav izdarīts, ievietojiet piegādātā USB B tipa kabeļa kvadrātveida (ārējo) galu USB B
tipa portā, kas atrodas bāzes aizmugurē.

2. Ievietojiet otru (porta) galu USB portā CFX Manager Dx datorā.

3. Ja DNS amplifikators jau nedarbojas, nospiediet jaudas slēdzi instrumenta aizmugurē, lai to
ieslēgtu.

4. Palaidiet CFX Manager Dx software.

Programmatūra automātiski atklāj pievienoto instrumentu un parāda tā nosaukumu Detected
Instruments (Atklātie instrumenti) rūtī Home (Sākums) logā.

Piezīme. Ja instruments neparādās rūtī Detected Instruments (Atklātie instrumenti),
pārliecinieties, vai USB kabelis ir pievienots pareizi. Lai pārinstalētu draiverus, atlasiet Tools >
Reinstall Instrument Drivers (Rīki > Atkārtoti instalēt instrumentu draiverus) CFX Manager Dx
software logā Home (Sākums).
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2. nodaļa. C1000 Dx DNS amplifikatora iestatīšana

Reakcijas moduļa atvienošana
Svarīgi! Pirms reakcijas moduļa atvienošanas izslēdziet DNS amplifikatoru C1000 Dx (skat. DNS
amplifikators C1000 Dx izslēgšana 32. lpp.). Atdzesēšanas stabilizatori reakcijas modulī uzreiz pēc
protokola izpildes vai inkubēšanas var būt karsti. Pirms reakcijas moduļa atvienošanas
pārliecinieties, ka stabilizatori ir vēsi.

Optiskā Reakcijas moduļa atvienošana no DNS amplifikatora pamatnes

1. DNS amplifikatora pamatnes aizmugurē piespiediet fiksatoru, lai atbloķētu un atbrīvotu optisko
reakcijas moduli.

2. Uzmanīgi izceliet optisko reakcijas moduli no nišas, katrā pusē satverot aiz roktura ierobojumiem.

3. Uzstādiet optisko reakcijas moduli uz tīras, līdzenas virsmas, kur tas ir aizsargāts pret triecieniem
un skrāpējumiem un no kurienes to nav iespējams nomest.

DNS amplifikators C1000 Dx izslēgšana
DNS amplifikatora izslēgšana

1. Pēc izpildes nospiediet vāka atvēršanas pogu CFX optiskās reakcijas moduļa priekšpusē, lai
piekļūtu paraugiem, kas ielādēti blokā.

2. Izņemiet paraugus no bloka un nospiediet vāka aizvēršanas pogu, lai aizvērtu vāku.

3. Nospiediet barošanas slēdzi DNS amplifikatora C1000 Dx aizmugures panelī, lai izslēgtu
sistēmu.
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3. nodaļa. CFX Manager Dx programmatūras
instalēšana

Šajā nodaļā izskaidrots, kā instalēt CFX Manager Dx programmatūru.

CFX Manager Dx software ir vajadzīga, lai analizētu reāllaika PCR datus no CFX96 Dx un CFX96
DeepWell Dx sistēmām. Varat izmantot šo programmatūru, lai vadītu šīs sistēmas programmatūras
vadības režīmā.

Informāciju par CFX Dx system DNS amplifikatora un optiskās reakcijas moduļa instalēšanu skatīt
C1000 Dx DNS amplifikatora iestatīšana 21. lpp.
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3. nodaļa. CFX Manager Dx programmatūras instalēšana

Sistēmas prasības
8. tabula uzskaitītas minimālās un ieteicamās sistēmas prasības attiecībā uz datoru, kurā darbojas
CFX Manager Dx software (turpmāk tekstā saukts CFX Manager Dx dators).

Sistēma Minimums Ieteicamais

Operētājsistēma Microsoft Windows 7 SP1
Pro

Jebkura no šīm:

n Microsoft Windows 7 SP2 Pro (32 un 64 bitu)

n Microsoft Windows 10 Pro (tikai 64 bitu)

n Microsoft Windows 10 Enterprise
(tikai 64 bitu)

Svarīgi! Secure Boot funkcijai jābūt atspējotai gan Microsoft Windows 10 Pro, gan Enterprise.

Porti 2 USB 2.0 ātrdarbības porti 2 USB 2.0 ātrdarbības porti

Vieta cietajā diskā 128 GB 128 GB

Procesora ātrums 2,4 GHz, divkodolu 2,4 GHz, četrkodolu

RAM 4 GB RAM 8 GB RAM

Ekrāna izšķirtspēja 1024 x 768 ar dabisko krāsu
režīmu

1280 x 1024 ar dabisko krāsu režīmu

PDF lasītājs Adobe PDF Reader vai Windows PDF Reader
no viena no atbalstītajiem Microsoft Office
Suites:

n 2007

n 2010

n 2013

8. tabula. Datora prasības darbā ar CFX Manager Dx software
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CFXManager Dx programmatūras instalēšana

CFX Manager Dx programmatūras instalēšana
Svarīgi! Pirms programmatūras instalēšanas vai jaunināšanas no CFX Manager Dx datora
jāatvieno visi pievienotie instrumenti. Programmatūras instalēšanas laikā DNS amplifikators nav
jāizslēdz. Pārliecinieties, vai visas izpildes ir saglabātas un vai neviens eksperiments šobrīd
nenotiek.

Piezīme. Ja instalējat CFX Manager Dx software operētājsistēmāWindows 10, pirms
instalēšanas procedūras sākšanas pārliecinieties, vai ir atspējota drošās sāknēšanas funkcija.

CFX Manager Dx software instalēšana

1. Ja nepieciešams, atvienojiet no datora visus pievienotos instrumentus.

Sameklējiet un atvienojiet instrumenta USB kabeli no CFX Manager Dx datora. Instrumentā
iespraustais kabeļa gals var palikt savā vietā.

2. Piesakieties CFX Manager Dx datorā ar administratora tiesībām.

3. Ievietojiet CFX Manager Dx programmatūras kompaktdisku datora CD dzinī.

4. Programmatūras palaišanas lapai jāparādās automātiski. Veiciet dubultklikšķi uz komandas
Install Software (Instalēt programmatūru) programmatūras palaišanas lapā.

Piezīme. Ja palaišanas lapa neatveras automātiski, navigējiet uz CD dzini un atveriet CFX_
Manager mapi, pēc tam veiciet dubultklikšķi uz setup.exe, lai palaistu programmatūras
instalēšanas vedni.

Padoms. Instalēšanas vednī noklikšķiniet uz pogas Documentation (Dokumentācija), lai
atrastu izlaiduma piezīmju, instrumentu rokasgrāmatu un citas dokumentācijas
pārmeklējamus eksemplārus.

5. Lai pabeigtu instalēšanu, izpildiet ekrānā redzamos norādījumus. Kad instalēšana būs pabeigta,
datora darbvirsmā parādīsies CFX Manager programmatūras ikona.

6. Kad instalēšana ir pabeigta, kompaktdisku var droši izņemt.
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3. nodaļa. CFX Manager Dx programmatūras instalēšana

Pievienoto instrumentu atklāšana
Instalēšanas laikā CFX Manager Dx programmatūras instalēšanas programma automātiski instalē
instrumentu draiverus CFX Manager Dx datorā. CFX Manager Dx atklāj pievienotos instrumentus, kad
jūs palaižat programmatūru.

Pievienoto instrumentu atklāšana

1. Ja tas vēl nav izdarīts, ievietojiet komplektācijā iekļautā USB B tipa kabeļa kvadrātveida
(spraudņa tipa) galu USB B tipa portā, kas atrodas instrumenta pamatnes aizmugurē.

2. Ievietojiet otru (porta) galu USB portā CFX Manager Dx datorā.

3. Ja instruments jau nedarbojas, instrumenta aizmugurē nospiediet barošanas slēdzi, lai to
ieslēgtu.

4. Palaidiet CFX Manager Dx.

Programmatūra automātiski nosaka atklāto instrumentu un parāda tā nosaukumu loga Home
(Sākums) rūtī Detected Instruments (Atklātie instrumenti).

Piezīme. Ja instruments neparādās rūtī Detected Instruments (Atklātie instrumenti),
pārliecinieties, vai USB kabelis ir pievienots pareizi. Lai atkārtoti instalētu draiverus, CFX
Manager Dx logā Home (Sākums) atlasiet Tools > Reinstall Instrument Drivers (Rīki > Atkārtoti
instalēt instrumentu draiverus).
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Programmatūras faili

Programmatūras faili
9. tabula ir uzskaitīti CFX Manager Dx software failu tipi.

Faila tips Paplašinājums Details

Protokols .prcl Satur protokola iestatīšanas informāciju, lai veiktu
PCR izpildi.

Plāksne .pltd Satur trauciņa iestatīšanas informāciju, lai veiktu
PCR izpildi.

Dati .pcrd Satur eksperimenta izpildes un PCR analīzes
rezultātus.

PrimePCR izpilde .csv Satur protokolu un trauciņu izkārtojumu PrimePCR
trauciņiem.

Gēnu pētījums .mgxd Satur vairāku PCR izpilžu un gēnu ekspresijas
analīžu rezultātus.

LIMS .plrn Satur trauciņa iestatīšanas un protokola
informāciju, kas nepieciešama, lai veiktu ar LIMS
saderīgu izpildi.

9. tabula. CFX Manager Dx software failu tipi
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3. nodaļa. CFX Manager Dx programmatūras instalēšana

Ieteicamie kiberdrošības pasākumi
Bio-Rad iesaka sadarboties ar jūsu uzņēmuma IT nodaļu, lai attiecībā uz kopā ar CFX96 Dx sistēmu
izmantoto datoru ieviestu kiberdrošības pasākumus. Piemēram:

n Instalējiet un konfigurējiet atbilstošas pretvīrusu un ugunsmūra lietojumprogrammas.

Svarīgi! Konfigurējiet vīrusu skenēšanu, lai tā notiktu ārpus darba laika vai tad, kad
instruments netiek aktīvi darbināts. Ja vīrusu skenēšana tiek uzsākta, kad CFX Manager Dx
veic eksperimentu, izpilde var tikt atcelta un dati — zaudēti.

n CFXManager Dx software nav aprīkots ar lietotāja sesijas neaktivitātes noilguma funkciju.
Ieviesiet Windows vai trešās puses lietotāju piekļuves drošības pasākumus (piemēram,
ekrānsaudzētāju ar pieteikšanās funkciju).

n Noņemamo datu nesēju drošība:

o Datu aizsardzībai USB ierīcē izmantojiet paroles un šifrēšanu.

o Visiem noņemamajiem datu nesējiem atspējojiet automātiskās startēšanas un automātiskās
atskaņošanas funkcijas.

o Izpildiet USB skenēšanu katru reizi, kad tiek iesprausta zibatmiņa.

n Lai atvieglotu datu atkopšanu, izmantojiet dublēšanas utilītu.
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4. nodaļa. Darba zona
CFXManager Dx programmatūra nodrošina interfeisu trauciņu iestatīšanai, izstrādājot PCR
protokolus, darbinot tos CFX Dx instrumentos un analizējot datus no PCR izpildēm.

CFX Manager Dx programmatūra piedāvā piecas primārās darba zonas:

n logu Home (Sākums);

n Startup Wizard (Startēšanas vednis);

n logu Protocol Editor (Protokola redaktors);

n logu Plate Editor (Trauciņa redaktors);

n logu Data Analysis (Datu analīze).

Šajā nodaļā ir parādīta un īsi aprakstīta katra darba zona.
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4. nodaļa. Darba zona

Home (Sākums) logs
CFXManager Dx software atveras uz Home (Sākums) logu un rāda Startup Wizard (Startēšanas
vednis), no kura jūs varat iestatīt eksperimentu, veikt vai atkārtot izpildi vai analizēt esošu izpildi. No
Home (Sākums) loga jūs varat skatīt arī pielietojuma un instrumentu žurnālus, izveidot un pārvaldīt
lietotājus un piekļūt daudziem noderīgiem rīkiem. Papildu informāciju skatīt 5. nodaļa, Home
(Sākums) logs
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Startup Wizard (Startēšanas vednis)

Startup Wizard (Startēšanas vednis)
Lietojiet rīku Startup Wizard (Startēšanas vednis), lai ātri iestatītu un izpildītu lietotāju definētos
eksperimentus vai atlasītu un izpildītu PrimePCR eksperimentu. Tāpat jūs varat lietot šo vedni, lai
atkārtotu izpildi vai analizētu izpildes datus.
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4. nodaļa. Darba zona

Protocol Editor (Protokola redaktors) logs
Protocol Editor (Protokola redaktors) logā jūs varat izveidot, atvērt, pārskatīt un rediģēt protokolu.
Varat modificēt arī vāka temperatūru atvērtā protokolā. Protocol Editor (Protokola redaktors)
funkcionalitāte detalizēti aprakstīta 6. nodaļa, Protokolu izveide.
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Plate Editor (Trauciņa redaktors) logs

Plate Editor (Trauciņa redaktors) logs
Plate Editor (Trauciņa redaktors) logā jūs varat izveidot, atvērt, pārskatīt un rediģēt trauciņu. Plate
Editor (Trauciņa redaktors) funkcionalitāte detalizēti aprakstīta šeit 7. nodaļa, Trauciņu sagatavošana
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4. nodaļa. Darba zona

Logs Data Analysis (Datu analīze)
Logā Data Analysis (Datu analīze) jūs varat skatīt un salīdzināt izpildes datus, veikt statistiskās
analīzes, eksportēt datus un izveidot publicēšanai gatavas atskaites. Loga Data Analysis (Datu
analīze) funkcionalitāte sīki aprakstīta 9. nodaļa, Pārskats par datu analīzi. Skat. arī 10. nodaļa, Datu
analīzes detaļas.
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CFXManager Dx programmatūra nodrošina interfeisu PCR protokolu izstrādāšanai, izpildot tos CFX
Dx sistēmās un analizējot datus no PCR izpildēm.

Šajā nodaļā notiek iepazīstināšana ar CFX Manager Dx software un tiek aprakstītas funkcijas, kurām
var piekļūt logā Home (Sākums).
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Logs Home (Sākums)
CFXManager Dx atveras logā Home (Sākums) un parāda Startup Wizard (Startēšanas vednis), no
kura jūs varat iestatīt izpildi, veikt vai atkārtot izpildi vai analizēt esošu izpildi. No Home (Sākums) loga
jūs varat skatīt arī pielietojuma un instrumentu žurnālus, izveidot un pārvaldīt lietotājus un piekļūt
daudziem noderīgiem rīkiem.

1. Programmatūras virsrakstjoslā tiek parādīts programmatūras nosaukums un pieteicies
lietotājs.

2. Izvēlnes josla nodrošina ātru piekļuvi komandām izvēlnēs File (Fails), View (Skatīt), Users
(Lietotāji), Run (Izpilde), Tools (Rīki), Window (Logs) un Help (Palīdzība).

3. Rīkjoslas komandas nodrošina ātru piekļuvi izvēlnes opcijām.

4. Kreisajā rūtī tiek parādīti instrumenti, kas pievienoti CFX Manager Dx datoram, un pogas, ar
kuru palīdzību var darbināt vāku un skatīt instrumentu statusu.

5. Galvenajā rūtī tiek parādīts darba logs. Noklusējuma darba logs ekrānā Home (Sākums) ir
Startup Wizard (Startēšanas vednis).

6. Statusa joslā tiek parādīti pievienoto instrumentu nosaukumi un pieteicies lietotājs.

APZĪMĒJUMI
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Izvēlnes File (Fails) komandas
New (Jauns)—atver dialoglodziņu, kurā varat izveidot jaunu protokolu, trauciņu vai gēnu pētījumu.

Open (Atvērt)—atver dialoglodziņu, kurā varat navigēt un atvērt esošo protokolu, trauciņu, datu
failu, gēnu pētījumu, LIMS failu, vai atvērt PrimePCR izpildes failu.

Recent Data Files (Nesenie datu faili)—parāda nesen atvērto PCR failu sarakstu.

Repeat a Run (Atkārtot izpildi)—atver Windows Explorer saglabāto PCR failu atrašanās vietā, kurā
varat atrast atkārtojamo izpildi.

Exit (Iziet)—aizver CFX Manager Dx.

Skatīšanas izvēlnes komandas
Application Log (Lietojumprogrammas žurnāls)— rāda programmatūras lietojuma žurnālu no
sākotnējās instalēšanas līdz šodienai.

Run Reports (Izpildes atskaites)— rāda izpildes atskaišu sarakstu.

Startup Wizard (Startēšanas vednis)— rāda Startup Wizard (Startēšanas vednis) galvenajā rūtī.

Run Setup (Izpildes iestatīšana)— rāda Run Setup (Izpildes iestatīšana) logu galvenajā rūtī.

Instrument Summary (Kopsavilkums par instrumentiem)— rāda Instrument Summary
(Kopsavilkums par instrumentiem) logu galvenajā rūtī.

Detected Instruments (Atklātie instrumenti)—pārslēdzas starp pievienoto instrumentu rādīšanu
un nerādīšanu kreisās puses rūtī. Pēc noklusējuma programmatūra rāda pievienotos instrumentus
kreisās puses rūtī.

Toolbar (Rīkjosla)—pārslēdzas starp rīkjoslas rādīšanu un nerādīšanu ekrāna augšā. Pēc
noklusējuma programmatūra rīkjoslu rāda.

Status Bar (Statusa josla)—pārslēdzas starp statusa joslas rādīšanu un nerādīšanu ekrāna
apakšā. Pēc noklusējuma programmatūra statusa joslu rāda.

Show (Rādīt) —atver dialoglodziņu, no kura jūs varat veikt tālāk norādīto.

n Skatīt vai bloķēt Status (Statusa) žurnālu.

n Atvērt un skatīt CFX Manager Dx datu mapi.

n Atvērt un skatīt lietotāja datu mapi.
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n Atvērt un skatīt LIMS failu mapi.

n Atvērt un skatīt PrimePCRmapi.

n Skatīt izpildes vēsturi.

n Skatīt visu pievienoto instrumentu rekvizītus.

Izvēlnes User (Lietotājs) komandas
Select User (Atlasīt lietotāju)—atver ekrānu Login (Pieteikšanās), kura nolaižamajā sarakstā User
Name (Lietotājvārds) varat atlasīt lietotāju un pieteikties lietojumprogrammā.

Change Password (Mainīt paroli)—atver dialoglodziņu Change Password (Mainīt paroli), kurā
lietotāji var mainīt savu CFX Manager Dx software paroli.

User Preference s (Lietotāja preferences)—atver dialoglodziņu User Preferences (Lietotāja
preferences), kurā lietotāji var mainīt noklusējuma iestatījumus tālāk norādītajām opcijām.

n E-pasta paziņojumu sūtīšana un saņemšana pēc izpildes pabeigšanas

n Datu failu saglabāšana

n Protokolu izveide, izmantojot rīku Protocol Editor (Protokola redaktors) vai Protocol
AutoWriter (Protokola automātiskais rakstītājs)

n Trauciņu izveide

n Datu analizēšana

n Gēnu ekspresijas analīzes veikšana

n Datu kvalitātes noteikšana

n CFX Dx instrumenta datu eksportēšana

User Administration (Lietotāju administrēšana)—atver dialoglodziņu User Administration
(Lietotāju administrēšana), kurā administratori var izveidot lietotājus, mainīt lomu atļaujas un piešķirt
lomas lietotājiem.

Bio-Rad Service Login (Pakalpojuma pieteikšanās)—paredzēta tikai Bio-Rad tehniskās
apkalpošanas personālam. Neatlasiet šo komandu.
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Izvēlnes Run (Izpilde) komandas
User-defined Run (Lietotāja definēta izpilde)—atver logu Run Setup (Izpildes iestatīšana), kurā
varat iestatīt lietotāja definētu protokolu un trauciņu, un pēc tam atlasītajos instrumentos izpilda PCR
eksperimentu.

PrimePCR Run (PrimePCR izpilde)— logā Run Setup (Izpildes iestatīšana) atver cilni Start Run
(Sākt izpildi) ar noklusējuma PrimePCR protokolu un trauciņu izkārtojumu, kas ielādēts, balstoties uz
atlasīto instrumentu.

End-Point Only Run (Tikai galapunkta izpilde) — logā Run Setup (Izpildes iestatīšana) atver cilni
Start Run (Sākt izpildi) ar noklusējuma galapunkta protokolu un trauciņu izkārtojumu, kas ielādēts,
balstoties uz atlasīto instrumentu.

Qualification Run (Kvalifikācijas izpilde)— logā Run Setup (Izpildes iestatīšana) atver cilni Start
Run (Sākt izpildi) ar noklusējuma Bio-Rad kvalifikācijas protokolu un trauciņu izkārtojumu, kas
ielādēts, balstoties uz atlasīto instrumentu.

Tools (Rīki) izvēlnes komandas
Master Mix Calculator (Galvenā maisījuma kalkulators)—atver rīku Master Mix Calculator
(Galvenā maisījuma kalkulators, kurā varat izveidot reakcijas maisījumu un izdrukāt aprēķinus.

Protocol AutoWriter (Protokola automātiskais rakstītājs)—atver dialoglodziņu Protocol
AutoWriter (Protokola automātiskais rakstītājs), kurā varat viegli izveidot jaunu protokolu.

Ta Calculator (Ta kalkulators)—atver rīku Ta Calculator (Ta kalkulators), kurā varat viegli aprēķināt
praimeru renaturācijas temperatūru.

Dye Calibration Wizard (Kontrastvielu kalibrēšanas vednis)—atver rīku Dye Calibration Wizard
(Kontrastvielu kalibrēšanas vednis), kurā varat kalibrēt instrumentu jaunam fluoroforam.

Reinstall Instrument Drivers (Atkārtoti instalēt instrumentu draiverus)—atkārtoti instalē
draiverus, kas kontrolē sakarus ar Bio-Rad reāllaika PCR sistēmām.

Zip Data and Log Files (Tilpsaspiest datus un žurnāla failus)—atver dialoglodziņu, kurā varat
atlasīt failus saspiešanai un saglabāšanai tilpsaspiestajā failā, lai tos uzglabātu vai nosūtītu pa e-
pastu.

Batch Analysis (Partijas analīze)—atver dialoglodziņu Batch Analysis (Partijas analīze), kurā varat
iestatīt parametrus vairāk nekā viena datu faila vienlaicīgai analizēšanai.

Options (Opcijas)—atver dialoglodziņu, kurā varat:

n konfigurēt e-pasta servera iestatījumus;

n konfigurēt eksportēšanas iestatījumus LIMS un citiem datu failiem.
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Izvēlnes Help (Palīdzība) komandas
Padoms. Izvēlne Help (Palīdzība) ir pieejama izvēļņu joslā visos CFX Manager Dx software
logos.

Open Operation Manual (Atvērt ekspluatācijas rokasgrāmatu)—atver šīs rokasgrāmatas PDF.

Gene Expression Gateway Web Site (Gēnu ekspresijas vārtejas tīmekļa vietne)—atver Bio-
Rad CFX Dx system lapu Home (Sākums).

PCR Reagents Web Site (PCR reaģentu tīmekļa vietne)—atver Bio-Rad PCR reaģentu tīmekļa
vietni, kurā varat pasūtīt PCR reaģentus, supermaisījumus, kontrastvielas un komplektus.

PCR Plastic Consumables Web Site (PCR plastmasas patēriņa produktu tīmekļa vietne)—
atver Bio-Rad PCR plastmasas un patēriņa produktu tīmekļa vietni, kurā varat pasūtīt PCR trauciņus,
trauciņu plombas, mēģenes un vāciņus, kā arī citus plastmasas piederumus.

Software Web Site (Programmatūras tīmekļa vietne)—atver Bio-Rad PCR analīzes
programmatūras tīmekļa vietni, kurā varat pasūtīt Bio-Rad CFX Manager Dx software atjauninātas
versijas.

About (Par)— rāda informāciju par CFX Manager Dx autortiesībām un versiju.

Rīkjoslas komandas

—atver Windows Explorer, kurā varat navigēt un atvērt datu failu vai gēnu pētījuma failu.

— atver Master Mix Calculator (Galvenā maisījuma kalkulators).

— atver logu Run Setup (Izpildes iestatīšana).

— atver logu Run Setup (Izpildes iestatīšana) ar noklusējuma PrimePCR protokolu un trauciņu
izkārtojumu, kas ielādēts, balstoties uz atlasīto instrumentu.

— atver Startup Wizard (Startēšanas vednis).
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Startup Wizard (Startēšanas vednis)
Kad CFX Manager Dx tiek palaista, darba rūtī tiek rādīts Startup Wizard (Startēšanas vednis). No
Startup Wizard (Startēšanas vednis) jūs varat

n atlasīt instrumentu no atklātajiem instrumentiem un iestatīt lietotāja definētu vai PrimePCR izpildi;

n atvērt un atkārtot izpildi;

n atvērt datu failu, lai analizētu rezultātus no atsevišķas izpildes vai gēnu pētījuma failu, kurā ir
rezultāti no daudzām gēnu ekspresijas izpildēm.

Sīkāk šie uzdevumi ir izskaidroti turpmākajās nodaļās.

Statusa josla
Statusa joslas kreisajā pusē, kas atrodas galvenā programmatūras loga apakšdaļā, tiek parādīts
atklāto instrumentu pašreizējais statuss. Statusa joslas labajā pusē tiek parādīts pašreizējā lietotāja
nosaukums, kā arī datums un laiks.
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Rūts Detected Instruments (Atklātie instrumenti)
Rūtī Detected Instruments (Atklātie instrumenti) tiek rādīts ikviens instruments, kas savienots ar CFX
Manager Dx datoru. Pēc noklusējuma katrs instruments redzams kā ikona, un tā sērijas numurs— kā
nosaukums.

Piemēram, šajā attēlā tiek rādīti četri atklāti instrumenti:

n Divi C1000 DNS amplifikatori ar CFX96 DeepWell reakcijas moduļiem (CFX96DW1 un
CFX96DW2)

n Divi C1000 DNS amplifikatori ar CFX96 reakcijas moduļiem (CFX96l01 un CFX96l02)

No šīs rūts var veikt tālāk norādītās darbības.

n Skatīt atlasītā instrumenta rekvizītus un kalibrētās kontrastvielas.

Informāciju par instrumenta rekvizītiem skatīt Instrumenta rekvizītu skatīšana 56. lpp.

n Skatīt pievienotā instrumenta statusu.

n Atvērt atlasītā instrumenta motorizēto vāku.

n Aizvērt atlasītā instrumenta motorizēto vāku.

n Skatīt visu pievienoto instrumentu statusu.
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Pievienota instrumenta statusa skatīšana

u Rūtī Detected Instruments (Atklātie instrumenti) atlasiet mērķa instrumentu un veiciet vienu no
tālāk norādītajām darbībām:

n Noklikšķiniet uz View Status (Skatīt statusu) sadaļā Selected Instrument (Atlasīts
instruments).

n Noklikšķiniet ar peles labo pogu un izvēlnē, kas parādās, atlasiet View Status (Skatīt
statusu).

Parādīsies dialoglodziņš Run Details (Izpildes dati), kurā redzama cilne Run Status (Izpildes
statuss). Atlasītā instrumenta statuss redzams zem izpildes statusa rūts, piemēram:

Instrumenta vāka atvēršana vai aizvēršana

u Rūtī Detected Instruments (Atklātie instrumenti) atlasiet mērķa instrumentu un veiciet vienu no
tālāk norādītajām darbībām:

n Noklikšķiniet uz Open Lid (Atvērt vāku) vai Close Lid (Aizvērt vāku) sadaļā Selected
Instrument (Atlasīts instruments).

n Noklikšķiniet ar peles labo pogu un izvēlnē, kas parādās, atlasiet atbilstošo darbību.

n Atveriet dialoglodziņu Run Details (Izpildes dati), atlasiet cilni Run Status (Izpildes statuss)
un noklikšķiniet uz Open Lid (Atvērt vāku) vai Close Lid (Aizvērt vāku).
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Visu atklāto instrumentu statusa skatīšana

u Veiciet vienu no tālāk norādītajām darbībām:

n Sadaļas All Instruments (Visi instrumenti) rūtī Detected Instruments (Atklātie instrumenti)
noklikšķiniet uz View Summary (Skatīt kopsavilkumu).

n Izvēlnes joslā atlasiet View > Instrument Summary (Skatīt > Kopsavilkums par
instrumentiem).

Parādīsies dialoglodziņš Instrument Summary (Kopsavilkums par instrumentiem):

Padoms. Ja sistēma atklāj tikai vienu pievienotu instrumentu, sadaļa All Instruments (Visi
instrumenti) rūtī Detected Instruments (Atklātie instrumenti) nav redzama. Lai skatītu
atsevišķa instrumenta kopsavilkumu, atlasiet View > Instrument Summary (Skatīt >
Kopsavilkums par instrumentiem).
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Instrument Summary (Kopsavilkums par instrumentiem) rīkjoslas elementi

10. tabula uzskaitīti elementi un funkcijas rīkjoslā Instrument Summary (Kopsavilkums par
instrumentiem).

Poga Pogas nosaukums Funkcija

Create a new Run
(Izveidot jaunu izpildi)

Izveido izpildi atlasītajam blokam,
atverot logu Run Setup (Izpildes
iestatīšana).

Stop (Apturēt) Aptur pašreizējo izpildi atlasītajos
blokos.

Pause (Pauzēt) Pauzē pašreizējo izpildi atlasītajos
blokos.

Atsākt Atsāk pašreizējo izpildi atlasītajos
blokos.

Mirgojoša bloka
indikators

Mirgo LED indikators uz atlasīto bloku
vāka.

Atvērt vāku Atver atlasītā bloka motorizēto vāku.

Aizvērt vāku Aizver atlasītā bloka motorizēto vāku.

Hide Selected Blocks
(Paslēpt atlasītos blokus)

Sarakstā Instrument Summary
(Kopsavilkums par instrumentiem)
paslēpj atlasītos blokus

Rādīt visus blokus Sarakstā Instrument Summary
(Kopsavilkums par instrumentiem) rāda
atlasītos blokus

Rādīt Atlasiet, kurus blokus rādīt sarakstā.
Atlasiet vienu no opcijām, lai rādītu
visus atklātos blokus, visus nelietotos
blokus, visus blokus, kas darbojas ar
pašreizējo lietotāju vai visus darbojošos
blokus

10. tabula. Instrument Summary (Kopsavilkums par instrumentiem) rīkjoslas elementi
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Instrumenta rekvizītu skatīšana
Rūtī Detected Instruments (Atklātie instrumenti) varat skatīt informāciju par atlasīto instrumentu,
tostarp tā rekvizītus, transportēšanas skrūves statusu un kalibrēto kontrastvielu (fluoroforu) sarakstu.

Instrumenta rekvizītu skatīšana

u Rūtī Detected Instruments (Atklātie instrumenti) ar peles labo pogu noklikšķiniet uz mērķa
instrumenta un izvēlnē, kas parādīsies, atlasiet Properties (Rekvizīti).

Cilne Properties (Rekvizīti)

Cilnē Properties (Rekvizīti) tiek norādīta tehniskā informācija par atlasīto instrumentu, tostarp modelis,
tā komponentu sērijas numuri un aparātprogrammatūras versijas. Instrumenta noklusējuma
nosaukums (tā sērijas numurs) parādās vairākās vietās, tostarp rūtī Detected Instruments (Atklātie
instrumenti) un dialoglodziņa Instrument Properties (Instrumenta rekvizīti) galvenes joslā. Jūs varat
pārdēvēt instrumentu, lai to varētu vieglāk identificēt.

Instrumenta pārdēvēšana

u Cilnē Instrument Properties (Instrumenta rekvizīti) ierakstiet nosaukumu lodziņā Rename
(Pārdēvēt) cilnes Properties (Rekvizīti) augšdaļā un noklikšķiniet uz Rename (Pārdēvēt).

Jaunais nosaukums parādās cilnes Properties (Rekvizīti) rindā Nickname (Segvārds), kā arī
galvenes joslā Instrument Properties (Instrumenta rekvizīti) un rūtī Detected Instruments (Atklātie
instrumenti).
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Cilne Shipping Screw (Transportēšanas skrūve)

Cilnē Shipping Screw (Transportēšanas skrūve) tiek parādīts atlasītā instrumenta transportēšanas
skrūves pašreizējais statuss (Removed (Izņemta) vai Installed (Uzstādīta)). Cilne ietver arī
norādījumus par sarkanās transportēšanas skrūves uzstādīšanu vai izņemšanu.

Padoms. Ja programmatūra atklās skrūvi, dialoglodziņā Instrument Properties (Instrumenta
rekvizīti) automātiski parādīsies cilne Shipping Screw (Transportēšanas skrūve). Lai izņemtu
skrūvi, ievērojiet norādījumus.

Piezīme. Pirms instrumenta lietošanas transportēšanas skrūve jāizņem. Papildu informāciju
skatīt Transportēšanas skrūves izņemšana 28. lpp.

Cilne Calibrated Dyes (Kalibrētās krāsvielas)

Cilnē Calibrated Dyes (Kalibrētās krāsvielas) tiek parādīti kalibrētie fluorofori un atlasītā instrumenta
trauciņi.

Lai redzētu sīkāku informāciju par kalibrēšanu, kolonnā Detail (Detalizēti dati) noklikšķiniet uz pogas
Info (Informācija).
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Pirms jūs sākat

Lietotāja preferenču iestatīšana
Padoms. Lai lietotu CFX Manager Dx software, nav nepieciešams veikt šos uzdevumus. Jūs
varat droši izlaist šo sadaļu vai jebkurā laikā veikt tajā aprakstītos uzdevumus.

CFX Manager Dx ļauj pielāgot darba vidi. Ja jūsu administrators ir izveidojis programmatūras
lietotājus, katrs lietotājs var pielāgot savu darba vidi. Ja jūsu administrators nav izveidojis lietotājus,
izmaiņas attiecas uz katru, kurš piesakās CFX Manager Dx. (Informāciju par CFX Manager Dx
lietotāju izveidi skat. B pielikums, Lietotāju un lomu CFX Manager Dx pārvaldīšana.)

Piemēram, izvēlnē Users > User Preferences (Lietotāji > Lietotāja preferences) varat veikt tālāk
norādītās darbības:

n Lai iestatītu e-pasta paziņojumu par izpildes pabeigšanu

n Mainiet noklusējuma iestatījumus tālāk norādītajiem vienumiem:

o Vieta, kur saglabāt failus

o Izpildes iestatīšanas faili

o Faila nosaukšanas prefikss

n Iestatiet noklusējuma parametrus, kas lietojami, izveidojot jaunu protokolu un trauciņu.

n Iestatiet noklusējuma datu analīzi un gēnu ekspresijas parametrus.

n Pielāgojiet noklusējuma kvalitātes kontroles parametrus.

n Pielāgojiet datu eksportēšanas datu parametrus.

Izvēlnē Tools (Rīki) jūs varat veikt tālāk norādītās darbības:

n Izveidojiet galveno maisījumu.

n Kalibrējiet kontrastvielas konkrētam instrumentam.

Piezīme. Galvenais maisījums un kontrastvielu kalibrēšana ir pieejama ikvienam, kurš piesakās
CFX Manager Dx.

Sadaļā ir sīkāk izskaidrots, kā veikt šos uzdevumus.
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E-pasta paziņojuma iestatīšana

Varat savienot CFX Manager Dx ar savu izejošā e-pasta serveri, lai izsūtītu e-pasta paziņojumu par
izpildes pabeigšanu lietotāju sarakstam. Varat izvēlēties arī pievienot lietotāju sarakstam datu failu un
analīzes atskaiti. Kā iestatīt savienojumu starp CFX Manager Dx un jūsu SMTP serveri, skatiet
Savienojuma izveidošana starp CFX Manager Dx un SMTP serveri 60. lpp.

Piezīme. Lietotāja iespēja piekļūt e-pasta iestatīšanas līdzekļiem ir atkarīga no lietotāju grupas
un administratora piešķirtajām atļaujām. Papildu informāciju par lietotāju un viņu lomu
pārvaldīšanu skatīt Lietotāju pārvaldīšana 261. lpp.

E-pasta paziņojumu iestatīšana

1. Atlasiet Users > User Preferences (Lietotāji > Lietotāja preferences), lai atvērtu dialoglodziņu
User Preferences (Lietotāja preferences).

Atveras dialoglodziņš User Preferences (Lietotāja preferences), kurā redzama cilne Email
(E-pasts).

Piezīme. Jūs redzat attiecīgu informāciju, ja sistēma konstatē, ka CFX Manager Dx nav
iestatīts derīgs SMTP serveris. Noklikšķiniet uz Configure Outgoing Email (Konfigurēt izejošo
e-pastu), lai atvērtu dialoglodziņu Options (Opcijas) un konfigurētu e-pasta SMTP serveri.
Papildu informāciju skatīt Savienojuma izveidošana starp CFX Manager Dx un SMTP serveri
60. lpp.

2. Tekstlodziņā To (Kam) ierakstiet katras personas e-pasta adresi, kuru plānojat informēt par
izpildes pabeigšanu. Pēc izpildes pabeigšanas visi adresāti saņems e-pastu.

Piezīme. Katra e-pasta adrese jāievada atsevišķā rindā. Pēc katras adreses nospiediet
ievadīšanas taustiņu vai Return (Atpakaļ).

3. (Papildiespēja) Tekstlodziņā cc ierakstiet jebkura adresāta e-pasta adresi, kuram plānojat sūtīt
katra e-pasta paziņojuma kopiju.
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4. (Papildiespēja) Pēc noklusējuma visi adresāti saņem datu faila kopiju kā pielikumu. Izņemiet
atzīmi no šīs izvēles rūtiņas, ja nevēlaties pievienot datu faila kopiju.

5. (Papildiespēja) Atlasiet Attach Analysis Report (Pievienot analīzes atskaiti), lai e-pastam
pievienotu analīzes atskaites PDF.

6. Lai saglabātu izmaiņas, noklikšķiniet uz OK (Labi) un aizveriet dialoglodziņu User Preferences
(Lietotāja preferences).

Adresāta e-pasta adreses rediģēšana

u Modificējiet e-pasta adresi, kā nepieciešams, un noklikšķiniet uz OK (Labi).

E-pasta adresāta noņemšana

1. Atlasiet e-pasta adresātu un nospiediet dzēšanas taustiņu.

2. Noklikšķiniet uz OK (Labi), lai saglabātu izmaiņas un aizvērtu dialoglodziņu.

Svarīgi! Noklikšķinot uz Restore Defaults (Atjaunot noklusējumus) dialoglodziņā User
Preferences (Lietotāja preferences), visas preferences visās cilnēs tiek atiestatītas uz
sākotnējiem rūpnīcas iestatījumiem. Ievērojiet piesardzību, noklikšķinot uz šīs pogas.

Savienojuma izveidošana starp CFX Manager Dx un SMTP serveri

Svarīgi! Daži komerciālā tīmekļa pasta pakalpojumu sniedzēji (piemēram, Yahoo! un Gmail) ir
paaugstinājuši e-pasta drošību. Ja izmantojat šos kontus, jums konta iestatījumos jāiespējo
opcija Allow less secure apps (Piekļuve lietotnēm ar zemāku drošības līmeni), lai CFX
Manager Dx varētu nosūtīt e-pasta ziņojumus. Sīkāku informāciju skatiet tīmekļa pasta
pakalpojumu sniedzēja nodrošināto informāciju par drošību.

Jums jaizveido CFX Manager Dx un e-pasta servera savienojums, lai programmatūra varētu nosūtīt e-
pasta paziņojumu.

CFX Manager Dx un e-pasta servera savienojuma izveide

1. Veiciet vienu no tālāk norādītajām darbībām:

n Atlasiet User > User Preferences (Lietotājs > Lietotāja preferences) un cilnē Email (E-pasts)
noklikšķiniet uz Configure Outgoing Email (Konfigurēt izejošo e-pastu).

n Atlasiet Tools > Options (Rīki > Opcijas).

Parādīsies dialoglodziņš Options (Opcijas), parādot cilni Email (E-pasts).

60 | CFX96 Dx un CFX96 DeepWell Dx sistēmas



Pirms jūs sākat

2. Sniedziet tālāk aprakstīto informāciju par jūsu uzņēmumu:

n SMTP Server Name (SMTP servera nosaukums)— izejošā e-pasta servera nosaukums
uzņēmumā.

n Port (Ports)—SMTP servera porta numurs. Tas parasti ir 25. ports.

n Use SSL (Izmantot SSL)—drošligzdu slāņa (SSL) opcija. Dažiem SMTP serveriem ir
nepieciešams šis iestatījums. Ja jūsu uzņēmumā tas nav nepieciešams, notīriet izvēles
rūtiņu.

n Use Default “From” Address (Izmantot noklusējuma adresi “No”)—e-pasta servera
nosaukums uzņēmumā. Dažiem SMTP serveriem tiek prasīts visiem e-pasta ziņojumiem
norādīt adresi “No”, kas pieder konkrētam domēnam, piemēram,
name@YourCompany.com. Tādā gadījumā notīriet izvēles rūtiņu un norādiet derīgu e-pasta
adresi.

n Authentication Required (Nepieciešama autentifikācija)— ja jūsu vietne pieprasa konta
autentifikāciju, pārbaudiet, vai ir atlasīta šī izvēles rūtiņa.

n User Name (Lietotājvārds)—autentificētā konta nosaukums. Tas ir nepieciešams tikai tad,
ja ir atlasīta opcija Authentication Required (Nepieciešama autentifikācija).

n Password (Parole)—autentificētā konta parole. Tas ir nepieciešams tikai tad, ja ir atlasīta
opcija Authentication Required (Nepieciešama autentifikācija).
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3. Lai pārbaudītu SMTP servera iestatījumu pareizību, tekstlodziņā Test Email Address (Pārbaudīt
e-pasta adresi) ievadiet derīgu e-pasta adresi un noklikšķiniet uz Test Email (Pārbaudīt e-pastu).

Piezīme. Daži SMTP serveri neļauj pielikumu nosūtīšanu, un citi SMTP serveri ļauj nosūtīt
pielikumus līdz noteiktam izmēram. Ja plānojat pa e-pastu nosūtīt datu failus un/vai
atskaites, izmantojot CFX Manager Dx, atlasiet Test Attachment (Pārbaudīt pielikumu) un
iestatiet Attachment Size in MB (Pielikuma izmērs MB) uz 5 megabaitiem (MB) vai vairāk.

4. Noklikšķiniet uz OK (Labi), lai saglabātu izmaiņas un aizvērtu dialoglodziņu.

Noklusējuma failu iestatījumu maiņa

Cilnē Files (Faili) dialoglodziņā User Preference (Lietotāja preferences) var mainīt šādus vienumus:

n Noklusējuma atrašanās vietu, kurā saglabāt CFX Manager Dx failus

n Noklusējuma failus izpildes iestatīšanai

n Noklusējuma failu nodēvēšanas parametrus

Noklusējuma failu iestatījumu maiņa

1. Atlasiet Users > User Preferences (Lietotāji > Lietotāja preferences), lai atvērtu dialoglodziņu
User Preferences (Lietotāja preferences).

2. Dialoglodziņā User Preferences (Lietotāja preferences) atlasiet cilni Files (Faili).
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3. Sadaļā Default Folder for File Creation (Noklusējuma mape failu izveidei) navigējiet un atlasiet
noklusējuma mapi, kurā vēlaties saglabāt jaunos failus. Katram failu veidam varat atlasīt citu
atrašanās vietu:

n Protokols

n Plāksne

n Datu fails

n Gēnu pētījums

4. Sadaļā File Selection for Run Setup (Faila atlase izpildes iestatīšanai) navigējiet uz mērķa
protokolu un trauciņa failiem un atlasiet tos, kam jāparādās, kad atverat logu Experiment Setup
(Eksperimenta iestatīšana).

5. Sadaļā Data File (Datu fails) definējiet datu failu prefiksu un/vai sufiksu. Ikvienas daļas gadījumā
atlasiet jaunu vērtību no nolaižamā saraksta. Tekstlodziņos Prefix (Prefikss) un Suffix (Sufikss)
varat ierakstīt arī pielāgotas prefiksa un sufiksa vērtības.

CFX Manager Dx rāda faila nosaukuma priekšskatījumu zem atlases lodziņiem.

6. Noklikšķiniet uz OK (Labi), lai saglabātu izmaiņas un aizvērtu dialoglodziņu.

Svarīgi! Noklikšķinot uz Restore Defaults (Atjaunot noklusējumus) dialoglodziņā User
Preferences (Lietotāja preferences), visas preferences visās cilnēs tiek atiestatītas uz
sākotnējiem rūpnīcas iestatījumiem. Ievērojiet piesardzību, noklikšķinot uz šīs pogas.
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Noklusējuma protokola parametru iestatīšana

Noklusējuma protokola parametru iestatīšana rīkos Protocol Editor (Protokola
redaktors) un Protocol AutoWriter (Protokola automātiskais rakstītājs)

1. Atlasiet Users > User Preferences (Lietotāji > Lietotāja preferences), lai atvērtu dialoglodziņu
User Preferences (Lietotāja preferences).

2. Dialoglodziņā User Preferences (Lietotāja preferences) atlasiet cilni Protocol (Protokols).

3. Sadaļā Protocol Editor (Protokola redaktors) norādiet šādu iestatījumu vērtības, kas parādās rīkā
Protocol Editor (Protokola redaktors):

n Sample volume (Parauga tilpums)—katra parauga tilpums iedobēs (in µl).

n Lid Shutoff temperature (Vāka izslēgšanas temperatūra)— temperatūra ºC, pie kādas
vāka sildītājs izpildes laikā izslēdzas.

4. Sadaļā Protocol AutoWriter (Protokola automātiskais rakstītājs) norādiet šādu iestatījumu
vērtības, kas parādās Protocol AutoWriter (Protokola automātiskais rakstītājs):

n Annealing temperature (Renaturācijas temperatūra)— temperatūra ºC eksperimentiem,
kuros lieto iProof DNS polimerāzi, iTaq DNS polimerāzi vai citas polimerāzes.

n Amplicon length (Amplikona garums)—amplikona garums bp.

5. Noklikšķiniet uz OK (Labi), lai saglabātu izmaiņas un aizvērtu dialoglodziņu.

Svarīgi! Noklikšķinot uz Restore Defaults (Atjaunot noklusējumus) dialoglodziņā User
Preferences (Lietotāja preferences), visas preferences visās cilnēs tiek atiestatītas uz
sākotnējiem rūpnīcas iestatījumiem. Ievērojiet piesardzību, noklikšķinot uz šīs pogas.
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Trauciņa noklusējuma parametru iestatīšana

Izmaiņas, ko veicat cilnē Plate (Trauciņš), ir pieejamas visiem programmatūras lietotājiem. Izmaiņas,
ko veicat trauciņa iestatīšanas laikā, ir pieejamas lietotājiem pēc tam, kad saglabājat un aizverat
trauciņa failu.

Dialoglodziņā User Preferences (Lietotāja preferences) var veikt tālāk norādītās darbības:

n Iestatīt trauciņa noklusējuma parametrus.

n Pievienot jaunu mērķu un paraugu nosaukumus to attiecīgajās bibliotēkās.

n Dzēst mērķu un paraugunosaukumus to attiecīgajās bibliotēkās.

Trauciņa noklusējuma parametru iestatīšana

1. Atlasiet Users > User Preferences (Lietotāji > Lietotāja preferences), lai atvērtu dialoglodziņu
User Preferences (Lietotāja preferences).

2. Dialoglodziņā User Preferences (Lietotāja preferences) atlasiet cilni Plate (Trauciņš).
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3. Norādiet vērtības tālāk minētajiem jauna trauciņa faila iestatījumiem. Šīs vērtības parādās logā
Plate Editor (Trauciņa redaktors):

n Plate type (Trauciņa veids)

n Plate size (Trauciņa lielums)

n Units (Mērvienības)— iedobju sākuma veidnes, kas satur standartus, koncentrācija.

CFX Manager Dx izmanto šīs mērvienības, lai cilnē Data Analysis Quantification (Datu
analīzes kvantitatīvā noteikšana) izveidotu standarta līkni.

n Scientific notation (Zinātnisks apzīmējums)—atlasot to, CFX Manager Dx parāda
koncentrācijas mērvienības zinātniskā apzīmējumā.

n Scan mode (Skenēšanas režīms)—kanālu skaits vai veids, kas jāskenē skenēšanas
laikā.

n Fluorophores (Fluorofori)—noklusējuma fluorofori, kas parādās rīka Plate Editor
(Trauciņa redaktors) kontroles materiālos, kas tiek ielādēti iedobē.

n Libraries (Bibiliotēkas)—mērķu un paraugu nosaukumi, kurus parasti izmantojat
eksperimentos.

o Target names (Mērķa nosaukumi)—mērķu gēnu un sekvenču nosaukumi.

o Sample names (Paraugu nosaukumi)—eksperimenta paraugu nosaukumi paraugus
raksturojoša iezīme (piemēram, Mouse1, Mouse2, Mouse3).

4. Noklikšķiniet uz OK (Labi), lai saglabātu izmaiņas un aizvērtu dialoglodziņu.

Lai pievienotu jaunu mērķa vai parauga nosaukumu

u Atbilstošajā bibliotēkas lodziņā ierakstiet mērķa vai parauga nosaukumu un noklikšķiniet uz OK
(Labi).

Lai dzēstu mērķa vai parauga nosaukumu

u Atbilstošajā bibliotēkas lodziņā atlasiet nosaukumu un nospiediet dzēšanas taustiņu; pēc tam
noklikšķiniet uz OK (Labi).

Svarīgi! Nosaukumi, ko noņemat no bibliotēkas, tiek noņemti no programmatūras un lietotājiem
vairs nav pieejami. Lai atjauninātu CFX Manager Dx noklusējuma nosaukumus, noklikšķiniet uz
Restore Defaults (Atjaunot noklusējumus). Noklikšķinot uz Restore Defaults (Atjaunot
noklusējumus) dialoglodziņā User Preferences (Lietotāja preferences), visas preferences visās
cilnēs tiek atiestatītas uz sākotnējiem rūpnīcas iestatījumiem. Ievērojiet piesardzību, dzēšot
noklusējuma CFX Manager Dx nosaukumus un noklikšķinot uz šīs pogas.
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Noklusējuma datu analīzes parametru iestatīšana

Noklusējuma datu analīzes parametru iestatīšana

1. Atlasiet Users > User Preferences (Lietotāji > Lietotāja preferences), lai atvērtu dialoglodziņu
User Preferences (Lietotāja preferences).

2. Dialoglodziņā User Preferences (Lietotāja preferences) atlasiet cilni Data Analysis (Datu analīze).

3. Sadaļā Analysis Mode (Analīzes režīms) atlasiet režīmu, kādā analizēt datus (vai nu Fluorophore
(Fluorofors), vai Target (Mērķis)).

4. Sadaļā PCR Quantitation (PCR kvantitatīvā noteikšana) iestatiet šādu opciju noklusējuma
parametrus:

n Baseline Setting (Bāzlīnijas iestatījums)—bāzlīnijas metode analīzes režīmam.

n Cq Determination Mode (Cq noteikšanas režīms)— režīms, kurā tiek aprēķinātas Cq
vērtības katram fluorescences trasējumam (vai nu regresijas, vai atsevišķa sliekšņa vērtība).

n Threshold Calc. Mode (Sliekšņa vērtības aprēķināšanas režīms)—galapunkta mērķa
daudzums.

Noklusējums ir Auto (Automātiski). Proti, programmatūra automātiski aprēķina galapunkta
mērķi. Lai iestatītu konkrētu sliekšņa vērtību, izņemiet atzīmi no Auto (Automātiski) izvēles
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rūtiņas un ievadiet savu galapunkta daudzumu, kas aprēķināts relatīvās fluorescences
vienībās (jeb RFV). Maksimālā vērtība ir 65000,00 RFV. Sekojošo izpilžu datu faili lietos šo
sliekšņa vērtības iestatījumu.

n Baseline Calc. Mode (Bāzlīnijas aprēķināšanas režīms)—bāzlīnijas vērtība visiem
trasējumiem.

Noklusējums ir Auto (Automātiski). Proti, programmatūra automātiski aprēķina bāzlīniju
visiem trasējumiem. Lai iestatītu konkrētu bāzlīnijas vērtību, izņemiet atzīmi no Auto
(Automātiski) izvēles rūtiņas un ierakstiet minimālās un maksimālās vērtības cikla
diapazonam (no 1 līdz 9999). Sekojošo izpilžu datu faili lietos šo cikla diapazonu.

n Log View (Žurnāla skats) —nosaka, kā programmatūra rāda amplifikācijas datus:

o On (Ieslēgts)—amplifikācijas dati tiek rādīti puslogaritmiskā grafikā.

o Off (Izslēgts)—amplifikācijas dati tiek rādīti lineārā grafikā.

5. Sadaļā End Point (Galamērķis) atlasiet galaciklu skaitu līdz vidējam, veicot galapunkta aprēķinus:

n PCR (PCR)—galaciklu skaits līdz vidējam kvantitatīvās noteikšanas datu nolūkā
(noklusējums ir 5).

n End Point Only run (Tikai galamērķa izpilde)—galaciklu skaits līdz vidējam galapunkta
datu nolūkā (noklusējums ir 2).

6. Sadaļā Melt Curve (Kušanas līkne) atlasiet nosakāmo maksimuma veidu (vai nu pozitīvo, vai
negatīvo).

7. Sadaļā Well Selector (Iedobju atlasītājs) atlasiet, kā rādīt iedobju etiķetes (pēc parauga veida,
mērķa nosaukuma vai parauga nosaukuma).

8. Noklikšķiniet uz OK (Labi), lai saglabātu izmaiņas un aizvērtu dialoglodziņu.

Svarīgi! Noklikšķinot uz Restore Defaults (Atjaunot noklusējumus) dialoglodziņā User
Preferences (Lietotāja preferences), visas preferences visās cilnēs tiek atiestatītas uz
sākotnējiem rūpnīcas iestatījumiem. Ievērojiet piesardzību, noklikšķinot uz šīs pogas.
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Noklusējuma gēnu ekspresijas datu faila parametru iestatīšana

Lai iestatītu noklusējuma parametrus jaunam gēnu ekspresijas datu failam, veiciet tālāk
norādīto.

1. Atlasiet Users > User Preferences (Lietotāji > Lietotāja preferences), lai atvērtu dialoglodziņu
User Preferences (Lietotāja preferences).

2. Dialoglodziņā User Preferences (Lietotāja preferences) atlasiet cilni Gene Expression (Gēnu
ekspresija).

3. Norādiet vērtības tālāk minētajiem iestatījumiem:

n Relative to (Attiecībā pret)—grafiski attēlo gēnu ekspresijas datus attiecībā pret kontroli
(sākas ar 1) vai nulli:

o Zero (Nulle)—programmatūra ignorē kontroli. Šis ir noklusējums, kad kontroles
paraugs tiek piešķirts logā Experiment Settings (Eksperimenta iestatījumi).

o Control (Kontrole)—programmatūra aprēķina datus attiecībā pret kontroles paraugu,
kas piešķirts logā Experiment Setup (Eksperimenta iestatīšana).

n X-axis (X ass)—grafiski attēlo mērķa paraugu uz x ass.

n Y-axis (Y ass)—grafiski attēlo lineāro, log2 vai log10 skalu uz y ass.
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n Scaling (Mērogošana)—mērogošanas opcija grafikam (noklusējuma opcija ir Unscaled
(Nemērogots)):

o Highest (Augstākais)—programmatūra mērogo grafiku līdz augstākajam datu
punktam.

o Lowest (Zemākais)—programmatūra mērogo grafiku līdz zemākajam datu punktam.

o Unscaled (Nemērogots)—programmatūra grafikā parāda nemērogotus datus.

n Mode (Režīms)—analīzes režīms, kas ir relatīvais daudzums (∆Cq) vai normalizēta
ekspresija (∆∆Cq).

n Error Bar (Kļūdas josla)—datu mainīgums, kas parādīts, kā standarta novirze (Std. Dev.
(Standarta novirze)) vai vidējās vērtības standarta kļūda (Std. Error Mean (Vidējās vērtības
standarta kļūda)).

n Error Bar Multiplier (Kļūdas joslas reizinātājs)—standarta novirzes reizinātājs, ko
izmanto, lai grafiski attēlotu kļūdu joslas (noklusējums ir 1).

Jūs varat palielināt reizinātāju līdz 2 vai 3.

n Sample Types to Exclude (Izslēdzamie paraugu veidi)—paraugu veidi, kas jāizslēdz no
analīzes.

Izslēgšanai no analīzes varat atlasīt vienu vai vairākus paraugus. Lai izslēgtu visus paraugu
veidus, notīriet jebkuru atlasīto paraugu veidu izvēles rūtiņas.

4. Noklikšķiniet uz OK (Labi), lai saglabātu izmaiņas un aizvērtu dialoglodziņu.

Svarīgi! Noklikšķinot uz Restore Defaults (Atjaunot noklusējumus) dialoglodziņā User
Preferences (Lietotāja preferences), visas preferences visās cilnēs tiek atiestatītas uz
sākotnējiem rūpnīcas iestatījumiem. Ievērojiet piesardzību, noklikšķinot uz šīs pogas.

Kvalitātes kontroles noteikumu pielāgošana

Sistēmā CFX Manager Dx var iestatīt kvalitātes kontroles noteikumus, kas tiek piemēroti datiem logā
Data Analysis (Datu analīze). Programmatūra validē šos datus atbilstoši iestatītajiem noteikumiem.

Piezīme. Pēc noklusējuma ir iespējoti visi kvalitātes kontroles noteikumi.

Padoms. Jūs varat bez grūtībām izslēgt iedobes, kas neatbilst kvalitātes kontroles parametram,
no analīzes loga Data Analysis (Datu analīze) kvalitātes kontroles modulī.

Kvalitātes kontroles noteikumu pielāgošana

1. Atlasiet Users > User Preferences (Lietotāji > Lietotāja preferences), lai atvērtu dialoglodziņu
User Preferences (Lietotāja preferences).

2. Dialoglodziņā User Preferences (Lietotāja preferences) atlasiet cilni QC (KK),
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kur:

n NTC (Bez veidnes kontroles)—bez veidnes kontroles

n NRT (Bez reversās transkriptāzes)—bez reversās transkriptāzes kontroles

n Efficiency (Efektivitāte)— reakcijas efektivitāte

n Std Curve R^2 (Standarta līknes kvadrāts)—standarta līknes R kvadrāta vērtība

n Replicate group Cq Std Dev (Replikātu grupai aprēķinātā standarta novirze)—katrai
replikātu grupai aprēķinātā standarta novirze

3. Attiecībā uz katru QC (KK) noteikumu, veiciet vienu no tālāk norādītajām darbībām:

n Lai lietotu tā noklusējuma vērtību, nedariet neko.

n Lai mainītu tā vērtību, noklikšķiniet uz tā tekstlodziņa Value (Vērtība), ierakstiet jaunu vērtību
un nospiediet ievadīšanas taustiņu.

n Lai atspējotu noteikumu, izņemiet atzīmi no tā izvēles rūtiņas Use (Lietot).

4. Noklikšķiniet uz OK (Labi), lai saglabātu izmaiņas un aizvērtu dialoglodziņu.

Svarīgi! Noklikšķinot uz Restore Defaults (Atjaunot noklusējumus) dialoglodziņā User
Preferences (Lietotāja preferences), visas preferences visās cilnēs tiek atiestatītas uz
sākotnējiem rūpnīcas iestatījumiem. Ievērojiet piesardzību, noklikšķinot uz šīs pogas.
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Datu eksporta parametru pielāgošana

CFXManager Dx datus var eksportēt šādos formātos:

n Teksts (.txt)

n CSV (.csv)

n Excel 2007 (.xlsx)

n Excel 2003 (.xls)

n XML (.xml)

n HTML (.html)

Varat norādīt eksportējamo datu veidu un pielāgot eksportēto datu izvadi.

Datu eksporta parametru pielāgošana

1. Atlasiet Users > User Preferences (Lietotāji > Lietotāja preferences), lai atvērtu dialoglodziņu
User Preferences (Lietotāja preferences).

2. Dialoglodziņā User Preferences (Lietotāja preferences) atlasiet cilni Custom Export (Pielāgots
eksports).
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3. Nolaižamajā sarakstā Export Format (Eksportēšanas formāts) atlasiet formātu, kurā datus
eksportēt.

4. Sadaļā Data to Export (Eksportējamie dati) ielieciet atzīmi eksportējamo datu veida izvēles
rūtiņās vai arī izņemiet atzīmi no šīm rūtiņām. Atlasītie vienumi ir redzami saraksta lodziņā
Exported Columns (Eksportētās kolonnas).

Piezīme. Pēc noklusējuma izpildes informācija ir ietverta galvenē. Izņemiet atzīmi no šīs
izvēles rūtiņas, ja nevēlaties iekļaut izpildes informāciju.

5. Varat mainīt atlasīto vienumu izvades rādīšanas secību.

Saraksta lodziņā Exported Columns (Eksportētās kolonnas) iezīmējiet vienumu un pēc tam
noklikšķiniet uz bulttaustiņiem saraksta kreisajā pusē, lai pārvietotu šo vienumu uz augšu vai uz
leju.

6. Pēc izvēles varat mainīt atlasīto vienumu izvades kolonnu nosaukumus:

a. Noklikšķiniet uz Customize Column Names (Pielāgot kolonnu nosaukumus).

Parādīsies dialoglodziņš Column Name Customizer (Kolonnu nosaukumu pielāgotājs).

b. Katra noklusējuma kolonnas nosaukuma gadījumā, ko vēlaties mainīt, ierakstiet jauno
nosaukumu tā laukā Custom Name (Pielāgots nosaukums).

c. Veiciet kādu no tālāk norādītajām darbībām:

n Noklikšķiniet uz OK (Labi), lai saglabātu izmaiņas un atgrieztos cilnē Custom Export
(Pielāgots eksports). Jaunais nosaukums parādās iekavās blakus noklusējuma
kolonnas nosaukumam saraksta lodziņā Exported Columns (Eksportētās kolonnas).

n Noklikšķiniet uz Cancel (Atcelt), lai notīrītu izmaiņas un atgrieztos cilnē Custom Export
(Pielāgots eksports).

7. Noklikšķiniet uz OK (Labi), lai saglabātu izmaiņas un aizvērtu dialoglodziņu.

Svarīgi! Noklikšķinot uz Restore Defaults (Atjaunot noklusējumus) dialoglodziņā User
Preferences (Lietotāja preferences), visas preferences visās cilnēs tiek atiestatītas uz
sākotnējiem rūpnīcas iestatījumiem. Ievērojiet piesardzību, noklikšķinot uz šīs pogas.

Reakcijas galvenā maisījuma izveide
Izmantojot CFX Manager Dx Master Mix Calculator (Galvenā maisījuma kalkulators), iespējams viegli
aprēķināt vajadzīgo katra komponenta daudzumu galvenajā maisījumā. Galvenā maisījuma aprēķinu
tabulu var nosūtīt drukāšanai uz noklusējuma printeri, kā arī saglabāt aprēķinus attiecībā uz katru
mērķi vēlākam lietojumam.
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Reakcijas Master maisījuma izveide, izmantojot Master Mix Calculator (Galvenā
maisījuma kalkulators)

1. Lai atvērtu Master Mix Calculator (Galvenā maisījuma kalkulators), veiciet vienu no tālāk
norādītajām darbībām:

n Atlasiet Tools > Master Mix Calculator (Rīki > Galvenā maisījuma kalkulators).

n Rīkjoslā noklikšķiniet uz Master Mix Calculator (Galvenā maisījuma kalkulators).

Parādās Master Mix Calculator (Galvenā maisījuma kalkulators).

2. Sadaļā Reaction (Reakcija) atlasiet noteikšanas metodi:

n SYBR®Green/EvaGreen

n Probes (Zondes)

3. Lai izveidotu jaunu mērķi, sadaļā Target (Mērķis) noklikšķiniet uz Create New (Izveidot jaunu).
Mērķu nolaižamajā sarakstā parādās jauns mērķa nosaukums.
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4. (Papildiespēja) Noklusējuma mērķa nosaukuma maiņa

a. Iezīmējiet mērķa nosaukumu nolaižamajā mērķu sarakstā.

b. Lodziņā Target (Mērķis) ierakstiet jaunu mērķa nosaukumu.

c. Nospiediet taustiņu Enter (Ievadīt).

5. Pielāgojiet turpvirziena un reverso praimeru, kā arī jebkuras zondes sākuma un galīgās
koncentrācijas.

6. Sadaļā Master Mix Setup (Galvenā maisījuma iestatīšana) pielāgojiet vērtības attiecībā uz tālāk
norādītājiem vienumiem

n Reakciju skaits izpildē

n Reakciju apjoms vienā iedobē

n Veidnes apjoms vienā iedobē

n Supermaisījuma koncentrācija vienā iedobē

n Lieko reakciju apjoms vienā iedobē

7. (Papildiespēja) Veiciet 2.–6. darbību attiecībā uz tik mērķiem, cik nepieciešams.

8. Sadaļā Choose Target to Calculate (Izvēlēties aprēķināmo mērķi) atlasiet aprēķināmo mērķi.

Padoms. Vienlaikus var aprēķināt vienu vai vairākus, vai visus mērķus.

Vajadzīgo komponentu aprēķinātie apjomi katram atlasītajam mērķim parādās galvenā
maisījuma tabulā.

9. Noklikšķiniet uz Set as Default (Iestatīt kā noklusējumu), lai iestatītu daudzumu ievadi sadaļās
Target (Mērķis) un Master Mix Setup (Galvenā maisījuma iestatīšana) kā jaunās noklusējuma
vērtības.

10. Noklikšķiniet uz OK (Labi), lai saglabātu dialoglodziņa Master Mix Calculator (Galvenā maisījuma
kalkulators) saturu.

Lai izdrukātu Master maisījuma aprēķinu tabulas izdrukāšana

u Lai izdrukātu Master maisījuma aprēķinu tabulu, noklikšķiniet uz Print (Drukāt).

Aprēķinu tabula tiek nosūtīta uz noklusējuma printeri drukāšanai.

Master maisījuma aprēķinu tabulas saglabāšana kā PDF

u Mainiet noklusējuma printeri uz PDF draiveri un noklikšķiniet uz Print (Drukāt) dialoglodziņā
Master Mix Calculator (Galvenā maisījuma kalkulators).
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Mērķu dzēšana

u Atlasiet mērķi, izmantojot nolaižamo mērķu sarakstu, un noklikšķiniet uz Remove (Noņemt).

Svarīgi! Mērķa noņemšana no mērķu saraksta noņem to arī no jebkuriem galvenā
maisījuma aprēķiniem, kuros tas lietots. Ievērojiet piesardzību, dzēšot mērķi.
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Jaunu kontrastvielu kalibrēšana
CFX96 Dx sistēmas ir kalibrētas rūpnīcā biežāk lietotajiem fluoroforiem balto iedobju un caurspīdīgo
iedobju trauciņos. 11. tabula uzskaitīti fluorofori un kanāls, kuram katrs instruments ir kalibrēts.

Piezīme. CFX96 sistēmas ietver arī kanālu, kas paredzēts FRET ķīmijai. Šis kanāls nav jākalibrē
konkrētām kontrastvielām.

Fluorofori Kanāls Ierosinājums, nm Noteikšana, nm

FAM, SYBR® Green I 1 450–490 515–530

VIC, HEX, CAL Fluor Gold 540, Cal
Fluor Orange 560

2 515–535 560–580

ROX, Texas Red, CAL Fluor Red
610, TEX 615

3 560–590 610–650

CY5, Quasar 670 4 620–650 675–690

Quasar 705, Cy5.5 5 672–684 705–730

11. tabula. Rūpnīcā kalibrēti fluorofori un kanāli

Jaunu kontrastvielu CFX sistēmām kalibrēšana

1. Logā Home (Sākums) atlasiet mērķa instrumentu rūtī Detected Instruments (Atklātie instrumenti).

2. Atlasiet Tools > Calibration Wizard (Rīki > Kalibrēšanas vednis), lai atvērtu vedni Dye Calibration
(Kontrastvielu kalibrēšana).

Mērķa instrumentam jau kalibrētie fluorofori ir redzami tabulā Calibrated Fluorophores (Kalibrētie
fluorofori).
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3. Sadaļā Calibrate New or Existing Fluorophores (Kalibrēt jaunus vai esošus fluoroforus) no
nolaižamā saraksta atlasiet kalibrējamo fluoroforu.

Ja fluorofora nosaukums nav iekļauts sarakstā, ierakstiet tā nosaukumu tekstlodziņā, lai
pievienotu to sarakstam.

4. Atlasiet šim fluoroforam trauciņa veidu.

Ja trauciņa veids nav iekļauts sarakstā, ierakstiet nosaukumu tekstlodziņā, lai pievienotu to
sarakstam.

5. Atlasiet šim fluoroforam kanālu.

6. Atlasiet šim fluoroforam trauciņa kolonnu.

7. (Papildiespēja) Ierakstiet ar fluoroforu saistāmo krāsu.

8. Lai pievienotu fluoroforu, noklikšķiniet uz Add to Plate (Pievienot trauciņam).

9. (Papildiespēja) Atkārtojiet 3.–8. darbību, lai pievienotu katru fluoroforu, ko plānojat trauciņam
kalibrēt.

10. Kad fluoroforu pievienošana ir pabeigta, noklikšķiniet uz View Plate (Skatīt trauciņu), lai atvērtu
logu Pure Dye Plate Display (Tīras kontrastvielas trauciņa displejs).

Izmantojiet šo logu kā norādi kontrastvielu ielādēšanai trauciņā.

11. Sagatavojiet 96 iedobju trauciņu kontrastvielu kalibrēšanai:

a. Ar pipeti iepiliniet kontrastvielas šķīdumu katrā iedobē, ievērojot displejā Pure Dye Plate
Display (Tīras kontrastvielas trauciņa displejs) redzamo modeli.

b. Katra fluorofora gadījumā piepildiet četras iedobes ar 50 µl (96 iedobju trauciņš) 300 nM
kontrastvielas šķīduma. Ņemiet vērā, ka vismaz puse trauciņa satur tukšas iedobes.

c. Hermetizējiet trauciņu, izmantojot to hermetizēšanas metodi, kādu lietosiet savā
eksperimentā.

12. Ievietojiet kalibrēšanas trauciņu blokā un aizveriet vāku.

13. Vednī Dye Calibration (Kontrastvielu kalibrēšana) noklikšķiniet uz Calibrate (Kalibrēt) un uz OK
(Labi), lai apstiprinātu, ka trauciņš atrodas blokā.

14. Kad CFX Manager Dx software pabeidz kalibrēšanas izpildi, parādās dialoglodziņš. Lai pabeigtu
kalibrēšanu, noklikšķiniet uz Yes (Jā) un atveriet Dye Calibration Viewer (Kontrastvielu
kalibrēšanas skatītājs).

15. Lai aizvērtu logu, noklikšķiniet uz OK (Labi).
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Protokols ir to darbību kopa, kuras tiek izpildītas īpašā secībā. CFX Manager Dx programmatūrā visas
darbības ir saistītas ar instrumenta opcijām. Piemēram, darbības instruē instrumentu kontrolēt bloku
un vāka temperatūru, lietot temperatūru starpību visā blokā, veikt trauciņa nolasīšanu vai veikt
kušanas līknes analīzi. Katra opcija tiek norādīta atsevišķam trauciņam un izpildes veidiem.

CFX Manager Dx nodrošina divas protokolu izveides opcijas: Protocol Editor (Protokola redaktors) un
Protocol AutoWriter (Protokola automātiskais rakstītājs).

Opcijas Protocol Editor (Protokola redaktors) funkcijas:

n Standarta protokols vadīklas ātrai protokolu izveidei

n Iespēja ātri aprēķināt gradientu atlasītajam rindu skaitam

n Iespēja ātri aprēķināt izpildes laiku atlasītajam trauciņu veidam

n Iespēja rediģēt protokola darbības

n Iespēja saglabāt protokolus atkārtotam lietojumam

n Iespēja nosūtīt protokolu uz noklusējuma printeri drukāšanai

Opcija Protocol AutoWriter (Protokola automātiskais rakstītājs), izmantojot jūsu sniegtos parametrus,
automātiski ģenerē pielāgotu PCR protokolu ar karsto sākšanu, sākotnējo denaturāciju, renaturāciju
un pagarinājuma darbībām. Pēc tam jūs varat skatīt ierosinātā protokola grafisko attēlojumu un
rediģēt, izpildīt vai saglabāt protokolu.
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Logs Protocol Editor (Protokola redaktors)
Izmantojiet logu Protocol Editor (Protokola redaktors), lai izveidotu, atvērtu, pārskatītu un rediģētu
protokolu. Logs Protocol Editor (Protokola redaktors) atveras, pēc noklusējuma parādot vispārīgu
reāllaika 2 darbību protokolu 96 iedobju trauciņam.

1. Izvēlnes josla nodrošina ātru piekļuvi izvēļņu File (Fails), Settings (Iestatījumi) un Tools
(Rīki) komandām.

2. Rīkjosla nodrošina ātru piekļuvi, lai saglabātu un izdrukātu protokolu, noteiktu, kur ievietot
darbību, iestatītu parauga tilpumu un skatītu paredzēto protokola izpildes laiku,

3. Galvenajā rūtī tiek parādīts protokola grafiskais attēlojums.

4. Apakšējā rūtī tiek parādīta protokola kontūra.

5. Kreisajā rūtī tiek parādītas protokola vadīklas, kuras varat pievienot, lai pielāgotu protokolu.

APZĪMĒJUMI
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Izvēlnes File (Fails) komandas
Save (Saglabāt)—saglabā pašreizējo protokolu.

Save As (Saglabāt kā)—saglabā pašreizējo protokolu ar jaunu nosaukumu vai jaunā vietā.

Close (Aizvērt)—aizver logu Protocol Editor (Protokola redaktors).

Izvēlnes Settings (Iestatījumi) komanda
Lid Settings (Vāka iestatījumi)—atver dialoglodziņu Lid Setting (Vāka iestatījums), kurā var mainīt
vai iestatīt vāka temperatūru.

Tools (Rīki) izvēlnes komandas
Gradient Calculator (Gradienta kalkulators)—atver dialoglodziņu, no kura var atlasīt bloka veidu
gradienta darbībai. Noklusējums ir 96 iedobes.

Run time Calculator (Izpildes laika kalkulators)—atver dialoglodziņu, no kura var atlasīt trauciņa
veidu un skenēšanas režīmu, lai aprēķinātu lēsto izpildes laiku logā Run Setup (Izpildes iestatīšana).
Noklusējums ir 96 iedobes, visi kanāli.

Rīkjoslas komandas

—saglabā pašreizējā protokola failu.

— izdrukā atlasīto logu.

— lietojiet šo komandu, lai atlasītu, kur ievietot darbības, kas attiecas uz
pašreiz atlasīto darbību.
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— lietojiet šo komandu, lai ievadītu parauga tilpumu µl. Paraugu tilpumi
atšķiras atkarībā no bloka veida:

n 96 dziļo iedobju bloka gadījumā diapazons ir 0–125 µl.

n 96 iedobju bloka gadījumā diapazons ir 0–50 µl.

— rāda aplēsto izpildes laiku, pamatojoties uz protokola darbībām,
rampveida izmaiņu ātrumu un atlasītā bloka veidu.

— rāda palīdzības informāciju attiecībā uz protokoliem.

Protokola rediģēšanas vadīklas
Loga Protocol Editor (Protokola redaktors) kreisā rūts satur vadīklas, kuras varat izmantot protokolu
izveidei.

Katra vadīkla sastāv no parametru, kas parāda protokola darbību, kopas. Jūs varat izmainīt katru
parametru un pievienot vai noņemt to, lai pielāgotu protokolu. Šajā sadaļā ir aprakstītas katras
vadīklas opcijas.

n Insert Step (Ievietot darbību)— ievieto darbību pirms vai pēc
atlasītās darbības. Jūs varat rediģēt temperatūras un turēšanas laika
vērtības protokola grafiskajā attēlojumā vai protokola kontūrā.

n Insert Gradient (Ievietot gradientu)— ievieto gradienta darbību,
balstoties uz iedobju bloka veidu, kas atlasīts gradienta kalkulatorā.
Jūs varat rediģēt gradienta diapazonu rūtī Gradient (Gradients), kas
parādās, kad ir ievietota gradienta darbība.

n Insert GOTO (Ievietot GOTO)— ievieto ciklēšanas (cilpas)
darbību, kas informē programmatūru, lai tā sekvencē veiktu
konkrētas darbības noteiktam ciklu skaitam. Atkārtojumi sākas pēc
pirmā cikla pabeigšanas. Piemēram, jūs varat informēt

programmatūru, lai tā 39 reizes atkārtotu 2.–4. darbību. Pēc pēdējā atkārtojuma programmatūra
būs 40 reizes atkārtojusi 2.–4. darbību. Jūs varat rediģēt atgriešanās (GOTO) darbību un ciklu
skaitu grafiskajā attēlojumā vai protokola kontūrā.

n Insert Melt Curve (Ievietot kušanas līkni)— ievieto kušanas līknes nolasīšanas darbību.
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n Insert Plate Read to Step (Ievietot darbībā trauciņa nolasīšanu)—atlasītajai darbībai
pievieno trauciņa nolasīšanas komandu. Trauciņa nolasīšanas laikā tiek mērīts fluorescences
daudzums cikla beigās. Parasti trauciņa nolasīšanas darbība ir pēdējā darbība GOTO cilpā.

Padoms. Pēc trauciņa nolasīšanas komandas pievienošanas darbībai, atlasot darbību,
poga mainās uz pogu Remove Plate Read (Noņemt trauciņa nolasījumu).

n Remove Plate Read (Noņemt trauciņa nolasījumu)—atlasītajai darbībai noņem trauciņa
nolasīšanas komandu.

Padoms. Pēc trauciņa nolasīšanas komandas noņemšanas no darbības, atlasot darbību,
poga mainās uz pogu Add Plate Read to Step (Pievienot darbībai trauciņa nolasījumu).

n Step Options (Darbības opcijas)—atver dialoglodziņu Step Options (Darbības opcijas) un
parāda atlasītajai darbībai pieejamās opcijas. Sīkāku informāciju par darbības opcijām skat.
Darbības opcijas 83. lpp.

Padoms. Tāpat jūs varat piekļūt vadīklai Step Options (Darbības opcijas), ar labo peles pogu
noklikšķinot uz grafiskā attēlojuma.

n Delete Step (Dzēst darbību)—protokolā dzēš atlasīto darbību.

Darbības opcijas

Atveriet dialoglodziņu Step Options (Darbības opcijas), lai skatītu opcijas, kuras varat pievienot, mainīt
vai noņemt no darbības.

n Plate Read (Trauciņa nolasījums)—atlasot šo opciju, darbībai tiek pievienots trauciņa
nolasījums.

n Temperature (Temperatūra)—atlasītajai darbībai iestata mērķa temperatūru.

n Gradient (Gradients)—darbībai iestata gradienta diapazonu; diapazons ir no 1 līdz 24 °C.
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Piezīme. Gradients tiek izpildīts ar zemāko temperatūru bloka priekšpusē (šajā attēlā — H
rinda) un augstāko temperatūru bloka aizmugurē (šajā attēlā — A rinda).

n Increment (Pieaugums)—atlasītās darbības palielinājuma (vai samazinājuma) apmērs; šī
vērtība katrā ciklā tiek pievienota mērķa temperatūrai. Diapazons ir ±0,1–10 °C.

Piezīme. Lai samazinātu temperatūru, pirms skaitliskās vērtības ierakstiet mīnus zīmi (–)
(piemēram, –5 °C).

n Ramp Rate (Izmaiņu ātrums)—atlasītās darbības izmaiņu ātrums; diapazons ir atkarīgs no
bloka izmēra.

n Time (Laiks)—atlasītās darbības turēšanas laiks

n Extend (Pagarināt)— laiks (sekundēs), par kādu tiek pagarināta vai saīsināta atlasītā darbība;
šī opcija katrā ciklā tiek pievienota turēšanas laikam; diapazons ir no 1 līdz 60 sekundēm.

n Beep (Signāls)—atlasot šo opciju, darbības beigās atskan signāls.

Padoms. Ievadot skaitli, kas ir ārpus opcija diapazona, programmatūra maina skaitli uz
tuvāko ierakstu diapazonā.
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Protokola izveide logā Protocol Editor (Protokola redaktors)
Logā Protocol Editor (Protokola redaktors) varat izveidot pielāgotus protokola failus. Tāpat jūs varat
rediģēt un saglabāt iepriekš saglabātos protokola failus vai parauga protokola failus, kas ietilpst CFX
Manager Dx software komplektācijā.

Lai izveidotu jaunu protokola failu, veiciet tālāk norādīto.

n Logā Protocol Editor (Protokola redaktors) atveriet protokola failu.

Padoms. Logā Protocol Editor (Protokola redaktors) varat atvērt jauno vai esošo protokolu.

n Iestatiet jauno protokolu.

n Protokola vadības rūtī protokolam pievienojiet darbības.

n Rediģējiet darbību rekvizītus.

n Saglabājiet protokolu.

Padoms. Lai izveidotu jaunu protokola failu no iepriekš saglabātā vai parauga protokola faila,
skat. Esoša protokola atvēršana logā Protocol Editor (Protokola redaktors) 87. lpp.

Jauna protokola faila atvēršana rīkā Protocol Editor (Protokola
redaktors)
CFXManager Dx piedāvā vairākas opcijas jaunā protokola faila atvēršanai:

n Izmantojot logu Home (Sākums)

n Izmantojot dialoglodziņu Startup Wizard (Startēšanas vednis)

n Izmantojot dialoglodziņu Run Setup (Izpildes iestatīšana)

Jauna protokola faila atvēršana, izmantojot logu Home (Sākums)

u Atlasiet File > New > Protocol (Fails > Jauns > Protokols).

Atvērsies logs Protocol Editor (Protokola redaktors), parādot noklusējuma protokola failu.

Padoms. Informāciju par noklusējuma protokola iestatīšanu skat. Noklusējuma failu
iestatījumu maiņa 62. lpp.
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Lai atvērtu jauno protokola failu, izmantojot Startup Wizard (Startēšanas vednis)

1. Logā Home (Sākums) veiciet vienu no tālāk norādītajām darbībām, lai atvērtu Startup Wizard
(Startēšanas vednis), ja tas netiek skatīts:

n Atlasiet View > Startup Wizard (Skatīt > Startēšanas vednis).

n Rīkjoslā noklikšķiniet uz Startup Wizard (Startēšanas vednis).

Dialoglodziņā Startup Wizard (Startēšanas vednis) pēc noklusējuma tiek parādīta cilne Run setup
(Izpildes iestatīšana) ar atlasītu instrumenta veidu CFX96.

2. Ja nepieciešams, nolaižamajā sarakstā atlasiet instrumenta veidu.

3. Noklikšķiniet uz izpildes veida User-defined (Lietotāja definēts).

Cilnē Protocol (Protokols) atvērsies dialoglodziņš Run Setup (Izpildes iestatīšana) un tiks
parādīts noklusējuma protokola fails.

4. Noklikšķiniet uz Create New (Izveidot jaunu).

Atvērsies logs Protocol Editor (Protokola redaktors), parādot noklusējuma reāllaika protokolu.

Jauno protokola failu atvēršana, izmantojot dialoglodziņu Run Setup (Izpildes
iestatīšana)

1. Logā Home (Sākums) veiciet vienu no tālāk norādītajām darbībām, lai atvērtu dialoglodziņu Run
Setup (Izpildes iestatīšana):

n Atlasiet Run > User-defined Run (Izpilde > Lietotāja definēta izpilde).

n Rīkjoslā noklikšķiniet uz User-defined Run Setup (Lietotāja definēta izpildes iestatīšana).

Cilnē Protocol (Protokols) atvērsies dialoglodziņš Run Setup (Izpildes iestatīšana) un tiks
parādīts noklusējuma protokola fails.

2. Noklikšķiniet uz Create New (Izveidot jaunu).

Atvērsies logs Protocol Editor (Protokola redaktors), parādot noklusējuma reāllaika protokolu.
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Esoša protokola atvēršana logā Protocol Editor (Protokola
redaktors)
CFXManager Dx nodrošina parauga protokolu failus, ko varat rediģēt un saglabāt kā pielāgotus
jaunus protokolus. Varat izveidot jaunu protokolu arī no esoša pielāgota protokola.

Parauga protokola faila atvēršana

1. Logā Home (Sākums) atlasiet File > Open > Protocol (Fails > Atvērt > Protokols).

Pēc noklusējuma pārlūkprogrammaWindows Explorer atveras CFX Manager Dx parauga failu
mapes atrašanās vietā.

2. Atveriet parauga failu mapi. Redzamas šādas mapes:

n ConventionalProtocols (Tradicionālie protokoli)—satur tradicionālas PCR analīzes
parauga protokolu failus.

n DataFiles (Datu faili)—satur parauga datu failus, ko varat izmantot, lai iepazītos ar CFX
Manager Dx funkcijām.

n MeltCalibration (Kušanas kalibrēšana)—satur parauga protokolu failus lietojumam ar
Bio-Rad Precision Melt Analysis (Precīza kušanas analīze) programmatūru.

n Plates (Trauciņi)—satur parauga trauciņu failus.

n RealTimeProtocols (Reāllaika protokoli)—satur reāllaika PCR analīzes parauga
protokolu failus.

3. Atveriet protokolu mapi, kas attiecas uz tā veida izpildi, ko plānojat veikt, vai nu
ConventionalProtocols (Tradicionālie protokoli), vai RealTimeProtocols (Reāllaika protokoli).

4. Atlasiet atbilstošu protokolu un noklikšķiniet uz Open (Atvērt).

Parauga protokols atveras logā Protocol Editor (Protokola redaktors).

5. Atlasiet File > Save As (Fails > Saglabāt kā) un saglabājiet protokolu ar jaunu nosaukumu vai
jaunā mapē.
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Esoša protokola atvēršana

1. Logā Home (Sākums) veiciet vienu no tālāk norādītajām darbībām:

n Atlasiet File > Open > Protocol (Fails > Atvērt > Protokols), navigējiet uz mērķa protokolu un
atlasiet to, pēc tam noklikšķiniet uz Open (Atvērt).

n Atveriet Startup Wizard (Startēšanas vednis) un veiciet vienu no tālāk norādītajām darbībām:

o Lai rediģētu redzamo protokolu, noklikšķiniet uz Edit Selected (Rediģēt atlasīto).

o Lai rediģētu citu atlasītu protokolu, noklikšķiniet uz Select Existing (Atlasīt esošu) un
navigējiet uz mērķa failu.

Protokols atveras logā Protocol Editor (Protokola redaktors).

2. Atlasiet File > Save As (Fails > Saglabāt kā) un saglabājiet protokolu ar jaunu nosaukumu vai
jaunā mapē.

Jauna protokola iestatīšana
Padoms. Ja protokola failā ir iekļauti vajadzīgie parametri (piemēram, ja rediģējat esošu trauciņa
failu), varat izlaist šo sadaļu. Turpiniet ar Darbību pievienošana protokolam 90. lpp.

Jaunos protokola failos ir vajadzīgi šādi parametri:

n Bloka veids

n Skenēšanas režīms izvēlētajam bloka veidam

n Vāka temperatūra

n Parauga tilpums

Bloka veida iestatīšana

CFXManager Dx automātiski aprēķina temperatūras soļus gradienta darbībām, pamatojoties uz bloka
veidu.

Piezīme. Logā Protocol Editor (Protokola redaktors) iestatītajam trauciņa veidam jābūt tādam
pašam kā trauciņam reakcijas modulī.

Bloka veida iestatīšana

u Logā Protocol Editor (Protokola redaktors) atlasiet Tools > Gradient Calculator (Rīki > Gradienta
kalkulators) un izvēlieties attiecīgo trauciņa veidu no parādītā nolaižamā saraksta.
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Skenēšanas režīma atlasīšana izvēlētajam bloka veidam

Lai noteiktu protokola izpildes laiku, atlasiet mērķa bloka veidu un skenēšanas režīmu.

Bloka veida un skenēšanas režīma atlase

u Logā Protocol Editor (Protokola redaktors) atlasiet Tools > Run time Calculator (Rīki > Izpildes
laika kalkulators) un nolaižamajā sarakstā, kas parādās, izvēlieties atbilstošo trauciņa veidu un
skenēšanas režīmu.

Vāka temperatūras regulēšana

CFXManager Dx iestata noklusējuma vāka temperatūru 105,0 °C

Jūs atbilstoši protokolam varat mainīt noklusējuma iestatījumus vai izslēgt vāka sildītāju.

Padoms. Jūs varat mainīt noklusējuma vāka temperatūru dialoglodziņā User Preferences
(Lietotāja preferences). Skat. Noklusējuma protokola parametru iestatīšana 64. lpp.

Vāka temperatūras regulēšana

1. Logā Plate Editor (Trauciņa redaktors) atlasiet Settings > Lid Settings (Iestatījumi > Vāka
iestatījumi).

Parādīsies dialoglodziņš Lid Settings (Vāka iestatījumi).

2. Veiciet vienu no tālāk norādītajām darbībām:

n Atlasiet opciju User Defined (Lietotāja definēts) un tekstlodziņā ievadiet temperatūras
vērtību.

n Atlasiet opciju Turn Off Lid Heater (Izslēgt vāka sildītāju).

3. Noklikšķiniet uz OK (Labi), lai apstiprinātu izmaiņas un aizvērtu dialoglodziņu.
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Parauga tilpuma iestatīšana

CFXManager Dx katrai iedobei iestata 25 µl noklusējuma parauga tilpumu. Tomēr CFX Dx system
diapazons ir 0–125 µl.

Instruments izmanto vienu diviem temperatūras kontroles režīmiem, lai noteiktu, kad paraugs
sasniedz protokolā noteikto mērķa temperatūru:

n Calculated mode (Aprēķinātais režīms)—kad tiek iestatīts blokam atbilstošais parauga
tilpums, instruments aprēķina parauga temperatūru, balstoties uz parauga tilpumu. Šis ir
standarta režīms.

n Block mode (Bloka režīms)—kad parauga tilpums ir iestatīts uz nulli (0) µl, instruments reģistrē
parauga temperatūru kā ekvivalentu izmērītajai bloka temperatūrai.

Lai konkrētam blokam iestatītu parauga tilpumu

u Loga Plate Editor (Trauciņa redaktors) rīkjoslas tekstlodziņā Sample Volume (Parauga tilpums)
ierakstiet pareizo vērtību.

Padoms. Jūs varat mainīt noklusējuma parauga tilpumu dialoglodziņā Lietotāja preferences.
Skat. Noklusējuma failu iestatījumu maiņa 62. lpp.

Darbību pievienošana protokolam
Darbības pievienošana protokolam

1. Atveriet protokolu logā Protocol Editor (Protokola redaktors).

2. Nosakiet, kur ievietot jauno darbību. Rīkjoslā atlasiet Before (Pirms) vai After (Pēc) no nolaižamā
saraksta Step (Darbība).

3. Diagrammā atlasiet darbību, pirms kuras vai pēc kuras plānojat jauno darbību.

4. Kreisajā rūtī noklikšķiniet uz Insert Step (Ievietot darbību).

5. Lai mainītu temperatūru vai aizturētu laiku, noklikšķiniet diagrammā vai protokola strukturējumā
uz noklusējuma vērtības un ierakstiet jauno vērtību.

6. (Papildiespēja) Rūtī pa kreisi noklikšķiniet uz Step Options (Darbības opcijas), lai rādītu
dialoglodziņu Step Options (Darbības opcijas) un modificētu atlasītās darbības pieejamās
opcijas.

Padoms. Dialoglodziņam Step Options (Darbības opcijas) var piekļūt ar peles labās pogas
izvēlni, noklikšķinot vai nu diagrammas rūtī, vai protokola strukturējuma rūtī.
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7. Lai saglabātu izmaiņas protokolā, noklikšķiniet uz OK (Labi) un pēc tam uz Yes (Jā).

Parādīsies dialoglodziņš Save As (Saglabāt kā)

8. Dialoglodziņā Save As (Saglabāt kā) ierakstiet jaunā protokola faila nosaukumu un noklikšķiniet
uz Save (Saglabāt).

Gradienta darbības ievietošana
Gradienta darbības ievietošana

1. Pārbaudiet, vai trauciņa lielums gradientam ir tāds pats kā instrumenta bloka veids— 96 iedobju.

2. Ja tas jau nav izdarīts, atlasiet gradientam trauciņa lielumu.

Atlasiet Tools > Gradient Calculator (Rīki > Gradienta kalkulators) un nolaižamajā sarakstā
izvēlieties atbilstošu iedobes veidu.

3. Rīkjoslas nolaižamajā sarakstā Insert Step (Ievietot darbību) atlasiet opciju Before (Pirms) vai
After (Pēc).

4. Grafikā vai strukturējuma rūtī atlasiet darbību pirms vai pēc, ko plānojat ievietot gradienta
darbībā.

Lietošanas rokasgrāmata | 91



6. nodaļa. Protokolu izveide

5. Kreisajā rūtī noklikšķiniet uz Insert Gradient (Ievietot gradientu). Jaunā gradienta darbība ir izcelta
grafikā un strukturējuma rūtī, piemēram:

Katras rindas temperatūra gradientā parādās labās rūts tabulā Gradient (Gradients).

6. Lai rediģētu gradienta temperatūras diapazonu, veiciet vienu no tālāk norādītajām darbībām:

n Grafikā vai strukturējuma rūtī noklikšķiniet uz noklusējuma temperatūras un ievadiet jauno
temperatūru.

n Noklikšķiniet uz Step Options (Darbības opcijas), lai logā Step Options (Darbības opcijas)
ievadītu gradientu diapazonu.

n Tabulā Gradient (Gradients) mainiet opcijas Range (Diapazons) vērtību.

7. Lai rediģētu turēšanas laiku, grafikā vai teksta skatā noklikšķiniet uz noklusējuma laika un
ievadiet jauno laiku.

8. Lai saglabātu izmaiņas, noklikšķiniet uz OK (Labi) un pēc tam uz Yes (Jā).
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GOTO darbības ievietošana
Piezīme. Jūs nevarat ievietot GOTO darbību GOTO komplektā; jūs nevarat izveidot vajadzīgās
GOTO cilpas.

Lai ievietotu GOTO darbību

1. Rīkjoslā atlasiet Before (Pirms) vai After (Pēc) no nolaižamā saraksta Insert Step (Ievietot
darbību).

2. Grafika atlasiet darbību pirms vai pēc, ko plānojat ievietot GOTO darbībā.

3. Kreisajā rūtī noklikšķiniet uz Insert GOTO (Ievietot GOTO).

4. Lai rediģētu GOTO darbības numuru vai GOTO atkārtojumu skaitu, grafikā vai strukturējuma rūtī
atlasiet noklusējuma skaitli un ievadiet jauno vērtību.

5. Lai saglabātu izmaiņas, noklikšķiniet uz OK (Labi) un pēc tam uz Yes (Jā).

Kušanas līknes darbības ievietošana
Padoms. GOTO cilpā nevar ievietot kušanas līknes darbību.

Piezīme. Kušanas līknes darbība ietver 30 sek. ilgu aizturi darbības sākumā, kas protokolā netiek
rādīta.

Kušanas līknes darbības ievietošana

1. Rīkjoslā atlasiet Before (Pirms) vai After (Pēc) no nolaižamā saraksta Insert Step (Ievietot
darbību).

2. Diagrammā atlasiet darbību, pirms kuras vai pēc kuras plānojat ievietot kušanas līknes darbību.
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3. Rūtī pa kreisi noklikšķiniet uz Insert Melt Curve (Ievietot kušanas līkni). Jaunā kušanas līknes
darbība ir izcelta grafikā un strukturējuma rūtī, piemēram:

4. Lai rediģētu kušanas temperatūras diapazonu vai palielinājumu laiku, atlasiet noklusējuma skaitli
grafikā vai strukturējuma rūtī un ievadiet jauno vērtību.

5. Lai saglabātu izmaiņas, noklikšķiniet uz OK (Labi) un pēc tam uz Yes (Jā).
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Trauciņa nolasījuma darbības pievienošana vai noņemšana
Padoms. Kad darbībai pievieno trauciņa nolasījuma komandu, tad, atlasot šo darbību, poga
mainās uz Remove Plate Read (Noņemt trauciņa nolasījumu).

Trauciņa nolasījuma pievienošana darbībai

1. Rīkjoslā atlasiet Before (Pirms) vai After (Pēc) no nolaižamā saraksta Insert Step (Ievietot
darbību).

2. Diagrammā atlasiet darbību, pirms kuras vai pēc kuras plānojat ievietot trauciņa nolasījuma
darbību.

3. Lai pievienotu trauciņa nolasījumu atlasītajai darbībai, kreisajā rūtī noklikšķiniet uz Add Plate
Read to Step (Pievienot darbībai trauciņa nolasījumu).

4. Lai saglabātu izmaiņas, noklikšķiniet uz OK (Labi) un pēc tam uz Yes (Jā).

Trauciņa nolasījumu noņemšana no darbības

u Diagrammā atlasiet darbību, kas satur trauciņa nolasījumu, un kreisajā rūtī noklikšķiniet uz
Remove Plate Read (Noņemt trauciņa nolasījumu).

Darbības opciju mainīšana
Darbības opciju mainīšana atlasītajai darbībai

1. Atlasiet mērķa darbību grafikā vai strukturējuma rūtī.

2. Kreisajā rūtī noklikšķiniet uz Step Options (Darbības opcijas), lai atvērtu dialoglodziņu Step
Options (Darbības opcijas).

Vai arī ar labo peles pogu noklikšķiniet rūtī un parādītajā izvēlnē atlasiet Step Options (Darbības
opcijas).

3. Lai pievienotu, mainītu vai noņemtu opcijas:

n attiecīgajā tekstlodziņā ievadiet vērtību;

n konkrētajā tekstlodziņā rediģējiet vērtību;

n atlasiet vai notīriet izvēles rūtiņu.

4. Noklikšķiniet uz OK (Labi), lai apstiprinātu izmaiņas un aizvērtu dialoglodziņu Step Options
(Darbības opcijas).

5. Lai saglabātu protokolu, noklikšķiniet uz OK (Labi) un tad uz Yes (Jā).
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Darbības dzēšana
Darbības dzēšana protokolā

1. Atlasiet darbību grafikā vai strukturējuma rūtī.

2. Lai dzēstu atlasīto darbību, rūtī pa kreisi noklikšķiniet uz Delete Step (Dzēst darbību).

3. Lai saglabātu protokolu, noklikšķiniet uz OK (Labi) un tad uz Yes (Jā).

Protokola kopēšana, eksportēšana vai drukāšana
Protokola kopēšana

u Ar labo peles pogu noklikšķiniet uz protokola kontūras un atlasiet Copy Protocol (Kopēt
protokolu).

Jūs varat ielīmēt strukturējumu .txt, .xls, .doc vai .ppt failā.

Protokola eksportēšana

1. Ar labo peles pogu noklikšķiniet uz protokola kontūras un atlasiet Export Protocol (Eksportēt
protokolu).

Parādīsies dialoglodziņš Save As (Saglabāt kā).

2. (Papildiespēja) PārlūkprogrammāWindows Explorer navigējiet uz mapi, kurā jāsaglabā protokola
fails.

3. Laukā File name (Faila nosaukums), ierakstiet eksportētā protokola faila nosaukumu.

4. Noklikšķiniet uz Saglabāt.

Protokola drukāšana

u Ar labo peles pogu noklikšķiniet uz protokola strukturējuma un atlasiet Print (Drukāt).

Jūs varat drukāt protokola strukturējuma, izmantojot noklusējuma printeri.
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Protokola izveide, izmantojot Protocol AutoWriter (Protokola
automātiskais rakstītājs)

Svarīgi! Bio-Rad negarantē, ka ar Protocol AutoWriter (Protokola automātiskais rakstītājs)
izveidota protokola izpilde vienmēr ļaus izveidot reāllaika PCR produktu.

CFX Manager Dx Protocol AutoWriter (Protokola automātiskais rakstītājs) automātiski ģenerē
ciklēšanas protokolus, balstoties uz tālāk norādītajiem ievades parametriem:

n Amplicon length (Amplikona garums)—gaidāmais PCR produkta garums.

n Annealing temperature (Renaturācijas temperatūra)— reakcijas Ta izmantotajiem
praimeriem.

Ja Ta nav zināma, varat izmantot rīku Ta Calculator (Ta kalkulators), lai automātiski aprēķinātu to,
balstoties uz praimera sekvencēm.

Piezīme. Ta tiek regulēta, ņemot vērā informāciju par praimera kušanas temperatūru (Tm),
kas balstās uz atlasīto fermentu un protokola ātrumu.

n Enzyme type (Fermentu veids)—DNA (DNS) polimerāzes ferments (iTaq DNA (iTaq DNS),
iProof DNA (iProof DNS) polimerāze vai Other (Cits)).

Ja izmantojat fermentu, kas nav saistīts ar iTaq vai iProof DNA (iProof DNS) polimerāzi, varat
ievadīt papildu informāciju, tostarp gradientu diapazonu, karstās sākšanas aktivizēšanas laiku
(sekundēs) un galīgo pagarinājuma laiku (sekundēs).

n Run speed (Izpildes ātrums)— reakcijas ātrums (standarta, liels vai ultraliels).

Protocol AutoWriter (Protokola automātiskais rakstītājs) optimizē protokolu atkarībā no atlasītā
ātruma iestatījuma. Kopējo izpildes laiku nosaka darbību un ciklu skaits, inkubācijas laiks katrā
darbībā un laiks, kas nepieciešams viendabīguma sasniegšanai mērķa temperatūrā.

Izmantojot ievadītos parametrus un standarta PCR vadlīnijas, Protocol AutoWriter (Protokola
automātiskais rakstītājs) automātiski ģenerē pielāgotu PCR protokolu ar karsto sākšanu, sākotnējo
denaturāciju, renaturāciju un pagarinājuma darbībām. Pēc tam jūs varat skatīt ierosinātā protokola
grafisko attēlojumu un rediģēt, izpildīt vai saglabāt protokolu.

Lietošanas rokasgrāmata | 97



6. nodaļa. Protokolu izveide

Jauna protokola izveide, izmantojot CFX Manager Dx Protocol AutoWriter (Protokola
automātiskais rakstītājs)

1. Logā Home (Sākums) atlasiet Tools > Protocol AutoWriter (Rīki > Protokola automātiskais
rakstītājs).

Parādīsies dialoglodziņš Protocol AutoWriter (Protokola automātiskais rakstītājs).

2. Sadaļā Enter Target Values/Enzyme (Ievadīt mērķa vērtības/fermentu) veiciet tālāk norādīto.

n Ievadiet praimeru renaturācijas temperatūru (Ta), ja tā ir zināma.

Padoms. Sīkāku informāciju skat. Ta Calculator (Ta kalkulators) lietošana 99. lpp.

Piezīme. Informāciju par rīkā Ta Calculator (Ta kalkulators) izmantotajiem aprēķiniem
skat. Breslauer et al. 1986.

n Bāzu pāros (bp) ievadiet amplikona garumu.

n Opciju sarakstā atlasiet fermentu veidu (iTaq DNA (iTaq DNS) polimerāze, iProof DNA
(iProof DNS) polimerāze vai Other (Cits)).

Padoms. Kā fermentu veidu atlasot Other (Cits), parametri sadaļā Additional
Parameters (Optional) (Papildu parametri (Papildiespēja)) kļūs aktīvi.
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Ta Calculator (Ta kalkulators) lietošana

3. Ja kā fermentu veidu atlasījāt Other (Cits), jūs varat pievienot protokolam jebkuru vai visus tālāk
norādītos parametrus.

n Gradientu diapazons

n Karstās sākšanas aktivizēšanas temperatūra

n Galīgais pagarinājuma laiks

4. Sadaļā Type (Veids) bīdiet slīdni, lai atlasītu protokola ātrumu (Standard (Standarta), Fast (Liels)
vai Ultrafast (Ultraliels)). CFX Manager Dx regulē kopējo izpildes laiku.

5. Atlasiet veicamā PCR veidu (noklusējuma iestatījums ir Real-time PCR (Reāllaika PCR)).

Reāllaika PCR laikā CFX Manager Dx pievieno trauciņa nolasīšanas darbību, lai vāktu
fluorescences datus.

6. Sadaļā Preview (Priekšskatījums) pārskatiet protokolu. Jūs varat veikt izmaiņas pēc
nepieciešamības.

7. Veiciet vienu no tālāk norādītajām darbībām:

n Noklikšķiniet uz OK (Labi), lai saglabātu jauno protokolu. Pēc tā saglabāšanas protokols
atveras rīkā Startup Wizard (Startēšanas vednis). Noklikšķiniet uz Edit Selected (Rediģēt
atlasīto), lai veiktu izmaiņas protokolā. Piemēram, jums var būt nepieciešams mainīt vāka
temperatūru un parauga tilpumu.

n Noklikšķiniet uz Cancel (Atcelt), lai aizvērtu logu, nesaglabājot protokolu.

Ta Calculator (Ta kalkulators) lietošana
Kad praimera renaturācijas temperatūra nav zināma, jūs varat lietot Ta Calculator (Ta kalkulators), lai
aprēķinātu vērtību. Šo vērtību var lietot Protocol AutoWriter (Protokola automātiskais rakstītājs) vai
Protocol Editor (Protokola redaktors), lai izveidotu savu protokolu.

Par Ta Calculator (Ta kalkulators)
Ta Calculator (Ta kalkulators) aprēķina Tm vērtību katram praimerim, kā arī Ta vērtību protokolam
standarta ātrumā.

Protokolam paredzētā Ta vērtība balstās uz vidējām praimera Tm vērtībām, piemērojot šādas kārtulas:

n ja praimera Tm vērtību starpība > 4°C, Ta = (zemākā no abām praimera Tm vērtībām + 2) — 4°C

n ja Tm vērtību starpība ir ≤4°C, Ta = (vidējā praimera Tm vērtība) — 4°C
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Bāzes pāru skaitīšanas metode

Katra praimera gadījumā Ta Calculator (Ta kalkulators) lieto bāzes pāru skaitīšanas metodi 14 bāzes
pāru (bp) vai mazāka pāru skaita secībām.

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

kur w, x, y un z ir bāzu A, T, G un C skaits attiecīgajā secībā.

Tuvāko kaimiņu metode

Sekvencēm, kas ir garākas par 14 bp, tiek izmantota tuvāko kaimiņu metode. Tuvāko kaimiņu metodē
kušanas temperatūras aprēķini balstās uz entropijas (oligonukleotīda nejaušības kārtības vai
mērījuma), entalpijas (siltuma, ko izdala vai absorbē oligonukleotīds), brīvās enerģijas un
temperatūras termodinamiskā attiecība.

∆H = ∆G + T* ∆S,

kur:

n ∆H = entalpijas vērtība, Cal/Mol*K

n T = temperatūra (Kelvini)

n ∆S = entropijas vērtība, Cal/Mol*K

n ∆G = Gibsa brīvā enerģija, Cal/Mol*K

Entropijas un entalpijas izmaiņas tiek tieši aprēķinātas, saskaitot 12. tabula rādīto nukleotīdu pāru
vērtības (Breslauer et al. 1986).

Saistību starp brīvo enerģiju un reaģentu un produktu koncentrāciju līdzsvara stāvoklī aprēķina ar
tālāk norādīto formulu.

∆G = R*T*ln ((DNS * praimeris)/(DNS + praimeris)),

kur R ir gāzes konstante (1,986 Cal/Mol*K).

Aizvietojot G divos vienādojumos un aprēķinot T, tiek iegūts vienādojums

T = ∆H/(∆S + R*Ln((DNS * praimersi)/(DNS + praimeris))),

pieņemot, ka DNS un DNS praimera kompleksa koncentrācijas ir vienādas.

Empīriski noteikts, ka pārejas laikā no vienpavediena DNS uz B formas DNS notiek 5 kcal brīvas
enerģijas (3,4 kcal) apmaiņa (Sugimoto et al. 1996). Tiek uzskatīts, ka tā ir spirāles iniciācijas enerģija.
Visbeidzot, ar sāli saistītas korekcijas pievienošana ļauj izveidot vienādojumu, ko izmanto Ta
kalkulators:

T = (∆H— 5(KCal/K*Mol))/(∆S + (R * ln(1/(paimeris)))) + 16,6 log10 (sāls molārā koncentrācija)
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Sāls koncentrācijai nav nepieciešama koriģēšana, jo pie 1 M NaCl tika noteikti dažādi parametri un 1
log10 ir nulle.

Termodinamiskajos aprēķinos tiek pieņemts, ka renaturācija parādās pie pH 7,0. Tm aprēķinos tiek
pieņemts, ka sekvences nav simetriskas un satur vismaz vienu G vai C.

Oligonukleotīdu sekvencei jābūt vismaz 14 bāzes garai, lai saņemtu pamatotas Tm vērtības. Ja ir
mazāk nekā 14 bāzes, tiek izmantota bāzu pāru skaitīšanas metode (skat. 12. tabula zemāk).

Mijiedarbība ∆H ∆S ∆G

Aa TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT Aa 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

12. tabula. Breslauera mijiedarbības konstantes
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Ta Calculator (Ta kalkulatora) lietošana

Lai lietotu Ta Calculator (Ta kalkulators)

1. Lai atvērtu Ta Calculator (Ta kalkulators), veiciet vienu no tālāk norādītajām darbībām:

n Ja ir atvērts rīks Protocol AutoWriter (Protokola automātiskais rakstītājs), noklikšķiniet uz Ta
Calculator (Ta kalkulators).

n Logā Home (Sākums) atlasiet Tools > Ta Calculator (Rīki > Ta kalkulators).

Parādīsies dialoglodziņš Ta Calculator (Ta kalkulators).

2. Tekstlodziņā Forward Primer (Tiešais praimeris) ierakstiet vai ielīmējiet tiešā praimera sekvenci.

Padoms. Tāpat jūs varat izmantot pogas A, T, G, C dialoglodziņa kreisajā pusē, lai ievadītu
sekvenci.

3. Tekstlodziņā Reverse Primer (Atgriezeniskais praimeris) ierakstiet vai ielīmējiet atgriezeniskā
praimera sekvenci.
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4. Noklikšķiniet uz Calculate (Aprēķināt).

Ta Calculator (Ta kalkulators) aprēķina un parāda katra praimera Tm, vidējās Tm un Ta vērtības,
piemēram:

Ja praimera Tm vērtības atšķiras par vairāk kā 4 °C, rīks Protocol AutoWriter (Protokola
automātiskais rakstītājs) izmanto zemāko praimera Tm vērtību + 2 °C kā pamatu Ta vērtības, kuru
varat papildus pārveidot, mainot fermentu un reakcijas ātrumu, aprēķināšanai.

Ta Calculator (Ta kalkulators) ģenerē renaturācijas temperatūru standarta ātrumam ar iTaq DNS
polimerāzi. Izmantojot citu fermentu, ātruma iestatījumi automātiski regulē Ta.

5. Veiciet vienu no tālāk norādītajām darbībām:

n Ja ar rīka Protocol AutoWriter (Protokola automātiskais rakstītājs) palīdzību ir atvērts Ta
Calculator (Ta kalkulators), noklikšķiniet uz OK (Labi). Atgriezīsieties rīkā Protocol AutoWriter
(Protokola automātiskais rakstītājs). Renaturācijas temperatūra tiek automātiski mainīta.

n Ja Ta Calculator (Ta kalkulators) ir atvērts ar izvēlnes Tools (Rīki) palīdzību, reģistrējiet
aprēķinus un noklikšķiniet uz Cancel (Atcelt), lai aizvērtu kalkulatoru.
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7. nodaļa. Trauciņu sagatavošana
Trauciņa fails satur informāciju par izpildes parametriem, tādiem kā skenēšanas režīms, fluorofori un
iedobju saturs. Pēc izpildes CFX Manager Dx programmatūra, saista iedobju saturu ar izpildes laikā
savāktajiem fluorescences datiem un lieto atbilstošu analīzi logā Data Analysis (Datu analīze).
Piemēram, ar standarta parauga veidu ielādētas iedobes tiek lietotas, lai ģenerētu standarta līkni.

CFX Manager Dx software nodrošina divas trauciņu izveides iespējas: logs Plate Editor (Trauciņa
redaktors) reāllaika PCR izpildēm un logs Setup Wizard (Iestatīšanas vednis) normalizētai gēnu
ekspresijas analīzei.

Logā Plate Editor (Trauciņa redaktors) ir ietvertas šādas iespējas:

n Standarta fluorofori un paraugu veidi, ko piešķirt trauciņu iedobēm

n Iespēja iestatīt atsauces mērķi un kontroles paraugu gēnu ekspresijas analīzei

n Iespēja rediģēt trauciņa iestatījumu pirms izpildes, tās laikā un pēc izpildes

n Iespēja saglabāt trauciņu failus atkārtotam lietojumam

n Iespēja nosūtīt trauciņa failus un noklusējuma printeri drukāšanai

Setup Wizard (Iestatīšanas vednis) vada trauciņu izkārtojuma izveidošanas procesu normalizētas
gēnu ekspresijas analīzei. Setup Wizard (Iestatīšanas vedni) var lietot pirms izpildes, tās laikā un pēc
izpildes.

Lietošanas rokasgrāmata | 105



7. nodaļa. Trauciņu sagatavošana

Logs Plate Editor (Trauciņa redaktors)
Logu Plate Editor (Trauciņa redaktors) varat lietot, lai veidotu pielāgotus trauciņus vai modificētu
esošos trauciņus.

1. Izvēļņu josla sniedz ātru piekļuvi izvēļņu File (Fails) un Settings (Iestatījumi) komandām, kā
arī trauciņu rediģēšanas rīku opcijām.

2. Rīkjosla sniedz ātru piekļuvi svarīgām trauciņa ielādēšanas funkcijām.

3. Galvenajā rūtī tiek rādīts trauciņu izkārtojums un trauciņa opcijas atbilstoši tam, kā tās
lietojat.

4. Labās puses rūtī tiek rādītas opcijas, kuras izmantojat, lai trauciņu pielāgotu.

5. Apakšējā rūtī tiek rādīts trauciņa veids un sniegta ātra piekļuve skatīšanas opcijām.

APZĪMĒJUMI
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Logs Plate Editor (Trauciņa redaktors)

Izvēlnes File (Fails) komandas
Save (Saglabāt)—saglabā trauciņa datu failu vietā, kas norādīta dialoglodziņa User Preferences
(Lietotāja preferences) cilnē File (Fails). Papildinformāciju skatiet šeit Noklusējuma failu iestatījumu
maiņa 62. lpp. Šis izvēlnes vienums ir pieejams tikai tad, kad tiek izveidots jaunais trauciņa fails.

Save As (Saglabāt kā)—saglabā atklātu trauciņa datu failu ar jaunu jūsu norādīto nosaukumu. Šis
izvēlnes vienums ir pieejams tikai tad, kad tiek izveidots jaunais trauciņa fails.

Extract Plate (Izvilkt trauciņu)—atver dialoglodziņu, kurā varat izvilkt/saglabāt trauciņa failu (.pltd).
Šis izvēlnes vienums ir pieejams tikai esošā trauciņa faila skatīšanas vai rediģēšanas laikā.

Print (Drukāt)— izdrukā atvērto trauciņa datu failu.

Close (Aizvērt)—aizver rīku Plate Editor (Trauciņa redaktors).

Izvēlnes Settings (Iestatījumi) komandas
Plate Size (Trauciņa lielums)—sniedz opcijas, no kurām var atlasīt trauciņa lielumu konkrētajai
izpildei.

Piezīme. CFX Dx system var lietot tikai 96 iedobju trauciņu.

Plate Type (Trauciņa veids)—sniedz iespēju izvēlēties iedobju veidu trauciņā, kas tur paraugus,
proti, BRWhite (BR balts) vai BR Clear (BR caurspīdīgs). Lai datu analīze būtu precīza, atlasītā
trauciņa veidam jābūt tādam pašam kā izpildē lietotais trauciņa veids.

Number Convention (Numuru konvencija)—sniedz iespēju atlasīt opciju rādīt mērvienības ar
zinātnisku apzīmējumu vai noņemt šādas opcijas atlasi. Noklusējums ir rādīt mērvienības ar
zinātnisku apzīmējumu.

Units (Mērvienības)—sniedz iespēju izvēlēties mērvienības, kādas rādīt izklājlapās, veicot
nezināmo līkņu kvantitatīvo noteikšanu salīdzinājumā ar standarta līknēm.

Izvēlnes Editing Tools (Rediģēšanas rīki) komandas
Setup Wizard (Startēšanas vednis)—atver dialoglodziņu Setup Wizard (Startēšanas vednis), kurā
varat definēt izkārtojumu un esošā trauciņa analīzes parametrus. Jūs varat izmantot Setup Wizard
(Startēšanas vednis) pirms izpildes, izpildes laikā un pēc izpildes.

Spreadsheet View/Importer (Izklājlapas skats/importētājs)—atver dialoglodziņu View (Skats),
kurā tiek parādīts trauciņa izkārtojums kā veidne izklājlapas formātā. Jūs varat izmantot šo
dialoglodziņu, lai eksportētu vai importētu trauciņa veidnes datus .csv formātā.

Flip Plate (Apvērst trauciņu)—apvērš trauciņa saturu par 180o.

Lietošanas rokasgrāmata | 107



7. nodaļa. Trauciņu sagatavošana

Rīkjoslas komandas

Saglabā esošo trauciņa failu.

Parāda nolaižamo sarakstu, kurā varat paaugstināt vai pazemināt trauciņa
skata palielināšanu.

Parāda nolaižamo sarakstu, kurā varat atlasīt skenēšanas režīmu, kura
laikā instrumentam tiek noteikts, no kuriem kanāliem vākt fluorescences
datus izpildes laikā.

Atver logu Well Groups Manager (Iedobju grupu pārvaldnieks), ko varat
izmantot, lai esošajam trauciņam izveidotu iedobju grupas.

Parāda dialoglodziņu, kurā varat izvēlēties krāsas un simbolus
amplifikācijas trajektorijām.

Atver dialoglodziņu View (Skats), kurā tiek parādīts trauciņu izkārtojums
kā veidne izklājlapas formātā. Jūs varat izmantot šo dialoglodziņu, lai
eksportētu vai importētu trauciņa veidnes datus .csv formātā.

Parāda nepieciešamās darbības trauciņa iestatīšanai un iedobju
ielādei.
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Trauciņa faila izveide, izmantojot logu Plate Editor (Trauciņa
redaktors)

Izmantojot logu Plate Editor (Trauciņa redaktors), var veidot pielāgotus trauciņu failus. Varat rediģēt
un saglabāt arī iepriekš saglabātus trauciņu failus vai parauga trauciņu failus, kas piegādāti kopā ar
CFX Manager Dx software.

Lai izveidotu jaunu trauciņa failu, veiciet tālāk norādīto.

n Atveriet trauciņa failu logā Plate Editor (Trauciņa redaktors).

n Atlasiet trauciņa veidu.

Piezīme. Konkrētā trauciņa faila trauciņa veidam jābūt tādam pašam kā trauciņam reakcijas
modulī.

n Atlasiet protokolā lietojamo skenēšanas režīmu.

n Atlasiet trauciņā lietojamos fluoroforus.

n Atlasiet parauga veidu, mērķus un paraugus.

n Atlasiet replikātus, ja tas ir atbilstoši.

n Saglabājiet trauciņu izkārtojumu.

Padoms. Lai izveidotu jaunu trauciņu no iepriekš saglabāta vai parauga trauciņa faila, skatiet
Esošā trauciņa faila atvēršana logā Plate Editor (Trauciņa redaktors) 112. lpp.
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Jaunā trauciņa faila atvēršana rīkā Plate Editor (Trauciņa
redaktors)
CFXManager Dx software piedāvā vairākas opcijas jaunā trauciņa faila atvēršanai:

n Izmantojot logu Home (Sākums)

n Izmantojot dialoglodziņu Startup Wizard (Startēšanas vednis)

n Izmantojot dialoglodziņu Run Setup (Izpildes iestatīšana)

Lai atvērtu jauno trauciņa failu, izmantojot logu Home (Sākums)

u Atlasiet File > New > Plate (Fails > Jauns > Trauciņš).

Atvērsies logs Plate Editor (Trauciņa redaktors), atlasītajam instrumentam parādot noklusējuma
trauciņa failu.

Padoms. Informāciju par noklusējuma trauciņa faila iestatīšanu skat. Noklusējuma failu
iestatījumu maiņa 62. lpp.

Lai atvērtu jauno trauciņa failu, izmantojot Startup Wizard (Startēšanas vednis)

1. Logā Home (Sākums) veiciet vienu no tālāk norādītajām darbībām, lai atvērtu Startup Wizard
(Startēšanas vednis), ja tas netiek skatīts:

n Atlasiet View > Startup Wizard (Skatīt > Startēšanas vednis).

n Rīkjoslā noklikšķiniet uz Startup Wizard (Startēšanas vednis).

Dialoglodziņā Startup Wizard (Startēšanas vednis) pēc noklusējuma tiek parādīta cilne Run
Setup (Izpildes iestatīšana) ar atlasītu instrumentu CFX96.

2. Ja nepieciešams, nolaižamajā sarakstā atlasiet instrumenta veidu.

3. Lai izveidotu jaunu trauciņu, noklikšķiniet uz izpildes veida User-defined (Lietotāja definēts).

Atvērsies dialoglodziņš Run Setup (Izpildes iestatīšana), parādot cilni Protocol (Protokols).

4. Noklikšķiniet uz cilnes Plate (Trauciņš) un uz Create New (Izveidot jaunu).

Atvērsies logs Plate Editor (Trauciņa redaktors), atlasītajam instrumentam parādot noklusējuma
trauciņu izkārtojumu.
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Lai atvērtu jauno trauciņa failu, izmantojot dialoglodziņu Run Setup (Izpildes iestatīšana)

1. Logā Home (Sākums) veiciet vienu no tālāk norādītajām darbībām, lai atvērtu dialoglodziņu Run
Setup (Izpildes iestatīšana):

n Atlasiet Run > User-defined Run (Izpilde > Lietotāja definēta izpilde).

n Rīkjoslā noklikšķiniet uz User-defined Run Setup (Lietotāja definēta izpildes iestatīšana).

Cilnē Protocol (Protokols) atvērsies dialoglodziņš Run Setup (Izpildes iestatīšana).

2. Lia izveidotu jaunu trauciņu, noklikšķiniet uz cilnes Plate (Trauciņš) un uz Create New (Izveidot
jaunu).

Atvērsies logs Plate Editor (Trauciņa redaktors), atlasītajam instrumentam parādot noklusējuma
trauciņu izkārtojumu.
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Esošā trauciņa faila atvēršana logā Plate Editor (Trauciņa
redaktors)
CFXManager Dx software nodrošina parauga trauciņu failus, ko varat rediģēt un saglabāt kā jaunu
trauciņu. Varat izveidot jaunu trauciņa failu arī no iepriekš saglabāta trauciņa faila.

Parauga trauciņa faila atvēršana

1. Logā Home (Sākums) atlasiet File > Open > Plate (Fails > Atvērt > Trauciņš).

PārlūkprogrammasWindows Explorer atveras mapes CFX Manager Dx Sample files (Parauga
faili) atrašanās vietā.

2. Atveriet mapi Sample files (Parauga faili) un tad atveriet mapi Plates (Trauciņi).

3. Atlasiet atbilstošu trauciņu un noklikšķiniet uz Open (Atvērt).

Parauga trauciņa fails atveras logā Plate Editor (Trauciņa redaktors).

4. Atlasiet File > Save As (Fails > Saglabāt kā) un saglabājiet trauciņa failu ar jaunu nosaukumu vai
jaunā mapē.

Iepriekš saglabāta trauciņa faila atvēršana

1. Logā Home (Sākums) atlasiet File > Open > Plate (Fails > Atvērt > Trauciņš), navigējiet uz mērķa
trauciņu, atlasiet to un noklikšķiniet uz Open (Atvērt).

Mērķa trauciņa fails atveras logā Plate Editor (Trauciņa redaktors).

2. Atlasiet File > Save As (Fails > Saglabāt kā) un saglabājiet trauciņa failu ar jaunu nosaukumu vai
jaunā mapē.
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Jaunā trauciņa faila iestatīšana
Padoms. Ja trauciņa failā ir iekļauti vajadzīgie parametri (piemēram, ja rediģējat parauga vai
esošu trauciņa failu), varat izlaist šo sadaļu. Turpiniet ar Papildu parametru piešķiršana trauciņa
failam 119. lpp.

Jaunos trauciņa failos ir vajadzīgi šādi parametri:

n Trauciņa lielums

n Trauciņa veids

n Skenēšanas režīms

n Viens fluorofors (kontrastviela)

n Viens parauga veids

Trauciņa lieluma un veida atlasīšana

Svarīgi! Trauciņa iestatīšanas laikā jāatlasa trauciņa lielums. Trauciņa lielumu nevar mainīt
izpildes laikā vai pēc tam.

Programmatūra izpildes laikā lieto trauciņa lielumu un veidu attiecībā uz visām iedobēm. Nodrošiniet,
ka atlasītais trauciņa lielums ir tāds pats kā trauciņam, ko lietosiet izpildē.

Bio-Rad CFX96 un CFX96 DeepWell instrumenti ir kalibrēti rūpnīcā daudzām fluorescējošām
kontrastvielu un trauciņu kombinācijām. Kalibrēšana ir saistīta ar konkrēto instrumentu, kontrastvielu
un trauciņa veidu. Pārliecinieties, vai fluorofors, ko plānojat lietot, ir kalibrēts jūsu atlasītajam trauciņa
veidam.

Skenēšanas režīma atlasīšana

CFX96 un CFX96 DeepWell sistēmas meklē un nosaka fluoroforus piecos kanālos. Visas sistēmas
lieto daudzu datu iegūšanas skenēšanas režīmus., lai izpildes laikā vāktu fluorescences datus.

CFX Manager Dx software nodrošina trīs skenēšanas režīmus:

n Visi kanāli

o Skenē 1.–5. kanālu CFX96 un CFX96 DeepWell sistēmā
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n SYBR® /FAM

o Skenē tikai 1. kanālu

o Nodrošina ātru skenēšanu

n FRET

o Skenē tikai FRET kanālu

o Nodrošina ātru skenēšanu

Fluoroforu atlasīšana

Svarīgi! Pirms izpildes sākšanas CFX Manager Dx software pārbauda, vai jūsu trauciņā norādītie
fluorofori ir kalibrēti attiecīgajam instrumentam. Jūs nevarat izpildīt trauciņu, ja tas ietver
fluoroforus, kas nav kalibrēti attiecīgajam instrumentam.

Jums pirms izpildes trauciņu izkārtojumā jāielādē vismaz viens fluorofors. Jūs šajā reizē varat ielādēt
tik daudz fluoroforu, cik nepieciešams, taču trauciņam jāsatur vismaz viens fluorofors. Atlasītie
flurofori parādās kā mērķu opcijas sadaļā Target Names (Mērķa nosaukumi).

Dialoglodziņu Select Fluorophores (Atlasīt fluoroforus) varat lietot, lai rīka Plate Editor (Trauciņa
redaktors) kontroles materiālos, kas tiek ielādēti, ielādētu arī fluoroforus (vai trauciņu kontrastvielas)
Fluorofori dialoglodziņā Select Fluorophores (Atlasīt fluoroforus) parādās atkarībā no atlasītā
skenēšanas režīma:

n Visi kanāli

Parādās visi pieejamie fluorofori.

Padoms. Jūs varat pievienot tik daudz fluoroforu, cik nepieciešams, taču jūs katrā iedobē
varat ielādēt tikai vienu fluoroforu vienam kanālam.

n SYBR®/FAM

Parādās tikai 1. kanāla fluorofori.

n FRET

Parādās tikai 6. kanāla fluorofors.

Padoms. 6. kanāla FRET fluorofors parādās tikai tad, kad atlasīts FRET skenēšanas režīms.
Tas nav pieejams skenēšanas režīmam All Channels (Visi kanāli).

Piezīme. Jūs nevarat tieši pievienot fluoroforus un noņemt tos dialoglodziņā Select Fluorophore
(Atlasīt fluoroforu). Jums jākalibrē jaunie fluorofori instrumentā, izmantojot rīku Calibration Wizard
(Kalibrēšanas vednis). Pēc kalibrēšanas jaunaus fluorofors tiek automātiski pievienots
sarakstam.
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Parauga veidu atlase

Svarīgi! Jums jāatlasa vismaz viens parauga veids, ko pirms izpildes piešķirt trauciņa iedobēm.

CFX Manager Dx software piedāvā piecus paraugs veidus:

n Unknown (Nezināms);

n Standard (Standarta);

n NTC (bez veidnes kontroles);

n Positive Control (Pozitīvā kontrole);

n Negative Control (Negatīvā kontrole);

n NRT (bez reversās transkriptāzes).

Parauga veidus trauciņa iedobēm piešķirat jūs.

Jauna trauciņa iestatīšana

Jauna trauciņa iestatīšana

1. Logā Plate Editor (Trauciņa redaktors) atveriet jaunu trauciņu.

2. Lai iestatītu trauciņa lielumu, atlasiet Settings > Plate Size (Iestatījumi > Trauciņa lielums) un
atlasiet atbilstošu trauciņa lielumu no nolaižamā saraksta.

3. Lai iestatītu trauciņa veidu, atlasiet Settings > Plate Type (Iestatījumi > Trauciņa veids) un atlasiet
vai nu BRWhite (BR balts), vai BR Clear (BR caurspīdīgs) no nolaižamā saraksta.

4. Pēc izvēles no izvēlnes Settings (Iestatījumi) varat mainīt skaitļu konvenciju un rādāmās
mērvienības.

n Lai mainītu skaitļu konvenciju, atlasiet Settings > Number Convention (Iestatījumi > Skaitļu
konvencija) un atlasiet Scientific Notation (Zinātnisks apzīmējums).

Padoms. Scientific Notation (Zinātnisks apzīmējums) ir atlasīts pēc noklusējuma. Šajā
gadījumā Scientific Notation (Zinātnisks apzīmējums) notīra noklusējumu un iestata
skaitļu konvenciju uz standarta formu.

n Lai mainītu rādāmās mērvienības, atlasiet Settings > Units (Iestatījumi > Mērvienības) un
atlasiet jaunu mērvienības vērtību.

5. Lai iestatītu skenēšanas režīmu, atlasiet attiecīgo skenēšanas režīmu no nolaižamā saraksta
Scan Mode (Skenēšanas režīms) loga Plate Editor (Trauciņa redaktors) rīkjoslā.
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6. Atlasiet nepieciešamos fluoroforus trauciņam.

a. Rūtī pa labi noklikšķiniet uz Select Fluorophores (Atlasīt fluoroforus).

Parādīsies dialoglodziņš Select Fluorophores (Atlasīt fluoroforus). Jūs redzat fluoroforus,
kādi pieejami skenēšanas režīma veidam, ko atlasījāt 5. solis, piemēram:

b. Lai atlasītu fluoroforu, ielieciet atzīmi tā izvēles rūtiņā Selected (Atlasīts).

Padoms. Lai noņemtu fluoroforu no saraksta, izņemiet atzīmi no tā izvēles rūtiņas
Selected (Atlasīts).

c. Lai mainītu fluorofora rādāmo krāsu, noklikšķiniet tā lodziņā Color (Krāsa).

Piezīme. Krāsa, ko atlasāt, reprezentē šo fluoroforu gan logā Plate Editor (Trauciņa
redaktors), gan Data Analysis (Datu analīze) diagrammās.

d. Dialoglodziņā Color (Krāsa) atlasiet vēlamo krāsu vai arī noklikšķiniet uz Define Custom
Colors (Noteikt pielāgotas krāsas) un izveidojiet jaunu krāsu, kas reprezentēs šo fluoroforu.

e. Noklikšķiniet uz OK (Labi), lai saglabātu izmaiņas un izietu no dialoglodziņa Select
Fluorophores (Atlasīt fluoroforus).
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7. Jums jāatlasa vismaz viena iedobe, kurā ielādēt parauga veidu. Pēc noklusējuma ir atlasīta
iedobe A1.

Trauciņa rūtī veiciet vienu no tālāk norādītajām darbībām:

n Lai ielādētu vairākas blakus esošas iedobes, noklikšķiniet uz iedobes un velciet uz mērķa
iedobi.

n Lai ielādētu vairākas iedobes, kas neatrodas viena otrai blakus, turiet nospiestu vadīšanas
taustiņu un noklikšķiniet uz katras iedobes.

n Lai ielādētu visu kolonnu ar vienu un to pašu parauga veidu, noklikšķiniet uz kolonnas
numura.

n Lai ielādētu visu rindu, noklikšķiniet uz šīs rindas numura.

n Lai ielādētu visu trauciņu, noklikšķiniet trauciņa augšējā kreisajā stūrī.

Piemēram:

8. Piešķiriet parauga veidu atlasītajai iedobei vai iedobēm no nolaižamās izvēlnes Sample Type
(Parauga veids).

Lietošanas rokasgrāmata | 117



7. nodaļa. Trauciņu sagatavošana

9. Piešķiriet visām iedobēm, kas satur parauga veidu, vismaz vienu fluoroforu. Iedobei vai iedobju
grupai var piešķirt vairāk nekā vienu fluoroforu.

Piezīme. Taču uz katru kanālu var piešķirt tikai vienu fluoroforu. No viena kanāla nevar
piešķirt vienai un tai pašai iedobei vairāk par vienu fluoroforu.

Padoms. Varat saistīt mērķi ar fluoroforu vai arī šajā reizē varat piešķirt iedobei tikai
fluoroforu, un saistīt mērķi ar fluoroforu pēc eksperimenta izpildes.

n Lai atlasītajām iedobēm piešķirtu tikai fluoroforu, sadaļā Target Names (Mērķa nosaukumi)
rūtī pa labi ielieciet atzīmi konkrētā fluorofora izvēles rūtiņā Load (Ielādēt).

n Lai saistītu mērķi ar fluoroforu, sadaļā Target Names (Mērķa nosaukumi) atlasiet no
nolaižamā saraksta mērķa nosaukumu konkrētajam fluoroforam. Programmatūra
automātiski atlasa savu izvēlēs rūtiņu Load (Ielāde).

10. Iedobju gadījumā, kas satur Standard (Standarta) parauga veidu, jāielādē koncentrācija. Katrai
iedobei var būt atšķirīga koncentrācijas vērtība. Pēc noklusējuma CFX Manager Dx software
ielādē 1.00E+06 koncentrāciju visās iedobēs ar standarta parauga veidu. Ja nepieciešams, šo
vērtību var mainīt.

a. Trauciņa rūtī jāatlasa standarta iedobe vai iedobju grupa.

b. Sadaļā Concentration (Koncentrācija) noklikšķiniet uz Load (Ielādēt), lai ielādētu vērtību
atlasītajai iedobei vai iedobēm.

c. (Papildiespēja) Lai ielādētu citu koncentrāciju, ierakstiet jauno vērtību tekstlodziņā
Concentration (Koncentrācija) un nospiediet ievadīšanas taustiņu.

d. Veiciet šo darbību attiecībā uz visām iedobēm ar standarta parauga veidu.

Padoms. Lai ielādētu vienādu koncentrāciju visās standarta iedobēs, pārliecinieties, vai
<All> (<Visi>) ir redzams nolaižamajā sarakstā zem vērtības Concentration
(Koncentrācija). Lai ielādētu vienādu koncentrācijas vērtību visām iedobēm ar konkrētu
fluoroforu, noklikšķiniet uz nolaižamā saraksta un atlasiet fluoroforu.

11. Lai saglabātu jauno trauciņu, noklikšķiniet uz OK (Labi).
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Papildu parametru piešķiršana trauciņa failam
Trauciņa fails satur informāciju par katras iedobes, kas ielādēta ar paraugu izpildei, saturu. Pēc
izpildes CFX Manager Dx software saista iedobes saturu ar fluorescences datiem, kas ievākti
protokola laikā, un lieto atbilstošo analīzi logā Data Analysis (Datu analīze).

CFX Manager Dx jūs varat piešķirt parametrus katrai iedobei trauciņā pirms izpildes eksperimentiem,
to laikā vai pēc izpildes eksperimentiem. Jūs varat piešķirt parametrus esošajam trauciņa failam vai
jaunam trauciņa failam. Šie parametri ietver:

n Target names (Mērķa nosaukumi)— interesējošais mērķis vai mērķi (gēni vai sekvences) katrā
ielādētā iedobē.

n Sample names (Paraugu nosaukumi)— identifikators vai stāvoklis, kas atbilst paraugam katrā
ielādētajā iedobē kā 0Hr, 1Hr vai 2Hr.

Padoms. Iedobju mērķu un paraugu nosaukumiem jābūt vienādiem, lai salīdzinātu datus
loga Data Analysis (Datu analīze) cilnē Gene Expression (Gēnu ekspresija). Katrā
nosaukumā jābūt vienādam lielo burtu, pieturzīmju un atstarpju lietojumam. Piemēram,
“Actin” nav tas pats, kas “actin”, “2Hr” nav tas pats, kas “2 hr”, un “Mouse 1” nav tas pats, kas
“mouse1”. Lai nodrošinātu konsekvenci nosaukumu piešķiršanā, ievadiet nosaukumus User
> User Preferences > Plate (Lietotājs > Lietotāja preferences > Trauciņš) bibliotēkas sadaļā
logā Home (Sākums).

n Biological sets (Bioloģiskie komplekti)— identifikators vai stāvoklis, kas atbilst iedobju
komplektam.

n Replicates (Replikāti) —katra iedobe, kas tiek izmantota vienādas parauga un mērķa(-u)
kombinācijas analizēšanai; tas ir, kopē qPCR reakcijas.

n Dilution series (Atšķaidīšanas sērija)—daudzums Standard (Standarta) parauga veida
koncentrācijas mainīšanai kopiju grupā, lai izveidotu standarta līknes datus analizēšanai.

Mērķa piešķiršana iedobēm
Padoms. Jūs varat piešķirt vienu mērķa nosaukumu vienai vai vairākām iedobēm. Tāpat jūs varat
piešķirt vairākus mērķus vieni iedobei.

Mērķa piešķiršana iedobei vai iedobju grupai

1. Funkcijā Plate Editor (Trauciņa redaktors) pārliecinieties, ka iedobei vai iedobju grupai ir piešķirts
parauga veids.

Informāciju par paraugu veidu piešķiršanu iedobēm skat. Parauga veidu atlase 115. lpp.
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2. Trauciņa rūtī atlasiet iedobi vai iedobju grupu.

n Lai atlasītu vienu iedobi, noklikšķiniet uz iedobes.

n Lai atlasītu vairākas blakus esošās iedobes, noklikšķiniet uz iedobes un velciet to uz mērķa
iedobi.

n Lai atlasītu vairākas iedobes, kas neatrodas viena otrai blakus, turiet nospiestu vadīšanas
taustiņu un noklikšķiniet uz katras iedobes.

n Lai atlasītu visu kolonnu ar vienu un to pašu parauga veidu, noklikšķiniet uz kolonnas
numura.

n Lai atlasītu visu rindu, noklikšķiniet uz šīs rindas numura.

3. Labajā rūtī katram atlasītajam fluoroforam atlasiet nosaukumu no nolaižamā saraksta Target
Name (Mērķa nosaukums).

4. Atkārtojiet 3. solis katrai iedobei vai iedobju grupai, kurai jāpiešķir mērķis.

Padoms. Katram atlasītajam fluoroforam jūs varat piešķirt vienu vai dažādus mērķa
nosaukumus.

5. Lai apstiprinātu izmaiņas un saglabātu trauciņu, noklikšķiniet uz OK (Labi).

Mērķa nosaukuma noņemšana

u Lai no atlasītās iedobes vai iedobju grupas noņemtu mērķa nosaukumu, notīriet tās izvēles rūtiņu
Load (Ielādēt).

Svarīgi! Noņemot mērķa nosaukumu no iedobes, tiek noņemts arī ar to saistītais fluorofors.
Ievērojiet piesardzību, noņemot mērķa nosaukumu no iedobes.

Mērķa nosaukuma pievienošana sarakstam

u Lai nolaižamajam sarakstam pievienotu mērķa nosaukumu, veiciet vienu no tālāk norādītajām
darbībām:

n Nolaižamajā sarakstā Target Name (Mērķa nosaukums) ierakstiet nosaukumu un nospiediet
ievadīšanas taustiņu.

Padoms. Mērķa nosaukumus, ko pievienojat vienam sarakstam, parādās visos pārējos
mērķa sarakstos.
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n Noklikšķiniet uz zaļā + simbola pa labi no nolaižamā sarakstā, ierakstiet mērķa nosaukumu
un nospiediet ievadīšanas taustiņu.

n Rīkjoslā noklikšķiniet uz User Preferences (Lietotāja preferences) un pievienojiet nosaukumu
bibliotēkai Target Names (Mērķa nosaukumi) cilnē Plate (Trauciņš).

Svarīgi! Mērķa nosaukumi, ko pievienojat nolaižamajam sarakstam, ir pieejami tikai esošajai
trauciņam un tikai tad, ja piešķirat nosaukumu iedobei un saglabājat trauciņu izkārtojumu. Ja
nosaukumu iedobei nepiešķirat un trauciņu izkārtojumu nesaglabājat, nosaukums netiek
saglabāts un nav pieejams turpmākam lietojumam. Lai neatgriezeniski pievienotu mērķa
nosaukumu, pievienojiet to bibliotēkai Target Names (Mērķa nosaukumi), izmantojot
dialoglodziņu User Preferences (Lietotāja preferences). Nosaukumi, ko pievienojat
bibliotēkai, ir pieejami pēc tam, kad no jauna atverat logu Plate Editor (Trauciņa redaktors).
Papildinformāciju skatiet šeit Trauciņa noklusējuma parametru iestatīšana 65. lpp.

Mērķa nosaukuma dzēšana no saraksta

1. Rīkjoslā noklikšķiniet uz User Preferences (Lietotāja preferences).

Atveras dialoglodziņš User Preferences (Lietotāja preferences), kurā redzama cilne Plate
(Trauciņš).

2. Bibliotēkas Target Names (Mērķa nosaukumi) cilnē Plate (Trauciņš) atlasiet dzēšamo
nosaukumu un nospiediet dzēšanas taustiņu.

3. Lai saglabātu izmaiņas, noklikšķiniet uz OK (Labi) un izejiet no dialoglodziņa User Preferences
(Lietotāja preferences).

Svarīgi! Jūs nevarat saglabāt mērķa nosaukumus, kurus saglabājāt ar trauciņa nosaukumu.
Pielāgotie nosaukumi, kurus pievienojat nolaižamajam sarakstam Target Names (Mērķa
nosaukumi), bet nelietojat un saglabājat ar trauciņu, tiks automātiski noņemti no saraksta.
Nosaukumi, kurus dzēšat bibliotēkā Target Names (Mērķa nosaukumi) tiek neatgriezeniski
dzēsti no programmatūras un vairs nav pieejami lietotājiem. Ievērojiet piesardzību, dzēšot
mērķa nosaukumus.
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Parauga nosaukuma piešķiršana iedobēm
Piezīme. Lai piešķirtu parauga nosaukumu, atlasītajām iedobēm jāpiešķir vismaz viens
fluorofors. Ja atlasītajām iedobēm fluorofors netiek piešķirts, nolaižamais saraksts Sample
Names (Paraugu nosaukumi) tiek atspējots. Informāciju par fluoroforu piešķiršanu skatīt Mērķa
piešķiršana iedobēm 119. lpp.

Padoms. Katrai iedobei vai iedobju grupai var piešķirt tikai vienu parauga nosaukumu.

Lai iedobei vai iedobju grupai piešķirtu parauga nosaukumu

1. Logā Plate Editor (Trauciņa redaktors) jāpārliecinās, vai iedobei vai iedobju grupai ir piešķirts
fluorofors.

2. Trauciņa rūtī jāatlasa iedobe vai iedobju grupa.

3. Rūtī pa labi nolaižamajā sarakstā Sample Names (Paraugu nosaukumi) atlasiet nosaukumu.

4. Atkārtojiet 3. solis ar katru iedobi vai iedobju grupu, kam jāpiešķir parauga nosaukums.

5. Lai apstiprinātu izmaiņas un saglabātu trauciņu, noklikšķiniet uz OK (Labi).

Parauga nosaukuma noņemšana

u Lai noņemtu parauga nosaukumu no atlasītas iedobes vai iedobju grupas, izņemiet atzīmi no tā
izvēles rūtiņas Load (Ielāde).

Lai parauga nosaukumu pievienotu sarakstam

u Lai parauga nosaukumu pievienotu nolaižamajam sarakstam, veiciet vienu no tālāk norādītajām
darbībām:

n Nolaižamajā sarakstā Sample Names (Paraugu nosaukumi) ierakstiet nosaukumu un
nospiediet ievadīšanas taustiņu.

n Noklikšķiniet uz zaļā + simbola pa labi no nolaižamā saraksta un ierakstiet parauga
nosaukumu.

n Rīkjoslā noklikšķiniet uz User Preferences (Lietotāja preferences) un pievienojiet nosaukumu
bibliotēkai Sample Names (Paraugu nosaukumi) cilnē Plate (Trauciņš).
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Svarīgi! Paraugu nosaukumi, ko pievienojat nolaižamajā sarakstā, ir pieejami tikai attiecībā
uz pašreizējo trauciņu un tikai tādā gadījumā, ja piešķirat nosaukumu iedobei un saglabājat
trauciņu izkārtojumu. Ja nosaukumu iedobei nepiešķirat un trauciņu izkārtojumu
nesaglabājat, nosaukums netiek saglabāts un nav pieejams turpmākam lietojumam. Lai
parauga nosaukumu pievienotu pastāvīgi, tas jāpievieno arī bibliotēkai Sample Names
(Paraugu nosaukumi), izmantojot dialoglodziņu User Preferences (Lietotāja preferences).
Nosaukumi, ko pievienojat bibliotēkai, ir pieejami pēc tam, kad no jauna atverat logu Plate
Editor (Trauciņa redaktors). Papildinformāciju skatiet šeit Trauciņa noklusējuma parametru
iestatīšana 65. lpp.

Parauga nosaukuma dzēšana no saraksta

1. Rīkjoslā noklikšķiniet uz User Preferences (Lietotāja preferences).

Atveras dialoglodziņš User Preferences (Lietotāja preferences), kurā redzama cilne Plate
(Trauciņš).

2. Bibliotēkā Sample Names (Paraugu nosaukumi), kas atrodas cilnē Plate (Trauciņš), atlasiet
dzēšamo nosaukumu un nospiediet dzēšanas taustiņu.

3. Lai saglabātu izmaiņas, noklikšķiniet uz OK (Labi) un izejiet no dialoglodziņa User Preferences
(Lietotāja preferences).

Svarīgi! Nav iespējams dzēst paraugu nosaukumus, kas saglabāti ar trauciņa failu.
Pielāgotie nosaukumi, ko pievienojat nolaižamajam sarakstam Sample Names (Paraugu
nosaukumi) un nelietojat un nesaglabājat ar trauciņu, tiek automātiski noņemti no nolaižamā
saraksta. Nosaukumi, ko dzēšat no bibliotēkas Sample Names (Paraugu nosaukumi), tiek
pastāvīgi noņemti no programmatūras un lietotājiem vairs nav pieejami. Ievērojiet
piesardzību, dzēšot paraugu nosaukumus.

Bioloģisko kopu piešķiršana iedobēm
Piezīme. Lai piešķirtu bioloģisku kopu, jums jāpiešķir atlasītajām iedobēm vismaz viens
fluorofors. Fluorofora piešķiršana iespējo Biological Set Name (Bioloģisko kopu nosaukums)
nolaižamo sarakstu. Informāciju par fluoroforu piešķiršanu skatīt Mērķa piešķiršana iedobēm 119.
lpp.

Padoms. Katrai iedobei vai iedobju grupai var piešķirt vienu bioloģisko kopu.

Lai piešķirtu iedobei vai iedobju grupai bioloģisku kopu, veiciet tālāk norādīto.

1. View (Skats) opcijās loga Plate Editor (Trauciņa redaktors) apakšā jāatlasa izvēles rūtiņa Biological
Set (Bioloģiska kopa).

2. Logā Plate Editor (Trauciņa redaktors) jāpārliecinās, vai iedobei vai iedobju grupai ir piešķirts
fluorofors.
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3. Trauciņa rūtī jāatlasa iedobe vai iedobju grupa.

4. Rūtī pa labi jāveic atlase no Biological Set Name (Bioloģisko kopu nosaukumu) nolaižamā
saraksta.

CFX Manager Dx software automātiski atlasa savu izvēles rūtiņu Load (Ielāde).

5. Atkārtojiet 4. solis ar katru iedobes vai iedobju grupu, kam jāpiešķir bioloģiska kopa.

6. Lai apstiprinātu izmaiņas un saglabātu trauciņu, noklikšķiniet uz OK (Labi).

Padoms. Bioloģisko kopu nosaukumu piešķiršana iedobēm iespējo Biological Set Analysis
Options (Bioloģiskās kopas analīzes opcijas) dialoglodziņā Experiment Settings
(Eksperimenta iestatījumi), kurā varat veikt paraugu analīzi vienā no četrām konfigurācijām.
Papildinformāciju skatiet šeit Eksperimenta iestatījumu mainīšana 130. lpp.

Bioloģisko kopu noņemšana

u Lai noņemtu bioloģisko kopu no atlasītās iedobes vai iedobju grupas, jāizņem atzīme no tā
izvēles rūtiņas Load (Ielāde).

Bioloģisku kopu pievienošana sarakstam

u Lai pievienotu nolaižamajam sarakstam bioloģisku kopu, ierakstiet nosaukumu nolaižamajā
lodziņā Biological Set Name (Bioloģiskās kopas nosaukums) un nospiediet ievadīšanas taustiņu.

Svarīgi! Bioloģisko kopu nosaukumi, ko pievienojat nolaižamajā sarakstā, ir pieejami tikai
attiecībā uz pašreizējo trauciņu un tikai tādā gadījumā, ja piešķirat nosaukumu iedobei un
saglabājat trauciņu izkārtojumu. Ja nosaukumu iedobei nepiešķirat un nesaglabājat trauciņu
izkārtojumu, nosaukums netiek saglabāts un nav pieejams turpmākam lietojumam.

Lai skatītu visas bioloģiskās kopas trauciņā

u Atlasiet izvēles rūtiņu Biological Set (Bioloģiskā kopa) View (Skats) opcijās, kas atrodas loga
Editor (Redaktors) apakšā.

Visas iedobes parāda attiecīgo savas bioloģiskās kopas nosaukumu, ja tāds ir piešķirts.
Biological Set Name (Bioloģiskās kopas nosaukums) kontrole tiek rādīta rūtī pa labi.

Lai paslēptu bioloģiskās kopas, izņemiet atzīmi no izvēles rūtiņas Biological Set (Bioloģiskā kopa)
View (Skats) opcijās.
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Replikātu numuru piešķiršana iedobēm
Svarīgi! Lai piešķirtu replikātu numurus, atlasītajām iedobēm jāsatur identisks iedobju saturs.
Proti, atlasītajām iedobēm jābūt viena un tā paša veida paraugiem un fluoroforam. Ja tas ir
atbilstīgi, tiem jābūt piešķirtam vienam un tam pašammērķim un paraugu nosaukumiem un vienai
un tai pašai bioloģiskai kopai. Ja tie nav vienādi, CFX Manager Dx software neiespējo šo opciju.

Lai piešķirtu replikātu numurus iedobju grupai

1. Logā Plate Editor (Trauciņa redaktors) pārliecinieties, vai iedobju grupas saturs ir identisks.

2. Trauciņa rūtī jāatlasa mērķa iedobju grupa.

3. Lai piešķirtu vienu un to pašu replikāta numuru visiem atlasītajām iedobēm, sadaļā Replicate #
(Replikāta Nr.) rūtī pa labi lodziņā ierakstiet replikāta numuru un atlasiet Load (Ielādēt).

4. (Papildiespēja) Lai atlasītu iedobes kopai piemērotu replikātu sēriju, veiciet tālāk norādītās
darbības.

a. Noklikšķiniet uz Replicate Series (Replikātu sērija). Sadaļa Replicate # (Replikāta Nr.)
mainās, lai parādītu šādas opcijas:
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n Replicate size (Replikāta lielums)—skaitlis, kas reprezentē iedobju skaitu katrā
replikātu grupā

n Starting replicate # (Sākuma replikāta Nr.)—pirmais numurs replikātu sērijā
atlasītajai replikātu grupai

Piezīme. Pēc noklusējuma CFX Manager Dx software rāda sākuma replikāta numuru,
kā tādu, kas par vienu numuru lielāks par pēdējo trauciņā piešķirto replikāta numuru.
Piemēram, ja trauciņā pēdējais replikāta numurs būs pieci, nākamais sākuma numurs
būs seši. Jūs varat mainīt sākuma numuru uz jebkuru numuru, kas nav jau piešķirts.

n Ielādes virziens (horizontāls vai vertikāls)

b. Noklikšķiniet uz Apply (Lietot), lai parametrus piemērotu sērijai, un atgriezieties ekrānā
Replicate # (Replikāta Nr.).

5. Lai apstiprinātu izmaiņas un saglabātu trauciņu, noklikšķiniet uz OK (Labi).

Iedobes noņemšana no replikātu sērijas

u Atlasiet noņemamo iedobi vai iedobju grupu un izņemiet atzīmi no izvēles rūtiņas Replicate #
Load (Replikāta Nr. ielāde).

Vai arī, lai notīrītu replikāta numuru no atlasītās iedobes vai iedobju grupas, varat noklikšķināt uz
Clear Replicate # (Notīrīt replikāta Nr.).

Atšķaidīšanas sērijas piešķiršana standarta paraugu veidiem
Kā minēts iepriekš, visām iedobēm ar standarta parauga veidu jāpiešķir koncentrācijas vērtība. Jūs
varat piešķirt atšķaidīšanas sēriju vairākām iedobēm ar standarta paraugu veidu.

Piezīme. Lai iedobju grupai piešķirtu atšķaidīšanas sēriju, iedobes jāiekļauj replikātu sērijā.
Informāciju par iedobju pievienošanu replikātu sērijā skat Replikātu numuru piešķiršana iedobēm
125. lpp.

Atšķaidīšanas sērijas piešķiršana standarta paraugu iedobju grupai

1. Rīkā Plate Editor (Trauciņa redaktors) pārliecinieties, ka tiek ievērotas tālāk norādītās prasības:

n Iedobju grupas paraugu veids ir Standard (Standarta).

n Visām iedobēm grupā ir piešķirts vismaz viens fluorofors, un tās visas satur tos pašus
fluoroforus.

n Visas iedobes grupā ir iekļautas vienā kopiju sērijā.

Piezīme. CFXManager Dx software iespējo opciju Dilution Series (Atšķaidīšanas sērija)
tikai tad, kad atlasītās iedobes atbilst šiem kritērijiem.
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2. Trauciņa rūtī jāatlasa mērķa iedobju grupa.

3. Labās rūts koncentrācijas sadaļā noklikšķiniet uz Dilution Series (Atšķaidīšanas sērija). Sadaļa
Concentration (Koncentrācija) mainās, lai parādītu tālāk norādītās opcijas:

n Starting concentration (Sākuma koncentrācija)—koncentrācijas vertība sērijas sākumā.

n Replicates from and to (Kopē no un uz)—kopijas sērijās, kurām tiks piemērots
atšķaidīšanas koeficients

n Dilution factor (Atšķaidīšanas koeficients)—daudzums koncentrācijas mainīšanai katrā
kopiju grupā

4. Iestatiet opciju vērtības vai apstipriniet noklusējuma vērtības.

5. Atšķaidīšanas sērija pēc noklusējuma samazinās par atšķaidīšanas koeficientu. Atlasiet
Palielināšana, lai palielinātu atšķaidīšanas sēriju.

6. (Papildiespēja) Atšķaidīšanas koeficients pēc noklusējuma tiek piemērots visiem fluoroforiem
replikātu sērijā. Ja jūsu sērija satur vairāk nekā vienu fluoroforu un jūs vēlaties piemērot
atšķaidīšanu vienam fluoroforam, atlasiet to no nolaižamā saraksta.

7. Noklikšķiniet uz Apply (Lietot), lai lietotu atšķaidīšanas sēriju iedobju grupai un atgrieztos skatā
Concentration (Koncentrācija).

8. Lai apstiprinātu izmaiņas un saglabātu trauciņu, noklikšķiniet uz OK (Labi).

Iedobju satura kopēšana citā iedobē
Iedobes saturu var kopēt un ielīmēt atsevišķā iedobē vai vairākās iedobēs. Tomēr nokopēt var tikai
vienas iedobes saturu. Nevar atlasīt vairākas iedobes un kopēt to saturu.

Iedobes satura pārkopēšana citā iedobē

1. Rūtī Plate (Trauciņš) jāatlasa kopējamā iedobe.

2. Ar peles labo pogu jānoklikšķina uz iedobes un jāatlasa Copy Well (Kopēt iedobi).
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3. Atlasiet iedobi vai iedobes, kur saturs jāielīmē, veicot tālāk norādītās darbības.

n Lai atlasītu atsevišķu iedobi, noklikšķiniet uz šīs iedobes.

n Lai atlasītu vairākas blakus esošās iedobes, noklikšķiniet uz iedobes un velciet to uz mērķa
iedobi.

n Lai atlasītu vairākas iedobes, kas neatrodas viena otrai blakus, turiet nospiestu vadīšanas
taustiņu un noklikšķiniet uz katras iedobes.

4. Kad mērķa iedobes ir atlasītas, jānoklikšķina ar peles labo pogu un jāatlasa Paste Well (Ielīmēt
iedobi).

CFX Manager Dx software ielīmē pirmās iedobes saturu atlasītajās iedobēs.

Piezīmes pievienošana iedobei
Jūs varat pievienot iedobei aprakstošu piezīmi. Iedobes piezīmes varat skatīt cilnē Quantification
(Kvantitatīvā noteikšana), kas atrodama logā Data Analysis (Datu analīze).

Piezīmes pievienošana iedobei

1. Rūtī Plate (Trauciņš) atlasiet iedobi vai iedobes, kurām plānojat pievienot piezīmi.

2. Apakšējās rūts sadaļā View (Skatīt) atlasiet Well Note (Iedobes piezīme).

Labajā rūtī parādās apgabals Well Note (Iedobes piezīme).

3. Tekstlodziņā ierakstiet piezīmes saturu un nospiediet ievadīšanas taustiņu.

Teksts parādās atlasīto iedobju apakšdaļā.

Padoms. Ja jūs izveidojāt iepriekšējo iedobes piezīmi, varat atlasīt to nolaižamajā sarakstā
un izmantot atlasītajām iedobēm.

Visa satura notīrīšana no iedobēm
Visu saturu var notīrīt no atsevišķas iedobes, no iedobju grupas vai no visa trauciņa. Iedobju
notīrīšana nenoņem trauciņa nolasīšanas laikā savāktos fluorescences datus.

Iedobju neatgriezeniska notīrīšana noņem saturu no iedobes. Ievērojiet piesardzību iedobju
notīrīšanā.
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Visu iestatījumu notīrīšana no iedobēm

1. Logā Plate Editor (Trauciņa redaktors) trauciņa rūtī atlasiet iedobi vai iedobju grupu, kā norādīts
tālāk.

n Lai atlasītu atsevišķu iedobi, noklikšķiniet uz šīs iedobes.

n Lai atlasītu vairākas blakus esošās iedobes, noklikšķiniet uz iedobes un velciet to uz mērķa
iedobi.

n Lai atlasītu vairākas iedobes, kas neatrodas viena otrai blakus, turiet nospiestu vadīšanas
taustiņu un noklikšķiniet uz katras iedobes.

n Lai atlasītu visu kolonnu ar vienu un to pašu parauga veidu, noklikšķiniet uz kolonnas
numura.

n Lai atlasītu visu rindu, noklikšķiniet uz šīs rindas numura.

2. Rūtī pa labi noklikšķiniet uz Clear Wells (Notīrīt iedobes).

CFX Manager Dx software notīra visus iestatījumus no atlasītajām iedobēm.

3. noklikšķiniet uz OK (Labi), lai apstiprinātu izmaiņas un saglabātu trauciņu.
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Eksperimenta iestatījumu mainīšana
Izmantojiet dialoglodziņu Experiment Settings (Eksperimenta iestatījumi), lai skatītu vai mainītu mērķu
vai paraugu sarakstus vai atlasītu analizējamo gēnu ekspresijas analīzes grupu un analīzes opciju, ja
bioloģiskās grupas piešķīrāt iedobēm trauciņā.

Dialoglodziņa Experiment Settings (Eksperimenta iestatījumi) cilnē Targets (Mērķi) ir parādīts mērķa
nosaukumu saraksts katrai PCR reakcijai, piemēram, interesējošais mērķa gēns vai gēnu sekvences.

Cilnē Samples ir parādīts paraugu nosaukumu saraksts, kurā norādīts mērķa avots, piemēram,
paraugs, kas paņemts 1 hour (1Hr) (1 stunda (1 h)) laikā vai no konkrētas personas (mouse1).

Trauciņa iestatījumu maiņa, izmantojot eksperimenta iestatījumu dialoglodziņu

1. Lai atvērtu dialoglodziņu Experiment Settings (Eksperimenta iestatījumi), veiciet vienu no tālāk
norādītajām darbībām:

n Loga Plate Editor (Trauciņa redaktors) labajā rūtī noklikšķiniet uz Experiment Settings
(Eksperimenta iestatījumi).

n Logā Data Analysis (Datu analīze) redzamajā cilnē Gene Expression (Gēnu ekspresija)
noklikšķiniet uz Experiment Settings (Eksperimenta iestatījumi).

Parādīsies dialoglodziņš Experiment Settings (Eksperimenta iestatījumi), attēlojot cilnes Targets
(Mērķi) saturu.
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2. Lai pievienotu jaunu mērķa vai parauga nosaukumu, atbilstošās cilnes tekstlodziņā New (Jauns)
ierakstiet nosaukumu un noklikšķiniet uz Add (Piešķirt).

3. Lai sarakstā noņemtu vienu vai vairākus mērķu vai paraugu nosaukumus, atbilstošās cilnes
kolonnā Select to Remove (Atlasīt vai noņemt) atlasiet vienuma izvēles rūtiņu un noklikšķiniet uz
Remove checked item(s) (Noņemt atzīmēto(-s) vienumu(-s)).

4. CFX Manager Dx software izslēdz paraugu veidu NTC (bez veidnes kontroles) no gēnu
ekspresijas analīzes.

Lai iekļautu NTC paraugu veidus, notīriet izvēles rūtiņu sadaļā Exclude the following sample
types (Izslēgt tālāk norādītos paraugu veidus). Jūs varat izslēgt tālāk norādītos paraugu veidus,
atlasot atbilstošu izvēles rūtiņu:

n NRT (bez reversās transkriptāzes);

n Negative Control (Negatīvā kontrole);

n Positive Control (Pozitīvā kontrole);

n Standard (Standarta).
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5. Cilnē Targets (Mērķi):

a. Lai atlasītu mērķi kā atsauci gēnu ekspresijas datu analīzei, atlasiet to kolonnā Reference
(Atsauce).

b. Lai noslēptu analīzes iestatījumus, kas tiks lietoti cilnē Gene Expression (Gēnu ekspresija)
logā Analysis Settings (Analīzes iestatījumi), notīriet izvēles rūtiņu Show Analysis Settings
(Rādīt analīzes iestatījumus).

Sistēma noslēpj tālāk norādītās kolonnas.

n Color (Krāsa);

n Show Chart (Rādīt diagrammu);

n Auto Efficiency (Automātiskā efektivitāte);

n Efficiency (%) (Efektivitāte (%)).

c. Lai mainītu diagrammā Gene Expression (Gēnu ekspresija) uzzīmētā mērķa krāsu, kolonnā
Color (Krāsa) noklikšķiniet uz tā šūnas, parādītajā dialoglodziņā Color (Krāsa) atlasiet jauno
krāsu un noklikšķiniet uz OK (Labi).

d. Lai diagrammā Gene Expression (Gēnu ekspresija) parādītu mērķi atlasītajā krāsā, kolonnā
Show Chart (Rādīt diagrammu) atlasiet tā izvēles rūtiņu.

e. CFX Manager Dx pēc noklusējuma automātiski aprēķina mērķa relatīvo efektivitāti, ja tā dati
ietver standarta līkni.

Lai izmantotu iepriekš noteikto efektivitātes vērtību, ierakstiet vērtību tās šūnā kolonnā
Efficiency (%) (Efektivitāte (%)) un nospiediet ievadīšanas taustiņu. CFX Manager Dx notīra
izvēles rūtiņu Auto Efficiency (Automātiskā efektivitāte).

6. Cilnē Samples (Paraugi):

a. Lai atlasītu paraugu kā kontroles paraugu gēnu ekspresijas datu analīzei, atlasiet tā izvēles
rūtiņu kolonnā Control (Kontrole).

b. Lai paraugam izpildei piešķirtu kontroles nosacījumu, noklikšķiniet uz tā izvēles rūtiņas
kolonnā Control (Kontrole).

c. Ja nav atlasīts, noklikšķiniet uz izvēlnes rūtiņas Show Analysis Settings (Rādīt analīzes
iestatījumus), lai skatītu vai mainītu analīzes parametrus, kas tiks lietoti cilnē Gene
Expression (Gēnu ekspresija). Programmatūra noslēpj kolonnas Color (Krāsa) un Show
Chart (Rādīt diagrammu):
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Iedobju grupu izveide

7. Ja jūs iedobēm trauciņā piešķīrāt vienu vai vairākus bioloģiskos komplektus (skat. Bioloģisko kopu
piešķiršana iedobēm 123. lpp.), sarakstā Biological Set Analysis Options (Bioloģiskā komplekta
analīzes opcijas) atlasiet vienu no tālāk norādītajām opcijām:

n Target vs. Sample (Mērķis salīdzinājumā ar paraugu)—gēnu ekspresijas aprēķinos tiek
izmantots tikai iedobes parauga nosaukums.

n Target vs. Biological Set (Mērķis salīdzinājumā ar bioloģisko komplektu)—aprēķinos
tiek izmantots tikai bioloģiskā komplekta nosaukums.

n Target vs. Sample_Biological Set (Mērķis salīdzinājumā ar paraugu_bioloģisko
komplektu)—parauga nosaukums un bioloģiskā komplekta nosaukums tiek apvienoti, lai
izmantošanai aprēķinos izveidotu vienu nosaukumu.

n Target vs. Biological Set_Sample (Mērķis salīdzinājumā ar bioloģisko komplektu_
paraugu)—bioloģiskā komplekta nosaukums un parauga nosaukums tiek apvienoti, lai
izmantošanai aprēķinos izveidotu vienu nosaukumu.

8. Noklikšķiniet uz OK (Labi), lai dialoglodziņā Experiment Settings (Eksperimenta iestatījumi)
saglabātu parametrus un atgrieztos logā Plate Editor (Trauciņa redaktors).

Iedobju grupu izveide
Iedobju grupas sadala vienu trauciņu iedobju apakškomplektos, kurus logā Data Analysis (Datu
analīze) var analizēt neatkarīgi. Kad iedobju grupas ir iestatītas, logā Data Analysis (Datu analīze)
atlasiet vienu grupu, lai analizētu datus kā neatkarīgu grupu. Piemēram, iestatiet iedobju grupas, lai
analizētu vairāku eksperimentu izpildi vienā trauciņā vai analizētu katru iedobju grupu ar atšķirīgu
standarta līkni.

Piezīme. Noklusējuma iedobju grupa ir All Wells (Visas iedobes).

Iedobju grupu izveide

1. Lai atvērtu Well Groups Manager (Iedobju grupu pārvaldnieks), veiciet vienu no tālāk norādītajām
darbībām:

n Rīkjoslā Plate Editor (Trauciņa redaktors) noklikšķiniet uz Well Groups (Iedobju grupas).

n Logā Data Analysis (Datu analīze) noklikšķiniet uz ManageWell Groups (Pārvaldīt iedobju
grupas).

Parādīsies dialoglodziņš Well Groups Manager (Iedobju grupu pārvaldnieks).
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2. Lai izveidotu jaunu grupu, noklikšķiniet uz Add (Pievienot). Nolaižamajā izvēlnē tiks parādīts
grupas nosaukums; pirmajai grupai tas būs Group 1 (1. grupa).

3. Trauciņa skatā atlasiet iedobes iedobju grupai, noklikšķinot un velkot pāri iedobju grupai.
Atlasītās iedobes logā Manager (Pārvaldnieks) parādīsies zilā krāsā.

4. (Papildiespēja) Lai mainītu grupas nosaukumu, atlasiet tās nosaukumu nolaižamajā izvēlnē un
ierakstiet jauno nosaukumu.

5. (Papildiespēja) Lai dzēstu iedobju grupu, atlasiet tās nosaukumu nolaižamajā izvēlnē un
noklikšķiniet uz Delete (Dzēst).

6. Noklikšķiniet uz OK (Labi), lai pabeigtu un aizvērtu logu, vai noklikšķiniet uz Cancel (Atcelt), lai
aizvērtu logu bez izmaiņu veikšanas.

Svarīgi! Lai parādītu iedobju grupas, loga Plate Editor (Trauciņa redaktors) apakšdaļā
redzamajās opcijās View (Skatīt) atlasiet Well Groups (Iedobju grupas).
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Iedobju grupu izveide

Izvēlnes, kas pieejama, noklikšķinot ar peles labo pogu, vienumi dialoglodziņam
Well Groups Manager (Iedobju grupu pārvaldnieks)

13. tabula ir uzskaitīti izvēlnes vienumi, kas pieejami dialoglodziņā Well Groups Manager (Iedobju
grupu pārvaldnieks), ar peles labo pogu noklikšķinot uz jebkuras iedobes.

Vienums Funkcija

Copy (Kopēt) Kopē iedobes saturu, kuru pēc tam var ielīmēt citā iedobē
vai iedobēs.

Copy as Image (Kopēt kā attēlu) Kopē iedobju atlasītāja skatu kā attēlu.

Print (Drukāt) Drukā iedobju atlasītāja skatu.

Print Selection (Drukāt atlasi) Drukā tikai atlasītās šūnas.

Export to Excel (Eksportēt uz
Excel)

Eksportē datus uz Excel izklājlapu.

Export to Csv (Eksportēt uz
Csv)

Eksportē datus kā ar komatu atdalīto datu dokumentu.

Export to Xml (Eksportēt uz
Xml)

Eksportē datus kā .xml dokumentu.

Export to Html (Eksportēt uz
Html)

Eksportē datus kā .html dokumentu.

13. tabula. Izvēlnes, kas pieejama, noklikšķinot ar peles labo pogu, vienumi
dialoglodziņā Plate Editor (Trauciņa redaktors) Well Selector (Iedobju atlasītājs)
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Trasējumu stilu maiņa
Trauciņa iestatīšanas laikā un izpildes gaitā var modificēt amplifikācijas trasējumu krāsu un stilu. Pēc
tam trasējumus var viegli skatīt reāllaika stāvokļa logā, notiekot datu vākšanai.

Trajektorijas stilu maiņa

1. Noklikšķiniet uz Trace Styles (Trajektorijas stili) rīkjoslā Plate Editor (Trauciņa redaktors).

Attiecībā uz atvērto trauciņu atveras dialoglodziņš Trace Styles (Trajektorijas stili), piemēram:

2. lai rādītu trasējumu stilus pēc konkrēta fluorofora, atlasiet to no nolaižamā saraksta Fluorophores
(Fluorofori).

3. Trajektoriju rādīšanas maiņa

a. Atlasiet trasējuma veidu no nolaižamā saraksta Wells (Iedobes).

b. Noklikšķiniet uz tā krāsas kolonnā Color (Krāsa).

c. Parādītajā dialoglodziņā Color (Krāsa) izvēlieties trasējumam citu krāsu un noklikšķiniet uz
OK (Labi).

Izmaiņas attiecībā uz konkrēto iedobes veidu parādās režģī zemāk.

d. (Papildiespēja) Atlasiet trasējumam simbolu no nolaižamā saraksta Symbols (Simboli).
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Trasējumu stilu maiņa

4. Lai ātri mainītu krāsu kopu, noklikšķiniet uz attiecīgās izvēles sadaļā Color Quick Set (Krāsu ātra
iestatīšana).

5. Lai skatītu iedobes etiķetes režģī, atlasiet etiķetes veidu sadaļā Well Labels (Iedobju etiķetes).

6. Noklikšķiniet uz OK (Labi), lai saglabātu izmaiņas, vai uz Cancel (Atcelt), lai izmaiņas atceltu.
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Trauciņa skatīšana izklājlapas formātā
Rīkā Spreadsheet View/Importer) (Izklājlapas skats/importētājs) trauciņš tiek parādīts izklājlapas
formātā. Jūs varat izmantot rīku Spreadsheet View/Importer (Izklājlapas skats/importētājs), lai
eksportētu saturu ar tabulatoriem atdalīta teksta formātā lietotnē, piemēram, Microsoft Excel. Tāpat
jūs varat eksportēt iedobju saturu ar tabulatoriem atdalīta teksta formātā no lietotnes.

Izklājlapas skata/importētāja rīku izmantošana

1. Rīkjoslā Plate Editor (Trauciņa redaktors) noklikšķiniet uz Spreadsheet View/Importer (Izklājlapas
skats/importētājs), lai atvērtu dialoglodziņu Plate Spreadsheet View (Trauciņa izklājlapas skats).

2. Dialoglodziņā Spreadsheet View (Izklājlapas skats) tiks parādīts trauciņa saturs vienam
fluoroforam. Lai skatītu trauciņa saturu citam fluoroforam, atlasiet to nolaižamajā sarakstā Fluors
List (Fluoroforu saraksts).

3. Noklikšķiniet uz Export Template (Eksportēt veidni), lai eksportētu trauciņa izklājlapas veidni
Excel failā (.csv formātā). Jūs varat rediģēt šo veidni, lai importētu informāciju par iedobes saturu.

4. (Papildiespēja) Noklikšķiniet uz Import (Importēt), lai importētu iedobes saturu no komatatdalīto
vērību faila.

5. Lai kārtotu datus izklājlapā saskaņā ar datiem konkrētā kolonnā, noklikšķiniet uz trijstūra blakus
kolonnas nosaukuma.

Padoms. Jūs varat rediģēt jebkuras šūnas saturu kolonnā, kuras nosaukumam blakus ir
zvaigznīte (*) (piemēram, * Target Name (Mērķa nosaukums)).

Piezīme. Atlasiet mērvienības standarta līknes datiem kolonnā Quantity (Daudzums), atverot rīku
Plate Editor (Trauciņa redaktors) un izvēlnes joslā atlasot Settings > Units (Iestatījumi >
Mērvienības). Pēc trauciņa izpildes pabeigšanas dati ar jūsu atlasītajām mērvienībām no šiem
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Trauciņa skatīšana izklājlapas formātā

standartiem parādās loga Data Analysis (Datu analīze) cilnes Quantification (Kvantitatīvā
noteikšana) diagrammā Standard Curve (Standarta līkne).

Izvēlnes, kas pieejama, noklikšķinot ar peles labo pogu, vienumi rīkam Plate
Spreadsheet View/Importer (Trauciņa izklājlapas skats/importētājs)

14. tabula ir uzskaitīti izvēlnes vienumi, kas pieejami rīkā Spreadsheet View/Importer (Izklājlapas
skats/importētājs), ar peles labo pogu noklikšķinot uz jebkuras iedobes rīkā.

Vienums Funkcija

Copy (Kopēt) Kopē visu izklājlapu.

Copy as Image (Kopēt
kā attēlu)

Kopē diagrammu kā attēla failu.

Print (Drukāt) Izdrukā izklājlapu.

Print Selection (Drukāt
atlasi)

Drukā tikai atlasītās šūnas.

Export to Excel
(Eksportēt uz Excel)

Eksportē failu uz Excel izklājlapu.

Export to CSV
(Eksportēt uz CSV)

Eksportē failu .csv formātā.

Export to Xml
(Eksportēt uz Xml)

Eksportē failu .xml formātā.

Export to Html
(Eksportēt uz Html)

Eksportē failu .html formātā.

Find (Atrast) Meklē specifisku tekstu.

Sort (Kārtot) Kārto izklājlapu, atlasot līdz trim datu kolonnām logā Sort (Kārtot).

14. tabula. Izvēlnes, kas pieejama, noklikšķinot ar peles labo pogu, vienumi rīkā
Plate Spreadsheet View/Importer (Trauciņa izklājlapas skats/importētājs)
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Trauciņu izkārtojuma izveide, izmantojot Plate Setup Wizard
(Trauciņa iestatīšanas vednis)

Jūs varat lietot Setup Wizard (Iestatīšanas vedni), lai ievadītu informāciju par trauciņu izkārtojumu,
kāda nepieciešama normalizētas gēnu ekspresijas analīzē, ieskaitot šādus vienumus:

n Mērķa nosaukumi

n Paraugu nosaukumi

n Mērķu un parauga atrašanās vietas trauciņā

n Atsauces gēns(-i)

n Control Sample (Kontroles paraugs)

Setup Wizard (Iestatīšanas vedni) var lietot pirms izpildes, tās laikā un pēc izpildes.

Trauciņa Setup Wizard (Iestatīšanas vednis) lietošana
Šajā sadaļā paskaidrots, kā izveidot trauciņu izkārtojumu, izmantojot trauciņu Setup Wizard
(Iestatīšanas vednis). Lai katras trauciņā esošās iedobes satura skatīšana būtu vienkāršāka,
noklikšķiniet uz Zoom plate (Tuvināt trauciņu) Setup Wizard (Iestatīšanas vedņa) augšpusē.

Svarīgi! Atgriešanās cilnē Auto layout (Automātiskais izkārtojums), ja esat kādā citā cilnē Setup
Wizard (Iestatīšanas vednis), atiestata trauciņu izkārtojumu. Ievērojiet piesardzību, atlasot šo
cilni.

Padoms. Izkārtojumu var atiestatīt, atlasot Tools > Clear Plate (Rīki > Notīrīt trauciņu); šīs
komandas atrodas iestatīšanas vednī.

Trauciņa Setup Wizard (Iestatīšanas vednis) lietošana

1. Atveriet logu Plate Editor (Trauciņa redaktors).

2. Lai atvērtu Setup Wizard (Iestatīšanas vednis), izvēlieties Editing Tools > Setup Wizard
(Rediģēšanas rīki > Iestatīšanas vednis).

Parādās Setup Wizard (Iestatīšanas vednis), rādot cilni Auto layout (Automātiskais izkārtojums).
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Trauciņu izkārtojuma izveide, izmantojot Plate Setup Wizard (Trauciņa iestatīšanas vednis)

3. Cilnē Auto layout (Automātiskais izkārtojums) veiciet tālāk norādītās darbības.

a. Noklikšķiniet režģī uz iedobes un velciet to pāri un uz leju, lai precizētu trauciņā apgabalu, kur
plānojat paraugu ielādēt.

b. Ievadiet ielādējamo mērķu un paraugu skaitu.

Padoms. Mērķu un paraugu skaitam jābūt vienādam ar atlasīto šūnu skaitu. Ja ievadītie
skaiti neietilpst atlasītajā apgabalā, modificējiet skaitļus vai trauciņa atlases apgabalu.
Vienumu orientāciju trauciņā, kā arī to grupējumu ir iespējams norādīt.

c. (Papildiespēja) Mainiet trauciņa orientāciju. Piemēram, jūs varat iestatīt mērķus kolonnās un
paraugus rindās vai arī grupēt pa paraugiem.

d. Noklikšķiniet uz Next (Tālāk), lai pārietu uz cilni Target names (Mērķa nosaukumi).

Piezīme. Ja trauciņu izkārtojumam nav pastāvīga modeļa, lietojiet cilni Target names (Mērķa
nosaukumi), lai manuāli pozicionētu mērķus, vai cilni Sample names (Paraugu nosaukumi),
lai manuāli pozicionētu paraugus trauciņā. Noklikšķiniet un velciet, lai atlasītu vairākas
iedobes.
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4. Cilnē Target names (Mērķa nosaukumi) definējiet mērķa grupu mērķa nosaukumus:

a. Veiciet vienu no tālāk norādītajām darbībām:

n Lai pārdēvētu mērķus atbilstoši grupai, iestatiet Select by (Atlasīt pēc) uz Target
(Mērķis).

n Lai pārdēvētu mērķus atbilstoši iedobei, iestatiet Select by (Atlasīt pēc) uz Well (Iedobe).

b. Atlasiet režģī mērķa grupu vai iedobi un ierakstiet nosaukumu nolaižamajā sarakstā Target
name (Mērķa nosaukums).

Padoms. Nospiediet tabulēšanas taustiņu, lai atlasītu nākamo grupu vai iedobi pa labi,
vai ievadīšanas taustiņu, lai atlasītu nākamo grupu vai iedobi uz leju. Vai arī cilnēs
Target name (Mērķa nosaukums) un Sample name (Parauga nosaukums) turiet
nospiestu vadīšanas taustiņu un noklikšķiniet uz iedobes, lai atlasītu vairākas iedobes,
kas neatrodas viens otram blakus.

c. Noklikšķiniet uz Next (Tālāk), lai pārietu uz cilni Sample names (Paraugu nosaukumi).

5. Cilnē Sample names (Paraugu nosaukumi) definējiet paraugu grupu paraugu nosaukumus.

6. Noklikšķiniet uz Next (Tālāk), lai pārietu uz cilni Reference targets (Atsauces mērķi).

7. Cilnē Reference targets (Atsauces mērķi) atlasiet vienu vai vairākus mērķus, kurus lietot kā
atsauces normalizētā gēnu ekspresijā, un noklikšķiniet uz Next (Tālāk), lai pārietu uz cilni Control
sample (Kontroles paraugs).

8. Cilnē Control sample (Kontroles paraugs) atlasiet vienu paraugu, ko lietot kā kontroli relatīvās
gēnu ekspresijas aprēķinos.

9. Noklikšķiniet uz OK (Labi), lai saglabātu trauciņu izkārtojumu un atgrieztos logā Plate Editor
(Trauciņa redaktors), kurā varat turpināt trauciņa parametru noteikšanu. Papildinformāciju skatiet
šeit Papildu parametru piešķiršana trauciņa failam 119. lpp.

Vai arī noklikšķiniet uz Previous (Atpakaļ), lai atgrieztos iepriekšējā cilnē un izdarītu kādas
izmaiņas.

Piezīme. Atgriešanās cilnē Auto layout (Automātiskais izkārtojums) automātiski atiestata
trauciņu. Ievērojiet piesardzību, noklikšķinot uz Previous (Atpakaļ).
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8. nodaļa. Eksperimentu veikšana
Šajā nodaļā ir izskaidrots, kā veikt pielāgotu (lietotāja definētu) vai PrimePCR testu eksperimentus,
izmantojot CFX Manager Dx programmatūru.

Izpildes datu fails satur izpildei nepieciešamo protokolu un informāciju par trauciņu. Tāpat fails satur
datus no analīzēm, ko CFX Manager Dx veic pēc izpildes pabeigšanas.

CFX Manager Dx programmatūra atvieglo iestatīšanu un veic lietotāja definētus vai PrimePCR
eksperimentus. Logs Run Setup (Izpildes iestatīšana) palīdz veikt vispārējas eksperimenta
iestatīšanas darbības, lai atvērtu dialoglodziņu Start Run (Sākt izpildi), kurā varat sākt izpildi.

Piekļuve logam Run Setup (Izpildes iestatīšana)
Piekļuve logam Run Setup (Izpildes iestatīšana)

u Veiciet vienu no tālāk norādītajām darbībām:

n Cilnē Run Setup (Izpildes iestatīšana) vednī Startup Wizard (Startēšanas vednis)
noklikšķiniet vai nu uz User-defined (Lietotāja definēta), vai uz PrimePCR.

n Loga Home (Sākums) rīkjoslā noklikšķiniet vai nu uz User-defined Run Setup (Lietotāja
definēta izpildes iestatīšana), vai uz PrimePCR Run Setup (PrimePCR izpildes iestatīšana).

n Logā Home (Sākums) atlasiet vai nu Run > User-defined Run (Izpilde > Lietotāja definēta
izpilde), vai arī Run > PrimePCR Run (Izpilde > PrimePCR izpilde).
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Run Setup (Izpildes iestatīšana) logs
Run Setup (Izpildes iestatīšana) logs sniedz ātru piekļuvi failiem un iestatījumiem, kādi vajadzīgi, lai
iestatītu un izpildītu eksperimentu. Kad izvēlaties izpildīt lietotāja definētu eksperimentu, atveras Run
Setup (Izpildes iestatīšana) logs, kurā redzama cilne Protocol (Protokols). Kad izvēlaties izpildīt
PrimePCR eksperimentu, atveras Run Setup (Izpildes iestatīšana) logs, kurā redzama cilne Start run
(Sākt izpildi).

Padoms. Skatīt PrimePCR eksperimentu veikšana 162. lpp., lai iegūtu informāciju par
PrimePCR; skatīt Cilne Start Run (Sākt izpildi) 152. lpp., lai iegūtu informāciju par cilni Start Run
(Sākt izpildi).
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Run Setup (Izpildes iestatīšana) logs

1. Cilnes jūs vada iestatīšanas un eksperimenta izpildes procesā:

n Cilne Protocol (Protokols) — atlasiet izpildīšanai vai rediģēšanai esošu
protokolu vai veidojiet jaunu protokolu rīkā Protocol Editor (Protokola
redaktors).

n Cilne Plate (Trauciņš) — atlasiet izpildīšanai vai rediģēšanai esošu trauciņu
vai izveidojiet jaunu trauciņu rīkā Plate Editor (Trauciņa redaktors).

n Cilne Start Run (Sākt izpildi) — skatiet eksperimenta iestatījumus, atlasiet
vienu vai vairākus instrumentu blokus un sāciet izpildi.

2. Galvenajā logā tiek rādītas katras cilnes opcijas atbilstoši tam, kā jūs tās lietojat.

3. Navigācijas pogas jūs aizved līdz cilnei Start Run (Sākt izpildi).

APZĪMĒJUMI
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Cilne Protocol (Protokols)
Cilnē Protocol (Protokols) tiek parādīts protokola faila, kuru plānojat izpildīt, priekšskatījums.
Protokola fails satur norādījumus instrumenta temperatūras darbībām, kā arī instrumenta opcijām, kas
ļauj kontrolēt izmaiņu ātrumu, parauga tilpumu un vāka temperatūru.

Programmatūra pēc noklusējuma parāda protokolu, kas definēts dialoglodziņa User > User
Preferences (Lietotājs > Lietotāja preferences) cilnes Files (Faili) sadaļā File Selection for Run Setup
(Faila atlase izpildes iestatīšanai). Jūs varat mainīt noklusējuma protokolu dialoglodziņā User
Preferences (Lietotāja preferences). Papildinformāciju skatiet šeit Noklusējuma failu iestatījumu
maiņa 62. lpp.

Cilnē Protocol (Protokols) jūs varat veikt tālāk norādīto.

n Jauna protokola izveide palaidei

n Atlasiet izpildīšanai vai rediģēšanai esošu protokolu.

Sīkāku informāciju par protokolu izveidi un pārveidošanu skat. 6. nodaļa, Protokolu izveide.
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Cilne Protocol (Protokols)

Jauna protokola izveide

1. Cilnē Protocol (Protokols) noklikšķiniet uz Create New (Izveidot jaunu).

Parādīsies logs Protocol Editor (Protokola redaktors).

2. Izmantojiet rīku Protocol Editor (Protokola redaktors), lai izveidotu jaunu protokolu.

3. Noklikšķiniet uz OK (Labi), pai saglabātu protokolu un atgrieztos dialoglodziņa Run Setup
(Izpildes iestatīšana) cilnē Protocol (Protokols).

4. Skatiet protokola informāciju un veiciet vienu no tālāk norādītajām darbībām:

n Ja informācija ir pareiza, noklikšķiniet uz Next (Tālāk), lai dotos uz cilni Plate (Trauciņš).

n Ja informācija nav pareiza, noklikšķiniet uz Edit Selected (Rediģēt atlasīto), lai atgrieztos
logā Protocol Editor (Protokola redaktors). Pārskatiet protokolu, saglabājiet izmaiņas un tad
cilnē Protocol (Protokols) noklikšķiniet uz Next (Tālāk), lai dotos uz cilni Plate (Trauciņš).

Esoša protokola atlase

1. Cilnē Protocol (Protokols) veiciet vienu no tālāk norādītajām darbībām:

n Noklikšķiniet uz Select Existing (Atlasīt esošo) un navigējiet uz esošo protokolu.

n Noklikšķiniet uz Express Load (Izteikt slodzi) un protokolu nolaižamajā sarakstā atlasiet
protokolu.

Padoms. Jūs varat pievienot protokolus vai noņemt tos nolaižamajā sarakstā Express
Load (Izteikt slodzi). Sīkāku informāciju skat. nākamajā sadaļā Ekspresielādes protokolu
pievienošana un noņemšana.

2. Skatiet protokola informāciju un veiciet vienu no tālāk norādītajām darbībām:

n Ja informācija ir pareiza, noklikšķiniet uz Next (Tālāk), lai dotos uz cilni Plate (Trauciņš).

n Ja informācija nav pareiza, noklikšķiniet uz Edit Selected (Rediģēt atlasīto), lai atvērtu logu
Protocol Editor (Protokola redaktors). Pārskatiet protokolu, saglabājiet izmaiņas un tad cilnē
Protocol (Protokols) noklikšķiniet uz Next (Tālāk), lai dotos uz cilni Plate (Trauciņš).
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Ekspresielādes protokolu pievienošana un noņemšana

Nolaižamā saraksta Express Load (Ekspresielāde), kas parādās logā Protocol Editor (Protokola
redaktors), saturu var modificēt. Protokoli, kas redzami šajā sarakstā, ir saglabāti šādā mapē:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\

Protokolu saraksta Express Load (Ekspresielāde) modificēšana

1. Navigējiet uz mapi ExpressLoad (Ekspresielāde) un atveriet to.

2. Pārskatiet mapē esošos protokolu failus (.pcrl).

3. Veiciet kādu no norādītajām darbībām.

n Lai noņemtu protokolus no nolaižamā saraksta, izdzēsiet tos no mapes.

n Lai pievienotu protokolus nolaižamajam sarakstam, kopējiet tos mapē.
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Cilne Plate (Trauciņš)
Piezīme. Ja cilnē Protocol (Protokols) atlasītais protokols neietver trauciņa nolasīšanas darbību
reāllaika PCR analīzei, cilne Plate (Trauciņš) ir paslēpts. Lai skatītu cilni Plate (Trauciņš),
protokolam pievienojiet vismaz vienu trauciņa nolasīšanu.

Cilnē Plate (Trauciņš) tiek parādīts trauciņa faila, kuru plānojat ielādēt, priekšskatījums. Reāllaika
PCR izpildes laikā trauciņa fails satur katras iedobes satura aprakstu, tostarp par tā fluoroforiem,
skenēšanas režīmu un trauciņa veidu. CFX Manager Dx programmatūra izmanto šos aprakstus datu
vākšanai un analīzei.

Programmatūra pēc noklusējuma parāda trauciņu, kas definēts dialoglodziņa User > User
Preferences (Lietotājs > Lietotāja preferences) cilnes Files (Faili) sadaļā File Selection for Run Setup
(Faila atlase izpildes iestatīšanai). Jūs varat mainīt noklusējuma trauciņu dialoglodziņā User
Preference (Lietotāja preferences). Papildinformāciju skatiet šeit Noklusējuma failu iestatījumu maiņa
62. lpp.

Cilnē Plate (Trauciņš) jūs varat veikt tālāk norādīto.

n Izveidot jaunu trauciņu ielādei.

n Atlasīt esošo trauciņu ielādei vai rediģēšanai.

Sīkāku informāciju par trauciņu izveidi un pārveidošanu skat. 7. nodaļa, Trauciņu sagatavošana.
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Jauna trauciņa izveide

1. Cilnē Plate (Trauciņš) noklikšķiniet uz Create New (Izveidot jaunu).

Parādīsies rīks Plate Editor (Trauciņa redaktors).

2. Izmantojiet rīku Plate Editor (Trauciņa redaktors), lai izveidotu jaunu trauciņu.

3. Noklikšķiniet uz OK (Labi), pai saglabātu trauciņu un atgrieztos dialoglodziņa Run Setup (Izpildes
iestatīšana) cilnē Plate (Trauciņš).

4. Skatiet informāciju par trauciņu un veiciet vienu no tālāk norādītajām darbībām:

n Ja informācija ir pareiza, noklikšķiniet uz Next (Tālāk), lai dotos uz cilni Start Run (Sākt
izpildi).

n Ja informācija nav pareiza, noklikšķiniet uz Edit Selected (Rediģēt atlasīto), lai atgrieztos rīkā
Plate Editor (Trauciņa redaktors). Pārskatiet trauciņa failu, saglabājiet izmaiņas un tad cilnē
Plate (Trauciņš) noklikšķiniet uz Next (Tālāk), lai dotos uz cilni Start Run (Sākt izpildi).

Esošā trauciņa faila atlasīšana

1. Cilnē Plate (Trauciņš) veiciet vienu no tālāk norādītajām darbībām:

n Noklikšķiniet uz Select Existing (Atlasīt esošo) un navigējiet uz esošo trauciņa failu.

n Noklikšķiniet uz Express Load (Izteikt slodzi) un nolaižamajā sarakstā atlasiet trauciņa failu.

Padoms. Jūs varat pievienot trauciņus vai noņemt tos nolaižamajā sarakstā Express
Load (Izteikt slodzi). Sīkāku informāciju skat. nākamajā sadaļā Ekspresielādes trauciņu
failu pievienošana un noņemšana.

2. Skatiet informāciju par trauciņu un veiciet vienu no tālāk norādītajām darbībām:

n Ja informācija ir pareiza, noklikšķiniet uz Next (Tālāk), lai dotos uz cilni Start Run (Sākt
izpildi).

n Ja informācija nav pareiza, noklikšķiniet uz Edit Selected (Rediģēt atlasīto), lai atvērtu logā
Plate Editor (Trauciņa redaktors). Pārskatiet trauciņa failu, saglabājiet izmaiņas un tad
noklikšķiniet uz Next (Tālāk), lai dotos uz cilni Start Run (Sākt izpildi).
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Cilne Plate (Trauciņš)

Ekspresielādes trauciņu failu pievienošana un noņemšana

Nolaižamā saraksta Express Load (Ekspresielāde), kas parādās logā Plate Editor (Trauciņa
redaktors), saturu var modificēt. Trauciņi, kas redzami šajā sarakstā, ir saglabāti šādā mapē:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\

Trauciņu failu saraksta Express Load (Ekspresielāde) modificēšana

1. Navigējiet uz mapi ExpressLoad (Ekspresielāde) un atveriet to.

2. Pārskatiet mapē esošos trauciņu failus (.pltd).

3. Veiciet vienu no tālāk norādītajām darbībām:

n Lai noņemtu trauciņu failus no nolaižamā saraksta, izdzēsiet tos no mapes.

n Lai pievienotu trauciņu failus nolaižamajam sarakstam, kopējiet tos mapē.

Lietošanas rokasgrāmata | 151



8. nodaļa. Eksperimentu veikšana

Cilne Start Run (Sākt izpildi)
Cilnē Start Run (Sākt izpildi) redzama informācija par izpildāmo eksperimentu. Tur redzams arī
pievienotais instrumentu bloks vai bloki, kuros varat izpildīt eksperimentu.

Cilnē Start Run (Sākt izpildi) jūs varat veikt tālāk norādītās darbības.

n Skatīt sīku izpildes informāciju, tostarp atlasīto protokola failu, trauciņa failu un skenēšanas
režīmu.

n Pievienot piezīmes par izpildi.

n Skatīt informāciju par visiem pievienotajiem instrumentiem, tostarp to izpildes statusu (darbojas
vai ir neaktīvs), parauga tilpumu (µl), vāka temperatūru (vāka temperatūra, emulācijas režīmu un
ID or svītrkodu, ja pieejams.

Piezīme. Kolonnas, kas parādās tabulā Start Run on Selected Block(s) (Sākt izpildi atlasītajā
(-os) blokā(-os), var modificēt. Informāciju skat Datu modificēšana tabulā Selected Blocks
(Atlasītie bloki) 153. lpp.

n Atlasiet bloku vai blokus, kam) veikt izpildi.

n Attālināti atveriet vai aizveriet katra atlasītā instrumenta vāku.

n Sāciet izpildi.
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Cilne Start Run (Sākt izpildi)

Datu modificēšana tabulā Selected Blocks (Atlasītie bloki)

Kolonnas, kas parādās tabulā Start Run on Selected Block(s) (Sākt izpild atlasītajā(-os) blokā(-os)),
var modificēt. Var modificēt arī noklusējuma parauga tilpuma un vāka temperatūras vērtības tabulā.
Izmaiņas iestatījumos tiek lietotas izpildē, kas tiks veikta.

Kolonnu pievienošana tabulā Start Run on Selected Blocks (Sākt izpild atlasītajā(-os)
blokā(-os))

u Ar peles labo pogu noklikšķiniet tabulā un atlasiet opciju parādītajā izvēlnē.

Kolonnu noņemšana tabulā Start Run on Selected Blocks (Sākt izpild atlasītajā(-os)
blokā(-os))

u Ar peles labo pogu noklikšķiniet tabulā un notīriet opciju parādītajā izvēlnē.

Parauga tilpuma vai vāka temperatūras vērtību rediģēšana blokā

u Atlasiet mērķa bloka parauga tilpuma vai vāka temperatūras šūnu un ierakstiet šūnā jaunu
vērtību.

Izpildes ID vai svītrkoda pievienošana attiecībā uz bloku

u Atlasiet mērķa bloka šūnu ID/Bar Code (ID/Svītrkods) un ierakstiet ID vai skenējiet bloku ar
svītrkodu lasītāju.

Eksperimenta izpilde
Svarīgi! Pirms eksperimenta izpildes pārliecinieties, vai jūsu datora antivīrusu programmatūra
izpildes laikā neuzsāks skenēšanu.

Eksperimenta izpilde

1. Cilnē Start Run (Sākt izpildi) pārliecinieties par trauciņa un protokola datiem sadaļā Run
Information (Informācija par izpildi).

2. (Papildiespēja) Pievienojiet piezīmes par izpildi vai eksperimentu tekstlodziņā Notes (Piezīmes).

3. Ielieciet atzīmi viena vai vairāku bloku izvēles rūtiņā, ar kuriem veikt izpildi.

Padoms. Lai eksperimentu izpildītu visos blokos, atlasiet Select All Blocks (Atlasīt visus
blokus), kas atrodas zem tabulas Selected Blocks (Atlasītie bloki).

4. (Papildiespēja) Noklikšķiniet uz Flash Block Indicator (Bloka indikators mirgo), lai LED indikators uz
atlasītajiem instrumentu blokiem mirgotu.
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5. Ievietojiet blokā eksperimenta trauciņus:

a. Noklikšķiniet uz Open Lid (Atvērt vāku). Atveras katra atlasītā bloka motorizētais vāks.

b. Ievietojiet eksperimenta bloku katrā atlasītajā blokā.

c. Noklikšķiniet uz Close Lid (Aizvērt vāku).

Padoms. Lai atvērtu un aizvērtu vāku, var arī nospiest pogu katra bloka priekšpusē.

6. Noklikšķiniet Open Lid (Atvērt vāku) un Close Lid (Aizvērt vāku), lai atvērtu un aizvērtu katra
atlasītā instrumentu bloka motorizēto vāku.

7. Skatiet izpildes datus un veiciet vienu no tālāk norādītajām darbībām:

n Ja dati ir pareizi, noklikšķiniet uz Start Run (Sākt izpildi).

n Ja dati nav pareizi:

o Koriģējiet datus tabulā Selected Blocks (Atlasītie bloki) un pēc tam noklikšķiniet uz Start
Run (Sākt izpildi).

o Atgriezieties, lai koriģētu cilni, un veiciet attiecīgās izmaiņas, saglabājiet izmaiņas un tad
noklikšķiniet uz Next (Tālāk), lai atgrieztos cilnē Start Run (Sākt izpildi) un izpildi
palaistu.

Jaunas izpildes sākšana no iepriekšējas izpildes

u Veiciet vienu no tālāk norādītajām darbībām:

n Atlasiet File > Repeat a Run (Fails > Atkārtot izpildi) galvenajā programmatūras izvēļņu joslā;
navigējiet uz datu failu, ko vēlaties atkārtot, un veiciet uz tā dubultklikšķi.

n Atlasiet cilni Repeat Run (Atkārtot izpildi) Startup Wizard (Startēšanas vednis) un veiciet
dubultklikšķi uz tās izpildes datu faila, ko vēlaties atkārtot.

Pēc izvēles cilnē Repeat Run (Atkārtot izpildi) varat noklikšķināt uz Browse (Pārlūkot) un
navigēt uz tās izpildes datu failu, ko vēlaties atkārtot, un veikt uz tā dubultklikšķi.
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Dialoglodziņš Run Details (Izpildes dati)

Dialoglodziņš Run Details (Izpildes dati)
Kad noklikšķināt uz Start Run (Sākt izpildi), CFX Manager Dx programmatūra jūs aicina saglabāt datu
failu (.pcrd), palaiž izpildi un atver dialoglodziņu Run Details (Izpildes dati). Dialoglodziņu Run Details
(Izpildes dati) veido trīs statusa cilnes:

n Run Status (Izpildes statuss)— lietojiet šo cilni, lai skatītu protokola pašreizējo statusu, atvērtu
vai aizvērtu vāku, pauzētu izpildi, pievienotu atkārtojumus, izlaistu darbības vai apturētu izpildi.

n Real-time Status (Reāllaika statuss)— lietojiet šo cilni, lai skatītu reāllaika PCR fluorescences
datus to vākšanas procesā.

n Time Status (Laika statuss)— lietojiet šo cilni, lai skatītu pilnekrāna laika atpakaļskaitīšanas
taimeri attiecībā uz konkrēto protokolu.

Detalizēts šo ciļņu skaidrojums ir sniegts turpmākajās sadaļās.

Cilne Run Status (Izpildes statuss)
Cilnē Run Status (Izpildes statuss) tiek parādīts notiekošās izpildes pašreizējais statuss. Tāpat šajā
skatā jūs varat kontrolēt vāku un mainīt notiekošo izpildi.
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1. Rūts Run Status (Izpildes statuss) — parāda pašreizējo protokola izpildes gaitu.

2. Vadīklas Run Status (Izpildes statuss) — ļauj darbināt instrumentu vai pārtraukt
pašreizējā protokola izpildi.

3. Rūts Run Information (Informācija par izpildi) — parāda izpildes datus.

APZĪMĒJUMI

Cilnes Run Status (Izpildes statuss) komandas

Izmantojiet cilnē Run Status (Izpildes statuss) pieejamās komandas, lai ar programmatūras palīdzību
darbinātu instrumentu vai mainītu notiekošo izpildi.

Piezīme. Izmaiņu veikšana protokolā, piemēram, atkārtojumu pievienošana, izpildes laikā
nemaina ar izpildi saistīto protokola failu. Šīs darbības tiek reģistrētas Run Log (Izpildes žurnāls).

— atver atlasīto instrumentu motorizētos vākus.

Svarīgi! Vāka atvēršana izpildes laikā aptur izpildi esošajā darbībā un var mainīt datus.

— aizver atlasīto instrumentu motorizētos vākus.

— pievieno vairāk atkārtojumu pašreizējai GOTO darbībai protokolā. Šī opcija ir pieejama tikai
tad, kad tiek izpildīta GOTO darbība.

— izlaiž pašreizējo darbību protokolā.

Piezīme. Ja izlaidīsiet GOTO darbību, programmatūra aicina apstiprināt, ka vēlaties izlaist
visu GOTO cilpu un turpināt ar protokola nākamo darbību.

— liek mirgot LED atlasītajam instrumentam, lai identificētu atlasītos blokus.
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—pauzē protokolu.

Piezīme. Šī darbība tiek reģistrēta Run Log (Izpildes žurnāls).

— atsāk pauzētā protokola izpildi.

— aptur izpildi pirms protokola beigām.

Piezīme. Apturot izpildi pirms protokola beigām, var tikt mainīti dati.
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Cilne Real-time Status (Reāllaika statuss)
Cilne Real-time Status (Reāllaika statuss) rāda reāllaika PCR datus, kas savākti katrā ciklā izpildes
laikā pēc pirmajiem diviem trauciņu nolasījumiem.

1. Amplification trace pane (Amplifikācijas trasējumu rūts) — rāda reāllaika
amplifikācijas datus izpildes laikā.

2. Well group identifier (Iedobju grupu identifikators) — ja iedobju grupas ir
identificētas trauciņa iestatījumā, lietotāji var atlasīt konkrētu iedobes grupu, lai
skatītu tās trasējumus, iedobes un tabulāro informāciju.

Step number identifier (Darbību skaita identifikators) — ja protokols vāc datus
vairāk nekā vienā darbībā (piemēram, amplifikācijas un kušanas līknes laikā),
lietotāji var atlasīt konkrētu darbību un skatīt šajā darbībā savāktos trasējumus.

3. Rūts Well selector (Iedobju atlasītājs) — rāda aktīvās, neaktīvās un tukšās
iedobes trauciņā.

4. Rūts Plate setup table (Trauciņa iestatīšanas tabula) — rāda trauciņa iestatīšanu
tabulas formātā.

APZĪMĒJUMI
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Dialoglodziņš Run Details (Izpildes dati)

5. Rūts Run details (Izpildes dati) — rāda izpildes reāllaika statusu, ieskaitot šādus
vienumus:

n Current step (Pašreizējā darbība)

n Current repeat (Pašreizējais atkārtojums)

n Current temperature (Pašreizējā temperatūra)

n Time remaining (Atlikušais laiks)

n Sample temperature (Parauga temperatūra)

n Lid temperature (Vāka temperatūra)

6. Plate Setup (Trauciņa iestatīšana) — atver dialoglodziņu Plate Setup (Trauciņa
iestatīšana), kurā lietotāji var modificēt pašreizējos trauciņa iestatījumus izpildes
laikā.

Cilne Real-time Status (Reāllaika statuss) jūs varat veikt tālāk norādīto.

n Rādīt vai paslēpt reāllaika trasējumus, atlasot tos iedobju atlasītāja rūtī vai trauciņa iestatīšanas
tabulā.

n Skatīt atsevišķu trasējumu vai trasējumu grupas, atlasot tās iedobju grupu nolaižamajā sarakstā.

n Rediģēt trauciņu vai nomainīt trauciņa failu.

n Lietot izpildē PrimePCR failu.

Reāllaika trajektoriju rādīšana un paslēpšana

Visas piepildītās iedobes pēc noklusējuma ir aktīvas un parādās trauciņa iestatīšanas tabulā. Aktīvās
iedobes iedobju atlasītāja rūtī parādās zilā krāsā. Iedobju atlasītāja rūtī paslēptās iedobes parādās
gaiši pelēkā krāsā, un neizmantotās iedobes parādās tumši pelēkā krāsā.

Izpildes laikā varat paslēpt trajektorijas no aktīvajām iedobēm. CFX Manager Dx turpina vākt datus
par visiem datiem; kad paslēpjat iedobes, to dati neparādās trauciņa iestatīšanas tabulā.

Reāllaika trajektoriju paslēpšana

u Iedobju atlasītāja rūtī noklikšķiniet uz aktīvajām (zilajām) iedobēm, kuras vēlaties paslēpt.

Reāllaika trajektoriju rādīšana

u Iedobju atlasītāja rūtī noklikšķiniet uz paslēptajām (gaiši pelēkajām) iedobēm, kurus vēlaties
parādīt.

Sīkāku informāciju par iedobju atlasītāju skat. Iedobju atlasītājs 176. lpp.
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Trauciņa iestatījuma rediģēšana

Trauciņa iestatījuma rediģēšana

u Noklikšķiniet uz Plate Setup (Trauciņa iestatīšana) un tad atlasiet View/Edit Plate (Skatīt/Rediģēt
trauciņu).

Parādās logs Plate Editor (Trauciņa redaktors), kurā var rediģēt trauciņu, kamēr notiek izpilde.
Papildu informāciju par trauciņu rediģēšanu skatīt 7. nodaļa, Trauciņu sagatavošana

Piezīme. No loga Plate Editor (Trauciņa redaktors) varat rediģēt arī trasējumu stilus.
Izmaiņas parādās amplifikācijas trasējumu plānā cilnē Real-time Status (Reāllaika statuss).

Trauciņa faila nomainīšana

Padoms. Trauciņa faila nomainīšana ir īpaši noderīga, ja izpildi sākat ar failu Quick Plate (Ātrais
trauciņš) mapē Express Load (Ekspresielāde).

Trauciņa faila nomainīšana

u Noklikšķiniet uz Plate Setup (Trauciņa iestatīšana) un atlasiet vienu no tālāk norādītajām opcijām.

n Replace Plate File (Nomainīt trauciņa failu) — atlasiet jaunu trauciņa failu pārlūkprogrammas
logā

n Apply PrimePCR file (Lietot PrimePCR failu) —meklējiet izpildes failu, no kura ar viedās
meklēšanas palīdzību tiks iegūts trauciņu izkārtojums, vai noklikšķiniet uz Browse (Pārlūkot),
lai atrastu failu, kuru lejupielādējāt no Bio-Rad tīmekļa vietnes un kas neatrodas PrimePCR
mapē

Piezīme. CFXManager Dx pārbauda trauciņa faila skenēšanas režīmu un trauciņa lielumu.
Tiem jābūt tādiem pašiem kā izpildes iestatījumiem, ar kuriem tika sākta izpilde.

160 | CFX96 Dx un CFX96 DeepWell Dx sistēmas
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Time Status (Laika statuss) cilne
Time Status (Laika statuss) cilne rāda laiku, kāds atlicis līdz pašreizējās izpildes pabeigšanai.
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PrimePCR eksperimentu veikšana
PrimePCR eksperimentiem tiek izmantots ceļš vai slimībām specifiski testi, kurus Bio-Rad ir validējis
praktiskajos eksperimentos un optimizējis. Tie ir pieejami tālāk norādītajos formātos.

n Iepriekš pārklāti paneļi — trauciņi, kas satur testus, kuri ir specifiski bioloģiskajam ceļam vai
slimībai; tie ietver PrimePCR kontroles materiālus un atsauces gēnus.

n Individuāli konfigurēti trauciņi — trauciņi, kurus var iestatīt lietotāja definētajā izkārtojumā ar
opciju izvēlēties testus interesējošajiem mērķiem, kontroles materiāliem un atsaucēm.

n Atsevišķi testi — mēģenes, kas satur atsevišķus praimera komplektus izmantošanai reāllaika
reakcijās.

Lai samazinātu vispārējo izpildes laiku, jūs protokolā varat noņemt kušanas darbību. Bio-Rad stingri
iesaka neveikt nekādas citas modifikācijas ar PrimePCR izpildes protokolu. Noklusējuma protokols ir
protokols, kas tika izmantots testa validācijai. Jebkāda novirze no tā var ietekmēt rezultātus. Protokola
izmaiņas ir atzīmētas iegūto datu faila cilnē Run Information (Informācija par izpildi) un visās
izveidotajās atskaitēs.

PrimePCR izpildes sākšana

u Lai sāktu PrimePCR izpildi, veiciet jebkuru no tālāk minētajām darbībām.

n Dialoglodziņa Startup Wizard (Startēšanas vednis) cilnē Run Setup (Izpildes iestatīšana)
atlasiet PrimePCR un tad atlasiet atbilstošo ķīmisko analīzi (SYBER vai īscauruli).

n Dialoglodziņa Startup Wizard (Startēšanas vednis) cilnes Repeat Run (Atkārtot izpildi)
sarakstā Recent Runs (Nesenās izpildes) atlasiet PrimePCR izpildi.

n Logā Home (Sākums) atlasiet File > New > PrimePCR Run File (Fails > Jauns > PrimePCR
izpildes fails).

n Logā Home (Sākums) atlasiet File > Open > PrimePCR Run File (Fails > Atvērt > PrimePCR
izpildes fails).

n Velciet un nometiet PrimePCR izpildes failu logā Home (Sākums).

Pēc PrimePCR atlases cilnē Start Run (Sākt izpildi) atveras logs Run Setup (Izpildes iestatīšana) ar
noklusējuma PrimePCR trauciņu izkārtojumu, kas ielādēts, balstoties uz atlasīto instrumentu.

Kušanas darbības noņemšana protokolā

u Cilnē Protocol (Protokols) notīriet lodziņu blakus opcijai Include Melt Step (Iekļaut kušanas
darbību).

162 | CFX96 Dx un CFX96 DeepWell Dx sistēmas



PrimePCR eksperimentu veikšana

Mērķa informācijas importēšana PrimePCR trauciņiem trauciņu izkārtojumā

1. Veiciet vienu no tālāk norādītajām darbībām:

n Dialoglodziņa Run Details (Izpildes dati) cilnē Real-time Status (Reāllaika statuss) atlasiet
Plate Setup > Apply PrimePCR File (Trauciņa iestatīšana > Lietot PrimePCR failu).

n Logā Data Analysis (Datu analīze) atlasiet Plate Setup > Apply PrimePCR File (Trauciņa
iestatīšana > Lietot PrimePCR failu).

2. PrimePCR izpildes faila dialoglodziņā noklikšķiniet uz Browse (Pārlūkot), lai navigētu uz
atbilstošo PrimePCR failu (.csv).

3. Atlasiet mērķa PrimePCR failu un noklikšķiniet uz Open (Atvērt).

CFX Manager Dx importē mērķa informāciju trauciņu izkārtojumā.
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9. nodaļa. Pārskats par datu analīzi
CFXManager Dx piedāvā vairākas datu failu atvēršanas un skatīšanas metodes. Jūs varat veikt tālāk
norādīto.

n Logā Home (Sākums) atlasiet File > Open > Data File (Fails > Atvērt > Datu fails) un pārlūkojiet,
lai atrastu mērķa .pcrd failu.

n Logā Home (Sākums) atlasiet File > Recent Data Files (Fails > Nesenie datu faili), lai izvēlētos
kādu no desmit pēdējiem atvērtajiem datu failiem.

Logs Data Analysis (Datu analīze)
Logā Data Analysis (Datu analīze) tiek parādītas vairākas cilnes; katrā cilnē tiek rādīti analizētie dati
konkrētai analīzes metodei vai izpildei specifiska informācija. Cilnes parādās tikai tad, ja izpildes laikā
savāktie dati ir pieejami attiecīgajam analīzes veidam.

Padoms. Lai izvēlētos parādāmās cilnes, atlasiet tās nolaižamajā izvēlnē View (Skatīt) logā Data
Analysis (Datu analīze). Lai atgrieztos sākotnējā ciļņu izkārtojumā, atlasiet Settings > Restore
Default Window Layout (Iestatījumi > Atjaunot noklusējuma loga izkārtojumu).
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Datu analīzes rīkjosla
Rīkjosla logā Data Analysis (Datu analīze) nodrošina ātru piekļuvi svarīgām datu analīzes funkcijām.

15. tabula ir uzskaitītas rīkjoslas pogu funkcijas.

Poga Nosaukums Funkcija

Plate Setup
(Trauciņa
iestatīšana)

View/Edit plate (Skatīt/rediģēt trauciņu):
atver rīku Plate Editor (Trauciņa redaktors),
lai skatītu un rediģētu iedobes saturu.

Replace Plate file (Nomainīt trauciņa failu):
atlasa trauciņa failu trauciņu izkārtojuma
nomaiņai.

Apply PrimePCR file (Lietot PrimePCR
failu): atlasa izpildes failu, lai nomainītu
trauciņu izkārtojumu PrimePCR izpildei.

Iedobju grupu
pārvaldīšana

Atver logu Well Groups Manager (Iedobju
grupu pārvaldnieks), lai izveidotu, rediģētu
un dzēstu iedobju grupas.

Iedobju grupa Nolaižamajā izvēlnē atlasa esošās iedobju
grupas nosaukumu. Pēc noklusējuma ir
atlasīta opcija All Wells (Visas iedobes). Šī
poga parādās tikai tad, kad ir izveidotas
iedobju grupas.

Analīzes režīms Analizē datus režīmā Fluorophore
(Fluorofors) vai režīmā Target (Mērķis).

Palīdzība Atver šīs rokasgrāmatas digitālo versiju
Acrobat PDF formātā.

15. tabula. Rīkjosla logā Data Analysis (Datu analīze)
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Logs Data Analysis (Datu analīze)

Izvēļņu josla Data Analysis (Datu analīze)
16. tabula ir uzskaitīti izvēļņu joslas vienumi, kas redzami logā Data Analysis (Datu analīze).

Izvēlnes
vienums Komanda Funkcija

File (Fails) Save (Saglabāt) Saglabā failu.

Save As (Saglabāt kā) Saglabā failu ar jaunu nosaukumu.

Repeat Run (Atkārtot izpildi) Izvelk protokolu un trauciņa failu no esošās
izpildes un veic atkārtotu izpildi.

Close (Aizvērt) Aizver logu Data Analysis (Datu analīze).

View (Skatīt) Run Log (Izpildes žurnāls) Atver logu Run Log (Izpildes žurnāls), lai
skatītu esošā datu faila izpildes žurnālu.

Quantification (Kvantitatīvā
noteikšana), Melt Curve
(Kušanas līkne), Gene
Expression (Gēnu ekspresija),
End Point (Galamērķis),
Custom Data View (Pielāgota
datu skatīšana), QC (KK), Run
Information (Izpildes
informācija)

Loga Data Analysis (Datu analīze) atlasītajās
cilnēs parāda analizētos datus. Jāatlasa
vismaz viena cilne.

Settings
(Iestatījumi)

Cq Determination Mode (Cq
noteikšanas režīms)

Atlasiet režīmu Regression (Regresija) vai
režīmu Single Threshold (Atsevišķa sliekšņa
vērtība), lai noteiktu, kā katrai trajektorijai tiek
aprēķinātas Cq vērtības.

Baseline Setting (Bāzlīnijas
iestatījums)

Atlasītajām iedobju grupām atlasiet metodi
Baseline Subtraction (Bāzlīnijas atņemšana).

Analysis Mode (Analīzes
režīms)

Atlasiet, lai analizētu datus pēc Fluorophore
(Fluorofors) vai Target (Mērķis).

16. tabula. Izvēļņu joslas vienumi logā Data Analysis (Datu analīze)
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Izvēlnes
vienums Komanda Funkcija

Cycles to Analyze
(Analizējamie cikli)

Atlasiet analizējamos ciklus.

Baseline Threshold (Bāzlīnijas
sliekšņa vērtības)

Atver logu Baseline Threshold (Bāzlīnijas
sliekšņa vērtības), lai pielāgotu bāzes līniju vai
sliekšņa vērtību.

Trace Styles (Trajektorijas stili) Atver logu Trace Styles (Trajektorijas stili).

Plate Setup (Trauciņa
iestatīšana)

Atver rīku Plate Editor (Trauciņa redaktors), lai
skatītu un rediģētu trauciņu; nomainiet esošo
trauciņu pret trauciņu no lietotāja definētā
trauciņa faila vai PrimePCR izpildes faila.

Include All Excluded Wells
(Iekļaut visas izslēgtās
iedobes)

Iekļauj analīzē visas izslēgtās iedobes.

Mouse Highlighting (Kursora
izcelšana)

Ieslēdz vai izslēdz vienlaicīgu datu izcelšanu ar
peles rādītāja palīdzību.

Padoms. Ja komanda Mouse Highlighting
(Kursora izcelšana) ir izslēgta, nospiediet
kontroles taustiņu, lai īslaicīgi ieslēgtu
izcelšanu.

Restore Default Window
Layout (Atjaunot noklusējuma
loga izkārtojumu)

Atjauno logu kārtošanas noklusējuma
iestatījumu.

16. tabula. Izvēļņu joslas vienumi logā Data Analysis (Datu analīze), turpinājums
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Logs Data Analysis (Datu analīze)

Izvēlnes
vienums Komanda Funkcija

Export
(Eksports)

Export All Data Sheets to
Excel (Eksportēt visas datu
lapas programmā Excel)

Eksportē visus izklājlapu skatus no katras
cilnes atsevišķā Excel failā.

Custom Export (Pielāgots
eksports)

Atver logu Custom Export (Pielāgots eksports),
kurā jāeksportē lauki un kur var norādīt faila
formātu.

Export to LIMS Folder
(Eksportēt uz LIMS mapi)

Atver logu, lai iepriekš noteiktā formātā
saglabātu datus LIMS mapē.

Seegene Export (Seegene
eksports)

Atver logu, lai identificētu vietu datu no visiem
izklājlapu skatiem saglabāšanai Excel failos,
kas īpaši strukturēti Seegene, Inc vajadzībām.

Tools (Rīki) Reports (Atskaites) Atver šī datu faila atskaiti.

Well Group Reports (Atskaites
par iedobju grupām)

Atver logu Well Group Report (Atskaite par
iedobju grupu), lai ģenerētu atskaites par
norādītajām iedobju grupām.

Import Fluorophore Calibration
(Importēt fluorofora
kalibrēšanu)

Atlasiet kalibrācijas failu, lai lietotu esošo datu
failu.

qbase+ Palaiž qbase+ v2.5 tieši no esošā .pcrd faila, ja
tas ir instalēts.

16. tabula. Izvēļņu joslas vienumi logā Data Analysis (Datu analīze), turpinājums
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Ciļņu informācija
Katras loga Data Analysis (Datu analīze) cilnes diagrammās un izklājlapās tiek parādīti konkrētas
analīzes metodes dati, un tas ietver iedobju atlasītāju, lai atlasītu datus, kurus vēlaties rādīt. Kad tā
tiek atvērta, logā Data Analysis (Datu analīze) pēc noklusējuma tiek parādīta cilne Quantification
(Kvantitatīvā noteikšana). Jūs varat izmantot diagrammas Amplifikācijadatus cilnē Quantification
(Kvantitatīvā noteikšana), lai noteiktu atbilstošos analīzes iestatījumus izpildei.

Piezīme. Programmatūra saista datus katras cilnes Data Analysis (Datu analīze) rūtīs.
Piemēram, iedobes izcelšana iedobju atlasītāja skatā, novietojot peles rādītāju virs iedobes, izceļ
datus visās pārējās rūtīs.
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Opcijas Step Number (Darbības numurs) atlasītājs
CFX96 un CFX96 DeepWell sistēmas var iegūt fluorescences datus vairākās protokola darbībās;
programmatūra uztur datus, kas neatkarīgi iegūti katrā darbībā. Programmatūrā tiek parādīts opcijas
Step Number (Darbības numurs) atlasītājs. Kad protokols satur vismaz vienu datu vākšanas darbību,
CFX Manager Dx software parāda datus no pirmās vākšanas darbības.

Ja protokols satur vairāk nekā vienu vākšanas darbību, jūs nolaižamajā sarakstā varat atlasīt vēl vienu
darbību, piemēram:

Atlasot darbību, programmatūra lieto šo atlasi visiem datiem, kad tiek rādīti logā Data Analysis (Datu
analīze).

Iedobju grupu skatīšana datu analīzē
Neatkarīgas analīzes nolūkā, kurā izmanto iedobju grupas, iedobes trauciņā var sagrupēt
apakškopās. Izveidojot iedobju grupas, to grupu nosaukumi parādās loga Data Analysis (Datu
analīze) nolaižamajā sarakstā Well Groups (Iedobju grupas) rīkjoslā.

Ja izveidojāt iedobju grupas, programmatūra rāda noklusējuma iedobju grupu All Wells (Visas
iedobes), kad atverat logu Data Analysis (Datu analīze), rādot datus visās iedobēs ar saturu
diagrammās un izklājlapās. Iedobju atlasītājā parādās tikai tās iedobes šajā iedobju grupā, kurās
ielādēts saturs, un tikai to iedobju dati ir iekļauti datu analīzes aprēķinos.

Piezīme. Ja iedobju grupas nav izveidotas, rīkjoslā nolaižamais saraksts Well Groups (Iedobju
grupas) neparādās.
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Iedobju satura mainīšana pēc izpildes
Datu analīzes laikā mainot veidu, kādā dati tiek rādīti, proti, mainot iedobju saturu logā Plate Editor
(Trauciņa redaktors), nekad netiek mainīti fluorescences dati, kas savākti no katras iedobes izpildes
laikā. Pēc tam, kad modulis savāc fluorescences datus, jūs šos datus nevarat dzēst, taču jūs varat
izvēlēties noņemt šos datus no skata un no analīzes.

Iedobju satura maiņa pēc izpildes

u Logā Data Analysis (Datu analīze) noklikšķiniet uz Plate Setup (Trauciņa iestatīšana) un atlasiet
vienu no šādām opcijām:

n Edit/View Plate (Redigēt/Skatīt trauciņu)—atver rīku Plate Editor (Trauciņa redaktors),
kurā var veikt manuālas izkārtojuma izmaiņas.

n Replace Plate file (Nomainīt trauciņa failu)—atver pārlūkprogrammu Select Plate (Atlasīt
trauciņu), kurā varat navigēt līdz iepriekš saglabātam trauciņa failam, ar kuru nomainīt
pašreizējo trauciņu izkārtojumu.

n Apply PrimePCR file (Lietot PrimePCR failu)—atver dialoglodziņu Select PrimePCR file
(Atlasīt PrimePCR failu), kurā varat navigēt līdz PrimePCR izpildes failam un piemērot to
trauciņu izkārtojumam.

Padoms. Varat pievienot vai rediģēt informāciju par iedobju saturu pirms izpildes, izpildes laikā
vai pēc tam, kad PCR izpilde ir pabeigta. Pirms izpildes jāpiešķir skenēšanas režīms un trauciņa
lielums. Šos parametrus pēc izpildes nevar mainīt.
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Datu analīzes iestatījumi
Diagrammas Amplification (Amplifikācija) dati cilnē Quantification (Kvantitatīvā noteikšana) rāda
katras iedobes relatīvo fluorescenci (RFV) katrā ciklā. Katrs trasējums diagrammā reprezentē datus
no atsevišķa fluorofora vienā iedobē. Šos datus lieto, lai noteiktu Cq vērtības katrai iedobei saistībā ar
katru atsevišķo fluoroforu. Programmatūra lieto vienu no diviem režīmiem, lai noteiktu Cq vērtības:

n Regression (Regresija)—piemēro atsevišķiem iedobes trasējumiem daudzvariējamu,
nelineāru regresijas modeli un pēc tam lieto šo modeli, lai aprēķinātu optimālu Cq vērtību.

n Single Threshold (Atsevišķa sliekšņa vērtība)— lieto atsevišķu sliekšņa vērtību, lai
aprēķinātu Cq vērtību, pamatojoties uz atsevišķu fluorescences trasējumu sliekšņa vērtības
šķērsošanas punktu.

Atlasiet Settings > Cq Determination Mode (Iestatījumi > Noteikšanas režīms), lai izvēlētos Cq
noteikšanas režīmu.

Sliekšņa vērtības pielāgošana
Režīmā Single Threshold (Atsevišķa sliekšņa vērtība) var pielāgot fluorofora sliekšņa vērtību,
noklikšķinot uz sliekšņa vērtību rindas Amplification (Amplifikācija) un virzot peles rādītāju vertikāli. Vai
arī var norādīt atlasītā fluorofora precīzu šķērsošanas sliekšņa vērtību.

Bāzlīnijas iestatījumi
Programmatūra automātiski katrai iedobei iestata atsevišķu bāzlīniju. Bāzlīnijas iestatījums nosaka
bāzes līnijas atņemšanas metodi visām fluorescences trajektorijām. Programmatūra nodrošina trīs
bāzlīnijas atņemšanas opcijas:

n No Baseline Subtraction (Bāzlīnijas atņemšana nenotiek)—parāda datus kā relatīvās
fluorescences trajektorijas. Šajā analīzes režīmā nav iespējams veikt dažas analīzes, tāpēc
programmatūra neparāda cilnes Gene Expression (Gēnu ekspresija), End Point (Galamērķis) un
Allelic Discrimination (Alēliskā diskriminācija).

n Baseline Subtracted (Bāzlīnija atņemta)—parāda datus kā trajektorijas ar atņemtām bāzes
līnijām katram fluoroforam iedobē. Programmatūrai jāatņem bāzlīnija no datiem, lai noteiktu
kvantitatīvās noteikšanas ciklus, veidotu standarta līknes un noteiktu nezināmu paraugu
koncentrāciju. Lai ģenerētu trajektoriju ar atņemtu bāzlīniju, programmatūra pielāgo
vispiemērotāko taisno līniju, kas iegūta, bāzes līnijas ciklu laikā reģistrējot katras iedobes
fluorescenci, un pēc tam katrā ciklā atņem vispiemērotākos datus no datiem ar atņemtajiem
pamatdatiem.

n Baseline Subtracted Curve Fit (Līknes atbilstība ar atņemtu bāzlīniju)—parāda datus kā
trajektorijas ar atņemtām bāzlīnijām, un programmatūra izlīdzina līkni ar atņemtu bāzes līniju,
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izmantojot centrētu vidējo vērtību filtru. Šis process tiek veikts tā, ka katra Cq vērtība paliek
nemainīga.

Papildus šīm opcijām jūs varat atlasīt arī opciju Apply Fluorescent Drift Correction (Lietot fluorescences
nobīdes korekciju). Iedobes, kuru RFU (RFV) vērtības dažu sākotnējo izpildes ciklu laikā ir ar neparastu
nobīdi, programmatūra no blakus esošajām iedobēm, kurām ir veiksmīgi ģenerēta horizontālā bāzes
līnija, iegūst paredzēto bāzlīniju.

Bāzlīnijas atņemšanas iestatījuma maiņa

u Atlasiet Settings > Baseline Setting (Iestatījumi > Bāzlīnijas iestatījums).

Analīzes režīms
Datus var grupēt un analizēt pēc katra fluorofora vai mērķa nosaukuma Grupējot pēc fluorofora, datu
trajektorijas tiek parādītas pēc fluorofora, kā norādīts trauciņa iestatījumā attiecīgajai izpildei. Atsevišķi
fluorofora dati parādās amplifikācijas un standarta līknes diagrammā (ja pieejama), kad ir atlasītas
attiecīgās fluorofora atlasītāja izvēles rūtiņas, kas atrodas zem amplifikācijas diagrammas.

Grupējot pēc mērķa, datu trajektorijas tiek parādītas pēc mērķa nosaukuma, kas ievadīts trauciņa
iestatījumā attiecīgajai izpildei.
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Datu analīzes režīma izvēle

u Veiciet vienu no tālāk norādītajām darbībām:

n Atlasiet Settings > Analysis Mode (Iestatījumi > Analīzes režīms).

n Izvēlieties režīmu rīkjoslas nolaižamajā izvēlnē Analysis Mode (Analīzes režīms).

Analizējamie cikli
Jūs varat ierobežot analizējamo ciklu skaitu. Varat analizēt datus arī no konkrētu ciklu kopas.
Maksimālais ciklu skaits, ko var analizēt, ir 50.

Piezīme. Ciklu noņemšanai no virknes sākuma var būt nozīmīga ietekme uz bāzes līnijas
veidošanu.

Datu analīzes aprobežošana ar konkrētu ciklu diapazonu

1. Atlasiet Settings > Cycles to Analyze (Iestatījumi > Analizējamie cikli).

Parādīsies dialoglodziņš Cycles to Analyze (Analizējamie cikli).

2. Ievadiet sākuma un beigu ciklu vērtības un noklikšķiniet uz OK (Labi).

Noklikšķiniet uz Restore Defaults (Atjaunot noklusējumus) dialoglodziņā Cycles to Analyze
(Analizējamie cikli), lai atgrieztos pie sākotnēji analīzē izmantotajiem cikliem.
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Iedobju atlasītājs
Lietojiet iedobju atlasītāju, lai rādītu vai paslēptu iedobju datus diagrammās vai izklājlapās visā Data
Analysis (Datu analīzes) logā. Iedobju atlasītājā var atlasīt tikai iedobes ar ielādētu paraugu. Iedobju
programmatūras krāsas iedobju atlasītājā:

n Zila—norāda atlasītās iedobes. Dati no atlasītajām iedobēm ir redzami Data Analysis (Datu
analīzes) logā.

n Gaiši pelēka—norāda neatlasītās iedobes. Dati no neatlasītajām iedobēm nav redzami Data
Analysis (Datu analīzes) logā.

n Tumši pelēka—norāda tukšas iedobes.

Iedobju datu rādīšana vai paslēpšana

u Iedobju atlasītājā veiciet kādu no norādītajām darbībām.

n Lai paslēptu vienu iedobi, noklikšķiniet uz atsevišķas iedobes. Lai rādītu šo iedobi, vēlreiz
noklikšķiniet uz šīs iedobes.

n Lai paslēptu vairākas iedobes, velciet pār iedobēm, kuras vēlaties atlasīt. Lai rādītu šīs
iedobes, vēlreiz velciet pār šīm iedobēm.

n Noklikšķiniet trauciņa augšējā kreisajā stūrī, lai paslēptu visas iedobes. Vēlreiz noklikšķiniet
trauciņa augšējā kreisajā stūrī, lai rādītu visas iedobes.

n Noklikšķiniet uz kolonnas vai rindas sākuma, lai paslēptu šīs iedobes. Vēlreiz noklikšķiniet uz
kolonnas vai rindas sākuma, lai rādītu iedobes.
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Iedobju atlasītāja peles labās pogas klikšķa izvēlnes vienumi
17. tabula uzskaitītas iedobju atlasītāja skatā pieejamās peles labās pogas klikšķa izvēlnes opcijas.

Vienums Funkcija

Well XX (Iedobe XX) Rāda tikai šo iedobi, noņem šo iedobi no skata, iestata krāsu šai
iedobei vai izslēdz šo iedobi no analīzes.

Selected Wells (Atlasītās
iedobes) (noklikšķināt ar peles
labo pogu un vilkt)

Rāda tikai šīs iedobes, noņem šīs iedobes no skata, iestata krāsu
šīm iedobēm vai izslēdz šīs iedobes no analīzes.

Copy (Kopēt) Kopē iedobes saturu starpliktuvē, iekļaujot parauga veidu un pēc
izvēles replikāta Nr.

Copy as Image (Kopēt kā
attēlu)

Kopē iedobju atlasītāja skatu kā attēlu.

Print (Drukāt) Drukā iedobju atlasītāja skatu.

Print Selection (Drukāt atlasi) Drukā pašreizējo atlasi.

Export to Excel (Eksportēt uz
Excel)

Eksportē datus uz Excel izklājlapu.

Export to Csv (Eksportēt uz
Csv)

Eksportē datus kā teksta dokumentu.

Export to Xml (Eksportēt uz
Xml)

Eksportē datus kā .xml dokumentu.

Well Labels (Iedobju etiķetes) Maina iedobju etiķetes uz Sample Type (Parauga veids), Target
Name (Mērķa nosaukums) vai Sample Name (Parauga
nosaukums).

17. tabula. Peles labās pogas klikšķa izvēlnes vienumi iedobju atlasītājos

Lietošanas rokasgrāmata | 177



9. nodaļa. Pārskats par datu analīzi

Iedobju īslaicīga izslēgšana no analīzes
Iedobju īslaicīga izslēgšana no analīzes

1. Iedobju atlasītājā ar peles labo pogu noklikšķiniet uz iedobes. Lai izslēgtu vairākas iedobes, ar
peles labo pogu noklikšķiniet uz vairākām iedobēm, trajektorijām vai punktiem un velciet tās.

2. Izvēlnē, kas pieejama, noklikšķinot ar peles labo pogu, izvēlieties atbilstošu opciju:

n Well > Exclude Well (Iedobe > Izslēgt iedobi).

n Selected Wells > Exclude from Analysis (Atlasītās iedobes > Izslēgt no analīzes).

n Selected Traces > Exclude these wells from Analysis (Atlasītās trajektorijas > Izslēgt šīs
iedobes no analīzes).

Vai arī, lai neatgriezeniski no analīzes noņemtu iedobes, notīriet iedobju saturu, rīkā Plate Editor
(Trauciņa redaktors) noklikšķinot uz pogas Clear Wells (Notīrīt iedobes).

Svarīgi! Jums atkārtoti jāievada jebkuras notīrītās iedobes saturs.

Lai iekļautu izslēgto iedobi

u Iedobju atlasītājā ar peles labo pogu noklikšķiniet uz atbilstošas iedobes un atlasiet Well > Include
Well in Analysis (Iedobe > Iekļaut iedobi analīzē).
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Diagrammas
Katrā logā Data Analysis (Datu analīze) redzamajā diagrammā dati tiek parādīti atsevišķā grafikā un
ietver opcijas datu vai diagrammu grafiku pielāgošanai un eksportēšanai.

Diagrammu kopējie peles labās pogas klikšķa izvēlnes vienumi
18. tabula uzskaitīti diagrammās pieejamie peles labās pogas klikšķa izvēlnes vienumi. Daži
pieejamie vienumi ir visās diagrammās, un šos vienumus var izmantot, lai mainītu to, kā dati tiek rādīti,
vai bez grūtībām datus no diagrammas eksportētu.

Vienums Funkcija

Copy (Kopēt) Kopē diagrammu starpliktuvē.

Save Image As (Saglabāt
attēlu kā)

Saglabā attēlu ar norādīto izmēru, izšķirtspēju un faila veidu. Pieejamie
attēlu formāti ir PNG (noklusējuma), JPG un BMP.

Page Setup (Lapas
iestatīšana)

Priekšskata un atlasa lapas iestatījumu drukāšanai.

Print (Drukāt) Izdrukā diagrammu.

Set Scale to Default
(Iestatīt mērogu kā
noklusējumu)

Atgriežas diagrammas noklusējuma skatā pēc diagrammas
palielināšanas.

Chart Options
(Diagrammas opcijas)

Atver logu Chart Options (Diagrammas opcijas), lai mainītu diagrammu,
ieskaitot virsraksta maiņu, robežvērtību izvēli x un y asij, režģa līniju
rādīšanu un mazāku atzīmju rādīšanu uz asīm.

18. tabula. Peles labās pogas klikšķa izvēlnes vienumi diagrammām

Piezīme. Izvēlnes vienumi, kas attiecas uz konkrētām diagrammām, aprakstīti 10. nodaļa, Datu
analīzes detaļas.
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Diagrammas datu kopēšana starpliktuvē
Diagrammas skata saturu var kopēt un ielīmēt jebkurā lietojumprogrammā, kas akceptē bitkartes
attēlu failus.

Diagrammas datu kopēšana starpliktuvē

1. No diagrammas peles labās pogas klikšķa izvēlnes atlasiet Copy (Kopēt).

2. Atveriet lietojumprogrammu, kas akceptē bitkartes attēlus, piemēram, Microsoft Word.

3. Noklikšķiniet ar peles labo pogu un atlasiet Paste (Ielīmēt), lai ielīmētu bitkartes attēlu no
starpliktuves lietojumprogrammā.

Bāzlīnijas sliekšņa vērtības iestatījumu modificēšana
Režīmā Single Threshold (Atsevišķa sliekšņa vērtība) var pielāgot fluorofora sliekšņa vērtību,
noklikšķinot uz sliekšņa vērtību rindas diagrammā Amplification (Amplifikācija) un virzot peles rādītāju
vertikāli. Vai arī var norādīt atlasītā fluorofora precīzu šķērsošanas sliekšņa vērtību.

Padoms. Var norādīt cikla diapazonu, lai noteiktu bāzlīniju visiem datu failiem cilnē Data Analysis
(Datu analīze), ejot User > User Preferences (Lietotājs > Lietotāja preferences).
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Sākuma un beigu bāzlīnijas ciklu pielāgošana attiecībā uz katru iedobi

1. Cilnē Quantification (Kvantitatīvā noteikšana) atlasiet atsevišķu fluoroforu diagrammā
Amplification (Amplifikācija).

2. No diagrammas peles labās pogas klikšķa izvēlnes atlasiet Baseline Threshold (Bāzlīnijas
sliekšņa vērtība).

Parādīsies dialoglodziņš Baseline Threshold (Bāzlīnijas sliekšņa vērtība).

3. Sadaļā Baseline Cycles (Bāzlīnijas cikli) veiciet vienu no tālāk norādītajām darbībām:

n Lai atlasītu vienu iedobi, noklikšķiniet uz tā rindas numura.

n Lai atlasītu vairākas blakus esošas iedobes, noklikšķiniet uz pirmās iedobes rindas numura
un velciet kolonnā uz leju līdz beidzamajai iedobei.

n Lai atlasītu vairākas iedobes, kas neatrodas viena otrai blakus, nospiediet vadīšanas
taustiņu un noklikšķiniet uz katras mērķa iedobes rindas numura.

n Lai atlasītu visas iedobes, noklikšķiniet tabulas augšējā kreisajā stūrī.

4. Pielāgojiet bāzlīnijas sākuma ciklu un bāzes līnijas beigu ciklu visām atlasītajām iedobēm vai
mainiet sākuma un beigu cikla numuru izklājlapas apakšā.
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Padoms. Lai atjaunotu iestatījumus uz pēdējā reizē saglabātajām vērtībām, noklikšķiniet uz
Reset All User Defined Values (Atiestatīt visas lietotāja definētās vērtības).

5. Lai saglabātu izmaiņas un atgrieztos pie diagrammas, noklikšķiniet uz OK (Labi).

Ciklu diapazonu norādīšana visiem datu failiem

u Logā Home (Sākums) vai Plate Editor (Trauciņa redaktors) atlasiet User > User Preferences
(Lietotājs > Lietotāja preferences) un izvēlieties cilni Data Analysis (Datu analīze).

Mērķu un paraugu datu kārtošana
Piezīme. Šī opcija ir pieejama tikai gēnu ekspresijas diagrammās.

Pēc noklusējuma saraksti Targets and Samples (Mērķi un paraugi) tiek rādīti alfabētiskā secībā.
Izmantojiet dialoglodziņu Sort (Kārtot), lai kārtotu rādīšanu apvērstā burtu secībā vai lai manuāli
pārvietotu terminu citā pozīcijā sarakstā.

Mērķu un paraugu datu kārtošana

1. No diagrammas peles labās pogas klikšķa izvēlnes noklikšķiniet uz Sort (Kārtot).

Parādīsies dialoglodziņš Gene Expression Chart Sorting (Gēnu ekspresijas diagrammas
kārtošana).
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2. Lai sarakstu kārtotu pretēji alfabētiskajai secībai, dialoglodziņā noklikšķiniet uz Z-A.

3. Lai manuāli pārvietotu terminu, atlasiet to un noklikšķiniet uz attiecīgās pogas starp diagrammām:

n Noklikšķiniet uz augšupvērstās vai lejupvērstās bultiņas, lai pārvietotu atlasīto terminu par
vienu pozīciju.

n Noklikšķiniet uz augšupvērstās vai lejupvērstās joslas bultiņas, lai pārvietotu atlasīto terminu
uz saraksta sākumu vai beigām.

4. Lai saglabātu izmaiņas un atgrieztos cilnē Gene Expression (Gēnu ekspresija), noklikšķiniet uz
OK (Labi).

Apgabala palielināšana diagrammā
Apgabala palielināšana diagrammā

u Noklikšķiniet un velciet pāri diagrammai un pēc tam noklikšķiniet uz Zoom (Tālummaiņa)*.
Programmatūra maina diagrammas izmērus un centrē to atlasītajā apgabalā.

Piezīme. * Joslu diagrammai nav nepieciešama noklikšķināšana uz uznirstošās komandas
Zoom (Tālummaiņa).

Diagrammas pilna skata atiestatīšana

u Ar labo peles pogu noklikšķiniet diagrammā un atlasiet Set Scale to Default (Iestatīt mērogu kā
noklusējumu).

Diagrammu iekopēšana Microsoft failā
Jūs varat iekopēt datu diagrammas Microsoft Word, Excel vai PowerPoint dokumentos. Attēla
izšķirtspēja atbilst ekrāna, no kura iegūts attēls, izšķirtspējai

Diagrammu kopēšana Microsoft failā

1. Logā Data Analysis (Datu analīze) izvēlnē, kurai var piekļūt, noklikšķinot ar peles labo pogu,
atlasiet Copy (Kopēt).

2. Atveriet tukšu Microsoft failu un ielīmējiet starpliktuves saturu.

Alternatīva: noklikšķiniet uz noklikšķināšanas un vilkšanas ikonas un velciet un nometiet
diagrammuMicrosoft failā.
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Izklājlapas
Data Analysis (Datu analīzē) rādītās izklājlapas ietver datu kārtošanas un pārsūtīšanas opcijas.
Kārtojiet kolonnas, izmantojot vienu no tālāk norādītajām metodēm.

n Noklikšķiniet kolonnā un velciet kolonnu uz jaunu atrašanās vietu atlasītajā tabulā.

n Noklikšķiniet uz kolonnas galvenes, lai kārtotu datus augošā vai dilstošā secībā.

Līdz trim datu kolonnu kārtošana logā Sort (Kārtot)

1. Ar peles labo pogu noklikšķiniet izklājlapā un atlasiet Sort (Kārtot).

2. Dialoglodziņā Sort (Kārtot) atlasiet pirmās kārtojamās kolonnas virsrakstu. Kārtojiet datus augošā
vai dilstošā secībā.

3. Atlasiet otro un trešo kārtojamo kolonnu un izvēlieties Ascending (Augošs) vai Descending
(Dilstošs).

4. Noklikšķiniet uz OK (Labi), lai datus kārtotu, vai uz Cancel (Atcelt), lai pārtrauktu kārtošanu.

Iezīmējiet datus saistītajās diagrammās un iedobju atlasītājā, turot peles rādītāju virs šūnas.
Noklikšķiniet šūnā, lai kopētu un ielīmētu tās saturu citā programmatūras programmā.

Izvēlnes, kas pieejama, noklikšķinot ar peles labo pogu, kopējie
vienumi izklājlapām
19. tabula ir uzskaitīti jebkurā izklājlapas skatā pieejamie izvēlnes, kas pieejama, noklikšķinot ar peles
labo pogu, vienumi

Vienums Funkcija

Copy (Kopēt) Kopē atlasīto iedobju saturu starpliktuvē, pēc tam ielīmē saturu
izklājlapā, piemēram, Excel failā.

Copy as Image (Kopēt kā attēlu) Kopē izklājlapas skatu kā attēla failu un ielīmē to failā, kas pieņem
attēla failu, piemēram, teksta, attēla vai izklājlapas failā.

Print (Drukāt) Drukā pašreizējo skatu.

Print Selection (Drukāt atlasi) Drukā pašreizējo atlasi.

19. tabula. Izvēlnes, kas pieejama, noklikšķinot ar peles labo pogu, kopējie vienumi
izklājlapām
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Vienums Funkcija

Export to Excel (Eksportēt uz
Excel)

Eksportē datus uz Excel izklājlapu.

Export to CSV (Eksportēt uz
CSV)

Eksportē datus uz ar komatu atdalīto datu (.csv) failu.

Export to Xml (Eksportēt uz Xml) Eksportē datus uz Xml failu.

Export to Html (Eksportēt uz
Html)

Eksportē datus uz Html failu.

Find (Atrast) Meklē tekstu.

Sort (Kārtot) Kārto datus trīs datu kolonnās.

Select Columns (Atlasīt
kolonnas)

Atlasa kolonnas, kas tiks parādītas izklājlapā.

19. tabula. Izvēlnes, kas pieejama, noklikšķinot ar peles labo pogu, kopējie vienumi
izklājlapām, turpinājums
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9. nodaļa. Pārskats par datu analīzi

Eksports
CFXManager Dx software nodrošina četras eksportēšanas opcijas no nolaižamās izvēlnes Export
(Eksports):

n Export All Data Sheets

n Custom Export (Pielāgots eksports)

n Export to LIMS (Eksportēt uz LIMS)

n Seegene Export (Seegene eksports)

Visu datu lapu eksportēšana
Jūs varat eksportēt visus izklājlapu skatus no katras CFX Manager Dx software cilnes atsevišķos
failos.

Visu datu lapu eksportēšana

u Atlasiet Export > Export All Data Sheets to Excel (Eksports > Eksportēt visas datu lapas
programmā Excel) un tad atlasiet vēlamo faila tipu:

n CSV (*.csv).

n Teksta failu (*.txt).

n Excel 2007 (*.xlsx).

n Excel 2003 (*.xls).

n XML (*.xml).
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Eksports

Pielāgota eksportēšanas faila izveide
Pielāgota eksporta faila izveidošana

1. Atlasiet Export > Custom Export (Eksports > Pielāgots eksports). Atveras dialoglodziņš Custom
Export (Pielāgots eksports).

2. Atlasiet eksportēšanas formātu no parādītā nolaižamā saraksta.

3. Atlasiet eksportējamo vienumu izvēles rūtiņas.

4. (Papildiespēja) Lai mainītu kolonnu nosaukumus, noklikšķiniet uz Customize Column Names
(Pielāgot kolonnu nosaukumus).

5. Noklikšķiniet uz Export (Eksports). Parādīsies dialoglodziņš Save As (Saglabāt kā).

6. Dialoglodziņā Save As (Saglabāt kā) norādiet faila nosaukumu un vietu, kur saglabāt eksportēto
failu.

7. Lai saglabātu eksportēto failu, noklikšķiniet uz OK (Labi).
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9. nodaļa. Pārskats par datu analīzi

Eksportēšana LIMS mapē
Jūs varat eksportēt datus ar LIMS saderīgā faila formātā.

Datu eksportēšana LIMS formātā

1. Atlasiet Export > Export to LIMS Folder (Eksports > Eksportēt LIMS mapē).

Parādīsies dialoglodziņš Save As (Saglabāt kā).

2. Dialoglodziņā Save As (Saglabāt kā) norādiet faila nosaukumu un vietu, kur saglabāt eksportēto
failu.

3. Lai saglabātu eksportēto failu, noklikšķiniet uz OK (Labi).

Seegene formatēto datu eksportēšana
Jūs varat eksportēt datus no visiem izklājlapu skatiem Excel failos, kas īpaši strukturēti Seegene, Inc
vajadzībām.

Datu eksportēšana Seegene specifiskā formātā

1. Atlasiet Export > Seegene Export (Eksports > Seegene eksports).

Parādīsies dialoglodziņš Save As (Saglabāt kā).

2. Dialoglodziņā Save As (Saglabāt kā) norādiet mapes, kurā saglabāt eksportētos Seegene
formatētos Excel (.xlsx) failus, atrašanās vietu.

3. Noklikšķiniet uz OK (Labi), lai saglabātu eksportētos failus.
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10. nodaļa. Datu analīzes detaļas
CFXManager Dx programmatūras logu Data Analysis (Datu analīze) veido daudzas cilnes, no kurām
skatīt datus. Šajā nodaļā minētās cilnes ir detalizēti izskaidrotas.

Padoms. Jūs varat izvēlēties, kuras cilnes logā Data Analysis (Datu analīze) skatīt, izmantojot
izvēlni View (Skatīt). Pielāgotais izkārtojums tiek saglabāts ar datu failu.
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10. nodaļa. Datu analīzes detaļas

Cilne Quantification (Kvantitatīvā noteikšana)
Lietojiet datus cilnē Quantification (Kvantitatīvā noteikšana), lai iestatītu datu analīzes nosacījumus,
ieskaitot bāzlīnijas iestatījumus atsevišķām iedobēm un sliekšņa vērtību iestatījumus. Cilne
Quantification (Kvantitatīvā noteikšana) rāda datus šādos četros skatos:

n Amplification (Amplifikācijas) diagramma— rāda relatīvās fluorescences vienības (RFU(RFV))
attiecībā uz katru iedobi ikvienā ciklā. Katrs trasējums diagrammā reprezentē datus no atsevišķa
fluorofora vienā iedobē.

n Standard curve (Standarta līkne) — redzama tikai tad, ja izpildē ir iekļautas iedobes, kas
apzīmētas kā parauga veida standarts (Std). Standarta līkne rāda sliekšņa vērtības ciklu, kāds
izplānots attiecībā pret sākuma daudzuma log. Leģenda rāda katras iedobes ar standarta
parauga veidu esošā fluorofora reakcijas efektivitāti (E).

n Well selector (Iedobju atlasītājs) — atlasa iedobes ar fluorescences datiem, kurus vēlaties rādīt.

n Spreadsheet (Izklājlapa) — rāda atlasītajās iedobēs savākto datu izklājlapu.

Fluorofora opcijas
Lai rādītu fluorofora datus cilnes Quantification (Kvantitatīvā noteikšana) diagrammās un izklājlapās,
atlasiet mērķa fluoroforu(-s) zem diagrammas Amplification (Amplifikācija). Lai paslēptu fluorofora
datus datu analīzes logā, izņemiet atzīmi no tā izvēles rūtiņas.
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Cilne Quantification (Kvantitatīvā noteikšana)

Dialoglodziņš Trace Styles (Trajektorijas stili)
Izmantojot dialoglodziņu Trace Styles (Trajektorijas stili), jūs varat pielāgot trajektoriju izskatu
amplifikācijas un kušanas līknes diagrammās cilnē Quantification (Kvantitatīvā noteikšana) un cilnē
Melt Curve (Kušanas līkne). Pēc tam jūs varat priekšskatīt izmaiņas iedobju atlasītājā, kas parādās
dialoglodziņā Trace Styles (Trajektorijas stili).

Trajektorijas stilu

1. Diagrammā Quantification (Kvantitatīvā noteikšana) atlasiet tikai vienu fluoroforu.

2. Lai atvērtu dialoglodziņu Trace Styles (Trajektorijas stili), veiciet vienu no tālāk norādītajām
darbībām:

n Diagrammā Amplification (Amplifikācija) noklikšķiniet uz Trace Styles (Trajektorijas stili).

n Izvēļņu joslā Data Analysis (Datu analīze) atlasiet Settings > Trace Styles (Iestatījumi >
Trajektorijas stili).

n Ar peles labo pogu noklikšķiniet uz trajektorijas un atlasiet Trace Styles (Trajektorijas stili).

Parādīsies dialoglodziņš Trace Styles (Trajektorijas stili).

3. Dialoglodziņa Trace Styles (Trajektorijas stili) iedobju atlasītājā, kas pieejams, apakšējā rūtī,
atlasiet noteiktu iedobju komplektu. Vai arī kolonnas Wells (Iedobes) nolaižamajā izvēlnē atlasiet
iedobes, kas satur vienu parauga tipu.
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10. nodaļa. Datu analīzes detaļas

4. Veiciet kādu no tālāk norādītajām darbībām.

n Lai izvēlētos atlasīto iedobju krāsu, kolonnā Color (Krāsa) noklikšķiniet uz lodziņa.

n Lai atlasītajām iedobēm piešķirtu simbolu, nolaižamajā sarakstā Symbol (Simbols) atlasiet
simbolu.

n Lai ātri iekrāsotu iedobes ar pogas etiķeti, noklikšķiniet uz atbilstošas ātrās iestatīšanas
opcijas:

o Random byWell (Nejauša pēc iedobes).

o Random by Replicate (Nejauša pēc kopijas).

o Use Solid Bar Colors (Izmantot fluorofora krāsas).

o Use Target Colors (Izmantot mērķa krāsas).

o Use Sample Colors (Izmantot parauga krāsas).

n Lai piešķirtu iedobju etiķetes, izvēlieties opciju Sample Type (Parauga tips), Target Name
(Mērķa nosaukums), Sample Name (Parauga nosaukums) vai Symbol (Simbols).

Opcija Log Scale (Logaritmiskā skala)
Atlasiet Log Scale (Logaritmiskā skala) zem diagrammas Amplification (Amplifikācija), lai skatītu
fluorescences trasējumus puslogaritma mērogā:

Padoms. Lai palielinātu jebkuru diagrammas apgabalu, velciet pāri mērķa apgabalam. Lai
atgrieztos pilnskata režīmā, ar peles labo pogu noklikšķiniet diagrammā un atlasiet Set Scale to
Default (Iestatīt mērogu uz noklusējumu).
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Cilne Quantification (Kvantitatīvā noteikšana)

Standard Curve (Standarta līknes) diagramma
Programmatūra izveido standarta līknes diagrammu cilnē Quantification (Kvantitatīvā noteikšana), ja
datos ir ietverti paraugu veidi, kas definēti kā Std vismaz vienam izpildē esošam fluoroforam.

Standard Curve (Standarta līknes) diagrammā tiek rādīta šāda informācija:

n Katras līknes (fluorofora vai mērķa) nosaukums.

n Katra fluorofora vai mērķa krāsa.

n Reakcijas efektivitāte (E). Lietojiet šo statistiku, lai optimizētu multipleksu reakciju un vai
vienādotu standarta līknes datus.

Piezīme. Reakcijas efektivitāte raksturo, cik daudz mērķa tiek radīts ar katru protokola ciklu.
100 % efektivitāte norāda, ka mērķis ar katru ciklu tiek dubultots.

n Noteikšanas koeficients, R2 (raksta kā R^2). Lietojiet šo statistiku, lai noteiktu, cik pareizi līnija
raksturo datus (atbilstības labums).

n Gradients

n y krustpunkts
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10. nodaļa. Datu analīzes detaļas

Diagrammas Amplification (Amplifikācija) izvēlnes opcijas
Papildus vispārējām izvēlnes, kurai var piekļūt, noklikšķinot ar peles labo pogu, opcijām, kas
paredzētas diagrammām (skat. Diagrammu kopējie peles labās pogas klikšķa izvēlnes vienumi 179. lpp.),
20. tabula uzskaita izvēlnes opcijas, kas pieejamas tikai diagrammā Amplification (Amplifikācija).

Piezīme. Diagrammā Standard Curve (Standarta līkne) ir sniegtas tikai vispārējās izvēlnes, kurai
var piekļūt, noklikšķinot ar peles labo pogu, opcijas.

Izvēlnes opcija Funkcija

Show Threshold Values (Rādīt
sliekšņa vērtības)

Rāda sliekšņa vērtību katrai amplifikācijas līknei diagrammā.

Trace Styles (Trajektorijas stili) Atver logu Trace Styles (Trajektorijas stili), lai mainītu trajektoriju
stilus, kas parādās cilnē Quantification (Kvantitatīvā noteikšana)
un cilnē Melt Curve (Kušanas līkne).

Baseline Thresholds (Bāzlīnijas
sliekšņa vērtības)

Atver logu Baseline Thresholds (Bāzlīnijas sliekšņa vērtības), lai
mainītu katra fluorofora bāzes līniju vai sliekšņa vērtības (izmaiņas
parādās diagrammas Amplification (Amplifikācija) cilnē
Quantification (Kvantitatīvā noteikšana)).

20. tabula. Diagrammas Amplification (Amplifikācija) izvēlnes, kurai var piekļūt, noklikšķinot
ar peles labo un kreiso pogu, vienumi
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Cilne Quantification (Kvantitatīvā noteikšana)

Kvantitatīvās noteikšanas cilnes izklājlapa
21. tabula definēti dati, kas tiek rādīti izklājlapā cilnē Kvantitatīvā noteikšana.

Informācija Apraksts

Well (Iedobe) Iedobes pozīcija trauciņā

Fluor (Fluors) Noteikts fluorofors

Target (Mērķis) Rīka Plate Editor (Trauciņa redaktors) iedobēs ielādētā mērķa
nosaukums

Content (Saturs) Rīkā Plate Editor (Trauciņa redaktors) parauga veida (obligāts) un
replikāta Nr. (papildiespēja) kombinācija

Paraugs Rīka Plate Editor (Trauciņa redaktors) iedobēs ielādētā parauga
nosaukums

Cq Kvantitatīvās noteikšanas cikls katram trasējumam

21. tabula. Kvantitatīvās noteikšanas cilnes izklājlapas saturs

Mērķa, satura vai parauga datu mainīšana

Jūs varat mainīt datus mērķa, satura un parauga kolonnās, ar rīka Plate Editor (Trauciņa redaktors)
palīdzību rediģējot trauciņa failu, pat pēc eksperimenta izpildes.

Datu maiņa satura, mērķa un parauga kolonnās

u Noklikšķiniet uz Plate Setup (Trauciņa iestatīšana) un atlasiet Wiew/Edit Plate (Skatīt/rediģēt
trauciņu), lai atvērtu Plate Editor (Trauciņa redaktors).
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10. nodaļa. Datu analīzes detaļas

Cilne Quantification Data (Kvantitatīvās noteikšanas dati)
Cilne Quantification Data (Kvantitatīvās noteikšanas dati) rāda katrā iedobē savāktos kvantitatīvās
noteikšanas datus. CFX Manager Dx software rāda datus četros dažādos izklājlapu skatos:

n Results (Rezultāti) — rāda datu izklājlapu. Tas ir noklusējuma skats.

n Standard Curve Results (Standarta līknes rezultāti) — rāda standarta līknes datu izklājlapu.

n Plate (Trauciņš) — rāda datus katrā iedobē, kā arī trauciņa karti.

n RFU (RFV)— rāda katras iedobes RFU (RFV) daudzumus katrā ciklā.

Atlasiet katru izklājlapu no nolaižamā saraksta, kas redzams zem cilnes Quantification Data
(Kvantitatīvās noteikšanas dati).

Izklājlapa Results (Rezultāti)
Izklājlapā Results (Rezultāti) tiek parādīti katras trauciņā esošās iedobes dati.

Piezīme. Visi Std. Dev (Standarta novirze) aprēķini attiecas uz kopiju grupām, kas logā Plate
Editor (Trauciņa redaktors) piešķirtas iedobēm. Aprēķinos tiek iegūta Cq vidējā vērtība katrai
iedobei kopiju grupā.

22. tabula definē datus, kas parādās izklājlapā Results (Rezultāti).

Informācija Apraksts

Well (Iedobe) Iedobes pozīcija trauciņā

Fluor (Fluors) Noteikts fluorofors

22. tabula. Izklājlapas Results (Rezultāti) saturs
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Cilne Quantification Data (Kvantitatīvās noteikšanas dati)

Informācija Apraksts

Target (Mērķis) Amplifikācijas mērķa nosaukums (gēns)

Content (Saturs) Parauga tips un kopijas numurs

Paraugs Parauga apraksts

Biological Set Name
(Bioloģiskā komplekta
nosaukums)

Bioloģiskā komplekta nosaukums

Cq Kvantitatīvās noteikšanas cikls

CqMean (Cq vidējais) Kvantitatīvās noteikšanas cikla vidējais rādītājs kopiju grupai

Cq Std. Dev (Cq standarta
novirze)

Kvantitatīvās noteikšanas cikla standarta novirze kopiju grupai

Starting Quantity (SQ) (Sākuma
daudzums (SQ))

Mērķa sākuma daudzuma aplēse

Log Starting Quantity (SQ) (Log
sākuma daudzums (SQ))

Sākuma daudzuma log

SQMean (SQ vidējais) Sākuma daudzuma vidējā vērtība

SQ Std. Dev (Cq standarta
novirze)

Sākuma daudzuma standarta novirze kopijās

22. tabula. Izklājlapas Results (Rezultāti) saturs, turpinājums
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Izklājlapa Standard Curve Results (Standarta līknes rezultāti)
Standard Curve Results (Standarta līknes rezultāti) izklājlapa rāda aprēķinātos standarta līknes
parametrus.

23. tabula definēti dati, kas parādās Standard Curve Results (Standarta līknes rezultāti) izklājlapā.

Informācija Apraksts

Fluor (or Target) (Fluors (vai
mērķis))

Noteiktais fluorofors (vai mērķis)

Efficiency % (Efektivitāte %) Reakcijas efektivitāte

Slīpums Standarta līknes gradients

Y-intercept (Y krustpunkts) Punkts, kurā līkne krusto y asi

R^2 Noteikšanas koeficients

23. tabula. Standarta līknes rezultātu izklājlapas saturs
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Cilne Quantification Data (Kvantitatīvās noteikšanas dati)

Plate (Trauciņš) izklājlapa
Izklājlapā Plate (Trauciņš) tiek parādīta trauciņu datu karte vienlaicīgi vienam fluoroforam.

Lai skatītu konkrēta fluorofora datus

u Noklikšķiniet uz to cilnes izklājlapas apakšdaļā.

Izklājlapa RFU (RFV)
Izklājlapā RFU (RFV) tiek parādītas relatīvās fluorescences vienības (RFV) katrai iedobei, kas iegūts
katrā izpildes ciklā. Iedobes numurs parādās katras kolonnas augšdaļā, un cikla numurs parādās pa
kreisi no katras rindas.
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Cilne Melt Curve (Kušanas līkne)
Atruna: Bio-Rad nepiešķir nekādas tiesības lietot kušanas līknes analīzi augstas izšķirtspējas
kušanas analīzē cilvēku vai veterinārajā in vitro diagnostikā. Turklāt šīs sistēmas pircēja pienākums ir
iegūt jebkādas intelektuālā īpašuma tiesības, kādas var būt vajadzīgas konkrētajos pielietojumos.

DNA (DNS) saistošo kontrastvielu un neskaldāmās hibridizācijas zonžu gadījumā fluorescence ir
visspilgtākā, kad divas DNA (DNS) dzīslas atkvēlinās. Tādēļ, temperatūrai paaugstinoties kušanas
temperatūras (Tm) virzienā, fluorescence mazinās ar pastāvīgu ātrumu (pastāvīgs gradients). Pie Tm
notiek ievērojams fluorescences samazinājums ar pamanāmu maiņu gradientā. Šīs maiņas ātrumu
nosaka fluorescences negatīvās pirmās regresijas plānošana salīdzinājumā ar temperatūru (-d
(RFU)/dT) (-d(RFV)/dT). Lielākais izmaiņu ātrums fluorescencē rada redzamus maksimumus un
pārstāv Tm, kāda ir divu dzīslu DNA (DNS) kompleksiem.

CFX Manager Dx software plāno RFU (RFV) datus, kas savākti kušanas līknes laikā kā temperatūras
funkcija. Lai analizētu kušanas maksimuma datus, programmatūra piešķir sākuma un beigu
temperatūru katram maksimumam, pārvietojot sliekšņa vērtības joslu. Maksimuma apgabala pamatni
norāda kušanas sliekšņa vērtības josla. Derīga maksimuma minimālajam augstumam jābūt relatīvam
pret attālumu starp sliekšņa vērtības joslu un augstākā maksimuma augstumu.

Cilnē Melt Curve (Kušanas līkne) tiek rādīta Tm (kušanas temperatūra), kāda ir amplificētajiem PCR
produktiem; tas redzams četros skatos:

n Melt Curve (Kušanas līkne) — rāda katra fluorofora reāllaika datus kā RFV uz katras iedobes
temperatūru.

n Melt Peak (Kušanas maksimums) — rāda RFV datu negatīvo regresiju uz katras iedobes
temperatūru.

n Well selector (Iedobju atlasītājs) — rāda iedobes, lai rādītu vai paslēptu datus.

n Peak spreadsheet (Maksimumu izklājlapa) — rāda atlasītajā iedobē savāktos datus.

Piezīme. Šajā izklājlapā tiek rādīti līdz diviem maksimumiem uz katru trasējumu. Lai redzētu
vairāk maksimumu, noklikšķiniet uz cilnes Melt Curve Data (Kušanas līknes dati).
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Cilne Melt Curve (Kušanas līkne)

24. tabula 201. lappusē definēti dati, kas parādās izklājlapā Melt Curve (Kušanas līkne).

Informācija Apraksts

Well (Iedobe) Iedobes pozīcija trauciņā

Fluor (Fluors) Noteikts fluorofors

Content (Saturs) Parauga veida un replikāta numura kombinācija

Sample (Paraugs) Logā Plate Editor (Trauciņa redaktors) ielādētā
parauga nosaukums

Melt Temp (Kušanas temperatūra) Kušanas maksimuma temperatūra attiecībā uz katru
iedobi

Piezīme. Šajā izklājlapā tiek rādīti tikai divi augstākie
maksimumi.

24. tabula. Kušanas līknes izklājlapas saturs
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Melt Curve (Kušanas līkne) datu pielāgošana
Melt Curve (Kušanas līkne) datu pielāgošana

u Veiciet kādu no tālāk norādītajām darbībām.

n Noklikšķiniet un velciet sliekšņa vērtību joslas diagrammāMelt Peak (Kušanas maksimums),
lai iekļautu maksimumus datu analīzē vai izslēgtu no tās.

n Atlasiet Positive (Pozitīvs) nolaižamajā izvēlnē Peaks (Maksimums), lai rādītu to maksimumu
izklājlapu, kas paceļas virs līnijas Melt Threshold (Kušanas sliekšņa vērtība), vai atlasiet
Negative (Negatīvs), lai skatītu to maksimumu izklājlapas datus, kas atrodas zem kušanas
sliekšņa vērtības līnijas.

n Atveriet logu Trace Styles (Trasējumu stili), lai mainītu trasējumu krāsas diagrammās Melt
Curve (Kušanas līkne) un Melt Peak (Kušanas maksimums).

n Atlasiet numuru atlasītājā Step Number (Darbības numurs), lai skatītu Melt Curve (Kušanas
līkne) datus citā protokola darbībā. Šajā sarakstā ir redzams vairāk par vienu darbību, ja
protokolā ir iekļauti trauciņu nolasījumi vairāk nekā vienā kušanas līknes darbībā.

n Iedobju atlasītājā atlasiet iedobes, lai galveno uzmanību pievērstu datu apakškopām.

n Atlasiet iedobju grupu, lai skatītu un analizētu iedobju apakškopu trauciņā. Atlasiet katru
iedobju grupu pēc nosaukuma rīkjoslas nolaižamajā izvēlnē Well Group (Iedobju grupa).
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Cilne Melt Curve Data (Kušanas līknes dati)

Cilne Melt Curve Data (Kušanas līknes dati)
Cilnē Melt Curve Data (Kušanas līknes dati) tiek rādīti dati no cilnes Melt Curve (Kušanas līkne)
daudzās izklājlapās, kas ietver katra trasējuma visas kušanas maksimālās temperatūras vērtības.
piedāvā četras izklājlapu opcijas, kurās skatīt kušanas līknes datus:

n Melt Peaks (Kušanas maksimālā temperatūra) — rāda visus katra trasējuma datus, tostarp visas
kušanas maksimālās temperatūras vērtības. Tas ir noklusējuma skats.

n Plate (Trauciņš) — rāda katras trauciņā esošās iedobes datu un satura skatu.

n RFU (RFV)— rāda katras iedobes RFU daudzumus katrā temperatūrā.

n -d(RFU)/dT (-(d(RFV)/dT)) — rāda negatīvu maiņas koeficientu RFU (RFV), mainoties
temperatūrai (T). Tas ir katras trauciņā esošās iedobes pirmais regresijas plāns.

Atlasiet katru izklājlapu no nolaižamā saraksta, kas redzams zem cilnes Melt Curve Data (Kušanas
līknes dati).

Melt Peaks (Kušanas maksimālā temperatūra) izklājlapa
Melt Peaks (Kušanas maksimālā temperatūra) izklājlapā tiek rādīti visi kušanas līknes dati.

25. tabula 204. lappusē definēti dati, kas parādās Melt Peaks (Kušanas maksimālā temperatūra)
izklājlapā.
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Informācija Apraksts

Well (Iedobe) Iedobes pozīcija trauciņā

Fluor (Fluors) Noteikts fluorofors

Content (Saturs) Logā Plate Editor (Trauciņa redaktors) uzskaitītais parauga veids

Target (Mērķis) Amplifikācijas mērķis (gēns)

Sample (Paraugs) Logā Plate Editor (Trauciņa redaktors) uzskaitītais parauga
nosaukums

Melt Temperature (Kušanas
temperatūra)

Katra produkta kušanas temperatūra, uzskaitīta kā maksimums
(augstākā) katrā rindā šajā izklājlapā

Peak Height (Maksimuma
augstums)

Maksimuma augstums

Begin Temperature (Sākuma
temperatūra)

Temperatūra maksimuma sākumā

End Temperature (Beigu
temperatūra)

Temperatūra maksimuma beigās

25. tabula. Melt Peaks (Kušanas maksimālā temperatūra) izklājlapas saturs

Plate (Trauciņš) izklājlapa
Plate (Trauciņš) izklājlapa rāda kušanas līknes datus trauciņa formātā.

Piezīme. Lai ieregulētu maksimumu, kādu izsauc programmatūra, pielāgojiet sliekšņa vērtības
līniju diagrammāMelt Peak (Kušanas maksimums) cilnē Melt Curve (Kušanas līkne).

26. tabula 205. lappusē definēti dati, kas parādās izklājlapā Plate (Trauciņš).
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Cilne Melt Curve Data (Kušanas līknes dati)

Informācija Apraksts

Content (Saturs) Parauga veida (obligāts) un replikāta Nr. (papildiespēja) kombinācija

Sample (Paraugs) Parauga apraksts

Peak 1 (Maksimums
1)

Pirmais kušanas maksimums (augstākais)

Peak 2 (Maksimums
2)

Otrais (zemākais) kušanas maksimums

26. tabula. Plate (Trauciņš) izklājlapas saturs

Izklājlapa RFU (RFV)
Izklājlapā RFU (RFV) tiek parādīta fluorescence katrai iedobei katrā ciklā, kas iegūts kušanas līknes
laikā.

27. tabula ir definēti dati, kas parādīti izklājlapā RFU (RFV).

Informācija Apraksts

Well number (A1, A2, A3, A4, A5) (Iedobes
numurs)

Iedobes pozīcija ielādēto iedobju trauciņā

Temperature (Temperatūra) Amplificētā mērķa kausēšanas temperatūra,
kas attēlota kā viena iedobe katrā rindā un
vairākas iedobes vairākiem produktiem tajā
pašā iedobē

27. tabula. Izklājlapas RFU (RFV) saturs
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-d(RFU)/dT (-d(RFV)/dT) izklājlapa
-d(RFU)/dT (-d(RFV)/dT) izklājlapa rāda negatīvu maiņas koeficientu RFU (RFV), mainoties
temperatūrai (T).

28. tabula definēti dati, kas parādās izklājlapā -d(RFU)/dT (-d(RFV)/dT).

Informācija Apraksts

Well number (A1, A2, A3, A4,
A5) (Iedobes numurs)

Iedobes pozīcija ielādēto iedobju trauciņā

Temperature -d(RFU)/dT
(Temperatūra -d(RFV)/dT)

Negatīvs maiņas koeficients RFU (RFV), mainoties temperatūrai (T)

28. tabula. -d(RFU)/dT (-d(RFV)/dT) izklājlapas saturs
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Cilne End Point (Galamērķis)

Cilne End Point (Galamērķis)
Atveriet cilni End Point (Galamērķis), lai analizētu paraugu iedobju galīgās relatīvās fluorescences
vienības (RFV). Programmatūra salīdzina iedobju ar nezināmiem paraugiem RFU (RFV) līmeņus ar
iedobju ar negatīvām kontrolēm RFU (RFV) līmeņiem un “nosauc” nezināmo pozitīvu vai negatīvu.
Pozitīviem paraugiem ir RFU (RFV) vērtība, kas ir lielāka par negatīvo kontroļu vidējo RFU (RFV)
vērtību plus bāzes vērtību.

Lai analizētu galapunkta datus, trauciņam jāsatur negatīvās kontroles, vai arī programmatūra nevar
veikt nosaukšanu. Palaidiet vienu no šiem divu veidu protokoliem:

n Palaidiet protokolu Quantification (Kvantitatīvā noteikšana) protokolu — iestatiet standarta
protokolu. Pēc izpildes pabeigšanas atveriet logu Data Analysis (Datu analīze), pielāgojiet datu
analīzes iestatījumus cilnē Quantification (Kvantitatīvā noteikšana) un tad noklikšķiniet uz cilnes
End Point (Galamērķis), lai izvēlētos galamērķa ciklu.

n Palaidiet End Point Only (Tikai galamērķa) protokolu — ielādējiet protokolu End Point Only (Tikai
galamērķis) cilnē Plate (Trauciņš) logā Run Setup (Izpildes iestatīšana), atlasiet vai izveidojiet
trauciņu un palaidiet izpildi

Cilnē End Point (Galamērķis) tiek rādītas vidējās RFU (RFV) vērtības, lai noteiktu, vai pēdējais (beigu)
cikls ir amplificējis mērķi. Lietojiet šos datus, lai noteiktu, vai paraugā ir (pozitīva) konkrēta mērķa
secība. Pozitīviem mērķiem ir augstākas RFU (RFV) vērtības par jūsu definēto bāzes līmeni.
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Padoms. Lai izveidotu galamērķa protokolu, atveriet protokola cilni (logs Run Setup (Izpildes
iestatīšana)) un atlasiet Run > End Point Only Run (Izpilde > Tikai galapunkta izpilde).

Kad izpilde pabeigta, atveras datu fails uz cilni End Point (Galamērķis), ko veido šādas sadaļas:

n Settings (Iestatījumi) — pielāgo datu analīzes iestatījumus.

n Results (Rezultāti) — rāda rezultātus uzreiz pēc iestatījumu pielāgošanas.

n Well Selector (Iedobju atlasītājs) — atlasa iedobes ar galapunkta datiem, kādus vēlaties rādīt.

n RFU spreadsheet (RFV izklājlapa) — rāda atlasītajos iedobēs savāktās RFU (RFV).

Dati rezultātu sadaļā
Sadaļā Results (Rezultāti) ir parādīti tālāk norādītie dati:

n Lowest RFU value (Mazākā RFV vērtība) — datu mazākā RFV vērtība.

n Highest RFU value (Lielākā RFV vērtība) — datu lielākā RFV vērtība.

n Negative Control Average (Negatīvo kontroļu vidējā vērtība) — vidējā RFU (RFV) vērtība
iedobēm, kas satur negatīvās kontroles.

n Cut Off Value (Robežvērtība) — aprēķināta, pievienojot toleranci (iestatījumos norādītos RFU
(RFV) vai Percentage of Range (Diapazona procenti)) un negatīvo kontroļu vidējo vērtību.
Paraugi ar RFV, kas ir lielākas par robežvērtību, tiks saukti par “pozitīviem”. Lai pielāgotu
robežvērtību, mainiet RFU (RFV) vai Percentage of Range (Diapazona procenti).

Cut Off Value (Robežvērtība) tiek aprēķināta, izmantojot tālāk norādīto formulu:

Robežvērtība = Negatīvo kontroļu vidējā vērtība + Tolerance

Atlasiet toleranci, izmantojot vienu no tālāk norādītajām metodēm:

n RFU (RFV) (noklusējuma) — atlasiet šo metodi, lai tolerancei izmantotu absolūto RFU (RFV)
vērtību. Minimālā RFU (RFV) tolerances vērtība ir 2. Maksimālā vērtība ir augstākās RFU (RFV)
vērtības absolūtā vērtība, no kuras atņemta zemākās RFU (RFV) vērtības absolūtā vērtība.
Noklusējuma RFU (RFV) tolerances vērtība ir 10 % no kopējā RFU (RFV) diapazona.

n Percent of Range (Diapazona procenti) — atlasiet šo metodi, lai tolerancei izmantotu RFU (RFV)
diapazona procentuālo daļu. Minimālā diapazona procentu vērtība ir 1 %. Maksimālā diapazona
procentu vērtība ir 99 %. Noklusējuma diapazona procentu vērtība ir 10 %.
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Cilne End Point (Galamērķis)

Galamērķa datu analīzes pielāgošana
Lai pielāgotu datus cilnē End Point (Galamērķis)

u Veiciet kādu no tālāk norādītajām darbībām.

n Izvēlieties fluoroforu no nolaižamā saraksta.

n Izvēlieties vērtību End Cycle to Average (Mērķcikls vidējai vērtībai), lai iestatītu ciklu skaitu,
ar kādu aprēķināt vidējo galapunkta RFU (RFV).

n Atlasiet RFUs (RFV), lai skatītu datus relatīvās fluorescences vienībās.

n Atlasiet Percentage of Range (Diapazona procentuālā attiecība), lai skatītu datus kā RFU
(RFV) diapazona procentuālo attiecību.

n Iedobju atlasītājā atlasiet iedobes, lai galveno uzmanību pievērstu datu apakškopām.

n Atlasiet iedobju grupu, lai skatītu un analizētu iedobju apakškopu trauciņā. Atlasiet katru
iedobju grupu pēc nosaukuma rīkjoslas nolaižamajā izvēlnē Well Group (Iedobju grupa).

RFU (RFV) izklājlapa galamērķa analīzei
29. tabula ir izskaidroti dati, kas parādās cilnes End Point (Galamērķis) izklājlapā RFU (RFV).

Informācija Apraksts

Well (Iedobe) Iedobes pozīcija trauciņā

Fluor (Fluors) Noteikts fluorofors

Content (Saturs) Parauga tipa un kopijas numura kombinācija

End RFU (Beigu RFV) RFU (RFV) galapunkta ciklā

Call (Signāls) Pozitīvais vai negatīvais, ja pozitīvajiem paraugiem RFU (RFV) vērtība ir
lielāka par negatīvo kontroļu vidējo RFV, kam pieskaitīta robežvērtība

Sample (Paraugs) Rīkjoslā Plate Editor (Trauciņa redaktors) ielādētais parauga nosaukums

29. tabula. Izklājlapas End Point (Galamērķis) saturs
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Cilne Allelic Discrimination (Alēliskā diskriminācija)
Cilnē Allelic Discrimination (Alēliskā diskriminācija) iedobēm ar nezināmiem paraugiem tiek piešķirti
genotipi. Izmantojiet šos datus, lai identificētu paraugus ar dažādiem genotipiem, tostarp 1. alēle, 2.
alēle, Heterozigota, Nav signāla (nav amplifikācijas) vai Nav noteikts.

Piezīme. Alēliskās diskriminācijas datiem jānāk no daudzkārtīgām izpildēm vismaz ar diviem
fluoroforiem. Katrs fluorofors visos paraugos identificē vienu alēli.

Alēliskās diskriminācijas analīzei nepieciešams tālāk norādītais minimālais iedobju saturs:

n Divi fluorofori katrā iedobē.

n NTC (bez veidnes kontroles) paraugi optimizētai datu analīzei.

CFX Manager Dx software piedāvā četras opcijas alēliskās diskriminācijas datu skatīšanai:

n Diagramma Allelic Discrimination (Alēliskā diskriminācija) — parāda datus RFV diagrammā
1 alēlei/2. alēlei. Katrs punkts diagrammā parāda datus no abiem fluoroforiem vienā iedobē. Jūs
varat pārslēgties starp Dekarta un polārajām koordinātām, atlasot un notīrot izvēles rūtiņu Polar
Coordinates (Polārās koordinātas). Dekarta koordinātās ir parādītas RFV 1. alēlei uz x ass un
RFV 2. alēlei uz y ass. Polārajās koordinātās ir parādīts leņķis uz x ass un attālums starp sākuma
punktu un RFV uz y ass (visu NTC vidējā vērtība).
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Cilne Allelic Discrimination (Alēliskā diskriminācija)

n Well spreadsheet (Iedobes izklājlapa) — parāda alēliskās diskriminācijas datus, kas savākti katrā
trauciņa iedobē.

n Well selector (Iedobju atlasītājs) — atlasa iedobes ar datiem par alēlēm, kurus vēlaties parādīt.

n Panelis Selected Fluorophores (Atlasītie fluorofori) —maina x un y ass etiķetes alēliskās
diskriminācijas diagrammā, analizējamo ciklu un to, vai parādīt signālu karti.

Alēliskās diskriminācijas datu pielāgošana
Programmatūra automātiski piešķir genotipus iedobēm ar nezināmiem paraugiem, pamatojoties uz
NTCs (NTC) un nezināmo datu punktu leņķa un attāluma no NTCs (NTC).

Alēliskās diskriminācijas datu pielāgošana

u Veiciet kādu no tālāk norādītajām darbībām.

n Lai parādītu polāras koordinātas, atlasiet izvēles rūtiņu diagrammā Allelic Discrimination
(Alēliskā diskriminācija).

n Lai skatītu citu fluoroforu, izvēlieties to paneļa Selected Fluorophores (Atlasītie fluorofori)
nolaižamajā sarakstā.

n Lai mainītu signālu, velciet pāri datu punktam(-iem) diagrammā Allelic Discrimination
(Alēliskā diskriminācija) un izvēlieties opciju sarakstā Atlasītās iedobes:

o Allele 1 (1. alēle)

o Allele 2 (2. alēle)

o Heterozygote (Heterozigota)

o Undetermined (Nav noteikts)

o No Call (Nav signāla)

o Auto Call (Automātiskais signāls)

Padoms. Atlasiet Auto Call (Automātiskais signāls), lai atjaunotu noklusējuma signālu.
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Diagrammas izvēlnes opcijas
Papildus vispārējām izvēlnes, kurai var piekļūt, noklikšķinot ar peles labo pogu, opcijām, kas
paredzētas diagrammām (skatīt Diagrammu kopējie peles labās pogas klikšķa izvēlnes vienumi 179. lpp.),
30. tabula uzskaita izvēlnes opcijas, kas pieejamas diagrammā Allelic Discrimination (Alēliskā
diskriminācija).

Izvēlnes opcija Funkcija

Zoom (Tālummaiņa) Fokusē diagrammas skatu uz atlasīto apgabalu (noklikšķinot un
velkot kursoru diagrammā).

Padoms. Lai atjaunotu tālummaiņu visu datu punktu
rādīšanai, noklikšķiniet ar peles labo pogu un atlasiet Set
Scale to Default (Iestatīt mērogu kā noklusējumu).

Well (Iedobe) Atlasītajai iedobei ir šādas opcijas: parādīt tikai šo iedobi, noņemt
šo iedobi no skata, iestatīt krāsu šai trajektorijai vai izslēgt šīs
iedobes no analīzes.

Selected Wells (Atlasītās
iedobes)

Atlasītajām iedobēm (atlasīti, noklikšķinot un velkot kursoru
diagrammā) ir šādas opcijas: parādīt tikai šīs iedobes, noņemt šīs
iedobes no skata, iestatīt krāsu šīm trajektorijām vai izslēgt šīs
iedobes no analīzes.

30. tabula. Diagrammas Allelic Discrimination (Alēliskā diskriminācija) labās un kreisās
izvēlnes opcijas
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Cilne Allelic Discrimination (Alēliskā diskriminācija)

Izklājlapa Allelic Discrimination (Alēliskā diskriminācija)
31. tabula definē datus, kas parādās izklājlapā Allelic Discrimination (Alēliskā diskriminācija).

Informācija Apraksts

Well (Iedobe) Iedobes pozīcija trauciņā

Sample (Paraugs) Parauga nosaukuma apraksts

Call (Signāls) Alēles identitāte, ieskaitot automātisko Allele 1 (1. alēle), Allele 2
(2. alēle), Heterozygote (Heterozigota), No Call (Nav signāla) vai
Undetermined (Nav noteikts)

Type (Veids) Auto (Automatic) (Automātiski) vai Manual (Manuāli) raksturo, kā
veikts izsaukums. Automatic (Automātiski) norāda, ka izsaukumu
izvēlējās programmatūra. Manual (Manuāli) norāda, ka izsaukumu
izvēlējās lietotājs

RFU1 (RFV1) RFU (RFV) Allele1 gadījumā

RFU2 (RFV2) RFU (RFV) Allele2 gadījumā

31. tabula. Izklājlapas Allelic Discrimination (Alēliskā diskriminācija) saturs
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Cilne Custom Data View (Pielāgota datu skatīšana)
Cilne Custom Data View (Pielāgota datu skatīšana) vienlaicīgi rāda vairākas rūtis pielāgojamā
formātā.

Nolaižamajā sarakstā Load a Preset View (Ielādēt iepriekš iestatītu skatu) tiek piedāvāta rādījuma
formāta veidņu izlase. Rādītais noklusējuma skats ir atkarīgs no analizētā faila. Piemēram, ja ir
redzami opcijas Melt Curve (Kušanas līkne) dati, parādās noklusējuma skats Amp+Melt
(Ampl.+Kausēšana).
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Cilne Custom Data View (Pielāgota datu skatīšana)

Pielāgota datu skata izveide
Pielāgota datu skata izveide

u Veiciet kādu no tālāk norādītajām darbībām.

n Nolaižamajā sarakstā atlasiet izvēles priekšiestatītu skatu.

n Nolaižamajā sarakstā, kas atrodas katras atsevišķās rūts augšā, atlasiet citu diagrammas
skatu.

n Mainiet rindu un kolonnu skaitu cilnē.

n Mainiet atsevišķās rūts izmērus. Velciet joslas katras rūts perifērijā.

Lai pielāgoto veidni saglabātu kā priekšiestatītu veidni, noklikšķiniet uz Save as Preset (Saglabāt kā
priekšiestatītu). Lai dzēstu, pārdēvētu vai atjaunotu esošos priekšiestatītos skatus, noklikšķiniet uz
Manage Presets (Pārvaldīt priekšiestatītos).
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Cilne QC (KK)
Izmantojiet cilni QC (KK), lai ātri novērtētu izpildes datu kvalitāti, balstoties uz noteikumiem, kas
definēti loga cilnē QC (KK).

CFX Manager Dx software piedāvā četras opcijas QC (KK) datu skatīšanai:

n Diagramma Amplification (Amplifikācijas)— rāda katras iedobes RFV katrā ciklā. Katrs
trasējums diagrammā reprezentē datus no atsevišķa fluorofora vienā iedobē.

n Tabula QC rules (KK noteikumi)—parāda pieejamos QC (KK) noteikumus un iestatījumus,
kas definē katru noteikumu. Lietotie QC (KK) noteikumi tiek norādīti ar atzīmi.

n Well selector (Iedobju atlasītājs)—atlasa iedobes ar fluorescences datiem, kurus vēlaties
rādīt.

n Rūts QC rule summary (KK noteikumu kopsavilkums)—parāda atlasīto QC (KK) noteikumu
un izceļ iedobes, kas neatbilst noteikuma prasībām.

QC (KK) kritēriju maiņa
QC (KK) kritēriju mainīšana

u Ielieciet atzīmi izvēles rūtiņā Use (Lietot), lai noteikumu iekļautu QC (KK), vai arī izņemiet atzīmi
no izvēles rūtiņu, lai noteikumu no tās izslēgtu.
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Cilne QC (KK)

Iedobju ar neatbilstošiem QC (KK) rezultātiem izslēgšana
CFXManager Dx software QC (KK) noteikumu tabulas kolonnā Results (Rezultāti) un kopsavilkuma
rūtī parāda iedobes, kas neatbilst QC (KK) kritērijiem.

Iedobju ar neatbilstošiem QC (KK) rezultātiem izslēgšana

u Atlasiet opciju Exclude Wells (Izslēgt iedobes) katrai izslēdzamajai iedobei.
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Cilne Run Information (Informācija par izpildi)
Cilnē Run Information (Informācija par izpildi) tiek parādīts protokols un cita informācija par katru
izpildi. Izmantojiet šo cilni, lai veiktu tālāk aprakstītās darbības.

n Skatīt protokolu.

n Ievadīt vai rediģēt piezīmes par izpildi.

n Ievadīt vai rediģēt izpildes ID vai svītrkodu.

n Skatīt notikumus, kas var parādīties izpildes laikā. Izmantot šos ziņojumus, lai palīdzētu novērst
izpildes problēmas.

Padoms. Ar peles labo pogu noklikšķiniet uz protokola, lai to kopētu, eksportētu vai izdrukātu. Ar
peles labo pogu noklikšķiniet uz rūtīm Notes (Piezīmes), ID/Bar Code (ID/svītrkods) vai Other
(Cits), lai izgrieztu, kopētu, ielīmētu, dzēstu vai atlasītu tekstu.
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Datu analīzes atskaites

Datu analīzes atskaites
Dialoglodziņā Report (Atskaite) tiek rādīta informācija par pašreizējo datu failu logā Data Analysis
(Kušanas pētījums). Lai atvērtu atskaiti, atlasiet Tools > Reports.

Dialoglodziņu Report (Atskaite) veido tālāk norādītās sadaļas.

n Izvēlne un rīkjosla — sniedz atskaites vai veidnes formatēšanas, saglabāšanas un drukāšanas
iespējas.

n Opciju saraksts (dialoglodziņa augšējā malā pa kreisi) — nodrošina atskaitē rādāmās iespējas.

n Opciju rūts (dialoglodziņa apakšējā malā pa kreisi) — rāda tekstlodziņus, kuros var ievadīt
informāciju par atlasīto opciju.

n Priekšskatījuma rūts (dialoglodziņa labajā pusē) — rāda pašreizējās atskaites priekšskatījumu.
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Datu analīzes atskaišu kategorijas
32. tabula ir uzskaitītas visas opcijas, kas pieejamas datu analīzes atskaitei atkarībā no logā Data
Analysis (Datu analīze) parādītā datu tipa.

Kategorija Opcija Apraksts

Header (Galvene)

Atskaites virsraksts, apakšvirsraksts un
logotips

Report Information (Informācija
par atskaiti)

Izpildes datums, lietotājvārds, datu faila
nosaukums, datu faila ceļš un atlasītā
iedobju grupa

Audit Information (Informācija
par auditu)

Papildinformācija, kas nepieciešama
auditēšanai, tostarp paraksti

Notes (Piezīmes) Piezīmes par datu atskaiti

Run Setup (Izpildes iestatīšana)

Run Information (Informācija
par izpildi)

Izpildes datums, lietotājvārds, datu faila
nosaukums, datu faila ceļš un atlasītā
iedobju grupa

Protocol (Protokols) Protokola darbību un opciju teksta skats

Plate Display (Trauciņa
rādījums)

Trauciņa skats ar informāciju par katru
trauciņa iedobi.

Quantification (Kvantitatīvā noteikšana)

Analysis Settings (Analīzes
iestatījumi)

Datu vākšanas darbības numurs,
analīzes režīms un bāzlīnijas
atņemšanas metode

Amplification Chart
(Amplifikācijas diagramma)

Amplifikācijas diagramma izpildēm, kas
ietver kvantitatīvās noteikšanas datus

Standard Curve Chart
(Standarta līknes diagramma)

Standarta līknes diagramma

32. tabula. Datu analīzes atskaišu kategorijas opciju sarakstā
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Kategorija Opcija Apraksts

Data (Dati) Izklājlapa, kurā uzskaitīti dati par katru
iedobi

Gene Expression — Bar Chart (Gēnu ekspresija — joslu diagramma)

Analysis Settings (Analīzes
iestatījumi)

Analīzes režīms, diagrammas dati,
mērogošanas opcija un diagrammas
kļūda

Chart (Diagramma) Joslu diagrammas kopija

Target Names (Mērķa
nosaukumi)

Mērķa nosaukumu diagramma

Sample Names (Paraugu
nosaukumi)

Paraugu nosaukumu diagramma

Data (Dati) Izklājlapa, kurā uzskaitīti dati par katru
iedobi

Target Stability (Mērķa
stabilitāte)

Mērķa stabilitātes vērtību diagramma

Gene Expression (Gēnu ekspresija) — klastergramma un izkliedes diagramma

Analysis Settings (Analīzes
iestatījumi)

Katra diagrammas veida iestatījumi

Chart (Diagramma) Diagrammas kopija

Data (Dati) Izklājlapa, kurā uzskaitīti dati katrā
mērķī

Melt Curve (Kušanas līkne)

Analysis Settings (Analīzes
iestatījumi)

Kušanas darbības numurs un sliekšņa
vērtības joslas iestatījums

Kušanas līknes diagramma Kušanas līknes diagramma

32. tabula. Datu analīzes atskaišu kategorijas opciju sarakstā, turpinājums
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Kategorija Opcija Apraksts

Diagramma Melt Peak
(Kušanas maksimālā
temperatūra)

Kušanas maksimālās temperatūras
diagramma

Data (Dati) Izklājlapa, kurā uzskaitīti dati par katru
iedobi

Allelic Discrimination (Alēliskā diskriminācija)

Analysis Settings (Analīzes
iestatījumi)

Parāda fluoroforus, ciklu un skata
signālu karti

Allelic Discrimination Chart
(Diagramma Alēliskā
diskriminācija)

Alēliskās diskriminācijas diagrammas
kopija

Data (Dati) Izklājlapa, kurā uzskaitīti dati par katru
iedobi

End Point (Galamērķis)

Analysis Settings (Analīzes
iestatījumi)

Fluorofors, beigu cikli līdz vidējai
vērtībai, režīms, mazākā RFV, augstākā
RFV un robežvērtība

Data (Dati) Izklājlapa, kurā uzskaitīti dati par katru
iedobi

QC Parameters (KK parametri)

Data (Dati) Izklājlapa, kurā uzskaitīti parametri
katram QC (KK) noteikumam

32. tabula. Datu analīzes atskaišu kategorijas opciju sarakstā, turpinājums
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Datu analīzes atskaites

Datu analīzes atskaites izveide
Atskaites izkārtojumu var saglabāt kā veidni, kuru var lietot atkārtoti līdzīgām atskaitēm.

Datu analīzes atskaites izveide

1. Pirms atskaites veidošanas veiciet galīgos pielāgojumus iedobju saturā, atlasītajās iedobēs,
diagrammās un izklājlapās logā Data Analysis (Datu analīze).

2. Atlasiet Tools > Reports (Rīki > Atskaites) izvēlnes joslā Data Analysis (Datu analīze), lai atvērtu
dialoglodziņu Report (Atskaite).

3. Izvēlieties opcijas, kuras vēlaties iekļaut atskaitē. Atskaite atveras ar atlasītām noklusējuma
opcijām. Ielieciet atzīmes izvēles rūtiņās vai arī izņemiet atzīmes no tām, lai mainītu veselas
kategorijas vai tikai atsevišķas opcijas kategorijas robežās.

Piezīme. Dati, kas parādās atskaitē, ir atkarīgi no pašreizējām atlasēm cilnēs logā Data
Analysis (Kušanas pētījums). Piemēram, kvantitātes noteikšanas izpilde var nesaturēt
standarta līkni un tādēļ šie dati neparādās logā Data Analysis (Datu analīze) vai datu
atskaitē.

4. Mainiet kategoriju un vienumu secību atskaitē. Aizvelciet opcijas uz attiecīgo pozīciju. Vienumus
var pārkārtot tikai to kategoriju robežās, pie kurām šie vienumi pieder.

5. (Papildiespēja) Rūtī Report Options (Atskaites opcijas) ievadiet informāciju, kas attiecas uz
atlasīto opciju:

n Izvēlieties atskaitē rādāmo informācijas apakškopu.

n Izvēlieties konkrētus iestatījumus atlasītajai opcijai.

n Mainiet tekstu, kāds jārāda attiecībā uz atlasīto opciju.

6. Noklikšķiniet uz Update Report (Atjaunināt atskaiti), lai atjauninātu Report Preview (Atskaites
priekšskatījumu) ar visām izmaiņām.

7. Izdrukājiet vai saglabājiet atskaiti. Lai izdrukātu pašreizējo atskaiti, noklikšķiniet uz pogas Print
Report (Drukāt atskaiti) rīkjoslā. Atlasiet File > Save (Fails > Saglabāt), lai saglabātu atskaiti PDF
(Adobe Acrobat Reader fails) formātā un atlasiet vietu, kurā failu saglabāt. Select File > Save As
(Atlasīt failu > Saglabāt kā), lai saglabātu atskaiti ar jaunu nosaukumu vai jaunā atrašanās vietā.

8. (Papildiespēja) Izveidojiet atskaites veidni ar tādu informāciju, kādu vēlaties. Lai saglabātu
pašreizējos atskaites iestatījumus veidnē, atlasiet Template > Save (Veidne > Saglabāt) vai Save
As (Saglabāt kā). Pēc tam nākamajā reizē, kad vēlaties veidot jaunu atskaiti, ielādējiet atskaites
veidni.
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Iedobju grupas atskaišu izveide
Iedobju grupas atskaites izveide

1. Atlasiet Tools > Well Group Reports (Rīki > Iedobju grupu atskaites) logā Data Analysis (Datu
analīze).

2. Dialoglodziņā Well Groups Reports (Iedobju grupu atskaites) atlasiet iedobju grupas,
amplifikācijas darbības un kušanas darbības, lai iekļautu atskaitē.

3. Ievadiet ceļu vai navigējiet līdz galamērķa mapei, kurā atskaiti saglabāt.

4. (Papildiespēja) Atlasiet Choose a Report Template (Izvēlēties atskaites veidni) un navigējiet līdz
veidņu failu mapei.

5. (Papildiespēja) Atlasiet Open Destination Folder (Atvērt galamērķa mapi), lai mapi atvērtu un
skatītu atskaites pēc tam, kad tās ģenerētas.

6. Noklikšķiniet uz Create Reports (Izveidot atskaites).
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11. nodaļa. Gēnu ekspresijas analīze
Lietojot reakcijās stingri kvalificētas kontroles, jūs varat izmantot CFX Manager Dx programmatūru, lai
veiktu gēnu ekspresijas izpildi un normalizētu relatīvās atšķirības mērķu koncentrācijā starp
paraugiem. Parasti interesējošā gēna ekspresijas līmeņu normalizēšanā lieto viena vai vairāku
interesējošo gēnu ekspresijas līmeņus. Atsauces gēni ņem vērā ielādēšanas atšķirības vai citas
variācijas, kādas reprezentētas katrā paraugā, un to ekspresijas līmeņi nedrīkst tikt ietekmēti
pētāmajā bioloģiskajā sistēmā.

Izvēlieties cilni Gene Expression (Gēnu ekspresija) logā Data Analysis (Datu analīze), lai izvērtētu
relatīvās atšķirības starp PCR reakcijām divās vai vairākās iedobēs. Piemēram, varat izvērtēt virusālo
genomu relatīvos skaitus vai transfektēto secību relatīvos skaitus PCR reakcijā. Izplatītākais
pielietojums gēnu ekspresijas pētījumā ir cDNA (cDNS) koncentrācijas salīdzinājums vairāk nekā
vienā reakcijā, lai izvērtētu stabila stāvokļa ziņotāja RNS līmeņus.

Programmatūra aprēķina mērķa relatīvās ekspresijas līmeni vienā no šiem scenārijiem:

n Mērķa secības (1. mērķis) relatīvās ekspresijas līmenis attiecībā pret citu mērķi (2. mērķis);
piemēram, viena gēna daudzums attiecībā pret citu gēnu vienādas paraugu apstrādes apstākļos.

n Vienas mērķa secības relatīvais ekspresijas līmenis vienā paraugā salīdzinājumā ar to pašu
mērķi atšķirīgas parauga apstrādes apstākļos; piemēram, viena gēna relatīvais daudzums
attiecībā pašam pret sevi dažādos laika, ģeogrāfijas vai attīstības stāvokļos.

Trauciņa iestatīšana gēnu ekspresijas analīzei
Lai veiktu gēnu ekspresijas analīzi, iedobju saturā jābūt iekļautiem šādiem vienumiem:

n Diviem vai vairākiem mērķiem— divi mērķi, kas reprezentē dažādus amplificētus gēnus vai
secības jūsu paraugos.

n Vienam vai vairākiem atsauces mērķiem— normalizētas ekspresijas gadījumā vismaz vienam
mērķim jābūt atsauces mērķim. Piešķiriet visus mērķus logā Experiment Settings (Eksperimenta
iestatījumi), lai analizētu datus normalizētas ekspresijas režīmā (ΔΔCq). Virknes, kas nesatur
atsauci, jāanalizē, izmantojot relatīvās ekspresijas režīmu (ΔCq).
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n Kopēji paraugi — reakcijām jāietver kopēji paraugi (vajadzīgi vismaz divi), lai skatītu savus datus,
plānotus cilnē Gene Expression (Gēnu ekspresija). Šiem paraugiem jāpārstāv dažādas
apstrādes vai nosacījumus attiecībā uz katru no jūsu mērķu secībām. Piešķiriet kontroles
paraugu (papildiespēja) logā Experiment Settings (Eksperimenta iestatījumi). Ja kontrole nav
atlasīta, programmatūra kā kontroli izmanto zemāko Cq.

Gēnu ekspresijas iestatīšanas prasības logā Plate Editor (Trauciņa redaktors) ir atkarīgas no tā, vai
reakcijas saturs ir vienkārtējs (singleplex) PCR, ar vienu fluoroforu reakcijās, vai daudzkārtējs
(multiplex) PCR, ar vairāk par vienu fluoroforu reakcijās.

Pakāpeniskā trauciņa iestatīšana
Ja datu faila trauciņa iestatīšana nesatur informāciju, kas nepieciešama analīzei, un ir atlasīta cilne
Gene Expression (Gēnu ekspresija), vieta, ko parasti aizņem joslu diagramma, saturēs norādījumus
par šīs informācijas ievadīšanu. Normalizētas gēnu ekspresijas veikšanai veiciet tālāk aprakstītās
darbības:

1. Definējiet vienumu Target (Mērķis) un Sample (Paraugs) nosaukumus, izmantojot jebkuru no
tālāk minētajām opcijām:

n Plate Setup (Trauciņa iestatīšana) — atver logu Plate Editor (Trauciņa redaktors).

n Replace Plate File (Nomainīt trauciņa failu) — atver pārlūkprogrammu Select Plate (Atlasīt
trauciņu), kurā varat navigēt uz iepriekš saglabāto trauciņa failu, ar kuru nomainīt esošo
trauciņu izkārtojumu.

n Replace PrimePCR File (Nomainīt PrimePCR failu) — atver faila dialoglodziņu Select
PrimePCR (Atlasīt PrimePCR), kurā varat navigēt uz izpildes failu PrimePCR un lietot to
trauciņu izkārtojumam.

2. Atlasiet vienu vai vairākus atsauces mērķus un kontroles paraugu, izmantojot dialoglodziņu
Experiment Settings (Eksperimenta iestatījumi).

Ja trauciņu izkārtojums jau satur mērķa un parauga informāciju, jāveic tikai otra darbība un tas ir
izcelts oranžā krāsā. Šī darbība jāpabeidz, pirms var notikt normalizētas gēnu ekspresijas
analīze.

Piezīme. Klastergrammas un izkliedes diagrammas dati tiek parādīti vienīgi tad, ja ir
izpildītas visas prasības attiecībā uz normalizētu gēnu ekspresiju, kas uzskaitītas gēnu
ekspresijas analīzes opcijā Plate Setup (Trauciņa iestatīšana).
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Diagrammas Gene Expression (Gēnu ekspresija)

Diagrammas Gene Expression (Gēnu ekspresija)
CFXManager Dx programmatūra vairākos skatos parāda gēnu ekspresijas datus. 33. tabula ir
uzskaitītas diagrammas opcijas, kas pieejamas programmatūrā.

Poga Nosaukums Funkcija

Joslu diagramma Parāda normalizētus gēnu ekspresijas datus
joslu diagrammas formātā.

Klastergramma Parāda normalizētas ekspresijas datus
hierarhijā, balstoties uz ekspresijas līdzības
pakāpi dažādiem mērķiem un paraugiem.

Izkliedes diagramma Parāda mērķu normalizētu ekspresiju
kontrolei salīdzinājumā ar eksperimenta
paraugu.

Rezultāti Apkopo datus no visām diagrammām.

33. tabula. Diagrammas Gene Expression (Gēnu ekspresija) opcijas
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Joslu diagramma

Mērķu relatīvā ekspresija ir prezentēta šajos divos skatos:

n Gēnu ekspresijas diagramma— rāda reāllaika PCR datus kā vienu no šīm:

o ΔΔCq — relatīvā normalizēta ekspresija, ko aprēķina, izmantojot kontrolparaugus un atsauces
mērķus.

o ΔCq — mērķa gēna relatīvais daudzums paraugā attiecībā pret kontrolparaugu.
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Joslu diagramma

n Izklājlapa — rāda gēnu ekspresijas datu izklājlapu.

Padoms. Noklikšķiniet ar peles labo pogu jebkurā diagrammā vai izklājlapā, lai skatītu
piedāvātās opcijas. Atlasiet opciju View/Edit Plate (Skatīt/Rediģēt trauciņu) no nolaižamās
izvēlnes Plate Setup (Trauciņa iestatīšana), lai atvērtu logu Plate Editor (Trauciņa redaktors)
un mainītu iedobes saturu trauciņā.

Padoms. No peles labās pogas klikšķa izvēlnes atlasiet Sort (Kārtot), lai pārkārtotu Target
(Mērķis) un Sample (Paraugs) nosaukumu secību diagrammā.

Normalizēta gēnu ekspresija

Lai normalizētu datus, lietojiet viena vai vairāku atsauces gēnu izmērīto ekspresijas līmeni kā
normēšanas koeficientu. Atsauces gēni ir mērķi, kas nav regulēti pētāmajā bioloģiskajā sistēmā, tādi
kā aktīns,GAPDH vai tubulīns.

Normalizētas gēnu ekspresijas (ΔΔCq) analīzes iestatīšana

1. Atveriet datu failu (paplašinājums .pcrd).

2. Pārskatiet datus, kas atrodas cilnes Quantification (Kvantitatīvā noteikšana) logā Data Analysis
(Datu analīze). Veiciet datu pielāgošanu, piemēram, mainiet sliekšņa vērtību un analīzes režīmu.

3. Izvēlieties cilni Gene Expression (Gēnu ekspresija).

4. Cilnē Gene Expression (Gēnu ekspresija) noklikšķiniet uz Experiment Settings (Eksperimenta
iestatījumi).

5. Dialoglodziņā Experiment Settings (Eksperimenta iestatījumi) veiciet tālāk norādītās darbības.

a. Izvēlieties cilni Samples (Paraugi) un atlasiet kontroli. Kad kontrole ir piešķirta, CFX Manager Dx
software normalizē visu gēnu relatīvos daudzumus uz kontroles daudzumu, kas iestatīts uz 1.

b. Izvēlieties cilni Target (Mērķis) un atlasiet atsauces gēnus. Gēnu ekspresijas analīzē ir
vajadzīga viena atsauce starp mērķiem jūsu paraugos.

6. Atlasiet Normalized Expression (ΔΔCq) (Normalizēta ekspresija (ΔΔC)), ja tā nav jau atlasīta, un
tad skatiet ekspresijas līmeņus cilnē Gene Expression (Gēnu ekspresija).
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Relatīvais daudzums

Pēc definīcijas relatīvā daudzuma (ΔCq) dati netiek normalizēti. Šo metodi lieto, lai kvantificētu
paraugus, kuros nav iekļauts neviens atsauces gēns (mērķis). Parasti pētnieki ir pārliecināti par vienu
no šādiem apsvērumiem, kad iestata savu virkni:

n Katrs paraugs satur vienu un to pašu daudzumu RNA (RNS) vai cDNA (cDNS) katrā iedobē.

n Jebkura dispersija ielādētā bioloģiskā parauga daudzumā tiks normalizēta pēc izpildes, izmantojot
kādu metodi datu analīzē ārpus programmatūras. Piemēram, pētnieks var izvēlēties dalīt relatīvā
daudzuma vērtību ar normalizēšanas koeficientu, iespējami ar katram paraugam ielādētās
nukleīnskābes masu vai šūnu skaitu, no kurām nukleīnskābe izolēta.

Relatīvā daudzuma (ΔCq) analīzes izpilde

u Cilnē Gene Expression (Gēnu ekspresija) atlasiet Relative Quantity (ΔCq) (Relatīvais daudzums
(ΔCq)) no nolaižamā saraksta Mode (Režīms) labās puses rūtī.

Padoms. Lai salīdzinātu rezultātus ar datiem no citām gēnu ekspresijas virknēm, atveriet
jaunu gēnu pētījumu vai pievienojiet datu failu esošam gēnu pētījumam.

Mērķu un paraugu datu kārtošana
Piezīme. Šī opcija ir pieejama tikai gēnu ekspresijas diagrammās.

Pēc noklusējuma saraksti Targets and Samples (Mērķi un paraugi) tiek rādīti alfabētiskā secībā.
Izmantojiet dialoglodziņu Sort (Kārtot), lai kārtotu rādīšanu apvērstā burtu secībā vai lai manuāli
pārvietotu terminu citā pozīcijā sarakstā.

Mērķu un paraugu datu kārtošana

1. No diagrammas peles labās pogas klikšķa izvēlnes noklikšķiniet uz Sort (Kārtot).

Parādīsies dialoglodziņš Gene Expression Chart Sorting (Gēnu ekspresijas diagrammas
kārtošana).

230 | CFX96 Dx un CFX96 DeepWell Dx sistēmas



Joslu diagramma

2. Lai sarakstu kārtotu pretēji alfabētiskajai secībai, dialoglodziņā noklikšķiniet uz Z-A.

3. Lai manuāli pārvietotu terminu, atlasiet to un noklikšķiniet uz attiecīgās pogas starp diagrammām:

n Noklikšķiniet uz augšupvērstās vai lejupvērstās bultiņas, lai pārvietotu atlasīto terminu par
vienu pozīciju.

n Noklikšķiniet uz augšupvērstās vai lejupvērstās joslas bultiņas, lai pārvietotu atlasīto terminu
uz saraksta sākumu vai beigām.

4. Lai saglabātu izmaiņas un atgrieztos cilnē Gene Expression (Gēnu ekspresija), noklikšķiniet uz
OK (Labi).

Gēnu ekspresijas datu pielāgošana
Pēc jūsu analīzes režīma— normalizētas ekspresijas (∆∆Cq) vai relatīvā daudzuma (∆Cq) — atlases
pielāgojiet cilnē Gene Expression (Gēnu ekspresija) redzamos datus, mainot iestatījumu opcijas pa
labi no diagrammas.

Padoms. Jūs varat iestatīt noklusējuma Gene Expression (Gēnu ekspresija) datu opcijas
dialoglodziņā User Preferences (Lietotāja preferences) (skat. Noklusējuma gēnu ekspresijas datu faila
parametru iestatīšana 69. lpp.).

Grafika dati

Iestatiet y ass vērtību uz lineārās skalas, lai iespējotu grafika datu opcijas. Grafika datu opcijas ļauj
parādīt datus grafikā ar vienu no tālāk norādītajām opcijām:

n Relative to control (Attiecībā pret kontroli) — zīmējiet grafika datus ar ass mērogu no 0 līdz 1. Ja
jūs izpildē piešķirat kontroli, atlasiet šo opciju, lai ātri vizualizētu mērķa ekspresijas līmeņa
paaugstināšanu un pazemināšanu.

n Relative to zero (Attiecībā pret nulli) — zīmējiet grafika datus ar sākuma punktu nullē.

Kontroles paraugs

Izmantojiet nolaižamo izvēlni Kontroles paraugs, lai atlasītu paraugu kas tiks izmantota, lai
normalizētu Relative Quantity (Relatīvais daudzums):

Diagrammas iestatījumi

Atzīmējot lodziņu Show Chart Settings (Rādīt diagrammas iestatījumus), tiek atklātas tālāk minētās
opcijas (aprakstītas zemāk): X-Axis (X ass), Y-Axis (Y ass), Scaling (Mērogošana), Error Type (Kļūdas
tips) un Chart Error Multiplier (Diagrammas kļūdas reizinātājs).
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X ass opcijas

X ass opcija sniedz iespēju atlasīt gēnu ekspresijas diagrammas x ass datus:

n Target (Mērķis) — grafiski attēlo mērķa nosaukumus uz x ass.

n Sample (Paraugs) — grafiski attēlo paraugu nosaukumus uz x ass.

Y ass opcijas

Y ass opcija ļauj rādīt diagrammu Gebe Expression (Gēnu ekspresija) uz vienas no tālāk norādītajām
skalām:

n Linerārā— atlasiet šo opciju, lai rādītu lineāro skalu.

Padoms. Y ass iestatījums Linear (Lineārā) iespējo nolaižamo sarakstu Graph Data (Grafika
dati), kurā varat izvēlēties zīmēt grafiku attiecībā pret kontroli vai attiecībā pret nulli.

n Log 2— atlasiet šo opciju, lai novērtētu paraugus lielā dinamiskajā diapazonā.

n Log 10— atlasiet šo opciju, lai novērtētu paraugus ļoti lielā dinamiskajā diapazonā.

Mērogošanas opcijas

Atlasiet Normalized Gene Expression (ΔΔCq) (Normalizēta gēnu ekspresija) un iestatiet Control
Sample (Kontrolparaugs) uz None (Neviens), lai iespējotu mērogošanas opcijas gēnu ekspresijas
diagrammā. Atlasiet vienu no šīm mērogošanas opcijām, lai aprēķinātu un prezentētu savus datus
savas virknes noformējumam atbilstošākajā veidā:

n Unscaled (Nemērogots) — prezentē nemērogotu normalizētu gēnu ekspresiju.

n Highest (Augstākais) —mērogo katra mērķa normalizētu gēnu ekspresiju, dalot katra parauga
ekspresijas līmeni ar ekspresijas augstāko līmeni visos paraugos.

Šajā mērogošanas opcijā tiek izmantota mērogošanas augstākajā līmenī formula.

n Lowest (Zemākais) —mērogo katra mērķa normalizētu gēnu ekspresiju, dalot katra parauga
ekspresijas līmeni ar ekspresijas zemāko līmeni visos paraugos.

Šajā mērogošanas opcijā tiek izmantota mērogošanas zemākajā līmenī formula.

n Average (Vidējais) —mērogo katra mērķa normalizētu gēnu ekspresiju, dalot katra parauga
ekspresijas līmeni ar visu paraugu ekspresijas līmeņa ģeometrisko vidējo.

Šajā mērogošanas opcijā tiek izmantota mērogošanas uz vidējo vērtību formula.
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Kļūdas tips

Diagrammā Gene Expression (Gēnu ekspresija) atlasiet opciju kļūdas tipa aprēķiniem (kļūdu joslas):

n Standard error of the mean (default) (Vidējās vērtības standarta kļūda (noklusējums)).

n Standard deviation (Standartnovirze).

Diagrammas kļūdas joslas reizinātājs

Diagrammā Gene Expression (Gēnu ekspresija) atlasiet reizinātāju kļūdu joslām. Atlasiet vienu no
šiem veseliem skaitļiem:
+/- 1 (noklusējuma), 2 vai 3. Reizinātāja veids mainās, atlasot kļūdas tipu:

n SEMs— vidējās vērtības standarta kļūda;

n Std Devs— standartnovirze.

Eksperimenta iestatījumi
Padoms. Šis dialoglodziņš ir pieejams arī logā Plate Editor (Trauciņa redaktors). Papildu
informāciju skatīt Eksperimenta iestatījumu mainīšana 130. lpp.

Dialoglodziņā Experiment Settings (Eksperimenta iestatījumi) var skatīt vai mainīt mērķu vai paraugu
sarakstus, atlasīt atsauces gēnus, atlasīt kontroles vai iestatīt analizējamo gēnu ekspresijas analīzes
grupu, ja iedobēm ir pievienoti bioloģisko kopu nosaukumi.

Dialoglodziņa Experiment Settings (Eksperimenta iestatījumi) atvēršana

u Cilnē Bar Chart (Joslu diagramma) noklikšķiniet uz Experiment Settings (Eksperimenta
iestatījumi) labās puses rūts apakšā.

Parādīsies dialoglodziņš Experiment Settings (Eksperimenta iestatījumi), rādot cilni Targets
(Mērķi).
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Targets (Mērķi) iestatījumu pielāgošana

u Cilnē Targets (Mērķi) veiciet vienu no šādām darbībām:

n Lai atlasītu mērķi kā gēnu ekspresijas datu analīzes atsauci, atlasiet tā nosaukumu kolonnā
Reference (Atsauce).

n Lai mainītu mērķa krāsu, noklikšķiniet tās šūnā kolonnā Color (Krāsa) un mainiet krāsu
parādītajā dialoglodziņā Color (Krāsa).

Krāsu maiņa parādās Gene Expression (Gēnu ekspresija) diagrammās.

n Lai lietotu iepriekš noteiktu efektivitātes vērtību, izņemiet atzīmi no mērķa izvēles rūtiņas
kolonnā Auto Efficiency (Automātiskā efektivitāte) un ievadiet mērķa efektivitātes
procentuālās attiecības skaitli.

Programmatūra aprēķina mērķa relatīvo efektivitāti, izmantojot Auto Efficiency (Automātiskā
efektivitāte), ja mērķa dati ietver standarta līkni.

Iestatījumu pielāgošana Sample (Bioloģiskā grupa)

u Cilnē Samples (Bioloģiskās grupas) veiciet tālāk norādītās darbības.

n Lai atlasītu paraugu kā gēnu ekspresijas datu analīzes kontroli, atlasiet tā nosaukumu
kolonnā Control (Kontrole).

n Lai mainītu parauga grupas krāsu, noklikšķiniet tās šūnā kolonnā Color (Krāsa) un mainiet
krāsu parādītajā dialoglodziņā Color (Krāsa).
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Krāsu maiņa parādās Gene Expression (Gēnu ekspresija) diagrammās.

n Lai rādītu paraugu gēnu ekspresijas diagrammās, atlasiet to kolonnā Show Chart (Rādīt
diagrammu).

n Lai izņemtu paraugu no gēnu ekspresijas diagrammām, izdzēsiet to kolonnā Show Chart
(Rādīt diagrammu).

Padoms. Parauga grupas dati paliek tabulā Results (Rezultāti).

Lai mainītu atlasi Biological Set Analysis Options (Bioloģisko kopu analīzes opcijas)

u Ja iedobēm trauciņā ir piešķirta viena vai vairākas bioloģiskās kopas (skatīt Bioloģisko kopu
piešķiršana iedobēm 123. lpp.), saraksts Biological Set Analysis Options (Bioloģisko kopu analīzes
opcijas) tiek rādīts dialoglodziņā Experiment Settings (Eksperimenta iestatījumi), sniedzot jums
iespēju mainīt atlasi, kā nepieciešams.

n Target vs. Sample (Mērķis salīdzinājumā ar paraugu) — gēnu ekspresijas aprēķinos tiek
izmantots tikai iedobes parauga nosaukums.

n Target vs. Biological Set (Mērķis salīdzinājumā ar bioloģisko komplektu)—aprēķinos
tiek izmantots tikai bioloģiskā komplekta nosaukums.

n Target vs. Sample_Biological Set (Mērķis salīdzinājumā ar paraugu_bioloģisko
komplektu)—parauga nosaukums un bioloģiskā komplekta nosaukums tiek apvienoti,
izveidojot vienu nosaukumu, ko lieto aprēķinos.

n Target vs. Biological Set_Sample (Mērķa salīdzinājums ar bioloģisko kopu_
paraugu) — bioloģiskās kopas nosaukums un parauga nosaukums tiek apvienoti, izveidojot
vienu nosaukumu, ko lieto aprēķinos.

Parauga veida izslēgšana no analīzes aprēķiniem

u Atlasiet tā izvēles rūtiņu dialoglodziņa Experiment Settings (Eksperimenta iestatījumi) apakšā.

Piezīme. Tādējādi kontroles un/vai standarti tiek izslēgti no gēnu ekspresijas analīzes.

Lietošanas rokasgrāmata | 235



11. nodaļa. Gēnu ekspresijas analīze

Mērķa stabilitātes vērtība
Mērķa stabilitātes vērtības tiek aprēķinātas katru reizi, kad tiek izmantots vairāk nekā viens atsauces
gēns. CFX Manager Dx programmatūra atsauces gēniem aprēķina divus kvalitātes parametrus:

n Normalizētu atsauces gēnu relatīvā daudzuma Coefficient Variance (CV) (Variāciju
koeficients (VK)). Zemāka VC vērtība apzīmē lielāku stabilitāti.

n M Value (M) (M vērtība (M))—atsauces gēna ekspresijas stabilitātes mērījums.

Ieteicamās CV (VK) un M vērtības tiek parādītas dialoglodziņa Stability Value (Stabilitātes vērtība)
apakšdaļā.

Mērķa stabilitātes vērtības skatīšana

u Cilnes Gene Expression Bar Chart (Gēnu ekspresijas joslu diagramma) labās rūts apakšdaļā
noklikšķiniet uz vienuma Target Stability Value (Mērķa stabilitātes vērtība).

Parādīsies dialoglodziņš Stability Value (Stabilitātes vērtība).

Peles labās pogas klikšķa izvēlnes opcijas
Noklikšķiniet ar peles labo pogu uz gēnu ekspresijas diagrammas, lai atlasītu 34. tabula parādītos
vienumus.

Vienums Funkcija

Copy (Kopēt) Kopē diagrammu starpliktuvē.

Save Image As (Saglabāt attēlu
kā)

Saglabā diagrammu kā attēla failu. Iestatiet attēla izšķirtspēju un
izmērus un tad atlasiet faila veidu (PNG, GIF, JPG, TIF vai BMP).

Page Setup (Lapas iestatīšana) Atlasa lapas iestatījumu drukāšanai.

Print (Drukāt) Izdrukā diagrammu.

Set Scale to Default (Iestatīt
mērogu kā noklusējumu)

Show All (Rādīt visu) rāda visus datus joslu diagrammā. Scroll Bar
(Ritjosla) rāda ritjoslu, ja paraugu ir pārāk daudz, lai rādītu
diagrammas ietvarā un vienlaikus saglabātu minimālo joslu
platumu.

(Diagrammas iestatījumi)
Chart Options (Diagrammas
opcijas)

Atver logu Chart Options (Diagrammas iestatījumi/Diagrammas
opcijas), lai pielāgotu grafiku.

34. tabula. Gēnu ekspresijas peles labās pogas klikšķa izvēlnes vienumi
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Vienums Funkcija

Sort (Kārtot) Kārto paraugu vai mērķu secību, kas redzami uz diagrammas x ass.

Use Corrected Std Devs (Lietot
koriģētās standarta novirzes)

Aprēķina kļūdu joslas, izmantojot koriģētās standarta novirzes
formulu.

Use Solid Bar Colors (Lietot
tīrtoņa joslu krāsas)

Rāda tīrtoņu joslas diagrammā.

X–Axis Labels (X ass etiķetes) Rāda x ass etiķetes horizontāli vai slīpi.

34. tabula. Gēnu ekspresijas peles labās pogas klikšķa izvēlnes vienumi, turpinājums

Datu izklājlapa
35. tabula ir definēti dati, kas parādīti datu tabulā Gene Expression (Gēnu ekspresija).

Piezīme. Vērtības tabulā tiek aprēķinātas, pamatojoties uz grafika veidu un preferencēm, kas
atlasītas labajā rūtī.

Informācija Apraksts

Mērķis Logā Experiment Settings (Eksperimenta iestatījumi) ir atlasīts
mērķa nosaukums (amplificētais gēns).

Paraugs Logā Experiment Settings (Eksperimenta iestatījumi) ir atlasīts
parauga nosaukums.

Ctrl Logā Experiment Settings (Eksperimenta iestatījumi) ir atlasīts
kontroles nosaukums.

Relatīvais daudzums vai
Ekspresija

Relatīvais daudzums (Δq) vai normalizēta gēnu ekspresija (ΔΔq)
atkarībā no atlasītā režīma.

Relatīvais daudzums vai
ekspresija SEM (vai
standartnovirze)

Relatīvā daudzuma vai normalizētas ekspresijas vidējās vērtības
standarta kļūda (SEM) vai standartnovirze atkarībā no atlasītās
opcijas.

Koriģētais relatīvais daudzums
vai ekspresija SEM (vai
standartnovirze)

Koriģētā vērtība relatīvā daudzuma vai normalizētas ekspresijas
SEM vai standartnovirzes aprēķināšanai atkarībā no atlasītās
opcijas.

35. tabula. Cilnes Graphing (Grafika veidošana)Bar Chart (Joslu diagramma) izklājlapā
sniegtās informācijas apraksts
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Informācija Apraksts

Vidējais Cq Kvantitatīvās noteikšanas cikla vidējā vērtība.

Cq SEM (vai standartnovirze) Kvantitatīvās noteikšanas cikla SEM vai standartnovirze atkarībā
no atlasītās opcijas.

35. tabula. Cilnes Graphing (Grafika veidošana)Bar Chart (Joslu diagramma) izklājlapā
sniegtās informācijas apraksts, turpinājums

Opcija Show Details (Rādīt informāciju)
36. tabula definē rādāmos datus, kad no joslu diagrammas izklājlapas peles labās poga klikšķa
izvēlnes tiek atlasīta opcija Show Details (Rādīt informāciju).

Informācija Apraksts

Datu kopa Fluorescences dati no viena fluorofora datu failā

Relatīvais daudzums Aprēķinātais paraugu relatīvais daudzums

Relatīvais daudzums SD Relatīvā daudzuma aprēķina standarta novirze

Koriģētais relatīvais daudzums
SD

Aprēķinātā koriģētā relatīvā daudzuma standarta novirze

Relatīvais daudzums SEM Relatīvā daudzuma aprēķina vidējā rādītāja standarta kļūda

Koriģētais relatīvais daudzums
SEM

Aprēķinātā koriģētā relatīvā daudzuma vidējā rādītāja standarta
kļūda

Relatīvais daudzums(lg) Relatīvā daudzuma log2, ko lieto statistiskajā analīzē

SD RQ(lg) Relatīvā daudzuma standarta novirze (log2)

SEM ekspresija (lg) Ekspresijas vidējā rādītāja standarta kļūda (log2)

Nemērogotā ekspresija Aprēķinātā nemērogotā ekspresija

Nemērogotā ekspresija SD Aprēķinātā nemērogotās ekspresijas standarta novirze

Koriģētā nemērogotā ekspresija
SD

Aprēķinātā koriģētās nemērogotās ekspresijas standarta novirze

36. tabula. Informācija joslu diagrammas izklājlapā ar atlasītu opciju Show Details (Rādīt
informāciju)
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Informācija Apraksts

Nemērogotā ekspresija SEM Aprēķinātā nemērogotās ekspresijas vidējā rādītāja standarta kļūda

Koriģētā nemērogotā ekspresija
SEM

Aprēķinātā koriģētās nemērogotās ekspresijas vidējā rādītāja
standarta kļūda

Nemērogotā ekspresija (lg) Nemērogotās ekspresijas log2

SD nemērogotā ekspresija (lg) Nemērogotās ekspresijas standarta novirze (log2)

SEM nemērogotā ekspresija
(lg)

Nemērogotās ekspresijas vidējā rādītāja standarta kļūda (log2)

Ekspresija Normalizētā gēnu ekspresija

Koriģētā ekspresija SD Aprēķinātā standarta novirze

Ekspresija SEM Vidējā rādītāja standarta kļūda

Koriģētā ekspresija SEM Aprēķinātā vidējā rādītāja standarta kļūda

Ekspresija (lg) Ekspresijas (normalizētas ekspresijas) log2, ko lieto statistiskajā
analīzē

SD ekspresija (lg) Ekspresijas standarta novirze (log2)

SEM ekspresija (lg) Ekspresijas vidējā rādītāja standarta kļūda (log2)

Vidējais Cq Kvantitatīvās noteikšanas cikla vidējais

Cq SD Kvantitatīvās noteikšanas cikla standarta novirze

Cq SEM Kvantitatīvās noteikšanas cikla vidējā rādītāja standarta kļūda

36. tabula. Informācija joslu diagrammas izklājlapā ar atlasītu opciju Show Details (Rādīt
informāciju), turpinājums
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Klastergramma
Klastergrammā dati tiek parādīti hierarhijā, balstoties uz ekspresijas līdzības pakāpi dažādiem
mērķiem un paraugiem.

Piezīme. Jums jāizvēlas atsauces mērķis, lai joslu diagrammās parādītu jebkurus datu grafiskos
attēlojumus, kas nav relatīvā ekspresija.

Klastergrammas attēlā ir parādīta šāda parauga vai mērķa relatīvā ekspresija:

n ekspresijas līmeņa paaugstināšana (sarkans) — lielāka ekspresija;

n ekspresijas līmeņa pazemināšana (zaļš vai zils) —mazāka ekspresija;

n regulēšana nenotiek (melns);

n vērtība netiek aprēķināta (melns ar baltu X zīmi).

Jo gaišāks krāsas tonis, jo lielāka relatīvo ekspresijas vērtību starpība. Ja nav iespējams aprēķināt
normalizētu Cq vērtību, kvadrāts būs melns ar baltu X zīmi.

Datu grafiskā attēlojuma ārpusē ir dendrogramma, kas norāda uz klasterēšanas hierarhiju. Mērķiem
vai paraugiem ar līdzīgiem ekspresijas profiliem būs blakus esošie atzarojumi, savukārt mērķi vai
paraugi ar atšķirīgiem profiliem būs attālāki.

Iestatījumi
Jūs varat iestatīt šādas opcijas:

n Cluster By (Izveidot klasteri pēc) — izvēlieties Targets (Mērķi), Samples (Paraugi), Both (Abi) vai
None (Neviens).

n Size (Izmērs) — regulē attēla izmēru maina diagrammas palielināšanas pakāpi.

n Split Out Replicates (Sadalītie replikāti) — parāda atsevišķu replikātu vērtības.

Padoms. Jūs varat mainīt krāsu shēmu klastergrammai un izkliedes diagrammai no sarkanā/zaļā līdz
sarkanajam/zilajam, atlasot šo opciju no izvēlnes, kurai var piekļūt, noklikšķinot ar peles labo pogu no
šīm diagrammām.

Peles labās pogas klikšķa izvēlnes opcijas
Peles labās pogas klikšķa izvēlnes opcijas klastergrammai ir tādas pašas kā joslu diagrammai.
Pieejamās opcijas skatīt 34. tabula 236. lappusē Papildus atlasiet Color Scheme (Krāsu shēma), lai
mainītu samazinošo (downregulation) ekspresiju no noklusējuma Red/Green (Sarkana/zaļa) uz
Red/Blue (Sarkana/zila) diagrammā.
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Klastergramma

Datu izklājlapa
Izklājlapā redzamas mērķa, parauga un normalizētas ekspresijas vērtības. Noklikšķiniet izvēles rūtiņā
blakus mērķim, lai to iekļautu plānā vai izslēgtu no tā.
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Izkliedes diagramma
Izkliedes diagrammā tiek parādīta mērķu normalizēta ekspresija kontrolei salīdzinājumā ar eksperimenta
paraugu. Līnijas diagrammā norāda regulēšanas sliekšņa vērtību. Datu punkti starp līnijām norāda, ka
starpība paraugu attiecīgā mērķa (gēna) ekspresijā ir nenozīmīga. Datu punkti ārpus līnijām pārsniedz
regulēšanas sliekšņa vērtību un var būt nozīmīgi.

Diagrammas attēlā tiek rādītas tālāk attēlotās mērķa ekspresijas izmaiņas, balstoties uz regulēšanas
sliekšņa vērtību:

n Ekspresijas līmeņa paaugstināšana (sarkans aplis) — relatīvi lielāka ekspresija.

n Ekspresijas līmeņa pazemināšana (zaļš vai zils aplis) — relatīvi mazāka ekspresija.

n Nav izmaiņu (melns aplis).

Noklikšķiniet un velciet sliekšņa vērtības līniju, lai pielāgotu regulēšanas sliekšņa vērtību.

Iestatījumi
Jūs varat iestatīt šādas opcijas:

n Control Sample (Kontroles paraugs)

n Experimental Sample (Eksperimentālais paraugs)

n Regulation Threshold (Regulēšanas sliekšņa vērtība) Palielinot vai samazinot opcijas
regulēšanas vērtību, sliekšņa vērtību līnijas diagrammā attiecīgi pārvietojas.

Peles labās pogas klikšķa izvēlnes opcijas
Peles labās pogas klikšķa izvēlnes opcijas izkliedes plānam ir tādas pašas kā joslu diagrammai.
Pieejamās opcijas skatīt 34. tabula 236. lappusē Papildus atlasiet Symbol (Simbols), lai mainītu plānā
lietoto simbolu no noklusējuma apļa uz kādu no šiem:

n Trijstūris

n Krusts

n Kvadrāts

n Rombs
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Izkliedes diagramma

Datu izklājlapa
Izklājlapā tiek parādītas mērķa un normalizētas ekspresijas vērtības kontroles un eksperimenta
paraugiem. Tajā arī norādīts, vai mērķi ir ar pazeminātu vai paaugstinātu ekspresijas līmeni, salīdzinot
ar regulēšanas sliekšņa vērtību. Noklikšķiniet izvēles rūtiņā blakus mērķim, lai to iekļautu plānā vai
izslēgtu no tā.
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Rezultāti
Rezultātu cilne sniedz izklājlapu, kurā apkopoti dati no visām diagrammām. 37. tabula definē rezultātu
izklājlapā rādītos datus.

Informācija Apraksts

Target (Mērķis) Mērķa nosaukums (amplificēts gēns)

Sample (Paraugs) Parauga nosaukums

Mean Cq (Vidējais) Kvantitatīvās noteikšanas cikla vidējais rādītājs

Mean Efficiency Corrected Cq
(Vidējais Cq ar koriģētu
efektivitāti)

Kvantitatīvās noteikšanas cikla vidējais rādītājs pēc reakcijas
efektivitātes pielāgošanas

Normalized Expression
(Normalizēta ekspresija)

Mērķa ekspresija, normalizēta uz atsauces mērķi (ΔΔCq)

Relative Normalized
Expression (Relatīvā
normalizēta ekspresija)

Normalizēta ekspresija, kas attiecas uz kontroles paraugu, saukta
arī par Fold Change

Regulation (Regulēšana) Izmaiņas ekspresijā attiecībā pret kontroles paraugu

Compared to Regulation
Threshold (Salīdzinājumā ar
regulēšanas sliekšņa vērtību)

Eksperimentāla parauga regulēšana augšup vai lejup, pamatojoties
uz sliekšņa vērtības iestatījumu

37. tabula. Informācija rezultātu cilnē

Piezīme. Replikātu dati atrodami tikai datu analīžu ciļņu izklājlapās, kurās atlasīts Split Out
Replicates (Izdalīt replikātus) (proti, Clustergram). Ja atlasāt “nav” kā kontroles paraugu joslu
diagrammā, starp ekspresijas datiem gēnu ekspresijas analīzes izklājlapās var būt neatbilstības.
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Gēnu pētījums

Gēnu pētījums
Izveidojiet gēnu pētījumu, lai salīdzinātu viena vai vairāku reāllaika PCR eksperimentu gēnu
ekspresijas datus, izmantojot starpizpildes kalibratoru, lai veiktu normalizēšanu starp eksperimentiem.
Izveidojiet gēnu pētījumu, pievienojot gēnu pētījumam datus no viena vai vairākiem datu failiem
(paplašinājums .bpcrd). Programmatūra tos sagrupē vienā failā (paplašinājums .mgxd).

Piezīme. Maksimālo paraugu skaitu, kādu var analizēt gēnu pētījumā, ierobežo datora RAM un
virtuālās atmiņas lielums.

Iekšējās izpildes kalibrēšana
Iekšējās izpildes kalibrēšanas mēģinājums notiek katrā gēnu pētījumā katrammērķim, lai normalizētu
iekšējās izpildes variācijas starp mērķiem, kas testēti atsevišķās reāllaika PCR izpildēs (tas ir,
dažādiem .pcrd failiem, kas ģenerēti no dažādiem trauciņiem).

Lai programmatūra atpazītu paraugu kā iekšējās izpildes kalibrētāju, tam katrā salīdzināmajā trauciņā
jābūt vienādammērķa nosaukumam, parauga nosaukumam un, ja tāds tiek izmantots, bioloģiskā
komplekta nosaukumam.

Piezīme. Lai tiktu veikta iekšējās izpildes kalibrēšana, gēnu pētījumā jābūt vismaz vienam
iekšējās izpildes kalibrēšanas paraugam. Mērķi bez atbilstošiem iekšējās izpildes kalibrētāja
paraugiem gēnu pētījumā tiks apstrādāti bez korekcijas (nav ieteicams).

Iekšējās izpildes kalibrētājus var lietot divos veidos:

n Mērķim— dažādiem PCR praimeriem var būt dažāda efektivitāte. Iekšējās izpildes kalibrētājs
pēc noklusējuma tiek lietots visām viena trauciņa iedobēm, kurām ir vienāds mērķa nosaukums,
piemēram, Cq, kas ģenerēti ar vienu testu.

n Visam pētījumam— lietotājs atlasa vienu iekšējās izpildes kalibrētāju un lieto to visam gēnu
pētījumam.

Dialoglodziņš Gene Study (Gēnu pētījums)
Dialoglodziņā Gene Study (Gēnu pētījums) ir divas cilnes.

n Cilne Study Setup (Pētījuma iestatīšana) — pārvalda izpildes gēnu pētījumā.

Svarīgi! Datu failu pievienošana un noņemšana gēnu pētījumā nemaina datus oriģinālajā
failā.

n Cilne Study Analysis (Pētījuma analīze) — parāda gēnu ekspresijas datus apvienotajām izpildēm.
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Cilne Study Setup (Pētījuma iestatīšana)
38. tabula ir izskaidroti dati, kas parādās cilnē Study Setup (Pētījuma iestatīšana).

Kolonnas nosaukums Apraksts

File Name (Faila
nosaukums)

Izpildes datu faila nosaukums (.pcrd paplašinājums)

File Folder (Faila mape) Direktorijā, kurā tiek uzglabāts katras datu pētījuma izpildes datu fails

Date Created (Izveides
datums)

Datums, kad izpildes dati tika savākti

Well Group Name (Iedobju
grupas nosaukums)

Iedobju grupas, kas tika atlasīta, kad fails tika pievienots gēnu
pētījumam, nosaukums

Padoms. Lai gēnu pētījumā analizētu vienu iedobju grupu, jums
pirms datu faila importēšanas gēnu pētījumā šī iedobju grupa
jāatlasa logā Data Analysis (Datu analīze).

Step (Darbība) Protokola darbība, kas ietver trauciņa nolasīšanu, lai vāktu reāllaika
PCR datus

Run Type (Izpildes veids) Lietotāja definēta vai PrimePCR izpilde

Protocol Edited (Rediģētais
protokols)

Ja ir atlasīta šī opcija, tā norāda, ka PrimePCR izpildei izmantotais
protokols tika rediģēts

View Plate (Skatīt trauciņu) Atver trauciņu karti ar datiem katrā izpildē, kas iekļauta gēnu pētījumā

38. tabula. Dialoglodziņā Gene Study (Gēnu pētījums) izvēlieties cilni Study Setup (Pētījuma
iestatīšana).

Gēnu pētījuma sagatavošana
Gēnu pētījuma sagatavošana

1. Pirms datu importēšanas gēnu pētījumā, logā Data Analysis (Datu analīze) veiciet tālāk
aprakstīto darbību.

n Pārbaudiet, vai paraugiem ar vienādu saturu ir vienāds nosaukums. Gēnu pētījumā
programmatūra pieņem, ka iedobes ar vienādiemmērķa vai parauga nosaukumiem satur
vienādus paraugus.

n Cilnē Quantification (Kvantitatīvā noteikšana) pielāgojiet bāzlīniju un sliekšņa vērtību (Cq), lai
katrā izpildē optimizētu datus.
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n Atlasiet iedobju grupu, kuru vēlaties iekļaut gēnu pētījumā.

Lai gēnu pētījumā rādītu datus no vienas iedobju grupas, šai grupai jābūt atlasītai pirms datu
faila importēšanas.

Cilnē Study Setup (Pētījuma iestatīšana) tiek rādīts visu gēnu pētījuma izpilžu saraksts.

2. Dialoglodziņā Gene Study (Gēnu pētījums) izvēlieties cilni Study Setup (Pētījuma iestatīšana).

3. Noklikšķiniet uz Add Data Files (Pievienot datu failus), lai atlasītu failu no pārlūkprogrammas loga.

Padoms. Lai gēnu pētījumam ātri pievienotu izpildes, velciet datu failus (.pcrd
paplašinājums) dialoglodziņā Study Setup (Pētījuma iestatīšana).

4. CFX Manager Dx software automātiski veic gēnu pētījuma analīzi, kad pievienojat datu failus.
Izvēlieties cilni Study Analysis (Pētījuma analīze), lai skatītu rezultātus.

Izpilžu noņemšana no gēnu pētījuma

u Sarakstā atlasiet vienu vai vairākus failus un noklikšķiniet uz Remove (Noņemt).

Piezīmju pievienošana par gēnu pētījumu

u Piezīmes par failiem un analīzi pievienojiet tekstlodziņā Notes (Piezīmes).

Cilne Study Analysis (Pētījuma analīze)
Cilnē Study Analysis (Pētījuma analīze) tiek parādīti dati no visām izpildēm gēnu pētījumā. Gēnu
ekspresijas datu analīzes opcijas ir tādas pašas kā vienam datu failam ar tālāk norādītajiem
izņēmumie:

n Joslu diagrammām parādās iekšējās izpildes kalibrēšanas vērtības (ja aprēķinātas), noklikšķinot
uz Inter-run Calibration (Iekšējās izpildes kalibrēšana).

Piezīme. Kā iekšējās izpildes kalibrētājus var izmantot tikai tālāk norādītos paraugu veidus.

o Nezināms

o Standarta

o Pozitīvā kontrole

Paraugu veidus Negatīvā kontrole, Bez veidnes kontroles (NTC) un Bez reversās transkriptāzes
(NRT) nevar izmantot kā iekšējās izpildes kalibrētājus.
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Gēnu pētījuma atskaites izveide
Gēnu pētījuma atskaites izveidošana

1. Pirms atskaites veidošanas pielāgojiet gēnu pētījuma atskaites datus un diagrammas, kā
nepieciešams.

2. Atlasiet Tools > Reports (Rīki > Atskaites) izvēlnē Gene Study (Gēnu pētījums), lai atvērtu
dialoglodziņu Report (Atskaite).

3. Izvēlieties opcijas, kuras vēlaties iekļaut atskaitē. Atskaite atveras ar atlasītām noklusējuma
opcijām. Ielieciet atzīmes izvēles rūtiņās vai arī izņemiet atzīmes no tām, lai mainītu veselas
kategorijas vai tikai atsevišķas opcijas kategorijas robežās.

Gēnu pētījuma atskaišu kategorijas 249. lpp. uzskaitītas pieejamās opcijas rādīšanai.

4. Mainiet kategoriju un vienumu secību atskaitē. Aizvelciet opcijas uz vajadzīgo pozīciju. Vienumus
var pārkārtot tikai to kategoriju robežās, pie kurām šie vienumi pieder.

5. Noklikšķiniet uz Update Report (Atjaunināt atskaiti), lai atjauninātu Report Preview (Atskaites
priekšskatījumu) ar visām izmaiņām.

6. Izdrukājiet vai saglabājiet atskaiti. Lai izdrukātu pašreizējo atskaiti, noklikšķiniet uz pogas Print
Report (Drukāt atskaiti) rīkjoslā. Atlasiet File > Save (Fails > Saglabāt), lai saglabātu atskaiti PDF
(Adobe Acrobat Reader fails) formātā un atlasiet vietu, kurā failu saglabāt. Atlasiet File > Save As
(Fails > Saglabāt kā), lai saglabātu atskaiti ar jaunu nosaukumu vai jaunā atrašanās vietā.

7. (Papildiespēja) Izveidojiet atskaites veidni ar tādu informāciju, kādu vēlaties. Lai saglabātu
pašreizējos atskaites iestatījumus veidnē, atlasiet Template > Save vai Save As (Veidne >
Saglabāt vai Saglabāt kā). Pēc tam nākamajā reizē, kad vēlaties veidot jaunu atskaiti, ielādējiet
atskaites veidni.
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Gēnu pētījuma atskaišu kategorijas
Izmantojiet dialoglodziņu Gene Study Report (Gēnu pētījuma atskaite), lai sakārtotu gēnu pētījuma
datus atskaitē. 39. tabula uzskaitītas visas gēnu pētījuma atskaitei pieejamās opcijas.

Kategorija Opcija Apraksts

Header (Galvene)

Atskaites virsraksts, apakšvirsraksts un
logotips

Report Information
(Informācija par atskaiti)

Datums, lietotājvārds, datu faila
nosaukums, datu faila ceļš un atlasītā
iedobju grupa

Gene Study File List (Gēnu
pētījuma failu saraksts)

Visu gēnu pētījumā esošo datu failu
saraksts

Notes (Piezīmes) Piezīmes par datu atskaiti

Study Analysis: Bar Chart (Pētījuma analīze: joslu diagramma)

Analysis Settings (Analīzes
iestatījumi)

Atlasīto analīzes parametru saraksts

Chart (Diagramma) Gēnu ekspresijas joslu diagramma, kas
atspoguļo datus

Target Names (Mērķa
nosaukumi)

Gēnu pētījumā izmantoto mērķu
saraksts

Sample Names (Paraugu
nosaukumi)

Gēnu pētījumā izmantoto paraugu
saraksts

Data (Dati) Izklājlapa, kas atspoguļo datus

Target Stability (Mērķa
stabilitāte)

Mērķa stabilitātes dati

Inter-run Calibration
(Iekšējās izpildes
kalibrēšana)

Iekšējās izpildes kalibrēšanas dati

39. tabula. Gēnu pētījuma atskaišu kategorijas
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Kategorija Opcija Apraksts

Study Analysis: Clustergram and Scatter Plot (Pētījuma analīze: klastergramma, izkliedes
plāns, vulkāna plāns un siltuma karte/Klastergramma un izkliedes plāns)

Analysis Settings (Analīzes
iestatījumi)

Katra diagrammas veida iestatījumi

Chart (Diagramma) Gēnu ekspresijas diagramma, kas
atspoguļo datus

Data (Dati) Izklājlapa, kurā uzskaitīti dati katrā mērķī

39. tabula. Gēnu pētījuma atskaišu kategorijas, turpinājums
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A pielikums. Datu analīzes aprēķini
CFXManager Dx programmatūra automātiski aprēķina formulas un parāda rezultātus cilnēs Data
Analysis (Datu analīze). Šajā pielikumā sīki izskaidrots, kā CFX Manager Dx programmatūra aprēķina
formulas.

Reakcijas efektivitāte
Pierādījumi liecina, ka, analizējot gēnu ekspresijas datus, katra praimera un zonžu kopas efektivitātes
precīza mērījuma lietojums sniegs precīzākus rezultātus. Gēnu ekspresijas aprēķinos lietotā
efektivitātes noklusējuma vērtība ir 100 %. Lai izvērtētu reakcijas efektivitāti, ģenerējiet standarta līkni,
izmantojot reprezentatīvā parauga seriālus atšķaidījumus attiecīgajā dinamiskajā diapazonā un tad
reģistrējiet efektivitāti sekojošas gēnu ekspresijas analīzes nolūkā. Ja jūsu virknē ir iekļauta standarta
līkne, tad programmatūra automātiski aprēķina efektivitāti un parāda to zem virsraksta Standard
Curve (Standarta līkne) cilnē Quantification (Kvantitatīvā noteikšana), ja ielikta atzīme izvēles rūtiņā
Auto Efficiency (Automātiskā efektivitāte) cilnē Targets (Mērķi), kas atrodas logā Experiment Settings
(Eksperimenta iestatījumi).

Efektivitāte (E) efektivitātes formulās attiecas uz “efektivitātēm”, kādas aprakstījis Pfaffl (2001) and
Vandesompele et al. (2002). Šajās publikācijās efektivitāte 2 (perfekta dubultošana ar katru ciklu) ir
līdzvērtīga 100 % efektivitātei šajā programmatūrā. Jums ir iespēja konvertēt savus efektivitātes
aprēķinus uz tiem, kādi lietoti programmatūrā, izmantojot šādas matemātiskas attiecības:

n E = (% efektivitāte * 0,01) + 1

n % efektivitāte = (E - 1) * 100
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Relatīvais daudzums
Jebkuram paraugam (GOI) paredzētā relatīvā daudzuma (ΔCq) aprēķināšanas formula ir:

Piezīme. Šī formula tiek izmantota, lai aprēķinātu relatīvo daudzumu, kad nav definēts kontroles
paraugs .

kur:

n E = praimera un zonžu kopas efektivitāte. Šo efektivitāti aprēķina ar formulu
(% efektivitāte * 0,01) + 1, kur 100 % efektivitāte = 2

n C q (min) = vidējā Cq vērtība paraugam ar zemāko vidējo Cq vērtību GOI;

n C q (paraugs) = parauga vidējā Cq vērtība;

n GOI = interesējošais gēns (viens mērķis)

Relatīvais daudzums, kad ir atlasīta kontrole
Kad ir piešķirts kontroles paraugs, jebkura parauga interesējošā gēna (GOI) relatīvais daudzums (RQ)
tiek aprēķināts, izmantojot tālāk norādīto formulu:

kur:

n E = praimera un zonžu kopas efektivitāte. Šo efektivitāti aprēķina ar formulu
(% efektivitāte * 0,01) + 1, kur 100 % efektivitāte = 2

n Cq (kontrole) = vidējā Cq kontroles paraugam

n Cq (paraugs) = vidējā Cq jebkuriem paraugiem ar GOI

n GOI = interesējošais gēns (viens mērķis).
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Relatīvā daudzuma standarta novirze

Relatīvā daudzuma standarta novirze
Relatīvā daudzuma standarta novirzes formula ir

kur:

n SD relatīvais daudzums = relatīvā daudzuma standarta novirze

n SD CqGOI sample = Cq standarta novirze paraugam (GOI)

n Relative Quantity = parauga relatīvais daudzums

n E = praimera un zonžu kopas efektivitāte. Šo efektivitāti aprēķina ar formulu
(% efektivitāte * 0,01) + 1, kur 100 % efektivitāte = 2

n GOI = interesējošais gēns (viens mērķis)

Efektivitātes koriģētais Cq (CqE)
Efektivitātes koriģētā Cq (CqE) formula ir

kur:

n E = efektivitāte

Vidējās efektivitātes koriģētais Cq (MCqE)
Vidējās efektivitātes koriģētā Cq formula ir

kur:

n CqE = efektivitātes koriģētais Cq;

n n = kopiju skaits.
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A pielikums. Datu analīzes aprēķini

Normēšanas koeficients
Normalizētās ekspresijas vienādojuma saucēju sauc par normējošo koeficientu. Normējošais
koeficients ir visu atsauces mērķu (gēnu) relatīvo daudzumu ģeometriskais vidējais konkrēta parauga
gadījumā, kā aprakstīts šajā formulā:

kur:

n RQ = relatīvais daudzums

n n = atsauces mērķu skaits

n GOI = interesējošais gēns (viens mērķis)
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Normalizēta ekspresija

Normalizēta ekspresija
Normalizēta ekspresija (ΔΔCq) ir jūsu mērķa (gēna) relatīvais daudzums, normalizēts uz atsauces
mērķu (gēnu vai secību) daudzumiem jūsu bioloģiskajā sistēmā. Lai atlasītu atsauces mērķus, atveriet
logu Experiment Settings (Eksperimenta iestatījumi) un noklikšķiniet uz atsauces kolonnas katram
mērķim, kas kalpo kā atsauces gēns.

Formula normalizētas ekspresijas gadījumā, kurā lieto aprēķināto relatīvā daudzuma (RQ) aprēķinu, ir

kur:

n RQ = parauga relatīvais daudzums

n Ref = atsauces mērķis virknē, kurā iekļauts viens vai vairāki atsauces mērķi katrā paraugā

n GOI = interesējošais gēns (viens mērķis)

Ar nosacījumu, ka atsauces mērķi nemaina savu ekspresijas līmeni jūsu bioloģiskajā sistēmā,
normalizētas ekspresijas aprēķinā tiks ņemtas vērā ielādes starpības vai variācijas šūnu skaitā, kāds
pārstāvēts katrā jūsu paraugā.

Normalizēta ekspresija, kad atlasīta kontrole
Logā Experiment Settings (Eksperimenta iestatījumi) atlasot kontroles paraugu, programmatūra
iestata kontroles parauga ekspresijas līmeni uz 1. Šajā situācijā programmatūra normalizē visu mērķu
(gēnu) ekspresijas relatīvos daudzumus uz kontroles daudzumu (vērtība 1). Šī normalizētā ekspresija
ir līdzvērtīga nemērogotas normalizētas ekspresijas analīzei, izvēloties kontroli.

Piezīme. Tā zināma arī kā relatīvā normalizētā ekspresija (RNE) un kārtu maiņa.

Lietošanas rokasgrāmata | 255



A pielikums. Datu analīzes aprēķini

Standarta novirze normalizētas ekspresijas gadījumā
Normalizētas ekspresijas vērtības pārmērogošanu veic, dalot normalizētas ekspresijas standarta
novirzi ar normalizētas ekspresijas vērtību augstākajā vai zemākajā individuālās ekspresijas līmenī
atkarībā no jūsu izvēlētās mērogošanas opcijas. Normēšanas koeficienta standarta novirzes (SD)
formula ir

kur:

n RQ = parauga relatīvais daudzums

n SD = standarta novirze

n NF = normēšanas koeficients

n Ref = atsauces mērķis

n n = atsauces mērķu skaits

Piešķirot kontroles paraugu, nevajag veikt šo standarta novirzes pārmērogošanas funkciju, kā
parādīts šajā formulā:

kur:

n NE = normalizēta ekspresija

n RQ = parauga relatīvais daudzums

n SD = standarta novirze

n GOI = interesējošais gēns (viens mērķis)
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Normalizēta ekspresija, kas mērogota augstākajā ekspresijas līmenī

Normalizēta ekspresija, kas mērogota augstākajā
ekspresijas līmenī

Kad izpilde neietver kontroles, mērogojiet normalizētu ekspresiju katram mērķim (gēnam), katra
parauga ekspresijas līmeni sadalot ar visu paraugu ekspresijas augstāko līmeni. Programmatūra
iestata augstāko ekspresijas līmeni uz 1 un atkārtoti mērogo visus parauga ekspresijas līmeņus.
Augstākās mērogošanas formula ir

kur:

n GOI = interesējošais gēns (mērķis)

Normalizēta ekspresija, kas mērogota zemākajā ekspresijas
līmenī

Kad izpildē nav iekļautas kontroles, mērogojiet katra mērķa (gēna) normalizētu ekspresiju (NE), dalot
katra parauga ekspresijas līmeni ar ekspresijas zemāko līmeni visos paraugos. Programmatūra
iestata ekspresijas zemāko līmeni uz vērtību 1 un pārmērogo visus paraugu ekspresijas līmeņus.
Zemākā mērogošanas formula ir

kur:

n GOI = interesējošais gēns (mērķis)
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A pielikums. Datu analīzes aprēķini

Normalizēta ekspresija, kas mērogota vidējā ekspresijas
līmenī

Kad izpilde neietver kontroles, mērogojiet normalizētu ekspresiju katram mērķim (gēnam), katra
parauga ekspresijas līmeni sadalot ar visu paraugu ekspresijas līmeņa vērtību vidējo ģeometrisko.
Programmatūra iestata vidējo ekspresijas līmeni uz 1 un atkārtoti mērogo visus parauga ekspresijas
līmeņus. Vidējās mērogošanas formula ir

kur:

n GOI = interesējošais gēns (mērķis);

n GM = visu paraugu normalizētas ekspresijas vērtību vidējais ģeometriskais.
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Standarta novirze mērogotas normalizētas ekspresijas gadījumā

Standarta novirze mērogotas normalizētas ekspresijas
gadījumā

Mērogotas normalizētas ekspresijas (NE) vērtības pārmērogošanu veic, dalot normalizētas
ekspresijas standarta novirzi (SD) ar normalizētas ekspresijas vērtību augstākajā (MAX) vai zemākajā
(MIN) ekspresijas līmenī atkarībā no tā, kuru mērogošanas opciju izvēlējāties.

Piezīme. Piešķirot kontroles paraugu, nevajag veikt šo standarta novirzes pārmērogošanas
funkciju.

Šīs formulas aprēķins ir

kur:

n NE = normalizēta ekspresija

n SD = standarta novirze

n GOI = interesējošais gēns (mērķis)

n MAX = augstākais ekspresijas līmenis

n MIN = zemākais ekspresijas līmenis

Regulēšana
Regulēšana ir palielinājuma vai samazinājuma mērījums mērķa ekspresijā eksperimentāla parauga
salīdzinājuma gadījumā ar kontroles paraugu un tiek noteikta šādi:

Ja ekspresija (eksperimentālā) > ekspresija (kontroles):

Ja ekspresija (eksperimentālā) < ekspresija (kontroles):

Piezīme. Joslu diagrammai ekspresija tiek balstīta vai nu uz relatīvo daudzumu, vai normalizētu
ekspresiju atkarībā no atlasītā režīma (skatīt Joslu diagramma 228. lpp.). Tomēr izkliedes plāna un
klastergrammas gadījumā regulēšana vienmēr tiek aprēķināta no normalizētās ekspresijas.
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A pielikums. Datu analīzes aprēķini

Koriģēto vērtību formulas
Koriģēto vērtību un nekoriģēto vērtību starpība ir redzama tikai tad, ja kā daļa no reāllaika PCR
izpildes tiek izveidota standarta līkne. Lai noteiktu kļūdas izplatību, programmatūra lieto trīs
vienādojumus:

n Standarta novirze

n Standarta kļūda normalizētas ekspresijas gadījumā

n Standarta kļūda normalizētā interesējošā gēna (mērķa) gadījumā

Standarta kļūdas formula ir

kur:

n n = atsauces mērķu (gēnu) skaits

n SD = standarta novirze

Standarta kļūda normēšanas koeficienta gadījumā normalizētas ekspresijas formulā ir

kur:

n n = atsauces mērķu skaits

n SE = standarta kļūda

n NF = normēšanas koeficients

n RQ = relatīvais daudzums

Standarta kļūdas normalizētā interesējošā gēna (GOI) gadījumā formula ir,

kur:

n SE = standarta kļūda

n GOI = interesējošais gēns (viens mērķis)

n NF = normēšanas koeficients

n n = atsauces mērķu skaits
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B pielikums. Lietotāju un lomu CFX Manager Dx
pārvaldīšana

CFXManager Dx programmatūrā var izveidot lietotājus un piešķirt lomu šiem lietotājiem. Lomas
ierobežo piekļuvi CFX Manager Dx līdzekļiem. Lietotājam vienā laikā var tikt piešķirta tikai viena loma.
Tomēr CFX Manager Dx programmatūras administrators jebkurā laikā lietotāja lomu var mainīt.

Padoms. Lai lietotu CFX Manager Dx, nav nepieciešams izveidot lietotājus. Ja lietotājus
neizveido, visa darbība tiek veikta ar noklusējuma lietotāja kontu admin (Administrators).

Svarīgi! Lietotājs admin ir noklusējuma administratora konts, ko lieto, sākotnēji piesakoties CFX
Manager Dx. Ieteicams izveidotu konkrētu lietotāju, kas veic CFX Manager Dx administrēšanu.
Piešķiriet šim lietotājam administratora lomu un veiciet visus administrēšanas uzdevumus ar šo
lietotāju.

Svarīgi! CFXManager Dx programmatūrai nav lietotāja sesijas neaktivitātes taimauta funkcijas.
Tādēļ ir ieteicams ieviest Windows vai trešās puses drošības pasākumus (piemēram, ieviestu
ekrānsaudzētāju ar obligātu pieteikšanos).

Lietotāju pārvaldīšana
CFXManager Dx software standarta laidienā lietotāju kontiem var būt jebkāds nosaukums vai parole.

Lai katram lietotājam piešķirtu lomu, logā User Administration (Lietotāju administrēšana) veiciet atlasi
no lomu saraksta. Šajā piemērā vieslietotājam ir piešķirtas papildu tiesības saglabāt failus.

Lietotāju pievienošana un noņemšana
Piezīme. Lietotājus var pievienot un noņemt tikai CFX Manager Dx administrators.

Lietotāja kontu pievienošana CFX Manager Dx

1. Logā Home (Sākums) atlasiet User > User Administration (Lietotājs > Lietotāju administrēšana).

Parādīsies dialoglodziņš User Administration (Lietotāju administrēšana).
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B pielikums. Lietotāju un lomu CFXManager Dx pārvaldīšana

2. Rūtī Manage Users (Pārvaldīt lietotājus) ierakstiet lietotāja lietotājvārdu.

3. Atlasiet lietotāja opciju Role (Loma).

Lomas ierobežo lietotāja tiesības. Noklusējuma loma ir Principal (Pamatlietotājs).

Padoms. Jūs varat mainīt katras lomas tiesības. Lomas tiesību izmaiņas ietekmē visus
lietotājus, kuriem ir piešķirta šī loma. Papildu informāciju skatīt Lomu tiesību pārvaldīšana
263. lpp.

4. (Papildiespēja) Ierakstiet lietotāja Full Name (Pilns vārds) un Password (Parole).

5. Lai atvērtu dialoglodziņu un apstiprinātu, ka vēlaties aizvērt logu, noklikšķiniet uz OK (Labi).

6. Lai aizvērtu dialoglodziņu un logu, noklikšķiniet uz Yes (Jā).

Lietotāja noņemšana

1. Rūtī Manage Users (Pārvaldīt lietotājus) katram lietotājam, kuru vēlaties noņemt, atlasiet opciju
Remove (Noņemt).

2. Lai atvērtu dialoglodziņu un apstiprinātu, ka vēlaties aizvērt logu, noklikšķiniet uz OK (Labi).

3. Lai aizvērtu dialoglodziņu un logu, noklikšķiniet uz Yes (Jā).

Piezīme. Programmatūras lietotāju sarakstā vienmēr jābūt vienam administratoram.
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Lietotāju pārvaldīšana

Lomu tiesību pārvaldīšana
CFXManager Dx ietver šādas četras lomas:

n Administrators (obligāts) — administratoriem ir visas tiesības, un jūs šīs tiesības nevarat mainīt.
Administratori var arī pievienot un noņemt lietotājus un mainīt katras lomas tiesības.

Piezīme. Tikai administrators var mainīt jebkuras lomas tiesības.

n Galvenais — pēc noklusējuma galvenajam lietotājam ir visas tiesības

n Operators — pēc noklusējuma lietotājam operatoram ir visas tiesības, izņemot tiesības izlaist
ciklus

n Viesis — pēc noklusējuma lietotājs viesis drīkst tikai lasīt failus

Svarīgi! Lomas tiesību maiņa ietekmē visus lietotājus, kuriem šī loma piešķirta. Lomu nav
iespējams pielāgot konkrētam lietotājam. Ievērojiet piesardzību, modificējot lomu tiesības.

Tiesību norādīšana katrai lomai

1. Logā Home (Sākums) atlasiet User > User Administration (Lietotājs > Lietotāju administrēšana).

2. Rūtī Manage Rights (Pārvaldīt tiesības) veiciet vienu no šādām darbībām:

n Lai noņemtu kādas tiesības no lomas, izņemiet atzīmi no attiecīgās izvēles rūtiņas.

n Lai pievienotu lomai kādas tiesības, ielieciet atzīmi attiecīgajā izvēles rūtiņā.

3. Lai atvērtu dialoglodziņu un apstiprinātu, ka vēlaties aizvērt logu, noklikšķiniet uz OK (Labi).

4. Lai aizvērtu dialoglodziņu un logu, noklikšķiniet uz Yes (Jā).

Visu tiesību atiestatīšana visām lomām

u Dialoglodziņā User Administration (Lietotāju administrēšana) noklikšķiniet uz Restore Default
Rights (Atjaunot noklusējuma tiesības).
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B pielikums. Lietotāju un lomu CFXManager Dx pārvaldīšana

Pieteikšanās CFX Manager Dx programmatūrā
CFXManager Dx programmatūra pārvalda, kurš piesakās programmatūrā ar dialoglodziņa Login
(Pieteikšanās) starpniecību. Palaižot programmatūru, CFX Manager Dx automātiski rāda
dialoglodziņu Login (Pieteikšanās), ja logā User Administration (Lietotāju administrēšana) ir norādīti
divi vai vairāki lietotāji.

CFX Manager Dx rāda tā lietotāja vārdu, kurš pieteicies sistēmā, loga Home (Sākums) augšā.

Pieteikšanās CFX Manager Dx

1. Dialoglodziņā Login (Pieteikšanās) atlasiet savu vārdu no nolaižamā saraksta User Name
(Lietotājvārds).

2. Ierakstiet savu paroli.

3. Noklikšķiniet uz OK (Labi), lai aizvērtu dialoglodziņu Login (Pieteikšanās) un atvērtu
programmatūru.
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Pieteikšanās CFX Manager Dx programmatūrā

Lietotāju maiņa
Lietotājus var mainīt, kamēr programmatūra darbojas.

Lietotāju pārslēgšana

1. Logā Home (Sākums) atlasiet User > Select User (Lietotājs > Atlasīt lietotāju), lai atvērtu
dialoglodziņu Login (Pieteikšanās).

2. Atlasiet vārdu no nolaižamā saraksta User Name (Lietotājvārds).

3. Ierakstiet jaunā lietotāja paroli.

4. Noklikšķiniet uz OK (Labi), lai aizvērtu dialoglodziņu Login (Pieteikšanās) un atvērtu
programmatūru.

Lietotāju paroļu mainīšana
CFXManager Dx lietotāji jebkurā laikā var mainīt savu paroli.

Lietotāju paroļu maiņa

1. Logā Home (Sākums) atlasiet User > Change Password (Lietotājs > Mainīt paroli), lai atvērtu
dialoglodziņu Change Password (Mainīt paroli).

2. Laukā Old Password (Vecā parole) ierakstiet pašreizējo paroli.

3. Laukā New Password (Jaunā parole) ierakstiet jauno paroli, un vēlreiz ierakstiet to laukā Confirm
New Password (Apstiprināt jauno paroli).

4. Noklikšķiniet uz OK (Labi), lai apstiprinātu izmaiņas.
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B pielikums. Lietotāju un lomu CFXManager Dx pārvaldīšana

Savas lomas un tiesību skatīšana
Padoms. Lietotāji, kuriem piešķirtas lietotāju lomas Galvenais, Operators vai Viesis, var skatīt
tikai savus lietotāja iestatījumus, tiesības un lomas.

Savu pašreizējo lietotāja lomu un tiesību skatīšana

u Logā Home (Sākums) atlasiet User > User Administration (Lietotājs > Lietotāju administrēšana).

Sazinieties ar savu CFX Manager Dx administratoru, lai modificētu lietotāja iestatījumus, tiesības un
lomas, kādas uzskaitītas logā User Administration (Lietotāju administrēšana).
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C pielikums. LIMS integrācija
Jūs varat konfigurēt CFX Manager Dx programmatūru lietošanai kopā ar laboratorijas informācijas
vadības sistēmu (LIMS). Lai integrētu LIMS, CFX Manager Dx nepieciešama trauciņu iestatīšanas
informācija, ko ģenerē LIMS platforma (LIMS fails — *.plrn), protokola fails, kas izveidots, izmantojot
CFX Manager Dx software (*.prcl), definēta datu eksportēšanas vieta un definēts eksportēšanas
formāts.

Pēc izpildes pabeigšanas CFX Manager Dx ģenerē datu failu (.pcrd) un saglabā to definētā datu
eksportēšanas mapē. CFX Manager Dx var izveidot arī ar LIMS saderīgu datu failu .csv formātā un
saglabāt to tajā pašā vietā.

Ar LIMS saderīgu datu failu izveide
Šajā pielikumā izskaidrots, kā iestatīt CFX Manager Dx programmatūru, lai izveidotu, saglabātu un
eksportētu ar LIMS saderīgus datu failus.

LIMS mapes un datu eksportēšanas opciju iestatīšana
CFXManager Dx Pēc noklusējuma saglabā LIMS protokolus, failus un datu eksportēšanas failus
mapē
_ C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Jūs varat konfigurēt CFX Manager Dx, lai saglabātu failus citā mapē, un mainīt LIMS datu
eksportēšanas opcijas.

LIMS mapes un datu eksportēšanas opciju iestatīšana

1. Logā Home (Sākums) atlasiet Tools > Options (Rīki > Opcijas).

2. Dialoglodziņā Options (Opcijas) atlasiet Data Export Settings (Datu eksportēšanas iestatījumi).
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C pielikums. LIMS integrācija

3. (Papildiespēja) Atlasiet opciju Automatically export LIMS data at end of run (Automātiski
eksportēt LIMS datus izpildes beigās).

Programmatūra automātiski eksportē LIMS datus pēc katras izpildes un saglabā tos norādītajā
vietā.

4. Lai mainītu LIMS datu eksportēšanas opcijas, noklikšķiniet uz LIMS Data Export Settings (LIMS
datu eksportēšanas opcijas).

Svarīgi! Atpakaļ CFX Manager Dx var importēt tikai tos LIMS datus, kas eksportēti .csv failā.

5. Dialoglodziņā LIMS Data Export Format Settings (LIMS datu eksportēšanas formāta iestatījumi)
atlasiet nepieciešamās eksportēšanas opcijas un noklikšķiniet uz OK (Labi).

6. Dialoglodziņā Options (Opcijas) navigējiet un atlasiet noklusējuma mapi, kurā vēlaties saglabāt
LIMS datu failus. Katram failu veidam varat atlasīt citu atrašanās vietu:

n Protokols

n LIMS fails

n Datu eksportēšana

7. Noklikšķiniet uz OK (Labi), lai saglabātu izmaiņas un aizvērtu dialoglodziņu Options (Opcijas).

LIMS protokola izveide
Lai palaistu LIMS izpildi, izveidojiet CFX Manager Dx protokola failu (*.prcl) un saglabājiet to tam
paredzētajā LIMS protokolu mapes atrašanās vietā.

Papildinformāciju skatiet šeit 6. nodaļa, Protokolu izveide
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Ar LIMS saderīgu datu failu izveide

LIMS faila izveide
LIMS fails (*.plrn) satur trauciņa iestatīšanas informāciju un protokola faila nosaukumu. Šo failu ir
ģenerējis jūsu iekšējais LIMS. CFX Manager Dx izmanto LIMS failu, lai izveidotu trauciņa failu
izmantošanai kopā ar protokola failu.

CFX Manager Dx nodrošina trauciņa importēšanas veidnes failus, kurus varat rediģēt, lai izveidotu
pielāgotu LIMS trauciņu failus.

Padoms. Šis uzdevums jāveic LIMS speciālistam.

LIMS faila izveide

1. Logā Home (Sākums) atlasiet View > Show > LIMS File Folder (Skatīt > Rādīt > LIMS failu mape).

2. Atveriet mapi LIMS Templates (LIMS veidnes) un atlasiet .csv failu, lai importētu to iekšējā LIMS.

3. Ar LIMS palīdzību rediģējiet veidnes failu, aizpildot obligātos laukus, kas uzskaitīti 40. tabula.

4. Saglabājiet veidni mapē LIMS File Folder (LIMS failu mape) ar faila nosaukuma paplašinājumu
.plm.

Svarīgi! CFXManager Dx var atvērt tikai .plm failu. Lai sāktu LIMS izpildi, jums jāsaglabā
.csv fails kā .plm fails.

Kolonna
Row
(rinda) Apraksts

Content
(Saturs) Nolūks

A 1 Trauciņa galvene Nerediģēt Iepriekš
definēts

A, B, C 2 Lauks/dati/norādījums Nerediģēt Iepriekš
definēts

40. tabula. LIMS .csv faila satura skaidrojums
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Kolonna
Row
(rinda) Apraksts

Content
(Saturs) Nolūks

B 3 Versija Nerediģēt Iepriekš
definēts

B 4 Trauciņa lielums Nerediģēt Iepriekš
definēts

B 5 Trauciņa veids Ievadiet “BR
White” (BR balts),
“BR Clear” (BR
caurspīdīgs) vai
citu kalibrētu
trauciņa veidu

Obligāts

B 6 Skenēšanas režīms Ievadiet
“SYBR/FAM
Only:” (Tikai
SYBR/FAM:), “All
Channels” (Visi
kanāli) vai “FRET”

Obligāts

40. tabula. LIMS .csv faila satura skaidrojums, turpinājums
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Kolonna
Row
(rinda) Apraksts

Content
(Saturs) Nolūks

B 7 Mērvienības Ievadiet vienu no
tālāk norādītajām:
“copy number”
(kopijas numurs),
“fold dilution”
(atšķaidīšanas
kārta),
“micromoles”
(mikromoli),
“nanomoles”
(nanomoli),
“picomoles”
(pikomoli),
“femtomoles”
(femtomoli),
“attomoles”
(atomoli),
“milligrams”
(miligrami),
“micrograms”
(mikrogrami),
“nanograms”
(nanogrami),
“picograms”
(pikogrami),
“femtograms”
(femogrami),
“attograms”
(atogrami) vai
“percent”
(procenti)

Obligāts

40. tabula. LIMS .csv faila satura skaidrojums, turpinājums
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Kolonna
Row
(rinda) Apraksts

Content
(Saturs) Nolūks

B 8 Run ID (Izpildes ID) Ievadiet īsu
aprakstu par
svītrkodu, kas
identificē šo izpildi
(ne vairāk kā 30
rakstzīmes,
komatu lietošana
nav atļauta)

Optional
(Izvēles)

B 9 Piezīme par izpildi Ievadiet izpildes
aprakstu

Optional
(Izvēles)

B 10 Izpildes protokols Ievadiet protokola
failu precīzi, kā
norādīts.

Obligāts

A 11 Datu fails Ievadiet datu faila
nosaukumu

Optional
(Izvēles)

A 12–15 Jāaizpilda/tukšs Nerediģēt Iepriekš
definēts

A 0 Trauciņa dati Nerediģēt Iepriekš
definēts

40. tabula. LIMS .csv faila satura skaidrojums, turpinājums
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Kolonna
Row
(rinda) Apraksts

Content
(Saturs) Nolūks

A 17–113 Iedobes pozīcija Nerediģēt Iepriekš
definēts

40. tabula. LIMS .csv faila satura skaidrojums, turpinājums
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Kolonna
Row
(rinda) Apraksts

Content
(Saturs) Nolūks

B–G Ch1 krāsviela, Ch2
krāsviela, Ch3 krāsviela,
Ch4 krāsviela, Ch5
krāsviela, FRET

Ievadiet vienu
kalibrētās
krāsvielas
nosaukumu
(piemēram,
“FAM”) katram
izmantotajam
kanālam

Obligāts

40. tabula. LIMS .csv faila satura skaidrojums, turpinājums
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Kolonna
Row
(rinda) Apraksts

Content
(Saturs) Nolūks

H Parauga veids Ievadiet vienu no
tālāk norādītajiem
paraugu veidiem:
“Nezināms”,
“Standarta”,
“Pozitīvā kontrole”,
“Negatīvā
kontrole”, “NTC”
vai “NRT”

Obligāts

I Parauga nosaukums Ievadiet parauga
nosaukumu

Optional
(Izvēles)

J–O CH1 mērķis, CH2 mērķis,
CH3 mērķis, CH4 mērķis,
CH5 mērķis, FRET mērķis

Ievadiet mērķa
nosaukumu
katram
izmantotajam
kanālam

Optional
(Izvēles)

P Bioloģiskā komplekta
nosaukums

Ievadiet bioloģiskā
komplekta
nosaukumu

Optional
(Izvēles)

Q Kopija Ievadiet pozitīvu
veselu skaitli
katram kopiju
komplektam.
Vērtība nevar būt
nulle.

Optional
(Izvēles)

R–W CH1 daudzums, CH2
daudzums, CH3
daudzums, CH4
daudzums, CH5
daudzums, FRET
daudzums

Ievadiet
daudzuma
vērtības jebkuriem
standartiem.
Ievadiet
koncentrāciju
decimālā formātā.

Obligāts visiem
standartiem

40. tabula. LIMS .csv faila satura skaidrojums, turpinājums
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Kolonna
Row
(rinda) Apraksts

Content
(Saturs) Nolūks

X Iedobes piezīme Ievadiet iedobes
piezīmi (ne vairāk
par 20
rakstzīmēm)

Optional
(Izvēles)

Y–AD Ch1 iedobes krāsa, Ch2
iedobes krāsa, Ch3
iedobes krāsa, Ch4
iedobes krāsa, Ch5
iedobes krāsa, FRET
iedobes krāsa

Ievadiet jebkuru
lietotāja definētu
trajektorijas stila
krāsu 32 bitu
veselu skaitļu
(argb) decimālā
formātā

Optional
(Izvēles)

40. tabula. LIMS .csv faila satura skaidrojums, turpinājums

LIMS izpildes palaišana
LIMS izpildes palaišana

1. Lai atvērtu LIMS .plrn failu, veiciet vienu no norādītajām darbībām:

n Logā Home (Sākums) atlasiet View > Show > LIMS File Folder (Skatīt > Rādīt > LIMS failu
mape) un atveriet mērķa .plrn failu.

n Logā Home (Sākums) atlasiet File > Open > LIMS File (Fails > Atvērt > LIMS fails) un atveriet
mērķa .plrn failu.

Fails atveras cilnē Start Run (Sākt izpildi) vednī Run Setup (Izpildes iestatīšana). Cilnē Start Run
(Sākt izpildi) redzama informācija par izpildāmo eksperimentu. Tur redzams arī pievienotais
instrumentu bloks vai bloki, kuros varat izpildīt eksperimentu.

2. Cilnē Start Run (Sākt izpildi) atlasiet instrumentu un noklikšķiniet uz Start Run (Sākt izpildi).
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Datu eksportēšana uz LIMS
Kad izpilde ir pabeigta, CFX Manager Dx ģenerē datu (.pcrd) failu un saglabā to noteiktajā datu
eksporta mapes atrašanās vietā.

Lai eksportētu datu failu uz LIMS

u Atveriet .pcrd failu un atlasiet Export > Export to LIMS Folder (Eksports > Eksportēt uz LIMS
mapi).

Padoms. Ja atlasāt Automatically Export Data after Run (Automātiski eksportēt datus pēc
izpildes) logā LIMS Options (LIMS opcijas), CFX Manager Dx izveido ar LIMS saderīgu datu failu
.csv formātā un saglabā to tajā pašā mapē.
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D pielikums. Problēmu novēršana CFX Manager
Dx programmatūras savienojuma problēmas

Lietojumprogrammas žurnāls
Pirms jaunas izpildes sākšanas CFX96 un CFX96 DeepWell instrumenti iniciē pašdiagnosticēšanas
pārbaudi, lai pārliecinātos, vai darbojas specifikāciju robežās. Programmatūra reģistrē šīs pārbaudes
rezultātus izpildes žurnāla un lietojumprogrammas žurnāla failā. Ja pamanāt problēmu vienā vai
vairākos eksperimentos, atveriet izpildes un lietojumprogrammas žurnālus, lai uzzinātu, kad problēma
ir sākusies.

CFX Manager Dx izseko informāciju par instrumenta stāvokli izpildes laikā, reģistrējot to
lietojumprogrammas žurnālā. Lietojiet šos žurnālus, lai izsekotu notikumus, kas atgadās ar
instrumentiem un programmā, un kādas problēmas jānovērš.

Lai atvērtu lietojumprogrammas žurnālu

u Logā Home (Sākums) atlasiet View > Application Log (Skatīt > Lietojumprogrammas žurnāls).
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Problēmu novēršana
Parasti programmatūras un instrumentu sakaru problēmas var atrisināt, restartējot datoru un sistēmu.
Pirms restartēšanas noteikti saglabājiet ikvienu notiekošo darbu.

Piezīme. Pārliecinieties, vai datoram ir pietiekama RAM un brīva vieta diskā. Minimālais RAM ir 4
GB, un minimālā vieta cietajā diskā— 128 GB.

Strāvas padeves pārtraukums
Strāvas padeves pārtraukuma gadījumā instruments un dators izslēgsies. Ja strāvas padeves
pārtraukums ir īss, instruments atsāks izpildīt protokolu, taču lietojumprogrammas žurnālā tiks veikta
piezīme par strāvas padeves pārtraukumu. Atkarībā no datora iestatījumiem, barošanas atslēgšanas
ilguma un protokola darbības instruments un programmatūra mēģina turpināt izpildi:

n Ja jāizpilda protokola darbība bez trauciņa nolasīšanas, protokola izpilde tiks turpināta, tiklīdz
instruments saņems barošanu.

n Ja jāizpilda protokola darbība ar trauciņa nolasīšanu, instruments gaidīs, kamēr programmatūra
restartēsies un atjaunos sakarus, lai vāktu datus. Šādā situācijā protokola izpilde turpināsies tikai
tad, ja programmatūru nav izslēdzis dators. Kad dators un programmatūra tiek palaisti atkārtoti,
turpinās protokola izpilde.

Paraugu izņemšana no reakcijas moduļa strāvas padeves pārtraukuma
gadījumā

Jūs varat atvērt reakcijas moduļa motorizētu vāku, lai strāvas padeves pārtraukuma gadījumā izņemtu
paraugus.

Fiksējošās plāksnes noņemšana

1. Piespiediet fiksatoru, lai noņemtu reakcijas moduli no DNS amplifikatora C1000 Dx.

2. Uzmanīgi uzlieciet reakcijas moduli uz galda vai laboratorijas sola.

3. Novietojiet moduli tā, lai tā priekšpuse sniegtos pāri malai par 5 cm (2 collas).
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4. Ar sešstūra stieņatslēgas palīdzību noskrūvējiet divas lielās skrūves zem reakcijas moduļa
priekšējās malas (zem pogas, kas paredzēta vāka atvēršanai).

No moduļa jābūt dzirdamam, kā atbrīvojas slēgmehānisms.

Svarīgi! Neizņemiet divas mazās skrūves, kas atrodas uz moduļa priekšējās malas.

5. Pabīdiet reakcijas moduļa vāku, lai to atvērtu. Ņemiet vērā, ka slēgmehānisms (tumša plastmasa)
vairs nav piestiprināts. Izņemiet paraugus no bloka.

6. Ievietojiet atpakaļ slēgmehānismu un nostipriniet to ar lielajām skrūvēm, lai uzstādītu atpakaļ
reakcijas moduļa vāku.
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Failu izgūšana CFX Manager Dx datorā
Jūs varat izgūt datus un žurnāla failus, kas atrodas instrumentā, un pārsūtīt tos uz pievienotā datora
cieto disku.

Piezīme. Visi faili instrumenta pamatnes reāllaika datu mapē tiek izgūti datorā.

Lai izgūtu failus no instrumenta

1. Loga Home (Sākums) rūtī Detected Instruments (Atklātie instrumenti) ar peles labo pogu
noklikšķiniet uz mērķa instrumenta un atlasiet vienu no tālāk redzamajām opcijām:

n Retrieve Log Files (Izgūt žurnāla failus)

n Retrieve Data Files (Izgūt datu failus)

2. Izvēlieties mapes, kurā saglabāt izgūtos failus, atrašanās vietu.

3. Noklikšķiniet uz Okay (Labi).

CFX Manager Dx programmatūras manuāla instalēšana
Manuāla CFX Manager Dx software programmatūras instalēšana

1. Ja nepieciešams, atvienojiet no datora visus pievienotos instrumentus.

Sameklējiet un atvienojiet instrumenta USB kabeli no CFX Manager Dx datora. Instrumentā
iespraustais kabeļa gals var palikt savā vietā.

2. Piesakieties CFX Manager Dx datorā ar administratora tiesībām.

3. Ievietojiet programmatūras CD.

4. PārlūkprogrammāWindows Explorer navigējiet uz CD, ar labo peles pogu noklikšķiniet uz
programmatūras CD ikonas un atlasiet Explore (Pārlūkot), lai atvērtu logu CD.

5. Veiciet dubultklikšķi uz mapes CFX_Manager, lai to atvērtu, un pēc tam veiciet dubultklikšķi uz
setup.exe, lai startētu programmatūras instalēšanas vedni.

6. Ievērojiet vednī sniegtos norādījumus, lai instalētu programmatūru, un pēc tam noklikšķiniet uz
Finish (Pabeigt).
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Draiveru pārinstalēšana
Instrumentu draiveru pārinstalēšana

u Logā Home (Sākums) atlasiet Tools > Reinstall Instrument Drivers (Rīki > Atkārtoti instalēt
instrumentu draiverus).

Piezīme. Ja pēc draiveru pārinstalēšanas un USB savienojuma pārbaudes ir problēmas
programmatūras sakaros ar reāllaika sistēmu, sazinieties ar Bio-Rad tehniskā atbalsta dienestu.
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Pārdale un lietojums avota un binārajās formās, ar modificēšanu vai bez tās, ir atļauti ar nosacījumu,
ka ir ievēroti šādi nosacījumi:

1. Avota koda pārdalēs ir jāsaglabā iepriekš redzamais autortiesību paziņojums, šis nosacījumu
saraksts un turpinājumā esošā atruna.

2. Pārdalēs binārā formā ir jāreproducē iepriekš redzamais autortiesību paziņojums, šis nosacījumu
saraksts un turpinājumā esošā atruna dokumentācijā un/vai citos materiālos, kas tiek iedalīti līdzi.

3. Galalietotāja dokumentācijā (ja tāda ir), kas tiek iekļauta pārdalē, jāietver šāds apliecinājums:

“Šajā produktā ir iekļauta programmatūra, ko izstrādājusi Čikāgas universitāte kā Argonnes
Nacionālās laboratorijas operators.”
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